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What is Mathcad?

Mathcad is a unique new way to work with formulas, numbers, text, and graphs.
Mathcad is as versatile as the most powerful spreadsheets and programming lan-
guages, yet it’s easy to learn and a pleasure to use.

Mathcad lets you type equations as you’re used to seeing them, expanded fully
on your screen. In a programming language, equations look something like this:

x=(-B+SQRT(B**2-4*A*C))/(2*A)

In a spreadsheet, equations go into cells looking something like this:

+(B1+SQRT(B1*B1-4*A1*C1))/(2*A1)

And that’s assuming you can see them. Usually all you see is a number.

In Mathcad, the same equation looks the way you might see it on a blackboard
or in a reference book:

But Mathcad equations do much more than look good. You can use them to
solve just about any math problem you can think of, symbolically or numeri-
cally. You can place text anywhere around them to document your work. You
can show how they look with Mathcad’s two and three dimensional plots. You
can even illustrate your work with graphics taken from another Windows appli-
cation.

Mathcad comes with its own on-line reference system as well. Mathcad’s Elec-
tronic Books make many useful formulas, data values and diagrams available in
your worksheet at the click of a button.

By combining text, graphics and equations in a single worksheet, Mathcad
makes it easy to keep track of the most complex calculations. By printing the
worksheet exactly as it appears on the screen, Mathcad lets you make a perma-
nent and accurate record of your work. 
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Mathcad features

Here is a short list of Mathcad’s features:

Interface features

Free-form, scratchpad-type interface.

Mix text, mathematics, and graphs anywhere on screen.

On-screen graphical equation editing.

Error checking: error messages flag individual equations.

Cut and paste for equations, text, plots and graphs.

Typing aids for Greek letters, operators, units and functions.

Full Windows compatibility: Resize and move windows, open multiple win-
dows, mouse support.

Context sensitive on-line Help.

Electronic Books with hundreds of standard formulas, constants, diagrams
and more.

Computational features

Precision: 15 decimal digits of accuracy for computed results; exact answers
for symbolic results.

Built-in units of measurement and dimension checking.

Built-in solver for simultaneous equations and inequalities.

Complex numbers, variables, and functions.

Derivatives and integrals.

Summations, products, and iteration.

Octal, decimal, and hexadecimal numbers.

Trigonometric, hyperbolic, exponential and Bessel functions.

Statistical functions including linear regression, gamma function, erf, cumula-
tive normal distribution.

Cubic spline curve-fitting.

Fast Fourier transforms, both one and two dimensional.

User-definable functions.

Vectors and matrices, including operations for matrix multiplication, matrix
inverse, transpose, determinant, dot and cross product.
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Symbolic features

Symbolic integration and differentiation.

Inverse, transpose and determinant of a matrix.

Factoring and simplifying expressions.

Solving equations.

Plotting features

One keystroke to generate a plot, then fill in the blanks.

A variety of plot types: rectangular (x-y) plots, polar plots, surface plots, con-
tour plots, vector field plots, three dimensional bar charts, scatter plots.

Graph axes can be linear or logarithmic, with or without grid lines.

Multiple line types, colors and line weights on graphs.

One or more traces per plot, identified by legends.

Three-dimensional surface plots, with variable perspective and scaling.

Import graphics via the clipboard.

Animation of plots, or anything else in your worksheet.

Text and worksheet features

Automatic word wrap.

Place text anywhere in the worksheet.

Spell checking with user-customizable dictionary.

Mix font, size, and style in each text region.

Paragraph formatting, alignment.

Printout reflects on-screen appearance — what you see is what you get.

Programming features 

Conditional branching

Looping constructs

Recursive definitions

Communication features

Open worksheets located anywhere on the Internet.

Establish hypertext links to other worksheets located anywhere in the world.
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How to use this manual 

This User’s Guide is organized into the following parts:

Getting Started
This section contains information on how to install Mathcad under Windows
as well as a quick introduction to Mathcad’s features.

Editing and Worksheet Features
This section describes how to edit equations and worksheets. It leads you
through the basic features of the Mathcad document-style interface. This sec-
tion covers editing and formatting equations and text, opening, saving, and
printing Mathcad worksheets, and using Mathcad with the Internet.

Computational Features
This section describes how Mathcad interprets equations and explains Math-
cad’s computational features: units of measurement, complex numbers, ma-
trices, built-in functions, equation-solving, programming and so on. This
section also describes how to do symbolic calculations.

Graphics Features
This section describes how to create and format Mathcad a variety of two
and three dimensional plots. It also describes how to import graphics into
Mathcad and how to create an animation clip of anything in your worksheet.

The User’s Guide ends with some useful reference appendices and a comprehen-
sive index.

As far as possible, the topics in this manual are described independently of each
other. This means that once you are familiar with the basic workings of the pro-
gram, you can just select a topic of interest and read about it.

If you’re trying to learn by reproducing screenshots from this User’s Guide,
keep in mind that some of them may be difficult to recreate because they con-
tain equations other than those displayed, because default plot formats and nu-
merical formats are not always used, because they involve random number
generation or because they use data files not available to you.
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Getting Started





Chapter 0
Setting up Mathcad for 
Macintosh

This chapter describes how to set up Mathcad to run under the
Macintosh, including hardware and software requirements. It
describes what files Mathcad needs, and how to install them. 

The following sections make up this chapter:

System requirements
Hardware and software requirements for Mathcad.

Installation
Instructions for using the installation program to copy files to the appro-
priate directories on your hard disk.

New Features
A summary of differences between Mathcad 6.0 and Mathcad 5.0.
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System requirements

  Mathcad requires the following hardware and software:

Hardware
A PowerPC or a Macintosh running a 68030 or higher processor.

A floating point unit (FPU), although not required, will significantly improve
performance when you’re using a 68030 (or higher) based Macintosh. 

At least 8 megabytes of memory.  

A hard disk with at least 20 megabytes of free space for Mathcad files.

Software
Macintosh System 7.0 or later.

Installation

All files on the Mathcad disks are compressed and should not be copied directly.
Mathcad comes with an installation script which creates a folder on your hard
disk and expands the necessary files into this folder.

Before you install Mathcad, make sure you backup your installation disks. To in-
stall Mathcad:

Place the disk marked “Disk 1” in the floppy disk drive.

Double-click on the icon named “Installer” and follow the on-screen instruc-
tions.

To start Mathcad, double-click on the Mathcad icon.

Choose About Mathcad from the ? menu and write down your serial number
in a safe place. There’s a space in the inside front cover of the User’s Guide
where you can write it down. You’ll need this number to get technical sup-
port.

Please send your registration card directly to MathSoft. This will allow us to
keep you informed of upgrades and new products.

If you have any problems installing Mathcad check the release notes distributed
with this version of Mathcad. You can read them by double-clicking on the “Re-
lease Notes” icon.   

If after having checked the release notes you are still having trouble, contact
MathSoft Technical Support. See the Getting Started leaflet enclosed with your
product for details.
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New features

If you’ve used Mathcad 5.0, you’ll notice many new features as well as many
new ways of doing things.

Enhancements to Cartesian and polar plots
Crossed axes in polar and Cartesian plots to show all four quadrants at once.
Individually select axes for labeling and formatting, plot tracing, adjusting
line weights on plots.

More types of 3D plots
Scatter plots, three-dimensional bar charts, vector field plots, plotting trajec-
tories in three dimensions.

Enhancements to 3D Plots
Improved control over axes, colored backplanes and edges, bounding boxes.

Math in text
Embed live equations in text and edit them just as if they were separate math
regions.

Improved document layout
Controlling indentation and alignment of text.

Dozens of new statistical functions
Functions for generating random numbers, cumulative and inverse cumula-
tive distributions and probability densities for a variety of commonly used
probability distributions.

Programmability 
Programming constructs such as loops and conditional branching, local as-
signment, recursive function definitions.

QuickSheets

A collection of templates for performing common procedures, all compiled
into a convenient, ready to use Electronic Book. 

Locked regions
Set aside a tamper-proof area of your worksheet for depositing anything you
don’t want anyone to accidentally change.

Advanced data smoothing functions
Smoothing with kernels and running medians, adaptive smoothing algo-
rithms.

Advanced regression functions
Multidimensional regression, adaptive regression methods.

Internet access
Open Mathcad worksheets located on any Internet server anywhere in the
world.
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Animation 
View dynamic processes by animating plots or calculations.

Hypertext links to other Mathcad worksheets
Create “hot-spots” for jumping to other Mathcad worksheets, either on your
own file system or anywhere in the world via the Internet.

Dragging across worksheets
Drag regions directly from one worksheet to another, bypassing the clip-
board altogether.

Operator extensibility
Define your own custom operators as easily as you’d define a function.
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Chapter 1
The Basics

This chapter describes everything you need to get started with
Mathcad. The following sections make up this chapter:

First principles
Mathcad’s design and interface.

What you can do with Mathcad
Starting Mathcad.

A simple calculation
Calculating with Mathcad.

Definitions and variables
Creating simple Mathcad equations.

Entering text
Adding notes and labels to a worksheet.

Regions and menus
How equations, text, and plots make up a worksheet; Mathcad’s menu
commands.

Iterative calculations
Using range variables to repeat an equation for several values.

Graphs
Building a simple two dimensional plot.

Saving, printing, and quitting
The Save and Print commands from the File menu.

Help
Mathcad’s on-line help system, its context sensitive help, balloon help,
and the use of QuickSheets for live examples.

Electronic Books
Using Mathcad’s Electronic Books to paste common formulas and dia-
grams into your worksheet.
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First principles 

Mathcad looks simple, and it is. It was created according to basic design princi-
ples to make it powerful, flexible, and easy to use. In Mathcad:

Everything appears in familiar math notation. If there’s a standard mathe-
matical way to show an equation, operation, or graph, Mathcad uses it.

What you see is what you get. There is no hidden information; everything
appears on the screen. When you print, the output looks just like the screen
display.

To create simple expressions, just type them. Mathcad uses the standard
keys for standard mathematical operations.

Typing aids make equations easier to enter. There are palettes for many of
the less common operators. Click on formulas or pictures in Mathcad’s Elec-
tronic Books to insert them into your worksheet. 

Fill in the blanks. Mathcad guides you through the creation of plots, inte-
grals, and other mathematical expressions by laying down the framework and
letting you fill in the blanks.

Calculation features are modular. If you don’t want to use a feature — like
complex numbers, units, or matrices — you can just pretend it isn’t there. 

The numerical algorithms are robust, standard, and predictable. Math-
cad’s numerical algorithms for things like integrals, matrix inversion, and
equation solving are reliable standard methods.

On-line help. Pressing [Command]/ brings up an extensive on-line help sys-
tem. Click on error messages, operators and functions and press [Com-
mand]/ to display the relevant help screen. There’s no need to search for the
topic you’re interested in. The User’s Guide includes more detail on all the
features, with step-by-step instructions and illustrative examples. At the back
of the User’s Guide is a complete cross-referenced index. 

QuickSheets. A collection of commonly used Mathcad procedures in a live
document interface. If you have a particular task in mind, you can look in
QuickSheets for a prefab working template and drag it right into your own
worksheet. 

Electronic Books. A variety of useful formulas, constants and graphic im-
ages are compiled in the Desktop Reference Book shipped with Mathcad.
You can insert many of them directly into your worksheet by clicking with
the mouse.

This chapter provides a quick introduction to Mathcad and demonstrates a few
more advanced features like iterative calculation and plotting. After you read
this chapter, you’ll have enough information to begin to solve your own prob-
lems in Mathcad. The rest of this User’s Guide describes all the features in de-
tail, so you can learn more about any selected topic.
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Notations and conventions

This User’s Guide the following notations and conventions:

Italics represent scalar variable names, function names, and error messages.

Bold Courier represents keys you should type.

Filled squares indicate steps you should follow.

Bold represents a menu command. It is also used to denote vector and matrix
valued variables.

An arrow such as that in “Change Defaults⇒Text” indicates a pull-right menu
command.

Function keys and other special keys are enclosed in brackets. For example, [↑],
[↓], [←], and [→] are the arrow keys on the keyboard. [F1], [F2], etc., are func-
tion keys; [Delete] is the Delete key for backspacing over characters; [Del] is
the Delete key for deleting characters to the right; and [Tab] is the Tab key.

[Ctrl], [Shift], and [Command] are the Control, Shift, and keys. When two
keys are shown together, for example, [Command]V, press and hold down the
first key, and then press the second key.

The symbol [↵] and [Return] refer to the same key.

When this User’s Guide shows spaces in an equation, you need not type the
spaces. Mathcad automatically spaces the equation correctly.

A Mathcad window takes on a variety of appearances depending on how you’ve
configured the various palettes. To maximize available space, nearly all screen-
shots in this User’s Guide are taken with all palettes, toolbars and font bars hid-
den.

What you can do with Mathcad 

Mathcad combines the live document interface of a spreadsheet with the WYSI-
WYG interface of a word processor. With Mathcad, you can typeset equations
on the screen exactly the way you see them in a book. But Mathcad equations
do more than look good on the screen. You can use them to actually do math.

Like a spreadsheet, as soon as you make a change anywhere in your worksheet,
Mathcad goes straight to work, updating results and redrawing graphs. With
Mathcad, you can easily read data from a file and do mathematical chores rang-
ing from adding up a column of numbers to evaluating integrals and derivatives,
inverting matrices and more. In fact, just about anything you can think of doing
with math, you can do with Mathcad.
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Like a word processor, Mathcad comes with a WYSIWYG interface, multiple
fonts, and the ability to print whatever you see on the screen. This, combined
with Mathcad’s live document interface, makes it easy to produce up-to-date,
publication quality engineering reports. 

Starting Mathcad

For instructions on how to install Mathcad on your computer, see the previous
chapter, “Setting up Mathcad for Macintosh.”

When you double-click on the Mathcad icon, you’ll see the window shown in
Figure 1. 

Figure 1: A Mathcad window showing the palette buttons, the toolbar and the
font bar.

You can place equations anywhere in the Mathcad worksheet. To get to places
not visible in the window, use the scroll bars as you would in any Macintosh ap-
plication.
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Each button in the strip of buttons just below the menus opens a symbol palette.
You can insert many operators, Greek letters, and plot regions by clicking on the
buttons found on these palettes. From left to right, these palettes are:  

 Button Opens palette...

Common arithmetic operators.

Equal signs for evaluation and definition. Boolean expressions.

Various two and three dimensional plot types.

Matrix and vector operators.

Derivatives, integrals, limits and iterated sums and products.

Programming constructs.

Greek letters.

Below this strip of buttons is the toolbar. Many menu commands can be ac-
cessed more quickly by clicking a button on the toolbar. To learn what a button
does, click on the button and read the message line. If you don’t want to activate
the button, move the pointer away without releasing the mouse button. If you
just want to know what the button does, let the pointer rest on the button momen-
tarily. You’ll see some text beside the pointer telling you what that button does.

The font bar is immediately under the toolbar. This contains scrolling lists and
buttons used to specify font characteristics in equations and text.

To conserve screen space, you can show or hide each of these features individu-
ally by choosing the appropriate command from the Window menu. Throughout
the figures in this User’s Guide, the symbol palette, the toolbar and the font bar
have all been hidden to allow more space for examples.

You can also detach each of these window elements and drag them around your
window. To do so, place the mouse pointer anywhere other than on a button or a
text box. Then press and hold down the mouse button and drag. You’ll find that
the toolbar and the symbol palette will rearrange themselves appropriately de-
pending on where you drag them. The font bar, on the other hand, will retain its
shape no matter where you drag it.
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A simple calculation 

Although Mathcad can perform sophisticated mathematics, you can just as eas-
ily use it as a simple calculator. To try your first calculation, follow these steps:

Click anywhere in the worksheet.
You see a small crosshair. Any-
thing you type appears at the
crosshair.

Type 15-8/104.5= . When you
press the equals sign, Mathcad com-
putes and shows the result.

This calculation demonstrates the way Mathcad works:

Mathcad shows equations as you might see them in a book or on a black-
board, expanded fully in two dimensions. Mathcad sizes fraction bars, brack-
ets, and other symbols to display equations the same way you would write
them on paper.

Mathcad understands which operation to perform first. In this example, Math-
cad knew to perform the division before the subtraction and displayed the
equation accordingly.

As soon as you type the equals sign, Mathcad returns the result. Unless you
specify otherwise, Mathcad processes each equation as you enter it. See the
section “Controlling calculation” in Chapter 6 to learn how to change this.

As you type each operator (in this case, − and / ), Mathcad shows a small rec-
tangle called a placeholder. Placeholders hold spaces open for numbers or ex-
pressions not yet typed. As soon as you type a number, it replaces the
placeholder in the equation. The placeholder that appears at the end of the
equation is used for unit conversions. Its use is discussed in the section “Dis-
playing units of results” in Chapter 8.

Once an equation is on the screen, you can edit it by clicking in the appropriate
spot and typing new letters, digits, or operators. You can type many operators
and Greek letters by clicking in the symbol palette located just below the menu
bar. Chapter 2, “Editing Equations,” explains in detail how to edit Mathcad
equations.
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Definitions and variables 

Mathcad’s power and versatility quickly become apparent once you begin to use
variables and functions. By defining variables and functions, you can link equa-
tions together and use intermediate results in further calculations.

The following examples show how to define and use several variables.

Defining variables 

To clear the previous equation and define a variable t, follow these steps:

Click in the equation you just typed
and press [Space] until the entire
expression is held between the two
editing lines. Then choose Cut
from the Edit menu.  

Now begin defining t. Type t: 
(the letter t, followed by a colon).
Mathcad shows the colon as the
definition symbol :=. 

Type 10 in the empty placeholder
to complete the definition for t.

If you make a mistake, click on the equation and press [Space] until the entire
expression is between the two editing lines, just as you did earlier. Then delete it
by choosing Cut from the Edit menu.

These steps show the form for typing any definition: 

Type the variable name to be defined.

Type the colon key to insert the definition symbol.

Type the value to be assigned to the variable. The value can be a single num-
ber, as in the example shown here, or a more complicated combination of
numbers and previously defined variables.
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Mathcad worksheets read from top to bottom and left to right. Once you have de-
fined a variable like t, you can compute with it anywhere below and to the right
of the equation that defines it. 

Now enter another definition.

Press [↵]. This moves the crosshair below the first equation.

To define acc as –9.8, type: acc:–9.8 . Then press [↵] again.

Figure 2 shows the two definitions you just entered.

Figure 2: Equations to define acc and t.

Calculating results 

   Now that the variables acc and t are defined, you can use them in other expres-
sions.

Click the mouse a few lines below the two definitions (see Figure 2). 

Type acc/2 [Space ]*t^2 . The caret symbol (^ ) represents raising to a
power, the asterisk (* ) is multiplication, and the slash (/ ) represents division.

Press the equals sign “=.”

This equation calculates the distance traveled by a falling body in time t with ac-
celeration acc. When you enter the equation, Mathcad returns the result as
shown in Figure 3. The window now contains two definitions, which define vari-
ables, and one evaluation, which computes a result.
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Figure 3: Calculating with variables.

Mathcad updates results as soon as you make changes. For example, If you click
on the 10 on your screen and change it to some other number, Mathcad changes
the result as soon as you press [↵] or click outside of the equation.

Entering text 

Mathcad handles text as easily as it does equations, so you can make notes about
the calculations you are doing. To begin typing text, click in an empty space and
choose Text Region from the Insert menu, press the double-quote key (") or
click on the text region button on the toolbar.

Here’s how to enter some text:

Click in the blank space to the right of the equations you entered. You’ll see a
small crosshair.

Press " to tell Mathcad that you’re about to enter some text. Mathcad changes
the crosshair into a vertical line called the insertion point. Characters you
type appear behind this line. A box surrounds the insertion point, indicating
you are now in a text region. This box is called a text box. It will grow as you
enter text.

Type Equations of motion

Mathcad shows the text in the worksheet, next to the equations (Figure 4).
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Figure 4: Entering text. Notice the text box surrounding it.

To enter a second line of text, just press [↵] and continue typing:

Press [↵].

Then type for falling body under gravity.

Click in a different spot in the worksheet or press [Shift][↵] to move out of
the text region. The text box will disappear once you have done this. Don’t
use the [↵] key. If you press [↵], Mathcad will insert a line break in the text
instead of leaving the text region.

Figure 5 shows the worksheet with two lines of text and the cursor outside the
text region. Since you are outside the text region, the cursor appears as a small
cross, and the text box is no longer visible.
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Figure 5: After clicking outside of a text region.

You can set the width of a text region and change the font, size, and style of the
text in it. For more information on how to do these things, see Chapter 4, “Text.”

Regions and menus 

Mathcad lets you enter equations and text anywhere in the worksheet. Each
equation or piece of text is a region. Mathcad creates an invisible rectangle to
hold each region. A Mathcad worksheet is a collection of such regions. To see
these regions, choose Regions from the View menu. Mathcad will display blank
space in gray and leave any regions in the default color. To turn the blank space
back into the default color, choose Regions from the View menu again.

To start a new region, you must first click in blank space. This leaves a small
crosshair wherever you clicked the mouse. Then either type an equation or
choose Text Region from the Insert menu. Whichever you do, Mathcad will
place a box around the region you’re working with.

In addition to equations and text, Mathcad supports a variety of plot regions.
Plots are described later in this chapter.
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Iterative calculations 

Mathcad can do repeated or iterative calculations as easily as individual calcula-
tions. Mathcad uses a special variable called a range variable to perform itera-
tion.

Range variables take on a range of values, such as all the integers from 0 to 10.
Whenever a range variable appears in a Mathcad equation, Mathcad calculates
the equation not just once, but once for each value of the range variable. 

This section describes how to use range variables to do iterative calculations.

Creating a range variable 

To compute equations for a range of values, first create a range variable. In the
problem shown in Figure 5, for example, you can compute results for a range of
values of t from 10 to 20 in steps of 1. To do so, follow these steps:

First, change t into a range variable
by editing its definition. Click on
the 10 in the equation t := 10.
The insertion point should be next
to the 10 as shown on the right.

Type ,11. This tells Mathcad that
the next number in the range will
be 11.

Type ;20. This tells Mathcad that
the last number in the range will be
20. Mathcad shows the semicolon
as a pair of dots.

Now click outside the equation for t. Mathcad begins to compute with t de-
fined as a range variable. Since t now takes on eleven different values, there
must also be eleven different answers. These are displayed in the table shown
in Figure 6. You may have to resize your window or scroll down to see the
whole table.
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Figure 6: Generating a table of answers with a range variable.

Defining a function

You can gain additional flexibility by defining functions. Here’s how to add a
function definition to your worksheet:

First delete the table. To do so,
click anywhere in the table press
[Space] until you’ve enclosed
everything between the two editing
lines.

Now define the function d(t) by typ-
ing d(t):

Complete the definition by typing
this expression:
1600+acc/2[Space]*t^2[↵]
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The definition you just typed defines a function. The function name is d, and the
argument of the function is t. You can use this function to evaluate the above ex-
pression for different values of t. To do so, simply replace t with an appropriate
number. For example:

To evaluate the function at the
value 12.5, type d(12.5)=. Math-
cad returns the correct value as
shown on the right.

To evaluate the function once for each value of t you defined earlier, click be-
low the other equations and type d(t)=.

Mathcad shows a table of values (Figure 7). The first two values, 1.11 ⋅ 10 3

and 1.007 ⋅ 10 3, are in exponential (powers of 10) notation.

Figure 7: Using a function to return a table of answers.

Formatting a result 

You can set the display format for any number Mathcad calculates and displays.
This means changing the number of decimal places shown, changing exponen-
tial notation to ordinary decimal notation, and so on.
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For example, here’s how to change the table in Figure 7 so that none of the num-
bers in it are displayed in exponential notation:

Click on the table with the mouse. 

Choose Number from the Format menu. You see the Format Number dialog
box. This box contains settings that affect how results are displayed, includ-
ing the number of decimal places, the use of exponential notation, and
whether the number is shown in decimal, octal, or hexadecimal. The option
button beside “Local” should be filled in. This indicates that whatever you do
in this dialog box affects only the result you’ve selected. 

The default setting for Exponential Threshold is 3. This means that only num-
bers greater than or equal to 103 are displayed in exponential notation. Click
to the right of the 3, press [Delete] and type 6.

Click the “OK” button. The equa-
tion changes to reflect the new re-
sult format — 1110 is no longer
shown in exponential notation.

When you format a result, only the display of the result is affected. Mathcad
maintains full precision internally.

Graphs 

Mathcad can show both two-dimensional Cartesian and polar graphs, contour
plots, surface plots as well as a variety of other three-dimensional plots. These
are all examples of plot regions.

This section describes how to create a simple two-dimensional graph showing
the points calculated in the previous section.

Creating a graph 

To create a graph in Mathcad, click in blank space where you want the graph to
appear and choose Graph⇒X-Y Plot from the Insert menu. An empty graph
appears with placeholders for the expressions to be graphed. Graphs are driven
by range variables: Mathcad will graph one point for each value of the range
variable used in the graph. 
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For example, here’s how to create a graph of d(t) versus t, with one point for
each value of t:

Click below the equation for d(t)
and choose Graph⇒X-Y Plot
from the Insert menu. Mathcad cre-
ates an empty graph.

The insertion point should now be
at the center of the bottom axis, on
the x-axis placeholder. Type the
variable name t. This tells Math-
cad to graph t on this axis.

Now click on the placeholder half-
way up the left axis (the y-axis
placeholder). Type d(t) here, to
tell Mathcad to graph d(t) on this
axis. The remaining placeholders
are for axis limits — the high and
low values for the axis. If you leave
these blank, Mathcad automatically
fills them when it creates the graph.

Click anywhere outside the graph. Mathcad calculates and graphs the points
as shown in Figure 8. A sample line appears under the “d(t).” This helps you
identify the different curves when you plot more than one function. Unless
you specify otherwise, Mathcad draws straight lines between the points and
fills in the missing axis limits.
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Figure 8: Graph of d(t) versus t.

For detailed information on creating and formatting graphs, see Chapter 19,
“Graphs.”

Resizing a graph 

The graph shown in Figure 8 is the default size. It’s easy to make a graph in
Mathcad any size you want: just select the graph and stretch it to the desired size.

To resize a graph, follow these steps:

Click the mouse just outside the graphics region. This anchors one corner of
the selection rectangle.

Press and hold down the mouse button. With the button still held, drag the
mouse toward the plot region. A dashed selection rectangle emerges from the
anchor point. 

When the selection rectangle just
encloses the graphics region, let go
of the mouse button. 
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Move the mouse pointer to the right or bottom edge of the selection rectangle.
It will change to a double headed arrow.

Press and hold down the mouse button. With the mouse button still pressed,
move the mouse. The graphics region will be stretched in the direction of mo-
tion.

Once the graphics region is the right size, let go of the mouse button. 

Click outside the graph to deselect it.

Figure 9 shows the result: a larger graph.

Figure 9: New graph, after resizing.

Formatting a graph 

The graph in Figure 9 still has the default characteristics: numbered linear axes,
no grid lines, and points connected with solid lines. You can change these char-
acteristics by formatting the graph, just as you earlier formatted a number.

To format the graph, follow these steps:

Double-click on the graph to bring up the appropriate dialog box. This box
contains settings for all available plot format options. To learn more about
these settings, see Chapter 19, “Graphs.”

Click on the Traces tab in the dialog box to see the correct page. 
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Click on “trace 1” in the scrolling list under “Legend Label.” Mathcad places
the current settings for trace 1 in the boxes under the corresponding columns
of the scrolling list.

Click on the arrow under the Type column to see a drop-down list of trace
types.

Choose “bar” from this drop-down list by clicking on it.

Click on the “OK” button to show the result of changing the setting. Mathcad
shows the graph as a bar chart instead of connecting the points with lines (Fig-
ure 10). Note that the sample line under the d(t) now has a bar on top of it.

Click outside the graph to deselect it.
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Figure 10: Graph formatted as a bar chart.

Saving, printing, and quitting 

Once you’ve created a worksheet, you will probably want to save or print it.
This section explains how to save and print in Mathcad.

Saving a worksheet 

 To save the file,

Choose Save from the File menu or click on the disk icon in the toolbar. If
the file has never been saved before, the Save As dialog box appears. Other-
wise, Mathcad saves the file with no further prompting.  

Type the name of the file in the text box provided. By default, Mathcad saves
the file either in the folder in which Mathcad is installed or in the folder from
which you most recently opened a worksheet during the current session. To
save to another folder, locate the folder using the Save As text box.

For more information on saving and opening files, see Chapter 3, “Documents
and Windows.”

Printing 

To print, choose Print from the File menu or click on the printer icon in the tool-
bar.
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For more information on printing, see Chapter 3, “Documents and Windows.”

Quitting Mathcad 

When you’re done using Mathcad, choose Quit from the File menu. Mathcad
closes down all its windows and returns you to the Program Manager. If you’ve
made any changes in your worksheets since the last time you saved, a dialog
box appears asking if you want to discard or save your changes.

Help 

Mathcad provides several ways to get help without having to consult this User’s
Guide.

Choosing QuickSheets from the ? menu opens a collection of examples in a
live document interface similar to Mathcad’s. You can drag these right into
your worksheet and use them as templates for your own work.

Pressing [Shift][Command]/ while on an operator, function, menu com-
mand, or error message opens context sensitive help on that message.

Holding the mouse pointer momentarily over various buttons and other win-
dow elements displays a message describing whatever is under the mouse
pointer.

Various operations like editing result in informative tips on the message line
at the bottom of the Mathcad window.

The following sections describe the first three help systems in some detail. The
remaining two need no further discussion.

On-line help

To see Mathcad’s on-line Help at any time, choose Help Topics from the ?
menu, or press [Command]/.

To get help on a particular topic, click on the underlined word that suggests that
topic. The “Search” button on the help window is good for finding help on some-
thing that may appear under several topics. 

QuickSheets 

If you learn best from examples, choose QuickSheets from the ? menu. When
you do, Mathcad will open a small window containing a list of commonly used
techniques you might need as you do your work. 

Double-click on underlined text or on indicated buttons to jump to an example il-
lustrating that technique. You can use the navigational buttons at the top of the
QuickSheet window to browse through the QuickSheets. These buttons are de-
scribed in the “Electronic Books” section later in this chapter. 
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Once you’ve found an example illustrating the particular technique you’re look-
ing for, you’ll be able to experiment with variations on that procedure right in
the QuickSheet. QuickSheets will update results just as if you were in a Mathcad
worksheet.

Mathcad’s QuickSheets also work as prefab building blocks for more compli-
cated problems. For example, if occassionally you want to apply a cubic spline
interpolation to some data, you may not remember all the details involved in us-
ing the cspline function. Rather than taking the time to refresh your memory,
you may prefer to have a sort of “black box” that you can just plug into your
worksheet.  

QuickSheets are designed as self-contained units so you can easily drag them
into your worksheet and get them working with just a few minor changes. To do
so:

Open a QuickSheet on the appropriate topic.

Enclose the regions you want to copy in a selection rectangle by dragging the
mouse around them. 

Drag the mouse pointer from the QuickSheet window to wherever you want
to place the example in your worksheet. You’ll see outlines of the selected re-
gions following the pointer into the the worksheet.

Release the mouse to drop your selection in the correct spot. 

Replace any data or any parameters used in the QuickSheet with your own
data as required.

To print the QuickSheet window, close all other open windows and choose
Print from the File menu.

Figure 11 shows an example of a QuickSheet. Most QuickSheets also have a but-
ton you can use to copy whatever is currently on the QuickSheet to a clipboard.
When you double-click this button, the pointer changes to indicate that it is “car-
rying” information. To “drop” this information into your worksheet, move the
pointer wherever you want to drop the information and double-click on the
mouse.

Figure 12 shows a Mathcad worksheet into which a QuickSheet example has
been dragged. You’ll find that by assembling pre-built and tested modules for
routine tasks like those found in QuickSheets, you’ll be able to put together solu-
tions to problems in a fraction of the time.
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Figure 11: A QuickSheet window.

Figure 12: A Mathcad worksheet after integrating the QuickSheet example into
the surrounding material.
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The QuickSheets book also contains special pages on which you can save any-
thing you want quick access to. Look for “Personal QuickSheets” or “Math Sym-
bols” in the table of contents. Anything you enter in these sheets will be saved
when you close QuickSheets. Changes made to any other QuickSheets will be
discarded when you close QuickSheets.

Context sensitive help

You can get context sensitive help while using Mathcad. For menu commands
you can simply click on the command and read the message line at the bottom
of your window. For toolbar or palette buttons, hold the pointer over the button
momentarily to see a tool tip.

You can also get more detailed help on menu commands or on many operators
and error messages. To do so:

Click on an error message, a built-in function or variable, or an operator.

Press [Command]/ to bring up the relevant Help screen.

To get help on menu commands or on any of the palette buttons:

Press [Shift][Command]/ Mathcad changes the pointer into a question
mark.

Choose a command from the menu. Mathcad shows the relevant Help screen.

Click on any palette button. Mathcad displays the operator’s name and a key-
board shortcut on the message line.

To resume editing, press [Esc]. Mathcad changes the mouse pointer back into
an arrow.

Electronic Books

Each Mathcad Electronic Book is a collection of up to several hundred Mathcad
worksheets containing text, pictures, formulas, and data. A Mathcad Electronic
Book is like any book, but it has some features that make it especially useful
when you’re working with Mathcad:

Every page of an Electronic Book is a live Mathcad worksheet: You can
change values, calculate results, and experiment right on the electronic
“page” in front of you.

If you have a second Mathcad worksheet open, you can paste data and formu-
las from the Electronic Book into your worksheet simply by double-clicking
on them, then going to the worksheet in which you want to paste them and
double-clicking again.
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Each Electronic Book has a table of contents and an extensive Index. Double-
clicking on a section title, index entry, or cross reference automatically opens
the appropriate section.

A palette of Electronic Book controls lets you browse through the Electronic
Book page by page or section by section, or jump directly to the table of con-
tents or Index.

Mathcad comes with an Electronic Book called the Desktop Reference. This con-
tains useful mathematical and engineering formulas, physical constants, proper-
ties of various materials and other useful information you would ordinarily look
up in any reference book. Several other Electronic Books on various mathemati-
cal and engineering topics are also available. Once you install additional Elec-
tronic Books, you can operate them just as you would the Desktop Reference.

To open the Desktop Reference, choose Desktop Reference from the Books
menu. Mathcad opens a window showing the front cover of the book. 

Click on the button labeled “TOC” to see the table of contents for the Desktop
Reference. You can browse through this window by using the scroll bars, just as
you would any Mathcad window. You can also use the palette buttons to move
around the book. The function of each button is given in the following table.

 Button Function

Jumps to book’s table of contents.

Jumps to book’s index.

Goes backward one book section.

Advances one book section forward.

Backtracks to whatever book section was last viewed.

Goes to previous page of current section.

Goes to next page of current section.

Search book for a particular word.

The key combinations [Shift][PgDn] and [Shift][PgUp] have the same ef-
fect as the Next Page and Previous Page buttons. To move one screen to the
right or left, click to the right or left of the scroll box in the horizontal scroll bar. 

Mathcad keeps a record of where you’ve been in the Electronic Book. When
you click on the Backtrack button, Mathcad goes back to the last section you
opened and the page you were on when you left it. Backtracking is especially
useful when you have double-clicked to look at a cross reference and you want
to go back to the section you just came from. When you go to the table of con-
tents, Mathcad starts its record over. This means you cannot backtrack beyond
the last time you viewed the table of contents.
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If you don’t want to go back one section at a time or if you want to go back fur-
ther than the backtrack button will take you, you can choose History from the
Books menu. This opens a window listing all the sections you’ve viewed since
you first opened the Electronic Book.

Finding information in an Electronic Book

An Electronic Book, like a paper one, comes with a table of contents and an in-
dex. To see these, click on either the “TOC” button or the “Index” button on the
palette. When you double-click on an entry in either the index or the table of
contents, Mathcad jumps to the appropriate page.

In addition to the table of contents and the index, you can search for all occur-
rences of a particular word. To do so:

Choose Search from the Books menu to open the  Search dialog box.

Type a word in the text box. As you type, the scrolling list displays words
that closely match the letters you type. 

Select a word and click on the Search Book button to see a list of topics con-
taining that word and the number of times it occurs in each topic. 

Choose one of these topics and click on Go to Section. Mathcad opens an
Electronic Book section containing the word you want to search for. 

Click on Next Occurrence or Prev. Occurrence to bring the next or previous oc-
currence of the word into the window. If Next Occurrence is grayed out, the last
occurrence of that word is currently visible. If Prev. Occurrence is grayed out,
the first occurrence of that word is currently visible. 

Note that this feature will not locate any annotations you may have saved using
the Annotate Book command described on page 39.

Copying information from an Electronic Book

There are three ways to copy information from an Electronic Book into your
Mathcad worksheet:

You can use the clipboard by selecting text or equations in the Electronic
Book, using Copy from the Edit menu, clicking on the appropriate spot and
choosing Paste, 

You can drag regions from the Book window into your worksheet, or

You can double-click on whatever you want to paste to “pick it up,” move the
mouse pointer to your Mathcad worksheet and double-click again to “put it
down.”
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Double-clicking with the mouse button on most formulas, numbers, and pictures
allows you to paste them directly from the book into your worksheet, bypassing
the clipboard in the process. If your book’s author has designed a region to do
something other than this, you’ll see a message on the status line when you click
on that region.

To paste something from the book into your worksheet:

In the book window, double-click on whatever you want to paste. The pointer
changes to indicate that it is “carrying” information from the book. Figure 13
shows how the pointer looks when it is carrying information.

Move the pointer to the worksheet and double-click where you want to paste.

Mathcad pastes the image, formula, or number directly into the worksheet. The
pointer’s original appearance is restored to indicate that it has “discharged” the
information it was carrying. Note that some Electronic Books have buttons
which, when double-clicked on, will paste several equations or graphs. Click
once to see on the status line what double-clicking was designed to do.

Figure 13 shows the pointer after having just “picked up” a circuit diagram of an
oscillator from an Electronic Book. It is usually more convenient to tile the win-
dows as shown in Figure 13 whenever you use the books. To do so:

Make sure only one document window is open. 

Choose Tile Vertical from Mathcad’s Window menu.

Figure 14 shows the result of double-clicking again. The pointer drops what it
was carrying and recovers its original appearance.

To switch to another book, pull down the Books menu. Mathcad shows all avail-
able books in the default folder. Select the book you want to open. Mathcad
opens a new book window showing the title screen of the new book.

If you’ve installed an Electronic Book in a folder other than the default folder,
choose Open Book from the Books menu and use the Open Book dialog box to
locate and open the book.
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Figure 13: The pointer becomes a book pierced by an arrow to indicate that it is
carrying information from the Electronic Book.

Figure 14: Double-clicking again causes the pointer to drop whatever it was
carrying wherever you double-clicked.
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Annotating an Electronic Book

By default, when you make changes in an Electronic Book, Mathcad remembers
those changes as long as the book is open. When you close the book, whatever
changes you make are lost. The next time you open that Electronic Book, it will
appear as if it had never been changed at all.  

If you want to save a copy of your Electronic Book, choose Annotate Book
from the Books menu before making any changes. This places a checkmark be-
side the menu command to indicate that you can now save an annotated copy of
your Electronic Book. The original copy of your Electronic Book will, of
course, remain untouched. 

As you make changes and type in your Electronic Book, you may want to mark
the regions you change. To do so, choose Annotation Options⇒Highlight Ed-
its from the Books menu. After you’ve done so, Mathcad displays any changed
regions in a different color. You can set this color by choosing Color⇒Annota-
tion from the Format menu. To stop highlighting regions, choose Annotatio
Options⇒Highlight Edits from the Books menu again. This removes the
checkmark from beside the menu command and disables this feature. 

Once you’ve made changes in your Electronic Book, choose the Annotation
Options from the Books menu to see a pull-right menu. You will have the op-
tion of:

Choosing Save Edited Section to save only the changes you’ve made in the
section you’re working on, or ... 

Choosing Save All Edits to save all changes since you last opened the book.

Once Mathcad saves an annotated copy of the Electronic Book, you’ll see an as-
terisk beside the title whenever you turn to an annotated section. The next time
you open that Electronic Book, Mathcad will open the annotated rather than the
original copy. 

If you’ve made changes to an Electronic Book and you haven’t chosen one of
the above options, you’ll see the dialog box below once you close the book:

If you click on the Save All button in this dialog box, Mathcad will save all
changes you’ve made since you last opened the Electronic Book. If you click
the Review button, Mathcad will show you the titles of all changed sections, one
at a time, and prompt you to either save or discard the changes you’ve made to
each section.
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Deleting your annotations

Once you’ve saved an edited copy of an Electronic Book, Mathcad will open up
that copy rather than the original unedited copy. Whenever you turn to a section
that’s been annotated and saved, you’ll see a “*” in the title bar beside that sec-
tion’s title.

The original section, as it appeared in the original copy of the Electronic Book
before you made any changes, is still available. To see it, choose View Original
Section from the Annotation Options pull-right off the Books menu. If you
want to go back to the corresponding section in the annotated copy of the Elec-
tronic Book, choose View Edited Section from the same menu.

You can permanently delete the annotations in a particular section by choosing
Restore Original Section from the Annotation Options pull-right off the
Books menu. To delete your annotated copy of the Electronic Book altogether,
choose Restore Original Book instead. This will delete all the annotations
you’ve made to that Electronic Book.
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Editing Features





Chapter 2
Editing Equations

This chapter describes the mechanics of creating mathematical
expressions and making changes in existing mathematical
expressions.

The following sections make up this chapter:

Building expressions 
How to create mathematical expressions in a straightforward way by
just typing a stream of characters. How to create expressions by exploit-
ing their structure.

Editing an existing expression
Inserting and deleting operators, changing the names of variables, using
Cut, Delete, Paste and Copy to streamline your editing. How to add a
line break to a lengthy expression.

Rearranging your worksheet
How to move one or more expressions to another part of your work-
sheet.
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Building expressions 

You can create many mathematical expressions by simply typing in a stream of
characters. Certain characters, like letters and digits, make up parts of names
and numbers. Other characters, like * and + represent “operators”. For example,
if you type the characters

3/4+5^2=

you get the result shown below:

Figure 1: An expression and its computed value.

You can type many of these operators by clicking on the appropriate button in
the various operator palettes. Each button on the strip of buttons just under the
menus calls up one of these palettes. Most of the operators used in this chapter
are on the arithmetic palette which you can open by clicking on the left-most
button (the one with a calculator on it). For example, instead of typing 5^2,
type 5, click on the button labelled xy on the arithmetic palette, and type 2 in the
placeholder.

On the surface, Mathcad’s equation editor seems very much like a simple text
editor, but there’s more to it than this. Mathematical expressions have a well de-
fined structure and Mathcad’s equation editor is designed specifically to work
within that structure. In Mathcad, mathematical expressions are not so much
typed in as they are built.

Mathcad automatically assembles the various parts that make up an expression
using the rules of precedence and some additional rules that simplify entering de-
nominators, exponents, and expressions in radicals. For example, when you type
/ to create a fraction, Mathcad stays in the denominator until you explicitly tell
it to leave by clicking on the fraction bar. This means that the characters
3/4+5^2 generate what you see in Figure 1 rather than 

3
4

 + 5 2
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Typing in names and numbers

When typing in names or numbers, Mathcad behaves very much like a standard
word processor. As you type, you’ll see the characters you type appear behind a
vertical editing line. The left and right arrow keys move this vertical editing line
to the left or to the right just as they would in a word processor. There are, how-
ever, two important differences:

As it moves to the right, the verti-
cal editing line leaves behind a
trail. This trail is a “horizontal edit-
ing line.” It’s importance will be-
come apparent in the next section
when you begin working with op-
erators.

Unless the equation you’ve clicked in already has an operator in it, pressing
[Space] will turn the math region into a text region. It is not possible to turn
a text region back into a math region.

Typing in operators

Operators are things like “+” and “−” that link variables and numbers together to
form expressions. The variables and numbers linked together by operators are
called “operands”. For example, in an expression like:

ax + y

the operands for the “+” are x and y. The operands for the exponent operator are
a and the expression x + y. 

The key to working with operators is learning to specify what variable or expres-
sion is to become an operand. There are two ways to do this: 

You can type the operator first and fill in the placeholders with operands, or 

You can learn how to use the editing lines to specify what variable or expres-
sion you want to turn into an operand.

The first method feels more like you’re building a skeleton and filling in the de-
tails later. You may find this method easier to use when you’re either building
very complicated expressions, or when you’re working with operators like sum-
mation and integration which require many operands and lack a natural typing
order.

The second method feels more like straight typing and can be much faster when
expressions are simple. In practice, you may find yourself switching back and
forth as the need arises.
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Here’s how to create the expression ax + y using the first method:

Press ̂  to create the exponent op-
erator. You’ll see two placeholders.

Click in the lower placeholder and
type a.

Click in the upper placeholder.

Type +.

Click in the remaining placeholders
and type x and y.

To use the editing lines to create the expression ax + y, proceed as follows:

Type a. The line beneath the a indi-
cates that a will become the first op-
erand of whatever operator you
type next.

Press ̂  to create the exponent op-
erator. As promised, a becomes the
first operand of the exponent. The
editing lines now surround another
placeholder. 

Type x+y in this placeholder to
complete the expression.

Note that in this example, you could type the expression the same way you’d
say it out loud. However, even this simple example already contains an ambigu-
ity. When you say “a to the x plus y” there’s no way to tell if you mean ax + y or
ax + y. For more complicated expressions, the number of ambiguities increases
dramatically. 

Although you could resolve any of these ambiguities by using parentheses, do-
ing so can quickly become cumbersome. A better way is to use the editing lines
to specify the operands of whatever operator you type. The following example il-
lustrates this by describing how to create the expression ax + y instead of ax + y.

50 Chapter 2  Editing Equations



Type a^x as you did in the pre-
vious example. Note how the edit-
ing lines hold the x between them.
If you were to type + at this point,
the x would become the first oper-
and of the plus.

Press [Space]. The editing lines
now hold the entire expression ax. 

Now type +. Whatever was held be-
tween the editing lines now be-
comes the first operand of the plus.

In the remaining placeholder, type
y.

Multiplication

A common way to show multiplication between two variables on a piece of pa-
per is to place them next to each other. For example, expressions like ax or
a(x + y) are easily understood to mean “a times x” and “a times the quantity x
plus y” respectively. 

This cannot be done with Mathcad for the simple reason that when you type ax,
Mathcad has no way of knowing whether you mean “a times x” or “the variable
named ax.” Similarly, when you type a(x+y), Mathcad cannot tell if you mean
“a times the quantity x plus y” or whether you mean “the function a applied to
the argument x + y.” 

To avoid ambiguity, you should always press * to indicate multiplication as
shown in the following example:

Type a followed by *. Mathcad in-
serts a small dot after the “a” to in-
dicate multiplication.

In the placeholder, type the second
factor, x.
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An annotated example 

When it comes to editing equations, knowing how to use of the editing lines as-
sumes an importance similar to knowing where to put the flashing vertical bar
you see in most word processors. A word processor can get away with a vertical
bar because text is inherently one-dimensional, like a line. New letters go either
to the left or to the right of old ones. Equations, on the other hand, are really two-
dimensional. Their structure is more like a trees with branches than like a line of
text. As a result, Mathcad has to use a two-dimensional version of that same ver-
tical bar. That’s why there are two editing lines: a vertical line and a horizontal
line.

Suppose, for example, that you want to type the slightly more complicated ex-
pression

x − 3⋅a2

−4 + √y + 1

Watch what happens to the editing lines in the following steps:

Type x-3*a^2. Since the editing
lines contain just the “2,” only the
“2” becomes the numerator when
you press /. Since we want the
whole expression, x − 3⋅a 2, to be
the numerator, we must make the
editing lines hold that entire expres-
sion.

To do so, press the [Space]. Each
time you press the [Space], the ed-
iting lines hold more of the expres-
sion. You’ll need to press [Space]
three times to enclose the entire ex-
pression.

Now press / to create a division
bar. Note that the numerator is
whatever was enclosed between the
editing lines when you pressed /.

Now type -4+ and click on the but-
ton labelled “√  ” on the arithmetic
palette. Then type y+1 under the
radical to complete the denomina-
tor. 
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To add something outside the radi-
cal sign, press [Space] twice
make the editing lines hold the radi-
cal. For example, to add the num-
ber π to the denominator, press
[Space] twice.

Press +. Since the editing lines
were holding the entire radical, it is
the entire radical that becomes the
first operand when you press +.

Click on the button labeled “π” on
the arithmetic palette. This is one
of Mathcad’s built-in variables.

Editing an existing expression 

This section describes how to make changes to an existing expression.

The simplest changes you can make are discussed in “Changing a name or num-
ber.” Here, the underlying tree structure of a math expression doesn’t matter. As
a result, the equation editor behaves very much like a text editor.

Most difficulties in editing equations arise from working with operators. That’s
because it’s only when you start working with operators that the underlying tree
structure of a math expression shows up. 

The next few sections describe the three things you can do with an operator: in-
serting an operator, deleting an operator, or replacing one operator with another.

The equation editor normally works from left to right. If you want to insert an
operator before an existing expression, or if you want to apply a function to an
existing expression, see the sections “Inserting an operator” and “Applying a
function to an expression.”

Although Mathcad inserts parentheses wherever required to prevent ambiguity,
you may at times want to add parentheses to clarify an expression or delete ex-
traneous parentheses. To do so, use the techniques described in the sections “In-
serting parentheses” and “Deleting parentheses.”
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When working with a complicated expression, it is often easier to work with
more manageable subexpressions within it. The sections “Moving parts of an ex-
pression” and “Deleting parts of an expression” describe how to use Cut, Copy,
and Paste to do so.

Changing a name or number 

      To edit a name or number:

Click on it with the mouse. This places the editing lines wherever you clicked
the mouse. 

Move the editing lines if necessary by pressing the [→] and [←] keys. Alterna-
tively, place the mouse pointer wherever you want the editing lines to go, and
click the mouse.

If you type a character, it will appear just to the left of the editing lines. Press-
ing [Delete] removes the character to the left of the editing lines. Pressing
[Del] removes the character to the right of the editing lines.

If you need to change several occurrences of the same name or number, you
may find it useful to choose Replace from the Edit menu. To search for a string
of characters, choose Find from the Edit menu. These commands are discussed
further in Chapter 4, “Text.”

Inserting an operator

The easiest place to insert an operator is between two characters in a name or
two numbers in a constant. For example, here is how to insert a plus sign be-
tween two characters:

Place the editing lines where you
want the plus sign to be.

Press the + key.

Note that Mathcad automatically inserts a space on either side of the plus sign.
You should never need to insert a space when typing an equation. Mathcad in-
serts spaces automatically wherever doing so is appropriate. In fact, if you do try
to insert a space, Mathcad assumes you meant to type text rather than math and
converts your math region into a text region accordingly. 

Operators such as division and exponentiation result in more dramatic format-
ting changes. For example, when you insert a divide sign, Mathcad moves every-
thing that comes after the divide sign into the denominator. Here’s how you
insert a divide sign.

Place the editing lines where you
want the divide sign to be. 
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Press the / key. Mathcad reformats
the expression to accommodate the
division.

Some operators require only one operand. Examples are the square root, abso-
lute value, and the complex conjugate operators. To insert one of these, place
the editing lines on either side of the operand and press the appropriate key-
stroke. Many of these operators are available on the arithmetic palette as well.
For example, to turn x into √x  do the following:

Place the editing lines around the
“x.”

Press \ to insert the square root op-
erator.

Applying an operator to an expression

The methods described in the previous section work most predictably when you
want to apply an operator to a variable or a number. If, however, you want to ap-
ply an operator to an entire expression there are two ways to proceed:

You can surround that expression in parentheses and proceed as described in
the previous section, or

You can use the editing lines to specify the expression you want to apply the
operator to.

Although the first method may be more intuitive, it is definitely slower since
you will need to type pairs of parentheses. The more efficient second method is
the subject of this section. The sections “Inserting parentheses” and “Deleting
parentheses” later in this chapter describe ways to work with parentheses more
efficiently. 

The editing lines consist of a horizontal line and a vertical line that moves left to
right along the horizontal line. To make an operator apply to an expression, se-
lect the expression by placing it between the two editing lines. The following ex-
amples show how typing *c results in completely different expressions
depending on what was selected.

Here, the two editing lines hold
only the numerator. This means
any operator you type will apply
only to the numerator.
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Typing *c results in this expres-
sion. Note how the expression held
between the editing lines became
the first operand of the multiplica-
tion.

Here, the editing lines hold the en-
tire fraction. This means any opera-
tor you type will apply to the entire
fraction.

Typing *c results in this expres-
sion. Note how the everything be-
tween the editing lines became the
first operand of the multiplication. 

Here, the editing lines hold the en-
tire fraction as they did in the pre-
vious example. However, this time
the vertical editing line is on the
left side instead of on the right side. 

Typing *c results in this expres-
sion. Note how the expression en-
closed by the editing lines became
the second rather than the first oper-
and of the multiplication. This hap-
pened because the vertical editing
line was on the left side rather than
the right side. 

Now that you know the significance of what’s held between these two editing
lines, the pertinent question becomes “How do I control what’s held between the
two editing lines?”

One way to control the length of the editing lines is to click on an operator.
When you click on an operator, you make the pair of editing lines hold that op-
erator together with everything that that operator applies to. Depending on ex-
actly where on the operator you click, you’ll find the vertical editing line either
on the left or on the right. Use the [Ins] key to move it from one side to the
other.

A second way to control the length of the two editing lines is to press [Space]
to cycle through all possible positions of the editing lines. Each time you press
[Space] the editing lines grow progressively longer. As they do so, they en-
close more and more of the expression, until eventually, they enclose the entire
expression. Pressing [Space] one more time brings the editing lines back to
where they were when you started.

The following example walks you through a short cycle:
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This is the starting position. The
two editing lines hold just the sin-
gle variable “d.”

Pressing [Space] makes the edit-
ing lines grow so that they now
hold the entire denominator.

Pressing [Space] once makes the
editing lines grow again so that
they now hold the entire expres-
sion. 

At this point, the editing lines can’t
become any longer. Pressing
[Space] brings the editing lines
back to the starting point of the cy-
cle.

You’ll notice that in stepping through the previous cycle there was never an in-
termediate step in which the editing lines held just the numerator. Nor was there
ever a step in which the editing lines held just the a or just the b in the numera-
tor. That’s because the sequence of steps the editing lines go through as you
press [Space] depends on the starting point of the cycle.

To set the starting point of the cycle, you can either click on the appropriate part
of the expression as described earlier, or you can use the arrow keys to move
around the expression. The arrow keys walk the editing lines through the expres-
sion in the indicated direction. Keep in mind however that the idea of “up” and
“down” or “left” and “right” may not always be clear, particularly when the ex-
pression becomes very complicated or when the expression involves summa-
tions, integrals and other advanced operators.

Deleting an operator

To delete an operator connecting two variable names or constants:

Place the editing lines after the op-
erator.

Press the [Delete] key.

You can also delete an operator by placing the editing lines before it and press-
ing the [Del] key instead. For example:
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Place the editing lines before the
operator.

Press the [Del] key.

In the above examples, it is easy to see what “before” and “after” mean because
the expressions involved naturally flow from left to right, the same way we read.
Fractions behave the same way. Since we would naturally say “a over b,” put-
ting the editing lines “after” the division bar means putting them just before the
b. Similarly, putting the editing lines “before” the division bar means putting
them immediately after the a. The following example illustrates this:

Place the editing lines after the divi-
sion bar. 

Press the [Delete] key.

To delete an operator having only one operand (for example, √ x , |x| or x!):

Position the editing lines just after
the operator. 

Press the [Delete] key.

For certain operators, it may not be clear where to put the editing lines. For ex-
ample, it is not clear when looking at |x| or x

_
 what “before” and “after” mean.

When this happens, Mathcad resolves the ambiguity by referring to the spoken
form of the expression. For example, since you would read x

_
 as “x conjugate,”

the bar is treated as being after the x.

Inserting a minus sign

 The minus sign that means “opposite of ” uses the same keystroke as the one
that means “subtract.” To determine which one to insert, Mathcad looks at
where the vertical editing line is. If it’s on the left, Mathcad inserts the “opposite
of ” minus sign. If it’s on the right, Mathcad inserts the “subtract” minus sign.
To move it from one side to the other, use the [Ins] key.

The following example shows how to insert a minus sign in front of the expres-
sion “sin(a).”
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Click on the sin(a).

If necessary, press [Ins] to move
the vertical editing line all the way
to the left.

Type - to insert a minus sign.

If what you really want to do is turn sin(a) into 1 − sin(a), insert another opera-
tor as described in the earlier section “Inserting an operator.” Then replace the
operator with a minus sign as described in “Replacing an operator.”

Applying a function to an expression 

 To turn an expression into the argument of a function, follow these steps:

Click in the expression and press
[Space] until the entire expres-
sion, w⋅t − k⋅z, is held between the
editing lines. 

Type the single-quote key (the
same as the double-quote key, but
unshifted). The selected expression
is enclosed by parentheses.

Press the [Space]. The editing
lines now hold the parentheses as
well.

If necessary, press the [Ins] key.
The vertical editing line switches to
the left side. If the vertical editing
line is already on the left side, skip
this step.

Now type the name of the function.
If the function you wish to use is a
built-in function, you can choose
Function from the Insert menu
and double-click on the name of
the function.

Editing an existing expression 59



Inserting parentheses 

   Mathcad places parentheses automatically as needed to maintain the precedence
of operations. There may be instances however, when you want to place paren-
theses to clarify an expression or to change the overall structure of the expres-
sion. You can either insert a matched pair of parentheses all at once or you can
insert the parentheses one at a time. We recommend you insert a matched pair
since this avoids the possibility of unmatched parentheses.

To enclose an expression with a matched pair of parentheses:

Select the expression by placing it
between the editing lines. You can
do this by clicking on the expres-
sion and pressing [Space] one or
more times.

Type the single-quote key. The se-
lected expression is now enclosed
by parentheses. 

It is sometimes necessary to insert parentheses one at a time using the ( and )
keys. For example, to change a − b + c to a − (b + c) do the following:

Move the editing lines just to the
left of the b. Make sure the vertical
editing line is on the left as shown.
Press [Ins] if necessary to move it
over.

Type (. Now click to the right of
the c. Make sure the vertical edit-
ing line is to the right as shown.
Press [Ins] if necessary to move it
over.

Type ).

Deleting parentheses

You cannot delete one parenthesis at a time. Whenever you delete one parenthe-
sis, Mathcad deletes the matched parenthesis as well. This prevents you from in-
advertently creating an expression having unmatched parentheses.

To delete a matched pair of parentheses:

Move the editing lines to the right
of the “(”.
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Press the [Delete] key. Note that
you could also begin with the edit-
ing lines to the left of the “)”and
pressing the [Del] key instead.

Moving parts of an expression 

    The menu commands Cut, Copy, and Paste from the Edit menu are useful for
editing complicated expressions. They function as follows:

Cut deletes whatever is between the editing lines and copies it to the clip-
board.

Copy takes whatever is between the editing lines and copies it to the clip-
board.

Paste takes whatever is on the clipboard and places it into your worksheet,
either into a placeholder or into the blank space between equations.

The following example shows how to use Copy and Paste to eliminate retyping. 

Suppose you want to build the expression

cos(wt + x) + sin(wt − x)

The argument to the sine function is nearly identical to that of the cosine func-
tion. You can take advantage of the similarity between the arguments of these
two functions by doing the following:

Build the first term, then leave a
placeholder where the argument to
the sine should go. Type sin() to
do this.

Click in the argument to the cosine
function and press [Space] until
the editing lines hold the argument
between them. The expression
looks like that shown on the right.

Choose Copy from the Edit menu. 

Click on the placeholder inside the
sine function.

Choose Paste from the Edit menu.
The expression now looks like that
shown on the right.

Now replace the “+” with a “−”.
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The Copy and Paste commands described above use the clipboard to move ex-
pressions from one place to another. There may, however, be times when you
don’t want to disturb the clipboard. You can bypass the clipboard by using Math-
cad’s drag and drop feature.

Suppose, as in the previous example, that you want to copy the expression
w⋅t + x and place it in the placeholder inside the sine function.

Select the argument to the cosine
function. The expression looks like
that shown on the right.

Press and hold down the [Ctrl]
key and the mouse button. The
pointer changes as shown on the
right to indicate that it carries the
selected expression with it. It con-
tinues to carry the selected expres-
sion until you release the mouse
button.

With the mouse button still held
down, drag the small box at the ar-
row’s tip over the placeholder.

Release the mouse button. The
pointer drops the expression into
the placeholder. It then recovers its
original form to indicate that its
contents have been discharged.

You can drag and drop expressions into placeholders in other expressions or into
any blank space in your worksheet. Just be sure you don’t let go of the mouse
button before you’ve dragged the pointer wherever you want to drop the expres-
sion. If you’re trying to drop the expression into a placeholder, be sure to posi-
tion the hollow box carefully over the placeholder.

If you don’t want to leave behind a copy of the expression as shown in the
above example, follow the same procedure using the [Shift] key instead of the
[Ctrl] key.

Deleting parts of an expression 

 You can avoid having to repeatedly backspace over parts of an expression by
choosing Cut from the Edit menu. This will delete whatever is between the edit-
ing lines place it on the clipboard.
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The following example shows how you can use the cut command to delete a sig-
nificant part of an expression.

Suppose you want to change the expression

cos



w⋅t + x

2




into 

cos



x
2





Rather than repeatedly backspacing, you can do the following:

Select the numerator as shown on
the right.

Choose Cut from the Edit menu.
This removes the numerator and
leaves behind a placeholder.

 

Type x in the placeholder. 

You can also delete part of an expression by using either the [Del] key or the
[Delete] key. If you use this method however, whatever you delete will not go
to the clipboard. This is useful when you intend to replace whatever you delete
with whatever is currently on the clipboard. 

To delete part of an expression without placing it on the clipboard:

Select the numerator as shown on
the right. Note that the vertical edit-
ing line is to the right.

Press [Delete]. Mathcad high-
lights your selection to indicate
what you’ve proposed to delete.
Mathcad takes this extra step since
once you delete, you’ll have to re-
type the expression to get it back.
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Press [Delete] one more time.
This removes the numerator and
leaves behind a placeholder.

 

To use the [Del] key instead of the [Delete] key, follow the preceding instruc-
tions but place the vertical editing line on the left side of the expression.

Rearranging your worksheet 

This section describes how to rearrange expressions, graphics and text in your
worksheets. The techniques described here work equally well for everything in
your worksheet: equations, plots, sketches and text. Before you use the methods
in this section, click in the empty space between regions to turn the cursor into a
crosshair.

You can get an overall view of how your worksheet looks by choosing Zoom
from the View menu and choosing a magnification from the Zoom dialog box.
Set the magnification:

Less than 100% to zoom out for an overall view.

Greater than 100% to zoom in for a close-up view.

Selecting, cutting, pasting and aligning regions work the same way regardless of
the magnification you choose.

Selecting regions

Before you can move or copy one or more regions, you must select them. To do
so:

Press and hold down the mouse button to anchor one corner of the selection
rectangle.

Without letting go of the mouse button, move the mouse so as to enclose
everything you want to select inside the selection rectangle.

Once the selection rectangle encloses everything you want to select, release
the mouse button. Mathcad encloses those regions you have selected.

Figure 2 shows how the worksheet might look just before you release the mouse
button.

64 Chapter 2  Editing Equations



Figure 2: Several regions enclosed in a selection rectangle.

Copying regions

   Once the regions are selected, you can copy them: 

by using Copy and Paste, or

if the regions start out in either an Electronic Book or in a locked area, by
dragging them with the mouse

To use the Copy and Paste commands:

Select the regions as described in the previous section.

Choose Copy from the Edit menu. This copies the selected regions into the
clipboard.

Click the mouse wherever you want to place a copy of the regions. You can
click either someplace else in your worksheet or in a different worksheet alto-
gether. Make sure you’ve clicked in an empty space. You should see the
crosshair.

Choose Paste from the Edit menu. 

If the regions you want to copy are coming from a locked area or from an Elec-
tronic Book, you can also copy them by dragging them with the mouse. To do
so:

Select the regions as described in the previous section.
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Place the pointer on the border of any selected region. It should turn into a
small hand.

Hold down the mouse button.

Without letting go of the button, move the mouse. You’ll see the rectangular
outlines of the selected regions move as you move the mouse.

At this point, you can either copy the selected regions to another spot in the
worksheet, or you can copy them into another worksheet. 

To copy the selected regions to another spot in the worksheet, move the rectan-
gular outlines to wherever you want to place the regions and let go of the mouse
button. If you want to copy the region to a spot beyond what you can see in the
window, just drag the regions in the appropriate direction. Mathcad will auto-
matically scroll in that direction.

To copy the selected regions into another worksheet, press the mouse button and
drag the rectangular outlines toward the destination worksheet. Do not linger
near the window’s frame; drag the regions decisively across the frame and into
the destination worksheet. Mathcad responds to hesitation near the window’s
frame by autoscrolling the document in the indicated direction.

Moving regions

   Once the regions are selected, you can move them by: 

dragging with the mouse or,

using Cut and Paste.

To drag regions with the mouse: 

Select the regions as described in the previous section.

Place the pointer on the border of any selected region. The pointer will turn
into a small hand.

Press and hold down the mouse button.

Without letting go of the button, move the mouse. You’ll see the rectangular
outlines of the selected regions following the mouse pointer.

At this point, you can either drag the selected regions to another spot in the
worksheet, or you can drag them to another worksheet. 

To move the selected regions to another spot in the worksheet, move the rectan-
gular outlines to wherever you want to place the regions and let go of the mouse
button. If you want to move the region to a spot beyond what you can see in the
window, just drag the regions in the appropriate direction. Mathcad will auto-
matically scroll in that direction.
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To copy the selected regions into another worksheet, press the mouse button and
drag the rectangular outlines toward the destination worksheet. Do not linger
near the window’s frame; drag the regions decisively across the frame and into
the destination worksheet. Mathcad responds to hesitation near the window’s
frame by autoscrolling the document in the indicated direction.

You can also move the selected regions by using Cut and Paste. To do so:

Select the regions as described in the previous section.

Choose Cut from the Edit menu. This deletes the selected regions and puts
them on the clipboard.

Click the mouse wherever you want the regions moved to. Make sure you’ve
clicked in an empty space. You can click either someplace else in your work-
sheet or in a different worksheet altogether. Make sure the cursor looks like a
crosshair.

Choose Paste from the Edit menu. 

Aligning Regions

Once regions are selected, you can align them either horizontally or vertically
by choosing Align Regions from the Edit menu. This is a pull-right menu. Drag
the mouse to the right to display two additional choices: Across and Down. You
can also choose these commands by clicking on the appropriate button on the
toolbar.

When you choose Align Regions⇒Down from the pull-right menu, Mathcad
does the following:

Mathcad draws an invisible vertical line halfway between the right edge of
the right-most selected region and the left edge of the left-most selected re-
gion.

All selected regions to the right of this line are moved left until their left
edges are aligned with this line.

All selected regions to the left of this line are moved right until their left
edges are aligned with this line.

Choosing Align Regions⇒Across works in much the same way. Mathcad
draws an invisible horizontal line halfway between the top edge of the upper-
most region and the bottom edge of the lowest region. Selected regions below
and above this line are moved up and down respectively until the midpoints of
their left edges are on this line.

Note that this means it is possible to inadvertently make regions overlap. If, for
example, the regions you select are almost horizontally aligned, choosing Align
Regions⇒Down may result in overlapping regions. 
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Deleting regions 

  To delete one or more regions:

Select the regions by dragging.

Choose Cut from the Edit menu.

Choosing Cut removes the selected regions from your worksheet and puts them
on the clipboard. If you don’t want to disturb the contents of your clipboard or if
you don’t want to save the selected regions, choose Delete from the Edit menu
instead.

Alternative ways to select regions

There are actually three different ways to select regions. Which one you choose
depends on the arrangement of the regions you want to select. 

The most common, selection by dragging the mouse, was discussed in a pre-
vious section. This is useful when the regions you want to select are not too far
apart, and can be enclosed in a rectangle. 

The two additional methods are:

Shift-clicking on the regions you want to select. 

Marking the two endpoints of a selection by clicking on them with the
[Ctrl] key held down.

Shift-clicking is useful when you want to select or deselect a region without af-
fecting any other regions. For example, you should shift-click when:

You can’t easily enclose the regions you want to select inside a rectangle. For
example, if one region is near the top of a worksheet and the other is near the
bottom, you cannot enclose them both in a rectangle without also enclosing
many other regions in between. 

You want to add several more regions to a collection of regions you may
have selected some other way.

Several regions are selected and you want to deselect one of them.

To select regions by shift-clicking, do the following:

Move the mouse pointer to the first region you want to select, 

Press and hold down the [Shift] key and click the mouse button.

Mathcad surrounds the selected region in a selection rectangle. To select addi-
tional regions, repeat these steps with the mouse on the region you want to se-
lect. Make sure you hold down the [Shift] key while clicking. If you don’t,
Mathcad will select whatever you shift-click on, but deselect all other selected
regions.
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When there are a lot of regions to select, the selection rectangle may become un-
wieldy. In such cases, you can fill in your selection by control-clicking as fol-
lows:

Select one or more regions either by shift-clicking, or by using the selection
rectangle.

With the [Ctrl] key held down, click on the last region in your selection.

Mathcad selects all regions between the first selected region and whatever re-
gion you control-clicked on. This may include regions beyond the right or left
edges of your window. You can think of control-clicking as a quick way to shift-
click every region between the first and last regions selected. 

The last region selected need not be the one you control-click on. If you control-
click on a region between two selected regions, Mathcad selects all regions be-
tween the two selected regions.

Inserting or deleting blank lines

  You can easily insert one or more blank lines into your worksheet. The proce-
dure is as follows: 

Click on the blank line below which you want to insert one or more blank
lines. Make sure the cursor looks like a crosshair.

Press the [Ins] key as many times as there are blank lines you want to insert.

Alternatively, press [↵] to insert a blank line and move the cursor to the left
margin.

To delete one or more blank lines from your worksheet:

Click above the blank lines you want to delete. Make sure the cursor looks
like a crosshair and that there are no regions to the right or left of the cursor.

Press [Del] as many times as there are lines you want to delete. Mathcad de-
letes blank lines below your cursor.

Alternatively, press [Delete] as many times as there are lines you want to
delete. Mathcad deletes blank lines above your cursor.

If you press either [Del] or [Delete] and nothing seems to be happening,
check to make sure that the cursor is on a line all by itself. If any region in your
worksheet extends into the line you are trying to delete, Mathcad won’t be able
to delete that line.

Separating regions 

 As you move and edit the regions in a Mathcad worksheet, they may end up
overlapping one another. Overlapping regions don’t interfere with each other’s
calculations, but they do make worksheets hard to read.
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A good way to determine whether regions overlap is to choose Regions from
the View menu. Mathcad will display blank space in gray and leave the regions
in white. Figure 3 shows an example.

To separate all overlapping regions, choose Separate Regions from the Format
menu. Wherever regions overlap, this command will move the regions in such a
way as to avoid overlaps while preserving the order of the calculations.

Be careful with the Separate Regions menu command since not only can it
have far-reaching effects, it also cannot be undone. As an alternative, consider
dragging regions individually, adding lines by pressing [Ins], or cutting and
pasting the equations so they don’t overlap.

Figure 4 shows the worksheet from Figure 3 after having chosen Separate Re-
gions from the Format menu. To turn the blank space back into white, choose
Regions from the View menu again.

Figure 3: Worksheet with overlapping regions.
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Figure 4: After separating the regions.
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Chapter 3
Documents and Windows

This chapter describes how to navigate within a window, and how
to save, load and print your work. The following sections make up
this chapter:

Window management
How to move through a window, how to move and resize windows, and
how to open several worksheets at once.

Worksheet management
How to save your work and how to load previously saved work. Incor-
porating an existing worksheet. How to export your work to other appli-
cations.

Safeguarding your calculations
How to write-protect selected areas of your worksheet.

Printing
How to print a worksheet. Includes a discussion of inserting headers
and footers, numbering pages, adjusting margins, and previewing your
printed output.

Configuration files
How to save values of system variables and default settings for plots
and numerical display.

73



Window management 

When you double click the Mathcad icon you’ll open up a window on a Math-
cad worksheet. There are times when a Mathcad worksheet cannot be displayed
in its entirety because the window is too small. To bring unseen portions of a
worksheet into view, you can:

Use the scroll bars and arrow keys to move around the worksheet.

Make the window larger.

Choose Zoom from the View menu and choose a number smaller than 100%.

Mathcad windows work very much like those of most Macintosh applications. If
you’ve worked with Macintosh applications before, much of the material in this
chapter will already be familiar to you.

 There are several ways to move the window from one part of a worksheet to an-
other:

Move the mouse pointer and click the mouse button. The cursor jumps from
wherever it was to wherever you clicked.

Use the arrow keys [↑], [↓], [→], and [←] to move the crosshair up, down,
right and left respectively. Mathcad scrolls the window whenever necessary.

Click in the scroll bar to position the scroll box. 

With the mouse pointer on the scroll box, press and hold down the mouse but-
ton and move the mouse to drag the scroll box to another part of the scroll
bar. 

Click on the arrows at the ends of the scroll bars to nudge the scroll box in the
directions indicated by the arrows.

Press [PgUp] and [PgDn] to move the cursor up and down by about one
fourth the height of the window. You can also use [Ctrl][PgUp] and
[Ctrl][PgDn] to move the cursor up and down by about 80% of the height
of the window.

Press [Ctrl][Home] to go to the first region of the worksheet, and
[Ctrl][End] to go to the last region of a worksheet.

Press [Shift][PgUp] and [Shift][PgDn] to position the preceding or fol-
lowing pagebreak at the top of the window.

Choose Go to Page from the Edit menu and enter the page number you want
to go to in the dialog box below. When you click “OK,” Mathcad places the
top of the page you specify at the top edge of the window.
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The position of the scroll box within the scroll bar serves as a rough guide to the
position of the window relative to the rest of the worksheet. If the top of the win-
dow is a third of the way down from the top of the worksheet, the scroll box will
be about a third of the way down the vertical scroll bar. The page number for
whatever page is visible in the window is shown on the message line at the bot-
tom of the window.

Multiple windows 

You can have up to eight windows open at one time. This allows you to work on
several worksheets at once by simply clicking the mouse in whatever document
window you want to work in. If the worksheet you want to work in is buried be-
hind many other windows, pull down the Window menu and choose its name.

To open a new document window, choose New from the File menu. To open a
window into a previously saved worksheet, choose Open from the File menu.

Worksheet management 

This section describes how to save and open worksheets, how to insert one work-
sheet into another, and how to export a worksheet in RTF (Rich Text Format) so
that a word processor capable of reading RTF will be able to open it.

Opening a worksheet 

 To work on a worksheet that you saved before, choose Open from the File
menu. Mathcad prompts you for a name by displaying the Open dialog box. You
can locate and open a Mathcad worksheet just as you would open a document as-
sociated with any other Macintosh application.

At the bottom of the File menu, Mathcad maintains a list of the most recently
opened worksheets. You can bypass the Open dialog box by choosing from this
list.
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Opening a worksheet on the Internet

If the Mathcad worksheet you want to open is on the World Wide Web, you
should open it by choosing Load from Web from the File menu. When you do
so, you’ll see the following dialog box:

Type the worksheet’s URL (Uniform Resource Locator) in the text box. This
identifies the name of the computer on which the worksheet is saved together
with the path to that worksheet within that computer’s file system.   

MathSoft maintains a collection of linked Mathcad worksheets. To access these,
choose QuickSheets from the ? menu and click on “MathSoft Web Site”.

Before using this feature, you also need to know whether you have direct access
to the Internet or whether you’ll be using a proxy. If you use a proxy, ask your
system administrator for the proxy machine’s name as well as the socket you’ll
be using to connect to it. Once you have this information, choose Internet
Setup from the File menu. Then enter this information in the appropriate places
in the Internet Setup dialog box.

Saving your work 

 There are two choices in the File menu that have to do with saving files to your
local file system: Save and Save As. 
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To save a worksheet that has never been saved before, you can choose either op-
tion. The Save As dialog box appears, prompting you for a filename.

To overwrite an original worksheet with a revised one, choose Save. Mathcad
overwrites the original copy of the worksheet with the new copy (shown in the
document window).

To make changes to an existing worksheet without modifying the original, you
must choose Save As from the File menu. 

Incorporating one worksheet inside another

   There may be times when you want to use formulas and calculations from one
worksheet inside another. You can of course simply open both worksheets and
use Copy and Paste from the Edit menu to move whatever you need to move.
However when many regions or worksheets are involved, this method is cumber-
some and may result in unecessarily cluttered worksheets.

There are two other ways to make formulas from one worksheet available in an-
other. The choice of which method to use depends on whether you want to actu-
ally see the regions in the second worksheet or whether you just want the second
worksheet to behave as if you could see the formulas there. The first method is
called inserting a worksheet; the second is called inserting a reference to a work-
sheet.

Whether you choose to insert or include a worksheet, the first step is the same:
click the mouse wherever you want to insert the worksheet. Make sure you click
in empty space and not in an existing region. The cursor should look like a
crosshair.

To insert one worksheet into another:

Choose Worksheet from the Insert menu, Mathcad displays a dialog box
identical to that described in the earlier section, “Opening a worksheet.” 

Use this dialog box to specify the name of the worksheet you want to insert,
then click “OK.”

When you click “OK”, Mathcad moves any regions below your crosshair down
to make room for the incoming worksheet. It then pastes all the regions from the
first worksheet into the second wherever the crosshair is located.

If you want to include a reference to a worksheet rather than inserting the entire
worksheet, you must have both worksheets open at the same time:

Open the worksheet you want to refer to.

Click on the window in which you want to refer to that worksheet and put the
crosshair wherever you want to refer to it.

Choose Reference from the Insert menu. You’ll see a dialog box containing
a list of open worksheets:
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In the list of open worksheets, select the worksheet you want to include. Note
that this list excludes any unnamed worksheets. Before a worksheet can be in-
cluded, it must have a name. Since the only way to name a worksheet is to
save it, you can’t include a worksheet until it has been saved at least once.

When you click “OK”, Mathcad pastes a small icon wherever you had the
crosshair as shown in Figure 1. All definitions in the included worksheet will be
available below or to the right of this icon. If you double-click on this icon,
Mathcad displays the included file. You can move or delete this icon just as you
would any other Mathcad region.

Figure 1: An icon representing an referenced worksheet. Definitions in the refer-
enced worksheet are available below and to the right of this icon.

Once a worksheet has been referenced by another worksheet, there is no need to
have the it open any longer. You only need to have the referenced worksheet
open when you first include it. 
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This mechanism will work no matter where the worksheet you refer to is lo-
cated. All that’s necessary is that you be able to open that worksheet. Once
you’ve included a reference to a worksheet, Mathcad remembers where the file
was when you first included it. Of course, if you move the referenced worksheet
after having included it, Mathcad will display an error message indicating that it
can no longer find it.

Exporting your worksheet 

   There are two ways to export your Mathcad worksheet into a word processor.
You can cut and paste as described in the section “Importing and exporting text”
on page 113, or you can save the document in RTF format as described here. 

To export your entire worksheet as an RTF file readable by any word processor
capable of reading an RTF file with embedded graphics:

Scroll to the bottom of your document to update all calculated results.

Choose Save As from the File menu.

In the Save As dialog box, choose “Rich Text Format” under “File Type”.
Then click “OK.”

When you open this RTF file with a word processor, you’ll find all the Mathcad
regions lined up one above the other at the left edge of the document. You can
then use your word processor to move these regions wherever you want to. 

Once the Mathcad regions have been loaded into a word processor, you’ll no
longer be able to edit equations and graphs. You will, however, still be able to
edit text.

Safeguarding your calculations

The ease with which you can alter a Mathcad worksheet can present a problem.
It is all too easy to alter a worksheet and to change things which are not meant
to be changed. For example, if you’ve developed and thoroughly tested a set of
equations, you may want to prevent anyone from tampering with them.

To avoid this, you may want to safeguard these equations by locking them up in
such a way that you’ll still be able to use them even though nobody will be able
to change them. To do this:

You designate a particular area in your worksheet as a lockable area.

You place the calculations that you want to lock up into that lockable area.

You lock the area.
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Once an equation is safely inside a locked area, nobody will be able to edit it.
That equation will, however, continue to affect other equations in the document.
For example, if you define a function inside a locked area, you’ll still be able to
use that function anywhere below and to the right of its definition. You will not,
however, be able to change the function definition itself.

The remainder of this section describes how to specify the beginning and the
end of the lockable area as well as how to lock and unlock that area once you’ve
created it.

Specifying the lockable area

A lockable area is designated by two lines as shown in Figure 2. The text open
padlocks above and below these lines indicate that the area is now unlocked. As
long as this area remains unlocked, you can edit equations and text in within it
as freely as you would anywhere else in the worksheet. 

To designate a lockable area:

Choose Lock Regions⇒Set Lockable Area from the Format menu. Math-
cad inserts a pair of lines like those in Figure 2. These mark the boundaries of
the lockable area.

Select either of these boundary lines just as you’d select any region: by drag-
ging the mouse across the line or by shift-clicking on the line itself.

Once you’ve selected the boundary line, drag it just as you’d drag any other
region. 

You should position the boundaries so that there’s enough space in between
them for whatever equations you want to lock. You can have any number of
lockable areas in your worksheet. The only restriction is that you cannot have
one lockable area inside another.
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Figure 2: The area between the two lines is a lockable area. The first pair is still
unlocked; the second pair was locked on the date shown.

Locking up the calculations

    Once you’ve placed whatever equations you want to lock up inside the lockable
area, you are ready to lock it up. You’ll be able to lock it up either with or with-
out a password. To do so:

Click in the lockable area.

Choose Lock Regions⇒Lock Area from the Format menu.

You’ll see a dialog box asking you if you want to set a password. Click “Yes”
if you want to require a password to unlock the area. Otherwise click “No.”

If you clicked “Yes,” you’ll be prompted for a password. Type any combina-
tion of letters and numbers. Keep in mind that the password is case sensitive.

Once locked, the locked area looks like the lower pair of lines in Figure 2. The
date and time the area was last locked is shown above and below the boundary
lines.

Locking without a password is useful when you just want to prevent yourself
from absent-mindedly changing something and you don’t want to worry about
having to remember a password. When a region is locked without a password,
anyone will be able to unlock it by simply choosing Lock Regions⇒Unlock
Area from the Format menu.
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Locking with a password is useful when you want to prevent unauthorized
changes to a worksheet. When you choose this option, make sure you remember
your password. If you forget your password, you may find yourself permanently
locked out of that lockable area.

Unlocking the calculations

    If you want to make changes to an equation inside a locked area, you’ll have to
unlock it first. To do so:

Click on one of the boundary lines of the region you want to unlock. Mathcad
highlights the boundary line.

Choose Lock Regions⇒Unlock Area from the Format menu.

If a password is required, you’ll be prompted for the password. 

Once an area is unlocked, you’ll be able to make whatever changes you want to
just as freely as you would anywhere else in your worksheet.

Deleting a lockable area

You can delete a lockable area just as you would any other region. To do so: 

Make sure the area is unlocked. You cannot delete a locked area.

Select either of the two lines indicating the extent of the locked area by drag-
ging the mouse across it.

Choose Cut from the Edit memu.

Printing

 To print all or part of a Mathcad worksheet, choose Print from the File menu.
The dialog box you see will depend on the particular printer you’ve selected. 

The Print dialog box lets you control what pages to print and what printer to
print on. By providing access to the Page Setup dialog box, it also lets you con-
trol the location of all margins, and the presence of headers and footers. The re-
mainder of this section discusses these options in detail.

Choosing what to print

You can choose to print the entire worksheet, selected pages, or selected re-
gions. To control what Mathcad prints, click on one of the following buttons in
the Print dialog box: 

All: Click this button to print all pages in the worksheet. 

Selection: Click this to print only the selected regions. If the button is gray,
you have not selected any regions to print. To select regions for printing, use
the dashed selection rectangle as described on page 64.
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Current Page: Click this button to print the page currently visible in your
document window. If a pagebreak divides your window, Mathcad prints the
page above the pagebreak. The current page number appears on the message
line at the bottom of the document window.

Pages: Click this button to print a range of pages. Then fill in the two text
boxes to indicate your selection. If you’ve selected a plotter as your output de-
vice, you’ll only be able to print one page; the text box beside “To:” will be
greyed out.

If you find more pages than you expect coming out of the printer, keep in mind
that Mathcad worksheets may be wider than a sheet of paper as well as longer.
See “Printing wide worksheets” on page 84.

Setting margins 

Mathcad worksheets have four user-setable margins. To set these margins, click
on the Page Setup button in the Print dialog box. Alternatively, choose Page
Setup from the File menu. This brings up the Page Setup dialog box. The four
text boxes in this dialog box show the distances from the margin to the corre-
sponding edge of the actual sheet of paper on which you will be printing. 

Left Margin: This is the distance from the left edge of the physical sheet of
paper to the left edge of the print area.

Right Margin: This appears as a solid vertical line in your window. You may
have to scroll to the right to see it. In addition to marking the right edge of the
printed area, the right margin serves as a wrap margin for all text regions.  

Don’t confuse the solid vertical line marking the right margin with the dashed
vertical line marking the right page boundary. This line marks the right-hand
edge of the sheet of paper itself. Its location depends on your choice of
printer. If you haven’t chosen a printer, you won’t see this dashed line at all.

Top Margin: This is the distance from the top edge of the physical sheet of pa-
per to the top edge of the print area. If your worksheet has a header, it appears
just above this margin. 

Bottom Margin: This is the distance from the bottom edge of the physical
sheet of paper to the bottom edge of the print area. If your worksheet has a
footer, it appears just below this margin. 

If you want the margin settings in the current worksheet available to other work-
sheets, save them in a configuration file as discussed on page 87.
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Printing wide worksheets

Because Mathcad worksheets can be wider than a sheet of paper, the idea of a
“page” is not as clear as it would be in, for example, a word-processor. Regions
separated by the dashed vertical line will print on separate sheets of paper, yet
the page number at the bottom of the Mathcad window does not change as you
scroll to the right.

You can think of the worksheet as being divided into vertical strips as shown in
Figure 3. Mathcad begins printing at the top of the left-most strip and continues
until it reaches the last region in this strip. It then goes to the top of the adjacent
strip and prints every page down to the last region in that strip. This procedure is
repeated until everything in the worksheet has been printed. Note that certain
layouts will produce one or more blank pages. Figure 3 illustrates such a case. 

Figure 3: Mathcad divides very wide worksheets into strips before printing.

You can control whether or not Mathcad prints the entire worksheet or just the
left-most strip shown in Figure 3. To do so, open the Page Setup Dialog box,
either by choosing Page Setup from the File menu or by clicking the Page
Setup button in the Print dialog box. Then:

To suppress printing of anything to the right of the right margin, click on the
Print to Right Margin button. 

To print all the regions in the worksheet, even those to the right of the right
margin, click on the Print Whole Width button.

Pagebreaks 

Mathcad provides two kinds of pagebreaks:

Soft pagebreaks: Mathcad uses your default printer settings and your top and
bottom margins to insert these pagebreaks automatically. These show up as
dotted horizontal lines. You cannot add or remove soft pagebreaks.
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Hard pagebreaks: You can insert a hard pagebreak by placing the cursor on
the appropriate line and choosing Page Break from the Insert menu.

To delete a hard pagebreak, select it by shift-clicking the mouse button on the
bend at the extreme left of the horizontal line marking it. Then choose Cut from
the Edit menu. The crosshair over the bend in the pagebreak shown in Figure 4
shows where to click. 

You can ask Mathcad to print a range of pages in the worksheet by typing the
page range in the Print dialog box. The page numbers in the dialog box refer
only to horizontal divisions. For example, if your worksheet looks like that
shown in Figure 3, and you ask Mathcad to print page 2, you will see two sheets
of paper corresponding to the lower-left and lower-right quadrants in Figure 3.

To print only the lower-left-hand page shown in Figure 3:

Choose Print from the File menu.

Type “2” in the boxes next to the words “From” and “To.” This suppresses
printing of the upper-left and upper-right quadrants.

Click on the button next to “Print to Right Margin only.” This suppresses
printing of the lower-right quadrant.

Click on “OK.”

Note that this makes it impossible to print the upper or lower right quadrants by
themselves.

Figure 4: To select a hard pagebreak, click where the pagebreak bends.

Printing 85



Headers and Footers

To add a header or a footer to every printed page, choose Headers/Footers from
the Format menu. This opens the Header/Footer dialog box shown below:

To add a header:

Click on the Header button.

Type the header into one or more of the text boxes on the left side of the dia-
log box. Whatever you type into the Left, Center and Right text boxes will ap-
pear left-justified, centered, and right-justified respectively.

To automatically insert the page number, current date, time or filename wher-
ever the insertion point is, click on the appropriate button below the text
boxes. Mathcad inserts a special code into the text box. This will be replaced
by the correct page number, date, time or filename when you print the work-
sheet. Note that Mathcad always begins numbering at page 1.

Make sure the Enable check box is checked. When this is unchecked, Math-
cad suppresses the display of headers and footers.

To add a footer:

Click on the Footer button.

Follow the rest of the instructions for inserting headers.

Print preview

To check your worksheet’s layout before printing, choose Print Preview from
the File menu. This brings up a dialog box showing how your worksheet will
look when printed.
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This dialog box shows the current page together with its four margins. You can-
not edit the current page or change its margins in this view. To edit the page, re-
turn to the normal worksheet view by clicking the Close button. To move the
margins, click on the Page Setup button and proceed as described on page 83.

The page you see in this dialog box is the same page you were viewing when
you chose Print Preview from the File menu. This is indicated by the page num-
ber at the bottom of the dialog box.

To view a different page, click on the arrow buttons at the top of the dialog box.
Mathcad will display the adjacent page in the direction indicated by the arrow. 

Once you’re satisfied with the layout, click on the Print button to open the Print
dialog box.

Configuration files

A configuration file saves numerical and text format settings and the values for
built-in variables. This lets you apply them to all new Mathcad worksheets or to
transfer them easily from one worksheet to another. There are two ways to save
a configuration file:

In the default configuration file 
Mathcad Config.

In a configuration file with a different name.

Upon opening a new worksheet:

Mathcad searches in the folder in which it is installed for a file called Math-
cad Config.

If it finds this file, it uses it to set the default values for formatting and for
various system variables.

This allows you to set a preferred format for all your new worksheets. For exam-
ple, if you have preferred text and math font choices that are different from
Mathcad’s defaults, do the following to use these choices in all new worksheets:

Choose Save Configuration from the File menu while you are in a work-
sheet that uses your preferred settings. 

Click “OK” to save your settings in the file Mathcad Config.  

Now each new worksheet you open will automatically use these font settings.

Sometimes you’ll want to save a configuration that will only be used for some
of your worksheets. For example, you might want to set a high displayed preci-
sion and small zero tolerance for a particular group of worksheets. To do this,
follow the steps below:
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Choose Save Configuration from the File menu while you are in a work-
sheet that uses the global numerical format in question.

Specify the folder in which you want to save the worksheet’s configuration
file.

Change the suggested filename to a different name, for example,
Numbers. Then click “OK.”

From now on, you can apply these format settings to any worksheet. To do so:

Choose Load Configuration from the File menu.

Click on Numbers in the scrolling list of configuration files, and click “OK.”

Your worksheet will now use the formats found in Numbers. Note that these
formats will be saved when you save the worksheet. This means that if you save
this worksheet, you won’t need to execute Numbers again for this worksheet.

The format settings that are saved in a configuration file are listed below. See
the appropriate chapter for more on each of these settings.

The default character properties (Chapter 4)

The default paragraph properties (Chapter 4)

The definitions of all math font tags (Chapter 5)

The margins for printing (Chapter 3)

The numerical result formats (Chapter 5)

Values for Mathcad’s built-in variables (Chapter 7)

The names of Mathcad’s basic units (Chapter 8)

The default calculation mode (Chapter 6)

88 Chapter 3  Documents and Windows



Chapter 4
Text

Text in Mathcad worksheets comes in two varieties: text regions
and paragraphs. Text regions are resizable areas of text that can
appear anywhere within the worksheet. Paragraphs are areas of
text that extend the full width of the page. Text regions and
paragraphs function as commentary in a Mathcad worksheet,
explaining and annotating the equations and plots.

Mathcad text can include any combination of fonts, sizes, and type
and paragraph styles. Text automatically wraps, breaking lines
according to margins that you specify. For paragraphs, you can
specify the alignment and indentation.

This chapter describes Mathcad’s commands for creating and
editing text regions and paragraphs.

This chapter includes the following sections:

Inserting text
Creating text regions and paragraphs; resizing text regions and para-
graphs.

Inserting equations into text
Embedding equations into text regions and paragraphs.

Text editing
Manipulating text that is already in a region: cutting and pasting; chang-
ing font properties, alignment and indentation; and typing Greek letters.

Find and Replace
Finding and replacing text strings and variable names.

Spellchecking
Using the Check Spelling command to find and correct spelling errors
in text.

Linking to other worksheets
How to make Mathcad jump to another worksheet when you double-
click on a region.
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Inserting text 

This section describes how to create text regions and paragraphs. Text regions
are useful for inserting comments around the equations and plots in your work-
sheet. Paragraphs, on the other hand, are useful for creating page-wide blocks of
text. Mathcad ignores text when it performs calculations.

Creating a text region 

 To intersperse small amounts of text among the equations and plots in your
worksheet, you can create text regions.

To create a text region, follow these steps:

Click in blank space to position the
crosshair where you want the text
region to begin. Then choose Text
Region from the Insert menu (or
click the “A” button on the tool-
bar). Mathcad begins a text region.
The crosshair changes into an inser-
tion point and a text box appears.

Now begin typing some text. Math-
cad displays the text and surrounds
it with a text box. As you type, the
insertion point moves and the text
box grows. 

When you’ve finished typing the
text, click outside the text region.
The text box will disappear.

You cannot leave a text region by pressing [↵]. You must leave the text region
by:

Clicking outside the region, or

By pressing [Shift][↵].

Figure 1 on the next page shows a Mathcad worksheet containing several text re-
gions followed by equations.

To insert text into an existing text region:

Click between two characters in a text region. A text box will surround your
text. Anything you type gets inserted at the insertion point. 

To delete text from an existing text region, click in the text region and:

Press [Delete] to delete the character to the left of the insertion point, or
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Press [Del] to delete the character to the right of the insertion point.

To overtype text:

Place the insertion point to the left of the first character you want to overtype.

Press the [Ins] key and begin typing. The vertical bar now has a break in the
middle to indicate that you are in overtype mode. To return to the default in-
sert mode, press [Ins] again.

To break a line or start a new line in a text region, press [↵]. Mathcad inserts a
hard line break and moves the insertion point down to the next line. When you
rewrap the text by changing the width of the text region, Mathcad will maintain
a line break at this spot in the text.  

To delete a hard line break, click at the beginning of the next line in the text re-
gion and press [Delete]. 

Figure 1: Text regions in a Mathcad worksheet.

Changing the width of a text region

When you start typing in a text region, the region grows as you type, wrapping
only when you reach the right margin or page boundary. Press [↵] whenever
you want to start a new line. Often you would like to set a width for your whole
text region, and have lines wrap to stay within that width as you type. To do this:

Type normally until the first line reaches the width you want.

Type a space and press [Ctrl][↵]. 
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All other lines will break to stay within this width. When you add to or edit the
text, Mathcad rewraps the text according to the width set by the line at the end
of which you pressed [Ctrl][↵]. 

To change the width of an existing text region do the following:

Press and hold down the mouse button near the text region.

With the button still pressed, drag the mouse to enclose the text region in the
selection rectangle.

Release the mouse button and move the pointer to the right edge of the text re-
gion until it changes to a double arrow. You can now change the size of the
text region the same way you change the size of any window: by dragging the
mouse. 

Creating paragraphs 

  Paragraphs are designed for text that stretches from one edge of a Mathcad work-
sheet to the other. They differ from text regions in the following ways:

Paragraphs start at the left edge of the worksheet and extend to the right mar-
gin. If a paragraph occupies a line on the screen, equations or plots cannot oc-
cupy the same line. Other regions must be either above the paragraph or
below it. Because of this, you can’t create a paragraph on a line containing
any other text, math or graphics region. If you try to do so you’ll see a mes-
sage telling you that the paragraph would overlap other regions.

Paragraphs push other regions out of the way as you type. In this way, para-
graphs behave more like a conventional text editor. Similarly, if a paragraph
shrinks as you delete text, Mathcad pulls the regions below it upward to fill
the empty space. 

All the paragraphs in a worksheet resize and rewrap when you change the
right margin. Text regions wrap at the right margin when you are first creat-
ing them, but they are then unaffected by changes in the right margin.

By automatically moving other regions as a paragraph grows and shrinks, Math-
cad makes it easy to add and delete text. 

To create a paragraph:

Click on a blank line in the worksheet.

Choose Paragraph from the Insert menu (or click “¶” on the toolbar). Math-
cad creates the first line of the paragraph. This is indicated by two horizontal
lines stretching across the page. The insertion point appears at the left edge of
the page.

Begin typing text into the paragraph.

Figure 2 shows a worksheet with a paragraph. Note that the lines above and be-
low the paragraph are visible only when the cursor is inside the paragraph.
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Figure 2: A worksheet with a paragraph.

When you use paragraphs, imagine that the worksheet is divided up into horizon-
tal bands of different types. Within the paragraphs, Mathcad behaves like an or-
dinary text editor. Between the paragraphs are regions that contain equations,
plots, and small text regions.

Once you’ve created a paragraph, you can type into it just as you would with a
text region. The wrap margin for a paragraph is the right margin. (See “Chang-
ing the width of paragraphs,” at the end of this section, if you want to change the
wrap margin for paragraphs.) If you type more text than will fit on a line, the
text will wrap, just as it does in a text region. 

As you create more lines of text, Mathcad pushes the regions below the text
downward. Paragraphs are designed to keep a constant amount of space between
the last line of the paragraph and the first region below it.

As in a text region, you can insert hard line breaks in a paragraph to force the
text to break at desired places.

Changing the width of paragraphs 

All paragraphs in a Mathcad worksheet have the same width. While you can
change the paragraph width for a worksheet, the change will affect all the para-
graphs in the worksheet.

To change the width of paragraphs in your worksheet:

Click on the worksheet where you want the right margin to be. The crosshair
marks the location.
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Choose Right Margin⇒Set from the Format menu.

Mathcad changes the width of all paragraphs in a worksheet, rewrapping the text
as necessary. A message appears at the bottom right of the screen indicating
how far the right margin is from the right edge of the paper. Note that setting the
right margin will affect how your worksheet prints; see the section on printing in
Chapter 3.

If you try to change the width of a single paragraph by following the instructions
for changing the width of a text region, Mathcad will ask if you want to convert
the paragraph into a text region. If you convert the paragraph into a text region,
you will be able to resize it by dragging as described in the section “Changing
the width of a text region.”

Moving text regions and paragraphs

To move a text region, a paragraph, or group of regions and paragraph, follow
the same steps that you would with math regions:

Click on an empty spot, hold the mouse button down, and drag the selection
rectangle across the region or regions you want to select . When you release
the mouse button, outlines show which regions are selected.

Now move the mouse pointer inside the selected region, hold down the
mouse button, and drag it to the desired spot. If you’ve selected more than
one region, the selected regions will move as a group.

You can also cut, paste, and copy text regions and paragraphs as you would any
other regions. Select the regions and then choose Cut, Paste, or Copy from the
Edit menu. You can also use the corresponding buttons on the toolbar.

Equations in text

This section describes how to insert equations into your text regions or para-
graphs. Equations inserted into text have the same properties as those in the rest
of your worksheet. You can edit them using the methods described in Chapter 2. 

Entering an equation into text can affect the spacing between the lines of the
text region or paragraph. If the equation is taller than a single line, the spacing
between all the lines in the paragraph adjusts to make room for the equation.

Inserting an equation into text 

You can place an equation into text either by creating a new equation or by past-
ing an existing equation into a text region or a paragraph.

To add a new equation into a text region or a paragraph, follow these steps:

Click in the text region or paragraph to place the insertion point where you
want the equation to start.
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Choose Math Region from the Insert menu.

Type in the equation just as you would in a math region.

When you’ve finished typing in the equation, click on any text to return to the
text region.

To paste an existing equation into either a text region or a paragraph, follow
these steps:

Select the equation you want to paste into the text.

Choose Copy from the Edit menu.

Click in the text region or paragraph to place the insertion point where you
want the equation to start.

Choose Paste from the Edit menu.

Editing equations in text

Once you’ve embedded an equation into a text region or paragraph, you can edit
it in the same way you edit equations anywhere else. For detailed procedures,
see Chapter 2, “Editing Equations.”

Turning embedded equations on and off

When you first insert an equation into text, it behaves just like an equation in a
math region; it affects calculations throughout the worksheet. If you want the
equation to be purely cosmetic, you can turn it off. To do so:

Click on the equation you want to turn off.

Choose Toggle Equation from the Math menu.

Once you’ve done so, the equation will neither affect nor be affected by other
equations in the worksheet. To turn it back on, do the same thing you did to turn
it off. The Toggle Equation command works like a push-button light switch.

For a more general discussion of turning equations on and off, see “Disabling
equations” in Chapter 6.

Text editing 

  This section describes Mathcad features for editing existing text. This includes
changing the words themselves, either manually, by clicking and typing, or auto-
matically using the Find and Replace feature and the Spellchecker. It also in-
cludes changing the way the words look by changing various font properties,
and changing the way they’re arranged by changing the alignment within text re-
gions.
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Moving the insertion point in text

In general, the procedures in this User’s Guide tell you to move the insertion
point around text regions and paragraphs by clicking with the mouse wherever
you want to put the insertion point. However, as an alternative, you can also use
the arrow keys to move the insertion point. This section briefly describes these
keys.

The arrow keys move the insertion point character by character or line by line
within text. Pressing [Ctrl] and an arrow key moves the insertion point word
by word or paragraph by paragraph. These and other ways of moving the inser-
tion point are summarized in the table below.

Key Action

[→] Move right one character.

[←] Move left one character.

[↑] Move up to the previous line.

[↓] Move down to the next line.

[Ctrl][→] Move to the beginning of the next word.

[Ctrl][←] Move to the beginning of the current word. If the insertion point is
already there, move to the beginning of the previous word.

[Ctrl][↑] Move to the beginning of the current paragraph. If the insertion
point is already there, move to the beginning of the previous para-
graph.

[Ctrl][↓] Move to the beginning of the next paragraph.

[Home] Move to the beginning of the current line.

[End] Move to the end of the current line.

Selecting text 

The commands described in the “Inserting text” section above involve selecting
the whole text region or paragraph by dragging the selection rectangle. The com-
mands described in this section on text editing involve working with strings of
text within a text region or paragraph. There are several ways to select a string
of text:

Click in the text region or paragraph so that the text box or top and bottom
lines appear. Drag across the text holding the mouse button down. Mathcad
highlights the selected text, including any full lines between the first and last
characters you selected.

Click in the text and press [Shift] and an arrow key. Mathcad highlights
the text in the direction of the arrow key used.
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Click in the text and press [Ctrl][Shift] and an arrow key. If a left or
right arrow is used, Mathcad highlights from the insertion point to the begin-
ning of the current or next word. If an up or down arrow is used, Mathcad
highlights text from the insertion point to the beginning or end of a line.

Select just one word of text by double-clicking on it.

When text is selected, Mathcad displays the phrase “Selected Text” in the left-
most window on the font bar. This phrase indicates that Mathcad will apply any
character property changes to that selected text and not to the default text.

Once text is selected, you can delete it, copy it, check the spelling, or change its
font, size, style, or color.

Cutting and copying text 

 To cut a string of characters from a text region or paragraph, follow these steps:

Click in the text region or para-
graph and select the desired string
of text. The highlighted text is
shown in “reverse video.”

Choose Cut from the Edit menu.
Mathcad deletes the text from the
text region or paragraph, copies it
to the clipboard, and rewraps the re-
maining text.

You could also copy text to the clipboard without deleting it. To do so, choose
Copy instead of Cut from the Edit menu. 

Once you’ve cut or copied text to the clipboard, you can paste it back into any
text region, paragraph or into an empty space to create a new paragraph. To do
so:

Click in the spot where you want to
paste the text. This can be any-
where in an existing text region, a
paragraph, or in an empty area of
your worksheet.
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Choose Paste from the Edit menu.
Mathcad pastes the text from the
clipboard into the text region or
paragraph. If the cursor looks like a
crosshair when you choose paste,
Mathcad creates a new paragraph
containing the pasted text.

Note that if you want to insert the entire contents of a text region or paragraph
into an existing region, you should select the material you want to insert as a
text string by clicking in the text and dragging to highlight it. If you copy an en-
tire region selected with the selection rectangle, you can paste this selection only
into a blank area of your worksheet.

Changing text fonts 

 When you first enter text, its properties are determined by the worksheet de-
faults. To change the font, size, style, position, and color of text, you must first
select it and choose Text from the Format menu. Any properties that you define
for selected text using this process override your worksheet’s default properties,
even when you change those default properties.

To change the properties of selected text:

Select some text using one of the methods described in the section “Selecting
text.” 

Choose Text from the Format menu. Mathcad displays a dialog box showing
available fonts. Alternatively, use the font bar. 

Change the appropriate properties in the dialog box and click “OK.” You can
change the following properties:

Font
To change the font of the selected text, scroll through the Font list in the dia-
log box and choose an available font. 

Size
To change the size of the selected text, scroll through the Size list in the dia-
log box. Font sizes are in points. Note that some fonts are available in many
sizes and others aren’t. Remember that if you choose a bigger font, the text
region  you’re in may grow and overlap nearby regions. Choose Separate
Regions from the Format menu if necessary.
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Style
To change the style of the selected text, scroll through the Font Style list in
the dialog box. 

As you scroll through the Font Style list you’ll notice that some style combi-
nations are unavailable. For example, some fonts come in bold or italic, but
not in bold and italic at the same time. If you’re using the font bar buttons
and nothing seems to be happening, check the dialog box to see if the style
you want is available for the font family you’re using.

Effects
To make selected text superscripted, subscripted, or underlined, click on the
appropriate Effects option in the dialog box.

Color
To change the color of the selected text, scroll through the color list in the
dialog box. Note that you can’t use the font bar to change color. You can
only use the dialog box.

When you place the insertion point in existing text and start typing, the new text
takes its character properties from the immediately preceding character.

Changing default text fonts

Your worksheet has default text properties that determine the appearance of
each new character that you enter in your worksheet, unless that character is pre-
ceded by a character for which you’ve changed the properties. If you want to
make global changes to the appearance of text in your worksheet, you can
change these defaults.

To change the default text properties in your worksheet, follow these steps:

Choose Defaults⇒Text from the Format menu. Mathcad brings up a dialog
box showing the current default text properties.

Follow the procedures in the previous section for changing fonts. Note that
you cannot select subscript or superscript as a default.

Click “OK”.

You can redefine the default text properties at any time. Any text already in
your worksheet will be converted to the new properties, unless you’ve explicitly
selected it and set its properties as described in the preceding section, “Changing
text fonts.” Any new text you type will have the new default text properties.

The default text properties that you define only affect text in the current work-
sheet. You can save these defaults for use with other worksheets by either:

using configuration files as described on page 87, or

choosing Defaults⇒Text from the Format menu if you want to save just the
default color and not the other font characteristics.
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Changing paragraph formats

When you first create a paragraph in your worksheet, its properties are deter-
mined by your worksheet’s defaults. Paragraph properties consist alignment and
indentation. You can change these properties for an individual paragraph by do-
ing the following: 

Select the paragraph by clicking on it.

Choose Paragraph from the Format menu. Mathcad displays the following
dialog box:

Change the appropriate properties in the dialog box and click “OK”. You can
change the following properties:

Alignment
To align the text at either the left or right margin, or to center the text, use
these three alignment buttons.

Indentation
To indent every line in the paragraph use the Indent All Lines text box. To
indent just the first line of the paragraph relative to all the other lines use the
Indent First Line text box. For a hanging indent, use a negative number in
the Indent First Line text box. Both these text boxes expect a number in
inches.

Changing default paragraph properties

Your worksheet has default paragraph properties that determine the appearance
of each paragraph you create in your worksheet. If you want to make global
changes to the appearance of paragraphs in your worksheet, you can change
these defaults. To do so:

Choose Defaults⇒Paragraph from the Format menu. Mathcad opens a dia-
log box showing current default paragraph properties.

Change the paragraph properties as needed to describe your new default prop-
erties. Follow the procedures in the previous section, “Changing paragraph
formats.” 

Click “OK”.
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You can redefine the default paragraph properties at any time. Any paragraphs
already in your worksheet will inherit these new properties, unless you’ve ex-
plicitly set their properties as described in the section, “Changing paragraph for-
mats.” Any new paragraphs will have the new default paragraph properties.

Greek letters in text

To type a Greek letter in a text region or paragraph:

Type the roman equivalent from the following table and press [Ctrl]G, or

Open the Greek letter palette by clicking on the button labeled αβ on the but-
ton strip under the menus, then click on the appropriate button on the palette.

The table on the following page lists all the Greek letters and their roman equiva-
lents. These are the same roman equivalents used in the Windows Symbol font.
To insert an uppercase Greek letter, use the uppercase roman equivalent. To in-
sert a lowercase Greek letter, use the lowercase roman equivalent.
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Name Uppercase Lowercase Roman equivalent

alpha Α α A

beta Β β B

chi Χ χ C

delta ∆ δ D

epsilon Ε ε E

eta Η η H

gamma Γ γ G

iota Ι ι I

kappa Κ κ K

lambda Λ λ L

mu Μ µ M

nu Ν ν N

omega Ω ω W

omicron Ο ο O

phi Φ φ F

phi(alternate) ϕ J

pi Π π P

psi Ψ ψ Y

rho Ρ ρ R

sigma Σ σ S

tau Τ τ T

theta Θ θ Q

theta(alternate) ϑ J

upsilon Υ υ U

xi Ξ ξ X

zeta Ζ ζ Z

To change existing text into its Greek equivalent, select the text and either:

Press [Ctrl]G, or

Choose Text from the Format menu and select the Symbol font.
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Importing and exporting text

   Mathcad’s text is formatted using Microsoft’s “Rich Text Format” (RTF) specifi-
cation. This means you can export text from Mathcad text regions or paragraphs
to word processing programs that read files in RTF format. For many word proc-
essing programs running under Windows concurrently with Mathcad, you can
export directly via the clipboard. To do so:

Click in a text region or paragraph to place the insertion point (a vertical bar). 

Drag to highlight the text you want to export.

Choose Copy from the Edit menu. 

Click in the target application’s window and paste from the clipboard.

You can also import text from most other Windows applications. To do so:

Place the text in the clipboard.

Click in an empty region of the Mathcad worksheet. You should see the
crosshair.

Choose Paste from Mathcad’s Edit menu. 

Mathcad creates a paragraph containing the text on the clipboard. If the text con-
tains RTF formatting codes, Mathcad formats the text as directed. If you want
the text to be in a text region instead of a paragraph, see the end of the section
“Changing the width of paragraphs” earlier in this chapter.

You can also export the entire worksheet, including equations and plots, in RTF
format using the methods described in the section “Exporting your worksheet”
on page 79.

Find and Replace 

Mathcad’s Find and Replace commands work in both text and equations. When
you search for a string of characters, Mathcad looks for that string as part of a
variable or function name or as a piece of text in a text region or paragraph.

Searching for text

To find a string of characters,

Choose Find from the Edit menu. Mathcad brings up the dialog box shown
in Figure 3.

Enter the string you want to find in the text box labeled “Find”. 

Click on “Next” or “Previous” to find the occurrence of the string immedi-
ately after or before the current insertion point location. 
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For example, to search for all occurrences of the letters lb in a worksheet: 

Choose Find from the Edit menu Mathcad brings up a dialog box and
prompts you for a string to find. 

Type lb and click on “Next”. 

Mathcad searches forward from the insertion point position for a region contain-
ing the letters lb, whether in text or in an equation. When Mathcad finds a
match in a text region or paragraph, it shows it in reverse video; when it finds a
match in an equation it positions the insertion point in the string. The dialog box
remains up so that you can continue searching (Figure 3). When you’re done
with the search, close the Find dialog box by double-clicking on the button on
its upper-left corner.

Figure 3. Searching for a text string.

Note that Mathcad’s Find command is case-sensitive, but not font-sensitive. For
example, if you’re searching for b, you won’t find B, but you will find β, since
this is nothing more than a lowercase b in Greek or Symbol font.

Replacing characters

To search and replace, choose Replace from the Edit menu. For example, to re-
place instances of the name sec with s:

Choose Replace from the Edit menu to bring up the Replace dialog box
shown in Figure 4.

Enter the string you want to find (the target string) in the text box labeled
“Find”. 
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Enter the string you want to replace it with in the text box labeled “Change
to”.

You now have four choices:

Click on “Find Next” to find and select the next instance of your target string.

Click on “Change” to replace the currently selected instance of the string.

Click on “Change and Find Next” to replace this instance and find the next
one.

Click on “Change All” to replace all instances without further prompting.

Figure 5 shows the result of choosing “Change All.”

Figure 4: Before replacing all instances of sec with s.
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Figure 5: After replacing sec with s.

Spellchecking

  After creating text, you can have Mathcad search it for misspelled words. Math-
cad will find misspelled words and suggest replacements. It will also let you add
words that commonly use to your dictionary. Note that Mathcad will spellcheck
only text regions and paragraphs, not math or graphics regions.

Checking text for misspelled words

To begin spellchecking, you first have to tell Mathcad what portions of the work-
sheet to spellcheck. There are two ways to do this:

Click at the beginning of wherever you want to spellcheck. Mathcad will
spellcheck starting from this point and continue to the end of the worksheet.
Mathcad will then let you either continue the spellcheck from the beginning
of the worksheet or quit spellchecking.

Alternatively, select the text you want to spellcheck by dragging the mouse
across the text.

Once you’ve defined a range over which to spellcheck:

Choose Check Spelling from the Edit menu. When Mathcad finds a mis-
spelled word, it opens the dialog box shown below.
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The dialog box shows the misspelled word along with a suggested replacement.
It may also show a list of other suggested replacements. If Mathcad has no im-
mediate suggestions, it will show only the misspelled word. However, if you
click the “Suggest” button, Mathcad will show a list of words that are less likely
but possible replacements.

After the dialog box appears, you’ve several options:

To change the word to the suggested replacement, click on “Change”.

To change the word to one from the list of replacements, select one and click
“Change”.

To see additional but less likely replacements, click “Suggest”. Note that if
Mathcad can offer no additional suggestions, the “Suggest” button will be
grayed out.

To change the word to one not listed, type the replacement into the “Change
to” box and click “Change”.

To leave the word as is, click “Ignore” or “Add”. If you click “Ignore”, Math-
cad will leave the word alone and continue spellchecking, ignoring all future
occurrences of the word as it does so. If you click “Add”, Mathcad will add
the word to your dictionary. The following section explains this dictionary in
more detail.

Personal dictionaries

To determine whether a word is misspelled, Mathcad compares it with the
words in the following dictionaries:

A general dictionary of common English words supplemented by mathemati-
cal terms.

A personal dictionary.

When a word is not found in either dictionary, Mathcad will warn you that it
may be misspelled. 
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If there are certain correctly spelled words throughout your worksheet which
Mathcad nevertheless shows as being misspelled, you may want to add them to
your personal dictionary. This will prevent Mathcad from considering them mis-
spelled.

To add a word to your personal dictionary:

When Mathcad shows the word in the Check Spelling dialog box, click
“Add”.

This will add the word to your dictionary. For future spellchecks, Mathcad will
not show it as being misspelled. 

Linking to other worksheets

You can create a link from any text region or paragraph to any Mathcad work-
sheet. When a reader clicks on this link, Mathcad will jump to the Mathcad
worksheet designated by the link. 

Mathcad can jump to any worksheet, no matter where it’s stored. All that’s re-
quired is that you be able to open that worksheet. 

Creating a new link

To create a link, you must specify two pieces of information:

What to double-click on in order to jump to another worksheet. This is the
“doorway”.

What worksheet to jump to. This is the “target worksheet.”

To specify these two pieces of information, you must have both worksheets
open at the same time. Begin by specifying the doorway:

Click in the worksheet which is to contain the doorway.

Select the text which you want to use to jump to the target worksheet when-
ever you double-click on it. 

The next step is to specify the target. To do so:

Open the target worksheet.

Choose Link⇒New from the Insert menu. You’ll see the following dialog
box:
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In the list of open windows, select the target worksheet and click “OK.” Note
that this list excludes any untitled windows you may have open. A worksheet
must have been saved at least once before it can become a target worksheet.

Once you’ve done this, Mathcad marks your gateway by underlining the text
and making it bold. The next time you double-click on this gateway, Mathcad
will open up the target worksheet. Note that you don’t need to have the target
worksheet already open before using the gateway. You only need to have it
open when you’re first creating the gateway.

This mechanism will work no matter where the target worksheet is located. All
that’s necessary is that you be able to open that worksheet.

Once you’ve created the link, you no longer need to know which of these com-
mands to use or even where the file is. Mathcad remembers where the file was
when you first created the link and does whatever is has to do to get there again.
Of course, if you move the target file after having created the link, Mathcad will
no longer be able to find it.

Erasing a link

To remove a link to another worksheet, simply click anywhere in the gateway
and choose Link⇒Erase from the Insert menu. Mathcad will remove all traces
of the link.

Links from other regions

The gateway to a target worksheet need not be a text string as described in the
section “Creating a new link”. Any Mathcad region will do. The procedure is
identical to that described in that section except that you don’t specify the gate-
way by selecting text. Instead, you do one of the following before choosing
Link⇒New from the Insert menu:

To make an equation or a plot a gateway, click anywhere in the equation or
plot.

To make an entire text region or paragraph a gateway, place the insertion
point anywhere within it.

There are two significant disadvantages to using something other than selected
text as a gateway:
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When you choose selected text as a gateway to another worksheet, Mathcad
automatically makes the selected text bold and underlined to indicate that a
link exists there. No corresponding indication is possible when you choose
something other than selected text as a gateway.

The link preempts the normal response to double-clicking. For example, if
you choose a plot as a gateway, you will no longer be able to double-click on
that plot to open a formatting dialog box.

For these reasons, we recommend that you use only selected text as a gateway to
another worksheet.
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Chapter 5
Equation and Result Formatting

Although Mathcad shows equations in standard math notation, you
do have some control over the way they are displayed. You can
determine the font, size, and style used for letters and numbers in
equations. You can also determine how Mathcad displays answers,
including specifying the number of decimal places, the base in
which they are displayed, and the use of scientific notation.

The following sections make up this chapter:

Formatting results
Changing the display of computed values in equations.

Math fonts
Changing the font, size, and style used in equations and plots.

Highlighting equations
Making a particular equation stand out from all the other equations and
regions in your worksheet.
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Formatting results 

The way that Mathcad displays numbers (the number of decimal places, whether
to use i or j for imaginary numbers, and so on) is called the result format. You
can set the result format for a whole worksheet (the global format) or for a sin-
gle calculated result (the local format).

Setting global result format 

 To change the default display of numerical results, click on an empty space and
choose Number from the Format menu. You will see the dialog box shown be-
low. Default values for the four precision settings are shown in parentheses. The
range of values allowed for each setting is shown to the right of the correspond-
ing text box.

Change the desired settings and click “OK.” Mathcad changes the display of all
results whose formats have not been explicitly specified. You can control the dis-
play of a single result without affecting any others by setting the local result for-
mat. The next section discusses how to do this.

This is the meaning of each of the settings in the dialog box:

Radix
This allows you to set the radix (base) in which results are displayed. The de-
fault is decimal. If you select “Octal” or “Hex,” Mathcad truncates the num-
ber to an integer and displays it as octal or hexadecimal. Hexadecimal results
are indicated by the letter “h” after the number, octal results by the letter
“o.” (Mathcad does not reliably show hexadecimal or octal numbers of mag-
nitude greater than 2 31, or about 2 ⋅ 10 9 ).   
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Imaginary 
Click on the i or j  button. Mathcad uses the selected letter to indicate an
imaginary result. The default is i. You can use either i or j in equations —
Mathcad always understands both. The selection you make here tells Math-
cad which one to use when it gives you a complex answer. See Chapter 7,
“Variables and Constants,” for more information on how to type complex
numbers.  

Trailing Zeros
Check this box to make all displayed results have as many digits to the right
of the decimal point as required by the current choice of Displayed Preci-
sion. For example, with Displayed Precision set to 3, Mathcad displays 5 as
5.000.

Display as Matrix
Check this box to suppress the use of scrolling output tables. Vectors and ma-
trices having more than nine rows or columns are displayed as scrolling out-
put tables unless this box is checked. See page 192 for more information on
scrolling output tables.

Displayed Precision
Enter an integer between 0 and 15. This indicates how many decimal places
to show in computed results. The default is 3. Numbers are rounded for dis-
play only. Mathcad maintains 15 digits of precision internally. 

Exponential Threshold
Enter an integer n between 0 and 15. Mathcad shows computed results of
magnitude greater than 10 n or smaller than 10 −n in exponential notation.
When the threshold is 3, numbers like 30,000 are displayed as 3⋅10 4 instead
of 30,000. The default is 3.  

Complex Tolerance
Enter an integer n between 0 and 63. If the ratio between the real and imagi-
nary part of a complex number is less than 10 −n or greater than 10 n, then the
smaller part is not shown. The default setting is 10. This means that numbers
like 1 + 10 −12 i will appear simply as 1. Mathcad rounds only the displayed
values. No change is made in the internally stored values.

Zero Tolerance
Enter an integer n between 0 and 307. Numbers less than 10 −n are shown as
zero. The default setting is 15. This means numbers of magnitude less than
10 −15 appear as zero. Mathcad changes the displayed values only. No
change is made in the internally stored values.

Changing the global result format affects only the worksheet you were in when
you made the change. Any other worksheets that may have been open at the
time retain their own global result formats.
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If you want to use your global result formats every time you start Mathcad,
choose Save Configuration from the File menu once they are all set to your lik-
ing. See Chapter 3 for more on configuration files.

All of these formatting options affect only the display of a number. Mathcad
continues to carry out all calculations in full precision regardless of formatting
options. If you copy a result by choosing Copy from the Edit menu, Mathcad
copies the answer to the precision displayed.

To see the number as it is stored internally:

Click anywhere on the result.

Press [Ctrl]F

Mathcad displays the number in full precision on the message line as shown in
Figure 1.

Figure 1: Full precision is maintained internally.

Setting local result format

You can set the format for a single result — a number, table, vector, or matrix —
 independently of the global result format. This is called setting the local result
format. To change the format with which a particular result is displayed, you
must:

Click anywhere in the equation
whose result you want to format. 
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Choose Number from the Format menu. Alternatively, double-click on the
equation itself. The dialog box shown on the right appears. Note that the op-
tion button “Local” is already selected. 

Change the desired settings. See the previous section to learn what the vari-
ous settings do and what their allowed values are. To display the six decimal
places shown below, you would change “Displayed Precision” from 3 to 6.

Click “OK.” Mathcad redisplays
the result using the new format.

You can also apply local formats to all tables, vectors, or matrices. Just click on
the table, vector, or matrix and choose Number from the Format menu. When
you click on “OK,” Mathcad applies the selected format to all the numbers in
the table, vector, or matrix. It is not possible to individually format these num-
bers.

When you click the button labelled “Local,” Mathcad disables the Imaginary
Unit and Zero Tolerance settings. These settings can only be set globally, not lo-
cally.

To redisplay a result using the global result format settings:

Click on the result to enclose the re-
sult between the editing lines.

Delete the equals sign.

Formatting results 127



Press = to replace the equals sign.
The result format has now been re-
stored to the global result format
settings.

Figure 2 shows the same number formatted several different ways.

Figure 2: Several ways to format the same number.
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Math fonts

      To change Mathcad’s default font for all variables and plots:

Click on any variable and choose Equation from the Format menu to see the
dialog box shown below. 

To change the font associated with that variable’s font tag, click on “Proper-
ties.” You’ll see a dialog box for changing fonts.

Click the “OK” button. Mathcad changes the font of all variables in the work-
sheet.

If you change the variable’s font, you may also want to change the font used for
numbers so that the two look good together. To do so, click on a number. The
font tag window should now say “Constants”. Then follow the procedure for
variables. 

You can also use the font bar to change font, size, or style of variables. To do so,
click on a variable, then click on the appropriate font bar button to make vari-
ables bold, italic or underlined or to specify the font or point size in the scrolling
lists.

The font, size, and style you choose for variables affects not only the appearance
of equations, but the appearance of the entire worksheet. Mathcad’s line-and-
character grid does not depend on the font size. Therefore, changing font charac-
teristics, particularly font sizes, may cause regions to overlap. You can separate
these regions by choosing Separate Regions from the Format menu.

You may wish to have your math regions colored differently from text to avoid
mixing the two up. To change the color of all equations in your worksheet
choose Equation from the Format menu.  

Font tags

Whenever you type a variable name, Mathcad: 

Assigns to it a font tag named “Variables.”

Looks up the font, size, and style associated with that particular font tag. 
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Displays the variable name using the font characteristics associated with the
font tag named “Variables.”

Similarly, when you type a constant, Mathcad:

Assigns to it a font tag named “Constants.”

Looks up the font, size, and style associated with that particular font tag. 

Displays the constant using the font characteristics associated with the font
tag named “Constants.”

This means that when you change a font, you are not changing the font for the
string itself. Instead, you are changing the font for the font tag assigned to that,
and possibly many other strings. This mechanism allows you to easily change
the font for many strings at once.

To see what font tag is currently assigned to a name or number, click on the
name or number and look at the font tag window on the font bar.

Alternatively, you can click on the name or number and choose Equation from
the Format menu. You’ll see the dialog box shown in the last section. The font
tag associated with whatever you clicked on will appear in the drop-down list as
shown in Figure 3. 

By default, variables are tagged with “Variables,” and numbers are tagged with
“Constants.” Answers displayed on the right of an equals sign are always tagged
as “Constants.” These two tag names cannot be changed. 

If you click on the button to the right of “Variables”, you’ll see a drop-down list
of available font tags. If you now choose “User 1” and click “OK,” the variable
selected in Figure 3 gets retagged and its font changes accordingly. Figure 4
shows the result.
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Figure 3: Scrolling list shows font tag of selected string.

Figure 4: First variable name from Figure 3 has been retagged. Note change in
font.
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Applications of Font Tags 

The notion of tagging strings becomes useful when you need to make many
changes in your worksheet. You may have already encountered the concept if
you’ve ever used style sheets to tag paragraphs in word processing or desktop
publishing software. By making changes to the style sheets rather than the para-
graphs themselves, you can make sweeping and strikingly uniform changes in
the way a worksheet looks. You can get this same kind of leverage by judicious
use of Mathcad’s font tags.

For example, many math books show vectors in a bold, underlined font and ma-
trices in a bold font. If you want to use this convention without having to scroll
through the worksheet and changing the font characteristics for every string in
it, do the following:

Choose Equation from the Format menu.

Click the down arrow beside the name of the current font tag to see a drop-
down list of available font tags.

Click on an unused font tag like “User1” to select it.

The name “User1” should now appear in the “Edit Tag Name” text box. Click
in this text box and change the name to something like “Vectors.”

Change this font tag to a bold, undelined font.

This creates a font tag called “Vectors” with the desired font. Proceed in a simi-
lar way to create a font tag named “Matrices” having a bold font. When you’re
done defining both font tags, click “OK.”

Now rather than individually changing the font, size and style for names of vec-
tors and matrices, you can simply change their font tags. To do so, do the follow-
ing:

Click on the name of the vector or matrix. The font tag assigned to that name
appears on the font bar. By default, this is “Variables.”

Click on the arrow beside the font bar window and Scroll down to the font
tag “Vectors”. The font tag changes to “Vectors” and the font changes to a
bold underlined font because that’s the font assigned to the Vectors font tag.

Repeat the previous two steps for all vectors in the worksheet. For matrices,
choose the newly created font tag “Matrices” instead. Note that you can tag only
one name at a time.

If after having done this you decide to remove all the underlines from the vec-
tors, you can simply: 

Choose Equation from the Format menu.

Choose “Vectors” from the drop-down list of font tags at the top of the dialog
box. 
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Click on the underline check box. 

Once you click on the “OK” button, the underlines will be removed from every
vector in the worksheet.

Note that this procedure changes the font for the names of vectors and matrices,
not the individual elements themselves. The individual elements continue to be
tagged as “Variables” or “Constants.” 

Saving font tags

Once you’ve completed a set of font tags that you like, you need not repeat the
process for other worksheets. You can save font tag information by choosing
Save Configuration from the File menu.

To apply font tag information to another worksheet, choose Load Configura-
tion from the File menu. 

For more information, see the section “Configuration files” in Chapter 3.

Font sensitivity

All names, whether function names or variable names, are font sensitive. This
means that x and x refer to different variables, and f(x) and f(x) refer to different
functions.

In deciding whether two variable names are the same, Mathcad actually checks
font tags rather than fonts. To avoid having distinct variables that look identical,
don’t create a font tag with exactly the same font, size and style as another font
tag.

Highlighting equations

To highlight an equation so that it stands out from the rest of the equations and
text in your worksheet:

Click in the equation you want to highlight.

Choose Highlight Equation from the Format menu.

Mathcad draws a box around the equation and fills it with a color light enough
so you can see the equation. This is a purely cosmetic change with no effect on
the equation other than rendering it more conspicuous.

The appearance of a highlighted equation on printing will depend very much on
the capabilities of your printer. Some printers will render a color as black, ob-
scuring the equation in the process. Others will render the exact same color as
just the right gray to highlight the equation without obscuring it.

To solve this problem, you should change the background color of a highlighted
equation by doing the following:
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Choose Color from the Format menu.

Pull right and choose Highlight to bring up a dialog box containing a palette
of colors.

Click on the appropriate color.
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Computational Features





Chapter 6
Equations and Computation

This chapter describes how to define and evaluate variables and
functions. This chapter discusses only numerical equations. To
learn how to use Mathcad’s symbolic processing features, turn to
Chapter 17, “Symbolic Calculation.”

The following sections make up this chapter:

Defining variables and functions
How to define variables and functions. How the relative placement of
equations affects calculations.

Evaluating expressions
How to get a numerical answer.

Copying numerical results
How to copy numerical results from one worksheet to another or from
Mathcad to other applications.

Controlling calculations
How to suppress the way Mathcad automatically updates the work-
sheet. 

Disabling equations
Turning calculation on and off for individual equations.

Error messages
What to do when Mathcad displays an error message.
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Defining variables and functions 

Whenever you type an equation into a worksheet, you are doing one of two
things:

You could be typing an expression and asking Mathcad to give you the an-
swer. This is discussed in the next section, “Evaluating expressions.”

You could be typing a variable or function name and assigning some value to
it. The remainder of this section discusses how to do this.

Defining a variable 

 A variable definition defines the value of a variable everywhere below the defi-
nition. To define a variable, you must follow these three steps:

Type the variable name to be de-
fined. Chapter 7 contains a descrip-
tion of valid variable names.

Press the colon (:) key. The defini-
tion symbol (:=) appears. 

Type an expression to complete the
definition. This expression can in-
clude numbers and any previously
defined variables and functions.

Figure 1 shows several examples of a variable definition. The left hand side of a
“ :=” can contain any of the following:

A simple variable name like x.

A subscripted variable name like vi.

A matrix whose elements are any of the above. For example:





x

y1





A function name with an argument list of simple variable names. For exam-
ple, f(x, y, z). This is described further in the next section.

A superscripted variable name like M< 1 >.
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Figure 1: Defining variables.

Defining a function 

 You can also define your own functions in Mathcad. Unlike a variable, the value
of a function depends on the values of its arguments.

You define a function in much the same way you define a variable. The name
goes on the left, a “:=” goes in the middle, and an expression goes on the right.
The main difference is that the name includes an argument list. The example be-
low shows how to define a function called dist(x, y) which returns the distance
between the point (x, y) and the origin.

To type such a function definition:

Type the function name. 

Type a left parenthesis followed by
one or more names separated by
commas.  Complete this argument
list by typing a right parenthesis. 

It makes no difference whether or not the names in the argument list have been
defined or used elsewhere in the worksheet. What is important is that these argu-
ments must be names. They cannot be more complicated expressions. 

Press the colon (:) key. You see
the definition symbol (:=).
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Type an expression to define the
function. In this example, the ex-
pression involves only the names in
the argument list. In general
though, the expression can contain
any previously defined functions
and variables as well.

Once you have defined a function, you can use it anywhere below the definition,
just as you would use a variable.

When you use a function in an equation, Mathcad:

evaluates the arguments you place between the parentheses, 

replaces the dummy arguments in the function definition with the actual argu-
ments you place between the parentheses, 

performs whatever arithmetic is specified by the function definition, and

returns the result as the value of the function.

Figure 2 shows an example.

Figure 2: A user-defined function to compute the  distance to the coordinate ori-
gin.

The arguments of a user function can represent scalars, vectors, or matrices. For
example, you could define the distance function as 

dist(v) := √v0
 2 + v1

 2
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This is an example of a function that accepts a vector as an argument, and re-
turns a scalar result. See the section on “Arrays and user functions” at the end of
Chapter 9 for more information. 

Note that function names are font sensitive. This means that the function f(x) is
different from the function f(x). Figure 3 shows an example. 

Mathcad’s built-in functions are defined for all fonts (except the Symbol font),
sizes and styles. This means that sin(x), sin(x), and sin(x) all refer to the same
function. 

Figure 3: Function names are font sensitive. Undefined variables are marked in
reverse video.

Variables in user functions 

When you define a function, you don’t have to define any of the names in the ar-
gument list. This is because when you define a function, you are telling Mathcad
what to do with the arguments, not what they are. When you define a function,
Mathcad doesn’t even have to know whether the arguments are scalars, vectors
or matrices. All it needs to know is how many arguments there are and what to
do with them. It is only when Mathcad actually uses a function that it needs to
know what the arguments really are.

However, if in the process of defining a function you use a variable name that is
not in the argument list, you must define that variable name above the function
definition. The value of that variable at the time you make the function defini-
tion then becomes a permanent part of the function. This is illustrated in 
Figure 4.
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When you evaluate a function, Mathcad:

evaluates the arguments, 

substitutes their values on the right side of the function definition, 

evaluates the values of the other variables at the point where the function is
defined, 

computes and returns a result.

If you want a function to depend on the value of a variable, you must include
that variable as an argument. If not, Mathcad will just use that variable’s fixed
value at the point in the worksheet where the function is defined.

Figure 4: The value of a user function depends on its arguments.

How Mathcad scans a worksheet 

 Mathcad scans a worksheet the same way you read it: left to right and top to bot-
tom. This means that a variable or function definition involving a “:=” affects
everything below and to the right of it.

To determine whether one equation is above or below another, Mathcad com-
pares their anchor points. To see these anchor points, choose Regions from the
View menu. Mathcad will display blank space in gray and leave regions white
(or whatever your background color happens to be). Each region’s anchor point
will appear as a dot on the left.
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Figure 5 shows an example of how not to place equations in a worksheet. In the
first evaluation, both x and y are shown in red to indicate that they are unde-
fined. This is because the definitions for x and y lie below where they are used.
Because Mathcad scans from top to bottom, when it gets to the first equation, it
has no idea what numbers to substitute in place of x and y.

The second evaluation, on the other hand, is below the definitions of x and y. By
the time Mathcad gets to this equation, it has already assigned values to both x
and y. 

Figure 5: Mathcad evaluates equations from top to bottom in a worksheet. The
small dot on the left side of each equation is an anchor point. Undefined vari-
ables are marked in reverse video.

You can define a variable twice in the same worksheet. Mathcad will simply use
the first definition for all expressions below the first definition and above the
second. For expressions below the second definition, Mathcad uses the second
definition. Figure 6 illustrates a worksheet in which some variables are defined
twice.
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Figure 6: A worksheet in which V and T are both defined twice.

Global definitions 

 Global definitions are exactly like local definitions except that they are evalu-
ated before any local definitions. If you define a variable or function with a
global definition, that variable or function is available to all local definitions in
your worksheet, regardless of whether the local definition appears above or be-
low the global definition.

To type a global definition, follow these steps:

Type a variable name or function to
be defined.

Press the tilde (~) key. The global
definition symbol appears.

Type an expression. The expression
can involve numbers or other glob-
ally defined variables and functions.

You can use global definitions for functions, subscripted variables, and anything
else that normally uses the definition symbol “:=”. Just type a tilde instead of a
colon, and Mathcad will show the global definition symbol “≡” in place of “:=” .
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This is the algorithm that Mathcad uses to evaluate all definitions, global and
otherwise: 

First, Mathcad takes one pass through the entire worksheet from top to bot-
tom. During this first pass, Mathcad evaluates global definitions only.

Mathcad then makes a second pass through the worksheet from top to bot-
tom. This time, Mathcad evaluates all definitions made with “:=” as well as
all equations containing “=”.

Figure 7 shows the results of a global definition for the variable R which appears
at the bottom of the figure. 

Figure 7: Using the global definition.

Although global definitions are evaluated before any local definitions, Mathcad
evaluates global definitions the same way it evaluates local definitions: top to
bottom and left to right. This means that whenever you use a variable to the
right of a “≡”:

that variable must also have been defined with a “≡,” and

the variable must have been defined above the place where you are trying to
use it.

Otherwise, the variable is marked in red to indicate that it is undefined.

It is good practice to allow only one definition for each global variable. Al-
though you can do things like define a variable with two different global defini-
tions or with one global and one local definition, this is never necessary and
usually serves only to make your worksheet difficult to understand.
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Evaluating expressions 

 To evaluate an expression, follow these steps:

Type an expression containing any
valid combination of numbers, vari-
ables and functions. Any variables
or functions in this expression
should be defined earlier in the
worksheet.

Press the “=” key. Mathcad com-
putes the value of the expression
and shows it after the equals sign. 

Figure 8 shows some calculations using the definitions from Figure 1.

Figure 8: Calculations based on the variables defined in Figure 1.

Whenever you evaluate an expression, Mathcad shows a final placeholder at the
end of the equation. You can use this placeholder for unit conversions, as ex-
plained in Chapter 8, “Units and Dimensions.” As soon as you click outside the
region, Mathcad hides the placeholder. 
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Copying numerical results

You can copy a numerical result and paste it either elsewhere in your worksheet
or into another application. This allows you to copy an array of numbers directly
from a spreadsheet or database into Mathcad where you can take advantage of
its free-form interface and its advanced mathematical tools, and vice versa.
Once you’ve performed the necessary computations, you can paste the resulting
array of numbers back to where it came from or even into another application. 

Copying a single number

To copy a single number appearing to the right of an equal sign:

Click on the result to the right of the equal sign. This puts the result between
the editing lines.

Choose Copy from the Edit menu. This places the result on the clipboard.

Click wherever you want to paste the result. If you’re pasting into another ap-
plication, choose Paste from that application’s Edit menu. If you’re pasting
into a Mathcad worksheet, choose Paste from Mathcad’s Edit menu.

The Copy command will copy the numerical result only to the precision dis-
played. To copy the result in greater precision, double-click on it and increase
“Displayed Precision” on the Format Number dialog box. Note that Copy will
not copy units and dimensions from a numerical result.

When you paste a numerical result into a Mathcad worksheet, it appears as:

a math region consisting of a number if you paste it into empty space,

a text string if you paste it into a text,

a number if you paste it into a placeholder in a math region or if you paste it
into text using the Math Region command on the Insert menu.

Copying an array of numbers

To copy an array (vector or matrix) appearing to the right of an equal sign:

Click on the array to the right of the equal sign. This puts the array between
the editing lines.

Choose Copy from the Edit menu. This places the array on the clipboard. 

Click wherever you want to paste the result. If you’re pasting into another ap-
plication, choose Paste from that application’s Edit menu. If you’re pasting
into a Mathcad worksheet, choose Paste from Mathcad’s Edit menu.

When you paste an array into a Mathcad worksheet, it appears as:

a vector or matrix if you paste it into empty space,

a text string if you paste it into text,
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a vector or matrix if you paste it into a placeholder in a math region or if you
paste it into text using the Math Region command on the Insert menu.

The Copy command will copy the numerical result to the precision with which
it is displayed. You can view the current display settings by double-clicking on
the result you want to copy and examining the dialog box. See Chapter 5 to
learn more about formatting numbers for display. Note that Copy will not copy
units and dimensions.

Copying numbers from a scrolling output table

When you display results in a scrolling output table as described on page 192,
you may want to copy some of the numbers from the table and use them else-
where.

To copy just one number from a scrolling output table, simply click on the num-
ber and choose Copy from the Edit menu. To copy more than one number from
a scrolling output table:

Click on the first number you want to copy.

Drag the mouse in the direction of the other values you want to copy while
holding the mouse button down.

Choose Copy from the Edit menu.

To copy all the values in a row or column, click on the column or row number
shown to the left of the row or at the top of the column. All the values in the row
or column will be selected. Then choose Copy from the Edit menu.

After you have copied one or more numbers from a scrolling output table, you
can paste them into another part of your worksheet or into another application.
Figure 9 shows an example of a new matrix created by copying and pasting num-
bers from a scrolling output table. Note that if you copied and pasted more than
nine rows or columns of numbers from the table, they will be displayed as a new
scrolling output table.
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Figure 9:  Creating a new matrix from numbers in a scrolling output table.

Controlling calculations 

When you start Mathcad, you are in “automatic mode.” This means that Math-
cad updates results in the worksheet window automatically. You can tell you’re
in automatic mode because the word “auto” appears in the message line.

If you don’t want to wait for Mathcad to make computations as you edit, disable
automatic mode by choosing Automatic Calculation from the Math menu or
by clicking the light bulb on the toolbar. The word “auto” disappears from the
message line and the checkmark beside Automatic Calculation disappears to in-
dicate that automatic mode is now off.

Automatic window update

 The word “auto” on the message line indicates that you are in automatic mode.
This means that:

As soon as you press the equals sign, Mathcad displays a result.

As soon as you click outside of an equation having a “:=” or a “≡, ” Mathcad
performs all calculations necessary to make the assignment statement.
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When you process a definition in automatic mode by clicking outside the equa-
tion region, this is what happens:

Mathcad evaluates the expression on the right side of the definition and as-
signs it to the name on the left.

Mathcad then takes note of all other equations in the worksheet that are in
any way affected by the definition you just made.

Finally, Mathcad updates any of the affected equations that are currently vis-
ible in the worksheet window. 

Although the equation you altered may affect equations throughout your work-
sheet, Mathcad performs only those calculations necessary to insure that what-
ever you can see in the window is up-to-date. This optimization makes sure you
don’t have to wait for Mathcad to evaluate expressions that are not visible.

In automatic mode, if you print or move to the end of the worksheet, Mathcad
automatically updates the whole worksheet.

Whenever Mathcad needs time to complete computations, the mouse pointer
changes its appearance and the word “WAIT” appears on the message line. This
can occur when you enter or calculate an equation, when you scroll, during print-
ing, or when you enlarge a window to reveal additional equations. In all these
cases, Mathcad evaluates pending calculations from earlier changes.

As Mathcad evaluates an expression, it covers it with a green cross-hatched rec-
tangle. This makes it easy to follow the progress of a calculation.

To force Mathcad to recalculate all equations throughout the worksheet, choose
Calculate Worksheet from the Math menu.

Manual window update

In manual mode, Mathcad does not compute equations or display results until
you specifically request it to recalculate. This means that you don’t have to wait
for Mathcad to calculate as you enter equations or scroll around a worksheet.

Mathcad keeps track of pending computations while you’re in manual mode. As
soon as you make a change that requires computation, the word “calc” appears
on the message line. This is to remind you that the results you see in the window
are not up-to-date and that you must recalculate them before you can be sure
they are updated. 
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Figure 10: The word “calc” on the message line indicates that recalculation is re-
quired.

You can update the screen by choosing Calculate from the Math menu. Math-
cad performs whatever computations are necessary to update all results visible
in the worksheet window. When you move down to see more of the worksheet,
the word “calc” reappears on the message line to indicate that you must recalcu-
late to see up-to-date results.

To process the whole worksheet, including those portions not visible in the
worksheet window, choose Calculate Worksheet from the Math menu.

To switch back to automatic mode, choose Automatic Calculation from the
Math menu. Mathcad updates the entire worksheet and displays the word
“auto” on the message line.

When you print a worksheet in manual calculation mode, the results on the print-
out are not necessarily up-to-date. When you’re in manual mode, make sure to
choose Calculate Worksheet from the Math menu before you print.
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Interrupting calculations

   To interrupt a computation in progress:

Press [Command][Period]. The dialog box shown below will appear.

Click “OK” to stop the calculations or “Cancel” to resume calculations.

If you click “OK,” Mathcad displays a message on the message line to indicate
that processing has been interrupted. The equation that was being processed
when you pressed [Command][Period] is marked with an error message indi-
cating that calculation has been interrupted. To resume an interrupted calcula-
tion, first click in the equation having the error message, then choose Calculate
from the Math menu.

If you find yourself frequently interrupting calculations to avoid having to wait
for Mathcad to recalculate as you edit your worksheet, you may wish to switch
to manual mode. To do so, disable automatic mode by choosing Automatic Cal-
culation from the Math menu. This will remove the checkmark from the menu.
In manual mode, Mathcad recalculates only when you choose Calculate from
the Math menu.

Starting in manual mode 

 If you often work in manual calculation mode, you may find it useful to start
Mathcad in manual mode rather than having to disable automatic calculation
each time you start up. To make Mathcad always start up in manual mode, do
the following:

Double click on the Mathcad icon.

Choose Automatic Calculation from the Math menu. This command puts
Mathcad into manual mode. The checkmark beside this menu item should
now be gone.

Choose Save Configuration from the File menu.

Click “OK” in the Save Configuration dialog box.

Mathcad saves the current configuration, including the fact that it is in manual
calculation mode. From this point on, Mathcad will always start in manual mode.
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Disabling equations 

You can disable calculation for a single equation by selecting it and choosing
Toggle Equation from the Math menu. With this feature, you can use Math-
cad’s equation editing, formatting, and display capabilities without having to
worry about error messages.

To disable calculation for an equation, follow these steps:

Click on the equation you want to disable.

Choose Toggle Equation from the Math menu.

Mathcad shows a small rectangle after
the equation to indicate that it is disabled.
An example is shown on the right.

You can edit a disabled equation just as
you would any other equation. However,
a disabled equation does not affect any
other calculations, nor does it reflect
changes you make to other equations in
the worksheet. 

To re-enable calculation for a disabled equation:

Click on the equation to select it.

Choose Toggle Equation from the Math menu. 

Mathcad removes the small rectangle beside the equation.

Note: If you disable a plot or an output table, Mathcad freezes the display for
the plot or table. Changes you make to other parts of the worksheet will not af-
fect the plot or table. If you move a disabled equation that happens to be display-
ing a result, the result will disappear. If you move a graph, whatever is inside the
graph will disappear.

Error messages 

Mathcad may encounter an error when evaluating an expression. If it does, it
marks the offending expression with an error message and highlights the offend-
ing name or operator in a different color. 

An error message is visible only when you click on the associated expression.
Figure 11 shows how an error message looks when you click on an expression.
You’ll always be able to get on-line help about the error message by clicking on
it and pressing [Command]/. 
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Mathcad cannot process an expression containing an error. If the expression is a
definition, the variable or function it is supposed to define will remain unde-
fined. This can cause any expressions that reference that variable to be unde-
fined as well. Mathcad indicates undefined variables and functions by
displaying their names in red. Figure 12 shows how an error in the definition of
x1 causes a variable to be undefined in three different places.

Figure 11: A worksheet containing an error message and several undefined vari-
ables.
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Figure 12: The same worksheet but showing additional error messages. Unde-
fined variables are marked in reverse video.

Note that in an expression in which zero is either a pre-factor or numerator (for
example 0 ⋅ x or 0 / x), Mathcad computes the result as zero, without evaluating
or checking for errors in the x expression.  

Fixing errors 

 If your worksheet contains several expressions with errors, as shown in Figure
12, this is what to do:

Determine which expression with an error is closest to the top of the work-
sheet. This error is probably the cause of many of the other errors.

If necessary, consult Appendix B for information on the error message or
click on the error and press [Command]/ for help.

If you anticipate time-consuming calculations, switch to manual mode. This
will allow you to make numerous changes without having to wait for Math-
cad to recalculate. When you are ready to recalculate, choose Calculate from
the Math menu.

Once you have determined which expression caused the error, edit that expres-
sion to fix the error, or change the variable definitions that led to the error.
When you click in the expression and begin editing, Mathcad removes the error
message. When you click outside the equation (or in manual calculation mode,
when you recalculate), Mathcad recomputes the expression. If you have fixed
the error, Mathcad then recomputes the other expressions affected by the expres-
sion you changed.
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Note that when you see an error message attached to an expression, it doesn’t
necessarily mean that you should edit that expression. More often than not, the
error arises as a result of functions or variables defined farther up in the work-
sheet. Edit these other definitions to fix the error. For example, in Figure 12, all
five errors are caused by a division by zero. To fix all five error messages at
once, change the definition for a as shown in Figure 13.

Figure 13: Changing the definition of the variable “a” fixes all errors at once.

A note about function definitions 

When you define a function, Mathcad does not try to evaluate it until you use it
later on in the worksheet. If there is an error, the use of the function is marked in
error, even though the real problem may be in the definition of the function it-
self. Figure 14 shows an example of this.

When a user-defined function is marked in error, be sure to check the function
definition to find the actual source of error.
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Figure 14: When an error message points to a function, go back and check the
way the function was defined. 

Figure 15: Mathcad allows recursive function definitions. These let you easily
define arbitrary periodic functions.
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Chapter 7
Variables and Constants

This chapter describes valid Mathcad variable names, function
names, and numbers, including predefined variables like π.

Mathcad handles imaginary and complex numbers as easily as it
does real numbers. Mathcad variables can have imaginary or
complex values, and most Mathcad built-in functions can take
complex arguments. This chapter describes how to use complex
numbers in Mathcad.

The following sections make up this chapter:

Names
Valid variable and function names; how to type Greek letters.

Predefined variables
List of variables that have values when you start Mathcad.

Numbers
Real, imaginary, hexadecimal, and octal numbers; dimensional values.

Complex numbers
How to use complex numbers in Mathcad.
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Names 

    This section describes valid Mathcad variable and function names.

Names in Mathcad can contain any of the following characters:

Uppercase and lowercase letters.

The digits 0 through 9. 

The underscore ( _ ). 

a prime symbol  ( ’  ). Note that this is not the same as an apostrophe. You’ll
find the prime symbol on the same key as the tilde (~).

percent (%).

Greek letters. To insert a Greek letter, type the equivalent roman letter and
press [Ctrl]G. The section “How to type Greek letters.” contains a table of
equivalent roman letters.

The infinity symbol ∞, generated by typing [Ctrl]Z.

Any other character provided you type [Ctrl][Shift]P before typing that
character. This is discussed further in the section “Using an operator symbol
in a name.”

Any math expression appearing between the brackets generated by typing
[Ctrl][Shift]O. This is discussed further in the section “Chemical formu-
las.”

The following restrictions apply to variable names:

A name cannot start with one of the digits 0 through 9. Mathcad interprets
anything beginining with a number as either an imaginary number (2i or 3j),
an octal or hexadecimal number (5o or 7h), or as a number times a variable
(3⋅x).

The infinity symbol, ∞, can only appear as the first character in a name.

Any characters you type after a period (.) will appear as a subscript. This is
discussed in the section “Literal subscripts” later in this chapter.

All characters in a name must be in the same font, have the same pointsize
and be in the same style (italic, bold, etc.). Greek letters can, however, appear
in any variable name.

Mathcad does not distinguish between variable names and function names.
Thus, if you define f(x), and later on you define the variable f, you will find
that you cannot use f(x) anywhere below the definition for f.
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Certain names are already used by Mathcad for built-in constants, units, and
functions. Although you can redefine these names, keep in mind that their
built-in meanings will no longer exist after the definition. For example, if you
define a variable mean, Mathcad’s built-in function mean(v) can no longer be
used.

Mathcad distinguishes between uppercase and lowercase letters. For example,
diam is a different variable from DIAM. Mathcad also distinguishes between
names in different fonts. Thus, DIAM is also a different variable from DIAM.
The following are examples of valid names:

alpha b

xyz700 A1_B2_C3_D4%%%
F1’ a%%

How to type Greek letters

There are two ways to type a Greek variable name in Mathcad:

Type the roman equivalent from the table on the following page. Then press
[Ctrl ]G. 

Click on the appropriate letter on Greek letter palette. To see this palette,
click on the button labelled “αβ” on the strip of buttons just below the menu
commands.

Note that although many of the uppercase Greek letters look like ordinary capi-
tal letters, they are not the same. Mathcad distinguishes between Greek and ro-
man letters. If you use a Greek letter in place of the corresponding roman letter
in a variable or function name, Mathcad will not recognize the two as equivalent.

Note: Because it is used so frequently, the Greek letter π can also be typed by
pressing [Ctrl]P.

The table on the following page lists all the Greek letters and their roman equiva-
lents. These are the same roman equivalents used in the Symbol font. To insert
an uppercase Greek letter, use the uppercase roman equivalent. To insert a low-
ercase Greek letter, use the lowercase roman equivalent.
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Name Uppercase Lowercase Roman equivalent

alpha Α α A

beta Β β B

chi Χ χ C

delta ∆ δ D

epsilon Ε ε E

eta Η η H

gamma Γ γ G

iota Ι ι I

kappa Κ κ K

lambda Λ λ L

mu Μ µ M

nu Ν ν N

omega Ω ω W

omicron Ο ο O

phi Φ φ F

phi(alternate) ϕ J

pi Π π P

psi Ψ ψ Y

rho Ρ ρ R

sigma Σ σ S

tau Τ τ T

theta Θ θ Q

theta(alternate) ϑ J

upsilon Υ υ U

xi Ξ ξ X

zeta Ζ ζ Z
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Literal subscripts 

 If you include a period in a variable name, Mathcad displays whatever follows
the period as a subscript. You can use these literal subscripts to create variables
with names like velinit and uair.

To create a literal subscript, follow these steps:

Type the portion of the name that
appears before the subscript.

Type a period, followed by the por-
tion of the name that is to become
the subscript.

Do not confuse literal subscripts with array subscripts. Although they appear
identical, they are quite different. A literal subscript, created by typing a period,
is really just part of a variable name. An array subscript represents a reference to
an array element. Array subscripts are generated with the left bracket key ([).
See Chapter 9 for a description of how to use subscripts with arrays.

Using an operator symbol in a name

When you’re in a math region, certain keystrokes insert a math operator rather
than the character you see imprinted on the key. For example, when you type
“$” you’ll see a summation symbol with placeholders, not a dollar sign. Al-
though this feature makes it easier to type math expressions, it also makes cer-
tain characters impossible to use in a variable name.

To circumvent this problem, Mathcad lets you temporarily enter text mode
while you’re still in a math expression. When you’re in text mode, all the keys
lose their mathematical meaning. This lets you type exactly what you see im-
printed on the keys on your keyboard. For example, here’s how you define the
variable a$ to be equal to “1”:

Type a. Do not type $ yet since at
this point, the “$” key will insert a
summation sign.

Type [Ctrl][Shift]P. The inser-
tion point turns red to show that
you’re now in text mode. 

Now go ahead and type $. 

Type [Ctrl][Shift]P again. The
insertion point turns back into blue
to show that you are now back in
math mode. 
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Type :1 to complete the definition.
Since you’re now back in math
mode, the “:” key, like all the oth-
ers, has recovered its mathematical
meaning.

Chemical formulas

Ordinarily, a name cannot contain other operators within it. There may be times
however when you want to define a name which contains superscripts, sub-
scripts or other operators as part of it. For example, you may want assign a value
to the variable named H2O. To do this:

Press [Ctrl][Shift]O. This in-
serts a pair of brackets with a place-
holder between them.

Type H[2.

Press the [Space] key to place the
H2 between the editing lines.

Now type O. 

Press : and type the appropriate
value in the placeholder.
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Predefined variables 

  Mathcad includes eight variables that, unlike ordinary variables, are already de-
fined when you start Mathcad. These variables are called predefined or built-in
variables. Predefined variables either have a conventional value, like π and e, or
are used as system variables to control how Mathcad works, like ORIGIN and
TOL.

Here is a complete list of Mathcad’s predefined variables and their default val-
ues:

Variable = default value Definition and use

π = 3.14159... Pi. Mathcad uses the value of π to 15 digits in nu-
merical calculations. In symbolic calculations, π
is exact. To type π, press [Ctrl]P.

e = 2.71828... The base of natural logarithms. Mathcad uses the
value of e to 15 digits in numerical calculations.
In symbolic calculations, e is exact.

∞ = 10307 Infinity. In numerical calculations, this is an ac-
tual number of finite magnitude. In symbolic cal-
culations, this represents a true infinity. To type
∞, press [Ctrl]Z.

% = 0.01 Percent. Use this in expressions like 10 ⋅ % or as
a scaling unit in the placeholder at the end of an
equation with an equals sign.

TOL = 10–3 Numerical tolerance for the various approxima-
tion algorithms (integrals, equation solving, etc.).
For more information, see the section on the spe-
cific operation in question.

ORIGIN = 0 Array origin. Specifies the index of the first ele-
ment of an array.

PRNCOLWIDTH = 8 Column width used when writing files with the
WRITEPRN function.

PRNPRECISION = 4 Number of significant digits used when writing
files with the WRITEPRN function.

FRAME = 0 Used to drive animation. Set to zero when no ani-
mation is in progress.

Although these variables already have values when you start Mathcad, you can
still redefine them. For example, if you want to use a variable called e with a
value other than the one Mathcad provides, enter a new definition, like e := 2.
The variable e takes on the new value everywhere in the worksheet below the
new definition.
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Mathcad’s predefined variables are defined for all fonts, sizes and styles. This
means that if you redefine e as shown on the previous page, you can still use e,
or e as the base for natural logarithms. Note however that Greek letters are not
included. This means that “ε”, although it is typed as “e” in the Symbol font, is
not the same number as e.

You can control the values of TOL, ORIGIN, PRNPRECISION, and PRNCOL-
WIDTH without having to explicitly define them in your worksheet. To do so,
choose Options ⇒Built-In Variables from the Math menu. The Built-in Vari-
ables dialog box appears, as shown below.

To set new starting values for any of these variables, enter a new value in the ap-
propriate text box and click “OK.” Then choose Calculate Document from the
Math menu to ensure that all existing equations take the new values into ac-
count.

The numbers in brackets to the right of the variable name represent the default
values for those variables. Those to the right of the text box represent valid val-
ues of the variables. 

Numbers 

This section describes the various types of numbers that Mathcad uses and how
to enter them into equations.

Types of numbers

Mathcad interprets anything beginning with a digit as a number. A digit can be
followed by:

other digits

a decimal point

digits after the decimal point

one of the letters h or o, for hex and octal numbers, i or j for imaginary
numbers, and M, L, T, Q or K for numbers carrying units. These are discussed
in more detail below.
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Note that Mathcad uses the period (.) to signify the decimal point. The comma
(,) is used both to show iteration and to separate values in an input table. These
topics are discussed in Chapter 10, “Range Variables.” 

Imaginary numbers
To enter an imaginary number, follow it with i or j, for example, 1i or 2.5j.
You cannot use i or j alone to represent the imaginary unit. You must always
type 1i or 1j. If you don’t, Mathcad will think you are referring to a vari-
able named either i or j. See “Complex numbers” later in this chapter.   

Dimensional values
Dimensional values are numbers associated with one of the Mathcad dimen-
sions: mass, length, time, charge, and temperature. Mathcad uses these di-
mensions to keep track of units for dimensional analysis and unit
conversions. To enter a dimensional value, type a number followed by an up-
per or lowercase M for mass, L for length, T for time, Q for charge, or K for
temperature. For example, 4.5m represents 4.5 mass units. For more de-
tailed information on units and dimensions, see Chapter 8, “Units and Di-
mensions.”  

Octal integers
To enter a number in octal, follow it with the upper or lowercase letter O.
For example, 25636o represents 11166 in decimal. Octal numbers must be
integers less than 231. 

Hexadecimal integers
To enter a number in hexadecimal, follow it with the upper or lowercase let-
ter H. For example, 2b9eh represents 11166 in decimal. To represent digits
above 9, use the upper or lowercase letters A through F. To enter a hexadeci-
mal number that begins with a letter, you must begin it with a leading zero.
If you don’t, Mathcad will think it’s a variable name. For example, use
0a3h rather than a3h to represent the decimal number 163 in hexadecimal.
Hexadecimal numbers must be integers less than 231.

Exponential notation

  To enter very large or very small numbers in exponential notation, just multiply
a number by a power of 10. For example, to represent the number 3 ⋅ 10 8, type
3*10^8.

Combining types of numbers

You can freely combine all types of numbers with various operators. Figure 1
shows some examples.
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Figure 1: Combining different types of numbers.

Complex numbers 

As described in the preceding section, Mathcad accepts complex numbers of the
form a + bi, where a and b are ordinary numbers. You can use j instead of i if
you prefer that notation.

Complex numbers can also arise if you enter an expression with a complex re-
sult. Even a Mathcad expression that involves only real numbers can have a
complex value. For example, if you evaluate √−1 , Mathcad will return i.

Although you can enter imaginary numbers followed by either i or j, Mathcad
normally displays them followed by i. To have Mathcad display imaginary num-
bers with j, choose Number from the Format menu, click on the Global option
button, and set “Imaginary” to j. See Chapter 5, “Equation and Result Format-
ting,” for a full description of this dialog box.

When typing complex numbers, remember that you cannot use i or j alone to rep-
resent the imaginary unit. You must always type 1i or 1j. If you don’t, Math-
cad will interpret the i or j as a variable. When the cursor is outside an equation
that shows 1i or 1j, Mathcad hides the superfluous 1.
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Complex operators and functions 

       Mathcad has the following special functions and operators for working with
complex numbers:

Re(z) Real part of a number z.

Im(z) Imaginary part of a number z.

arg(z) Angle in complex plane from real axis to z. This returns a result be-
tween −π and π radians.

|z| The magnitude of the number z. To take the magnitude of an ex-
pression, click on it and press the vertical-bar key “|”. 

z
_

Complex conjugate of z. To apply the conjugate operator to an ex-
pression, select the expression, then press double-quote ("). The
conjugate of the complex number a + b⋅i is a − b⋅i.

Figure 2 shows some examples of how to use complex numbers in Mathcad.

Figure 2: Complex numbers in Mathcad.
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Multivalued functions

When complex numbers are available, many functions and operators we think of
as returning unique results become multivalued. The impact of this on logarith-
mic and exponential functions is discussed more fully on page 269.

As a general rule, when a function or operator is multivalued, Mathcad always
returns the value making the smallest positive angle relative to the positive real
axis in the complex plane. This is the principal value. 

For example, when asked to evaluate (−1)1/3, Mathcad will return .5 + .866i de-
spite the fact that we commonly think of the cube root of –1 as being 1. This is
because the number .5 + .866i makes an angle of only 60 degrees from the posi-
tive real axis. The number −1, on the other hand, is all the way on the other side,
180 degrees from the positive real axis.

The single exception to this rule is the nth root operator described on page 241.
This operator always returns a real root whenever one is available. Figure 3 com-
pares these two alternatives.  

Figure 3: Finding real valued roots of a negative number.
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Chapter 8
Units and Dimensions

Units of measurement, while not required in Mathcad equations,
can help detect errors and enhance the display of computed results.
Mathcad’s unit capabilities take care of many of the usual chores
associated with using units and dimensions in scientific
calculation. Once you enter the appropriate definitions, Mathcad
automatically performs unit conversions and flags incorrect and
inconsistent dimensional calculations.

This chapter describes how to use units and dimensions in
Mathcad, including unit conversions and dimensional checking.

The following sections make up this chapter.

Computing with units
How to use units in an equation and how Mathcad catches any dimen-
sional inconsistencies.

Displaying units of results
How Mathcad displays units and how to convert from one unit to an-
other.

Changing dimension names
How to change the names of Mathcad’s five fundamental dimensions.

Built-in units
Choosing a system of units, defining your own units in terms of funda-
mental dimensions.
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Computing with units 

When you first start Mathcad, a complete set of units is available for your calcu-
lations. You can treat these units just like built-in variables. To assign units to a
number, just multiply it by the name of the unit. For example:

mass:75*kg

acc:100*m/sec^2
acc_g:9.8*m/sec^2

F:mass*(acc + acc_g)

Figure 1 shows how these equations appear in a worksheet. 

Figure 1: Equations using units.

Mathcad will recognize most units by their common abbreviations. Appendix C
lists all of Mathcad’s built-in units.

You can also use the Insert Unit dialog box to insert one of Mathcad’s built-in
units into any placeholder. The Insert Unit dialog box offers the following ad-
vantages: 

You won’t have to remember the abbreviation Mathcad uses for a unit.

You’ll see at a glance all available units appropriate to the result you’ve
clicked on.

You can’t make any typing mistakes.
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To use the Insert Unit dialog box:

Click in the empty placeholder and choose Unit from the Insert menu. Math-
cad opens a dialog box with two scrolling lists.

The right-hand scrolling list shows built-in units corresponding to whatever
physical quantity is selected in the left-hand scrolling list. For convenience,
when “Dimensionless” is selected on the left, a list of all available built-in
units shows on the right.

If necessary, use the left scrolling list to display only those units correspond-
ing to a particular physical quantity. This makes it easier to find a particular
unit or to see what choices are appropriate.

In the right scrolling list, double-click on the unit you want to insert. Mathcad
inserts that unit into the empty placeholder.

Note that Mathcad performs some dimensional analysis by trying to match the
dimensions of your result with one of the common physical quantities in the left
scrolling list. If it finds a match, you’ll see all the built-in units corresponding to
the highlighted physical quantity in the left-hand scrolling list. If nothing
matches, Mathcad simply lists all available built-units on the right.

Dimensional checking

Whenever you enter an expression involving units, Mathcad checks it for dimen-
sional consistency. If you add or subtract values with incompatible units, or vio-
late other principles of dimensional analysis, Mathcad displays an appropriate
error message.  

For example, suppose you had defined acc as 100⋅m/sec instead of 100⋅m/sec 2

as shown in Figure 2. Since acc is in units of velocity and acc_g is in units of ac-
celeration, it is inappropriate to add them together. When you attempt to do so,
Mathcad displays an appropriate error message. 

Unit errors are usually caused by one of the following:   

An incorrect unit conversion,
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A variable with the wrong units as shown in Figure 2,

Units in exponents or subscripts (for example v3⋅acre  or 2 3⋅ft  ),

Units as arguments to inappropriate functions (for example, sin(0⋅henry)).

Figure 2: An equation with incompatible units.

Defining your own units

Although Mathcad recognizes many common units, you may need to define
your own unit if:

that unit isn’t in the list of built-in units in Appendix C, or 

you prefer to use your own abbreviation instead of that shown in Appendix C.

You define your own units in terms of existing units in exactly the same way
you would define a variable in terms of an existing variable. Figure 3 shows
how to define new units as well as how to redefine existing units.
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Figure 3: Defining your own units.

Since units behave just like variables, you may run into unexpected conflicts.
For example, if you define the variable m in your worksheet, you won’t be able
to use the built-in unit m for meters anywhere below that definition.

Displaying units of results 

  Mathcad automatically displays results in terms of the fundamental units: m, kg,
sec, coul, and K (degrees Kelvin). You can have Mathcad redisplay a particular
result in terms of any of Mathcad’s built-in units. To do so:

Click in the result. You’ll see an empty placeholder to its right. This is the
units placeholder.

Click on the units placeholder and choose Unit from the Insert menu. Math-
cad opens the Insert Unit dialog box. This is described in detail on page 171.

Double-click on the unit in terms of which you want to display the result.
Mathcad inserts this unit in the units placeholder.

Another way to insert a unit is to type it directly into the units placeholder. This
method is more general since it works not only for built-in units but for units
you’ve defined yourself and for combinations of units.
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For example, in Figure 1, F is displayed in terms of the fundamental units kg, m
and sec. To change this to dyne:

Click in a displayed result to see
the units placeholder to its right.
Then click on this units placeholder.

In the units placeholder, type dyne.

Click outside the equation. Math-
cad displays the answer in terms of
the units you entered.

Unit conversions

There are two ways to convert from one set of units to another:

By using the Insert Unit dialog box, or

By typing the new units in the units placeholder itself.

If you want to display the result in terms of one of Mathcad’s built-in units, the
simplest method is to use the Insert Unit dialog box:

Click on the unit you want to replace.

Choose Unit from the Insert menu.

In the scrolling list of units, double-click on the unit in terms of which you
want to display the result. 

If you want to display the result in terms of something not available through the
Insert Unit dialog box, for example a unit you defined yourself or an algebraic
combination of units, you can edit the units placeholder directly. For example,
to express the result in the previous example in terms of force-pounds rather
than dynes:  

Click in the name of the unit you
want to replace. 

Delete the unit name. The calcu-
lated result disappears since Math-
cad no longer knows what units to
display it in.

Type in the name of the new unit
and click outside the equation. 

Figure 4 shows F displayed both in terms of its fundamental MKS units and in
terms of several combinations of units.
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When you enter an inappropriate unit in the units placeholder, Mathcad will dis-
play whatever combination of kg, m, sec, coul, or K makes the result have the
right units. For example, in the last equation in Figure 4, you see that kW ⋅ sec is
not a unit of force. Mathcad therefore inserts m−1 to cancel the extra length di-
mension.

Figure 4: A calculated result displayed in terms of different units.

Whenever you enter units in the units placeholder, Mathcad divides the value to
be displayed by whatever you enter in the units placeholder. This ensures that
the complete displayed result — the number times the expression you entered
for the placeholder — is a correct value for the equation.

Conversions involving an offset in addition to a multiplication, for example
gauge pressure to absolute pressure, cannot be performed directly with Math-
cad’s unit conversion mechanism. 

In particular, when working with temperature, keep in mind that you cannot use
Mathcad’s unit conversions to convert between Fahrenheit and Centigrade. You
can, however, perform conversions of this type by defining suitable functions.
See Chapter 6 for more on defining your own functions.

Scaling results   

The techniques described in this chapter are not restricted to units. You can put
any variable, constant or expression in a units placeholder. Mathcad will then re-
display the result in terms of the value of whatever is in the units placeholder.
Just remember that whenever you type something in the units placeholder, Math-
cad will change the calculated result so that the complete displayed result — the
number times the expression you entered in the placeholder — is correct.
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For example, you can use the units placeholder to display a result as a multiple
of π. To do so:

Click on the units placeholder.

Click on π on the symbol palette.
Then click outside the equation.
Mathcad shows the result in terms
of π.

You can also use the units placeholder for dimensionless units like degrees and
radians. To convert a number in degrees to radians, multiply it by the built-in
unit rad. You can also type deg into the units placeholder to convert the result
from radians to degrees. Figure 5 shows some examples of these techniques
with deg.

Figure 5: Using dimensionless units in placeholders.
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Built-in units

 When you start Mathcad, the MKS system of units is automatically loaded. This
means that when you use the equal sign to display a result having units, Math-
cad will display those units in terms of some combination of m, kg, sec, coul,
and K. You can of course, as discussed on page 174, convert this combination of
m, kg, sec, coul, and K into a different unit by typing that unit into the units
placeholder. However, until you do so, Mathcad will use the MKS fundamental
units to display your result.

You can have Mathcad display results in terms of the fundamental CGS or the
fundamental US units. To do so, choose Options⇒System of Units from the
Math menu. You will see the dialog box shown below:

Click on the button corresponding to the default units in which you want to dis-
play results. The table below summarizes what each button does.

MKS Displays results in terms of m, kg, sec, coul, and K.

CGS Displays results in terms of cm, gm, sec, coul, and K.

US Displays results in terms of ft, lb, sec, coul, and K.

none Displays results in terms of fundamental dimensions of length,
mass, time, charge, and absolute temperature. All built-in units are
disabled.

Most units are available in all three systems of units. For example, when CGS is
selected, you’ll still be able to use kg and lb even though these are not, strictly
speaking, part of the CGS system of units. A small minority of units are not avail-
able across all three systems of units. For a listing of which units are available in
each system, see Appendix C.

If you click “none” in the Change System of Units dialog box, there will be no
built-in units at all. You can, however, still define and use your own units as de-
scribed on page 172. To do so, you use the special built-in constants: 1L, 1M,
1T, 1Q, and 1K. These represent the dimensions length, mass, time, charge, and
absolute temperature. When you click “none,” Mathcad will display answers in
terms of the fundamental dimensions of length, mass, time, charge, and tempera-
ture rather in terms of any system of units. Figure 6 shows how to define units
using these built-in constants and how to carry out the analysis in Figure 1 after
having done so.
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Figure 6: Using the constants 1L, 1M, and 1T to define a system of units.
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Changing dimension names 

The previous section showed how you can display a result in terms of the funda-
mental units of either of three systems of units or in terms of the fundamental
physical dimensions of mass, length, time, charge and temperature. This section
describes how to go even further and actually change the names of the funda-
mental dimensions altogether. 

This may be useful if the nature of your work makes another set of fundamental
dimensions more appropriate. Thus, a commodities trader may prefer to use
bushels and currency rather than charge and temperature; a car salesman might
define trucks and sedans rather than length and mass. In short, a dimension is
nothing more than a way of tagging numbers so you can keep better track of
them. It just so happens that in physical problems, it’s convenient to name these
dimensions mass, length, time, charge and temperature.

To change the names of the dimensions:

Choose Options⇒Dimensional Format from the Math menu. This brings
up the Dimensional Format dialog box shown below.

Click on the check box beside Display dimensions.

To change a dimension name, edit the name shown in the appropriate text
box.

Renaming the dimensions in this dialog box changes the dimension names only
for the Mathcad worksheet you are working on. To make these dimension
names a permanent part of your Mathcad configuration, choose Save Configu-
ration from the File menu and click “OK” in the dialog box. See Chapter 3 for
more on configuration files.
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Chapter 9
Vectors and Matrices

This chapter describes Mathcad arrays. While ordinary variables
(scalars) hold a single value, arrays hold many values. 

As is customary in linear algebra, arrays having only one column
will often be referred to as vectors. All others are matrices. The
following sections make up this chapter.

Creating a vector or matrix
How to create or edit vectors and matrices

Computing with arrays
Defining variables as arrays and using them in expressions.

Subscripts and superscripts
Referring to individual array elements and columns.

Displaying vectors and matrices
How Mathcad displays answers involving matrices and vectors.

Limits on array sizes
Limits on the sizes of arrays to be stored, displayed, or entered.

Vector and matrix operators
Operators designed for use with vectors and matrices.

Vector and matrix functions
Built-in functions designed for use with vectors and matrices.

Doing calculations in parallel
Using Mathcad’s “vectorize” operator to speed calculations.

Simultaneous definitions
Using vectors to define several variables simultaneously.

Arrays and user-defined functions
Using arrays as arguments to user defined functions.

Nested arrays
Arrays in which the elements are themselves arrays.
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Creating a vector or matrix

    A single number in Mathcad is called a scalar. A column of numbers is a vector,
and a rectangular array of numbers is called a matrix. The general term for a vec-
tor or matrix is an array.

There are three ways to create an array:

By filling in an array of empty placeholders as discussed in this section. This
technique is useful for arrays that are not too large.

By using range variables to fill in the elements as discussed in the following
chapter on range variables. This technique is useful when you have some ex-
plicit formula for the elements in terms of their indices.

By reading them in from a datafile as discussed in Chapter 18. 

You may wish to distinguish between the names of matrices, vectors and scalars
by font. For example, in many math and engineering books, names of vectors
are set in bold while those of scalars are set in italic. The section “Math fonts” in
Chapter 5, “Equation and Result Formatting” describes how to do this.

Creating a vector

    A vector is an array or matrix containing one column. To create a vector in
Mathcad, follow these steps:

Click in either a blank space or on a placeholder.

Choose Matrix from the Insert
menu. A dialog box appears, as
shown on the right. 

Enter the number of elements in the text box beside “Rows.” For example, to
create a three-element vector, type 3. 

Enter 1 in the text box beside “Col-
umns.” Then click “Create.” Math-
cad inserts a vector of placeholders.

The next step is to fill in these placeholders with scalar expressions. To do so,
follow these steps:
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Click on the top placeholder and
type 2.

Move the insertion point to the next
placeholder. You can do this by
clicking directly on the second
placeholder.

Type 3 on the second placeholder.
Then move the insertion point to
the third placeholder and type 4.

&M0bc3V2.PNT

If you’re going to need several vectors in your calculation, you can leave the In-
sert Matrix dialog box up for later use.

Once you have created a vector, you can use it in calculations just as you would
a number. For example, to add another vector to this vector, follow these steps:

Press [Space] to enclose the entire
vector is now between the editing
lines. This ensures that the plus
sign you type next will apply to the
whole vector rather than to one of
its elements.

Type the plus key (+). Mathcad
shows a placeholder for the second
vector.

Use the Insert Matrix dialog box to
create another three-element vector.

Fill in this vector by clicking in
each placeholder and typing in the
numbers shown on the right. 

&M0cd3V3.PNT

Press the equals sign (=) to see the
result.
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Addition is just one of Mathcad’s vector and matrix operations. Mathcad also in-
cludes matrix subtraction, matrix multiplication, dot product, integer powers, de-
terminants, and many other operators and functions for vectors and matrices.
Complete lists appear in the sections “Vector and matrix operators” and “Vector
and matrix functions,” later in this chapter.

Creating a matrix

  To create a matrix, first click in a blank space or on a placeholder. Then:

Choose Matrix from the Insert
menu. The dialog box shown on
the right appears.

Enter a number of rows and a num-
ber of columns in the appropriate
boxes. In this example, there are
two rows and three columns. Then
click on “Create.” Mathcad inserts
a matrix of placeholders. 

Fill in the placeholders to complete
the matrix as described in the pre-
vious section for vectors. 

M0ddM2X3.PNT

You can use this matrix in equations, just as you would a number or vector.

Throughout this manual, the term “vector” refers to a column vector. A column
vector is identical to a matrix with one column. You can also create a row vector
by creating a matrix with one row and many columns. Operators and functions
which expect vectors always expect column vectors. They do not apply to row
vectors. To change a row vector into a column vector, use the transpose operator
[Ctrl]1.  

Changing the size of a matrix

  You can change the size of a matrix by inserting and deleting rows and columns.
To do so, follow these steps:

Click on one of the matrix elements
to place it between the editing
lines. Mathcad will begin inserting
or deleting with this element.
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Choose Matrix from the Insert
menu. The dialog box as shown on
the right appears. 

Type the number of rows and/or
columns you want to insert or de-
lete. Then click on either “Insert”
or “Delete.” For example, to delete
the column that currently holds the
selected element, type 1 in the box
next to “Columns,”  0 in the box
next to “Rows,” and click on “De-
lete.”

Here’s how Mathcad inserts or deletes rows or columns based on what you type
in the dialog box:

If you insert rows, Mathcad creates rows of empty placeholders below the se-
lected element. If you insert columns, Mathcad creates columns of empty
placeholders to the right of the selected element. 

To insert a row above the top row or a column to the left of the first column,
first place the whole matrix between the editing lines. To do so, click in the
matrix and press [Space]. Then choose Matrix and proceed as you would
normally.

If you delete rows or columns, Mathcad begins with the row or column occu-
pied by the selected element. Mathcad deletes rows from that element down-
ward and columns from that element rightward.

If you type 0 as the number for “Rows,” Mathcad neither inserts nor deletes
rows. If you type 0 as the number for “Columns,” Mathcad neither inserts nor
deletes columns.

Note that when you delete rows or columns, Mathcad discards the information
in the rows or columns you eliminate. 

To delete an entire matrix or vector, place the entire matrix or vector between
the editing lines and choose Cut from the Edit menu. 

Computing with arrays 

Variables can represent arrays as well as scalars. Defining a variable as an array
is very much like defining a scalar. First type a variable name and a colon as
you would with any other definition. Then create an array (vector or matrix) on
the other side of the equation.
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For example, to define a vector v, follow these steps:

Click in empty space and type v,
followed by the colon key (:).

M0faDVEC.PNT

Choose Matrix from the Insert
menu to bring up a dialog box.
Type 3 in the box next to “Rows”
and 1 in the box next to “Columns.”

Press “Create” and fill in the ele-
ments.

You can now use the name v in place of the actual vector in any equation. Fig-
ure 1 demonstrates that the variable name v and the vector itself are interchange-
able. Once you have defined a vector, you can of course define other vectors in
terms of that vector, just as if you were doing mathematics on paper.

Figure 1: Defining and using a vector variable.

Do not use the same name for a scalar variable and a vector variable. This will
simply redefine the variable. 
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Subscripts and superscripts

You can refer to individual array elements by using subscripts. You can also re-
fer to an entire column of an array by using a superscript. To type a subscript,
use the left bracket key “[ ” and put an integer or a pair of integers in the place-
holder. To insert a superscript operator, press [Ctrl]6 and place an integer in
the placeholder.

Vector and matrix elements are ordinarily numbered starting with row zero and
column zero. To change this, change the value of the built-in variable ORIGIN.
See “Changing the ORIGIN,” later in this chapter.

Subscripts and vector elements

The top equation in Figure 1 defines the vector v. To see the zeroth (top) ele-
ment of the vector v:

Type v[0=&M0gaSSUB.PNT

You can also define individual vector elements by using a subscript on the left
side of a definition. To change v2 to 6:

Type v[2:6

Figure 2 shows how this changes the value of v.

When you define vector elements, you may leave gaps in the vector. For exam-
ple, if v is undefined and you define v3 as 10, v0, v1, and v2 are all undefined.
Mathcad fills these gaps with zeros until you enter specific values for them, as
shown in Figure 3. Be careful of inadvertently creating very large vectors and
matrices by doing this. 
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Figure 2: Defining a vector element.

Figure 3: Mathcad places zeros into all elements you don’t explicitly define.
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Subscripts and matrix elements

To view or define a matrix element, use two subscripts separated by a comma.
In general, to refer to the element in the i th row, j th column of matrix M, type:

M[i,j

Note that the subscripts, like division and exponentiation, are “sticky.” What-
ever you type after [ remains in the subscript until you press [Space] to leave.

If you want to add more to the equation, press [Space] to place the entire ma-
trix element name, Mi, j , between the editing lines.

Figure 4 shows some examples of how to define individual matrix elements and
how to view them. Notice that, as with vectors, Mathcad fills unspecified matrix
elements with zeros.

Figure 4: Defining and viewing matrix elements.

You can also define the elements of a vector or matrix with a definition like
vi := i, where i is a range variable. See the next chapter, “Range Variables.”

Superscripts with matrix columns

To refer to an entire column of an array, press [Ctrl]6 and place the column
number in the resultant placeholder. Figure 5 below shows how to place the
third column of the matrix M in the vector v. 
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Figure 5: Using the superscript operator to extract a column from a matrix.

You can also extract a single row from a matrix by extracting a column from the
transposed matrix. This is shown on the right-hand side of Figure 5.

Changing the ORIGIN

By default, Mathcad arrays begin at element zero. To change this, change the
value of the built-in variable ORIGIN. When you use subscripts to refer to array
elements, Mathcad assumes the arrays begin at the current value of ORIGIN.

For example, suppose you want all your arrays to begin with element one. There
are two ways to change the value of ORIGIN for the whole worksheet:

Choose the Options ⇒Built-In Variables command from the Math menu
and change the value of ORIGIN.

Enter a global definition for ORIGIN anywhere in your worksheet. For exam-
ple, to change the ORIGIN to one, type: ORIGIN~1. 

If you change ORIGIN to one, Mathcad no longer maintains an element zero for
vectors or a zeroth row and column for matrices. Figure 6 shows a worksheet
with the ORIGIN set to 1. Note that when you try to refer to v0, Mathcad displays
an apropriate error message.
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Figure 6: Arrays beginning at element one instead of at element zero.

When you redefine ORIGIN in a worksheet, keep in mind the following sugges-
tions:

If you define ORIGIN with a definition in the worksheet rather than using the
Options ⇒Built-in Variables menu command, use a single global definition.
Although you can redefine ORIGIN with a “:=” this will invariably lead to
confusion. Changing ORIGIN in the middle of a worksheet can cause confus-
ing effects. Array elements will seem to have shifted n positions, where n is
the difference between the old ORIGIN and the new ORIGIN. 

Don’t forget to type ORIGIN in capital letters. Mathcad variable names are
case-sensitive. Because ORIGIN is a built-in variable, its name is not font sen-
sitive. It is however, still case-sensitive.

When you define an array, Mathcad assigns zero to any undefined elements.
See Figure 3 in this chapter for an example.

If you inadvertently define an array starting with element one when ORIGIN
is set to its default value of zero, you will get unexpected answers with array
functions like mean and fft. This is because Mathcad will automatically de-
fine x0 = 0 for all these arrays. This extra element distorts the values returned
by array functions. To avoid this problem, choose Options ⇒Built-In Vari-
ables from the Math menu and set ORIGIN to 1 in the Built-In Variable dia-
log box.

When you set ORIGIN in the Built-In Variable dialog box, its value applies to
all array variables. It is not possible to have some variables use one ORIGIN
and others use a different ORIGIN.
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You can use ORIGIN to define variables with negative subscripts. If you set
ORIGIN to –10, all arrays will begin with element –10. 

If you reference an array element with a subscript less than ORIGIN, Mathcad
marks the array reference with an error message indicating that the array in-
dex goes beyond the ends of the array.

Displaying vectors and matrices

After computing with arrays in Mathcad, your resulting arrays may be large and
unwieldy when displayed. Mathcad therefore displays matrices and vectors hav-
ing more than nine rows or columns as scrolling output tables rather than as ma-
trices or vectors. Figure 7 shows an example.

Figure 7: Displaying results in a scrolling output table.

A scrolling output table displays a portion of an array. To the left of each row
and at the top of each column, there is a number indicating the index of the row
or column. Use these row and column headers to determine the index of a par-
ticular value in the table.

If your results extend beyond the table, a scroll bar will appear along the appro-
priate edge of the table. You can scroll through the table using these scroll bars
just as you would scroll through any window.
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Another way to view more of a resulting array is to enlarge the table. To resize a
scrolling output table:

Click the mouse just outside the equation region in which the scrolling output
table appears. This anchors one corner of the selection rectangle.

Press and hold down the mouse button. With the button still held, drag the
mouse across the scrolling output table. A selection rectangle emerges from
the anchor point.

When the selection rectangle just encloses the equation region, release the
mouse button.

Move the mouse pointer to the right or bottom edge of the selection rectangle.
It will change to a double headed arrow.

Press and hold down the mouse button. With the mouse button still pressed,
move the mouse. The scrolling output table will be stretched in the direction
of the motion.

Once the scrolling output table is the right size, release the mouse button.
Click outside the selection rectangle to deselect the equation region.

In addition to being able to resize and scroll through a scrolling output table,
you can copy one or more values from it and paste them into another part of
your worksheet or into another Windows application. For information on copy-
ing results from a scrolling output table, see page 148.

Changing the display of arrays

Although matrices and vectors having more than nine rows or columns are auto-
matically displayed as scrolling output tables, you can have Mathcad display
them as matrices. To do so:

Click on the scrolling output table.

Choose Number from the Format menu.

Click on the box beside “Display as Matrix.” The box should now be checked.

Click the “OK” button.

To display all the matrices and vectors of results in your worksheet as matrices
regardless of their size:

Click on an empty part of your worksheet.

Choose Number from the Format menu.

Click on the box beside “Display as Matrix.”

Make sure the “Global” radio button is filled and click “OK”.
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Graphical display of matrices

In addition to looking at the actual numbers making up an array, you can also
see a graphical representation of those same numbers. There are three ways to
do this:

For an arbitrary array, you can use the various three dimensional plot types
discussed starting at Chapter 21, “Surface plots.”

For an array of integers between 0 and 255, you can look at a gray scale im-
age by choosing Picture from the Insert menu and entering the array’s name
in the placeholder.

For three arrays of integers beyween 0 and 255 representing the red, green
and blue components of an image, by choosing Picture from the Insert menu
and entering the array’s names, separated by commas, in the placeholder.

You’ll find numerous examples of three dimensional plots of matrices beginning
with Chapter 21, “Surface plots.” An example of viewing a matrix as a gray
scale image is shown in the last Figure of Chapter 14, “Programming.” 

Limits on array sizes 

Mathcad has the following limits on the sizes of arrays to be defined, entered, or
displayed:

Limit on input arrays
You cannot use the Matrix command on the Insert menu to create an array
having more than 100 elements. This limitation applies whether you attempt
to create a new array or add to an existing array. You can however, create
larger arrays by either using the augment or stack functions to join arrays to-
gether, by using range variables, or by reading the numbers in directly from
a disk file. An example of how to use the augment function is shown in Fig-
ure 8. The use of range variables to create arrays is discussed in Chapter 10,
“Range Variables.” Reading files directly from a disk is discussed in Chapter
18 “Data Files.”

Limit on displayed arrays
If an array has more than nine rows or columns, Mathcad automatically dis-
plays it as a scrolling output table. You can enlarge the table or use the scroll
bars provided in order to view all of the array. If, however, you change the
local result format such that Mathcad displays it as an array rather than as a
scrolling output table, Mathcad displays only the first two hundred rows or
columns. Mathcad uses an ellipsis to indicate that rows and columns are pre-
sent but not displayed. Although Mathcad does not display these rows or col-
umns, it does continue to keep track of them internally.
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Limit on array size
The effective array size limit depends on the memory available on your sys-
tem. For most systems, it will usually be at least 1 million elements. In no
system will it be higher than 8 million elements. If you try to define an array
larger than your system will accomodate, you’ll see an error message indicat-
ing that you have insufficient memory to do so. The elements can be distrib-
uted among any combination of rows and columns. When only limited
memory is available and you define several very large arrays, the array size
limit may decrease. 

Figure 8: Using the augment function to combine two matrices.

Vector and matrix operators 

Some of Mathcad’s operators have special meanings for vectors and matrices.
For example, the multiplication symbol means multiplication when applied to
two numbers, but it means dot product when applied to vectors, and matrix mul-
tiplication when applied to matrices. 

 The table on the next page describes Mathcad’s vector and matrix operations.
Many of these operators are available from the symbol palette. Note that opera-
tors which expect vectors always expect column vectors rather than row vectors.
To change a row vector into a column vector, use the transpose operator
[Ctrl]1.

Vector and matrix operators 195



Operators not listed in this table will not work for vectors and matrices. You
can, however, use the “vectorize” operator to perform any scalar operation or
function element by element on a vector or matrix. See the section “Doing calcu-
lations in parallel,” later in this chapter. Figure 9 shows some ways to use vector
and matrix operations.

Figure 9: Vector and matrix operations.

In the following table,  

A and B represent arrays, either vector or matrix.

u and v represent vectors.

M represents a square matrix.

ui and vi represent the individual elements of vectors u and v.

z represents a scalar.

m and n represent integers.
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Operation Appearance Keystroke Description

Scalar
multiplication

A⋅z * Multiplies each element of A by the scalar z.

Dot product u⋅v * Returns a scalar: Σ ui⋅vi. The vectors must have
the same number of elements.

Matrix 
multiplication

A⋅B * Returns the matrix product of A and B. The num-
ber of columns in A must match the number of
rows in B. 

Vector/Matrix 
multiplication

A⋅v * Returns the product of A and v. The number of
columns in A must match the number of rows in
v.

Scalar 
division

A
z

/ Divides each element of the array A by the scalar
z.

Vector and 
matrix 
addition

A + B + Adds corresponding elements of A and B. The ar-
rays A and B must have the same number of
rows and columns.

Scalar
addition

A + z + Adds z to each element of A.

Vector and 
matrix 
subtraction

A − B – Subtracts corresponding elements of A and B.
The arrays A and B must have the same number
of rows and columns.

Scalar 
subtraction

A − z – Subtracts z from each element of A.

Negative of 
vector or 
matrix

−A – Returns an array whose elements are the nega-
tives of the elements of A.

Powers of
matrix, 
matrix inverse 

Mn ^ n th power of square matrix M (using matrix mul-
tiplication). n must be an integer. M −1 represents
the inverse of M. Other negative powers are pow-
ers of the inverse. Returns a matrix.
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Operation Appearance Keystroke Description

Magnitude
of vector 

| v | | Returns √v ⋅ v
_

 where v
_
 is the complex conjugate

of v.

Determinant | M | | M must be square matrix. Returns a scalar.

Transpose AT [Ctrl]1 Interchanges row and columns of A.

Cross product u × v [Ctrl]8 u and v must be three-element vectors; result is
another three-element vector.

Complex 
conjugate

A
__

" Takes complex conjugate of each element of A.

Sum Σv [Ctrl]4 Sum elements in v.

Vectorize A
→

[Ctrl]– Treat all operations in A element by element. See
the section “Doing calculations in parallel” later
in this chapter for a complete description. 

Superscript A< n > [Ctrl]6 n th column of array A. Returns a vector.

Vector
subscript

vn [ n th element of a vector.

Matrix
subscript

Am,n [ (m, n) th element of a matrix.

 

Vector and matrix functions

  Mathcad includes functions for manipulating arrays in ways that are common in
linear algebra. These functions are intended for use with vectors and matrices. If
a function is not explicitly set up to take a vector or matrix argument, it is inap-
propriate to supply one to it as an argument. Note that functions which expect
vectors always expect column vectors rather than row vectors. To change a row
vector into a column vector, use the transpose operator [Ctrl]1. 

The following tables list Mathcad’s vector and matrix functions. In these tables,

A and B are arrays, either vector or matrix.

v is a vector. 

M and N are square matrices.

z is a scalar expression. 

Names beginning with m, n, i or j are integers.
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Size and scope of an array

Mathcad provides several functions that return information about the size of an
array and its elements. Figure 10 shows how these functions are used.

Function Name Returns...

rows(A) Number of rows in array A. If A is a scalar, returns 0.

cols(A) Number of columns in array A. If A is a scalar, returns 0.

length(v) Number of elements in vector v. 

last(v) Index of last element in vector v. 

max(A) Largest element in array A. If A has complex elements, re-
turns the largest real part plus i times the largest imaginary
part.

min(A) Smallest element in array A. If A has complex elements, re-
turns the smallest real part plus i times the smallest imagi-
nary part.

Figure 10: Vector and matrix functions for finding the size of an array and infor-
mation about its elements.
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Special types of matrices

You can use the following functions to derive from an array or scalar a special
type or form of a matrix. 

Function Name Returns...

identity(n) An n × n matrix of 0’s with 1’s on the diagonal.

Re(A) An array of the same size as A but with the imaginary parts
of each element set to 0.

Im(A) An array of the same size as A but with the real parts of
each element set to 0.

⊕ diag(v) A diagonal matrix containing on its diagonal the elements
of v. 

⊕ geninv(A) The left inverse matrix L of A, such that L⋅A = I, where I
is the identity matrix having the same number of columns
as A. Matrix A is an m × n real-valued matrix, where m ≥ n.

⊕ rref(A) The reduced-row echelon form of A. 

Figure 11: Functions for transforming arrays. 
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Special characteristics of a matrix

You can use the functions in the following table to find the trace, rank, norms,
and condition numbers of a matrix. 

Function Name Returns...

tr(M) The sum of the diagonal elements, otherwise known as the
trace, of M. 

⊕ rank(A) The rank of the real-valued matrix A.

⊕ norm1(M) The L1 norm of the matrix M.

⊕ norm2(M) The L2 norm of the matrix M.

⊕ norme(M) The Euclidean norm of the matrix M.

⊕ normi(M) The infinity norm of the matrix M.

⊕ cond1(M) The condition number of the matrix M based on the L1
norm.

⊕ cond2(M) The condition number of the matrix M based on the L2
norm.

⊕ conde(M) The condition number of the matrix M based on the Euclid-
ean norm.

⊕ condi(M) The condition number of the matrix M based on the infin-
ity norm.

Forming new matrices from existing ones

Mathcad provides two functions for joining matrices together, either side by
side, or one on top of the other. Mathcad also provides a function for extracting
a smaller matrix from a larger one. Figures 12 and 13 show some examples.

Function Name Returns...

augment(A, B)
   

An array formed by placing A and B side by side. The ar-
rays A and B must have the same number of rows.

stack(A, B)  An array formed by placing A above B. The arrays A and
B must have the same number of columns.

submatrix(A, ir, jr, ic, jc) A submatrix of A consisting of all elements contained in
rows ir through jr and columns ic through jc. To maintain
order of rows and/or columns, make sure ir ≤ jr and ic ≤ jc,
otherwise order of rows and/or columns will be reversed.
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Figure 12: Joining matrices together with the stack and augment functions.

Figure 13: Extracting a submatrix from a matrix using the submatrix function.
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Eigenvalues and eigenvectors

Mathcad provides functions for working with eigenvalues and eigenvectors of a
matrix. Figure 14 shows how some of these functions are used.

Function Name Returns...

eigenvals(M) A vector containing the eigenvalues of the matrix M.

eigenvec(M, z) A matrix containing the normalized eigenvector corre-
sponding to the eigenvalue z of the square matrix M.

⊕ eigenvecs(M) A matrix containing normalized eigenvectors correspond-
ing to the eigenvalues of the square matrix M. The nth col-
umn of the matrix returned is an eigenvector corresponding
to the nth eigenvalue returned by eigenvals.

⊕ genvals(M, N) A vector v of computed eigenvalues each of which satisfies
the generalized eigenvalue problem M⋅x = vi⋅N⋅x. Matrices
M and N contain real values. Vector x is the corresponding
eigenvector. M and N are square matrices having the same
number of columns. 

⊕ genvecs(M, N) A matrix containing the normalized eigenvectors corre-
sponding to the eigenvalues in v, the vector returned by
genvals. The nth column of this matrix is the eigenvector x
satisfying the generalized eigenvalue problem
M⋅x = vn⋅N⋅x. Matrices M and N are real valued square ma-
trices having the same number of columns. 

Figure 14: Finding eigenvalues and eigenvectors.
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Figure 15: Using eigenvecs to find all the eigenvectors at once.

Decomposition

Mathcad PLUS offers some additional functions for performing the cholesky de-
composition, the QR decomposition, the LU decomposition, and the singular
value decomposition of a matrix. Some of these functions return two or three
matrices joined together as one large matrix. Use submatrix to extract these two
or three smaller matrices. Figure 16 shows an example.

Function Name Returns...

⊕ cholesky(M) A lower triangular matrix L such that L⋅LT = M. This uses
only the upper triangular part of M. The upper triangular of
M, when reflected about the diagonal, must form a positive
definite matrix.

⊕ qr(A) A matrix whose first n columns contain the square, or-
thonormal matrix Q, and whose remaining columns contain
the upper triangular matrix, R. Matrices Q and R satisfy
the equation A = Q⋅R, where A is a real-valued array.

⊕ lu(M) One matrix containing the three square matrices P, L, and
U, all having the same size as M and joined together side
by side, in that order. These three matrices satisfy the equa-
tion P⋅M = L⋅U. L and U are lower and upper triangular re-
spectively.
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⊕ svd(A) One matrix containing two stacked matrices U and V,
where U is the upper m × n submatrix and V is the lower
n × n submatrix. Matrices U and V satisfy the equation
A = U⋅diag(s)⋅VT, where s is a vector returned by svds(A).
A is an m × n array of real values, where m ≥ n.

⊕ svds(A) A vector containing the singular values of the m × n real-
valued array A, where m ≥ n.

Figure 16: Using the submatrix function to extract the results from the rq func-
tion. Use submatrix in a similar way to extract results from the lu and svd func-
tions.

Solving a linear system of equations

With Mathcad PLUS, you’ll be able to use the lsolve function to solve a linear
system of equations. Figure 17 shows an example. Note that the argument M for
lsolve must be a matrix that is neither singular nor nearly singular. A matrix is
singular if its determinant is equal to zero. A matrix is nearly singular if it has a
high condition number. You may want to use one of the functions described on
page 201 to find the condition number of a matrix.

Function Name Returns...

⊕ lsolve(M, v) A solution vector x such that M⋅x = v.

Alternatively, you can also solve a system of linear equations by using matrix in-
version as shown in the lower right corner of Figure 9.
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Figure 17: Using lsolve to solve 2 equations in 2 unknowns.

Doing calculations in parallel 

Any calculation Mathcad can perform with single values, it can also perform
with vectors or matrices of values. There are two ways to do this:

By iterating over each element using range variables as described in the next
chapter “Range Variables.”

By using the “vectorize” operator described in this chapter.

Mathcad’s vectorize operator allows it to perform the same operation efficiently
on each element of a vector or matrix.

Mathematical notation often shows repeated operations with subscripts. For ex-
ample, to define a matrix P by multiplying corresponding elements of the matri-
ces M and N, you would write:

Pi, j = Mi, j ⋅ Ni, j

Note that this is not matrix multiplication, but multiplication element by ele-
ment. It is possible to perform this operation in Mathcad using subscripts, as de-
scribed in the next chapter, but it is much faster to perform exactly the same
operation with a vectorized equation.
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How to apply the vectorize operator to an expression 

Here’s how to apply the vectorize operator to an expression like M ⋅ N:

Select the whole expression by
clicking inside and pressing
[Space] until the right-hand side
is held between the editing lines. 

Press [Ctrl]– to apply the vector-
ize operator. Mathcad puts an ar-
row over the top of the selected
expression.

How the vectorize operator changes the meaning of an expression 

The vectorize operator changes the meaning of the operators and functions to
which it applies. The vectorize operator tells Mathcad to apply the operators and
functions with their scalar meanings, element by element.

Here are some examples of how the vectorize operator changes the meaning of
expressions with vectors and matrices:

If v is a vector, sin(v) is an illegal expression. But if you apply the vectorize
operator, Mathcad applies the sine function to every element in v. The result
is a new vector whose elements are the sines of the elements in v.

If M is a matrix, √M  is an illegal expression. But if you apply the vectorize
operator, Mathcad takes the square root of every element of M and places the
results in a new matrix. 

If v and w are vectors, then v⋅w means the dot product of v and w. But if you
apply the vectorize operator, the result is a new vector whose i th element is
obtained by multiplying vi and wi. This is not the same as the dot product.

These properties of the vectorize operator let you use scalar operators and func-
tions with array operands and arguments. In this manual, this is referred to as
“vectorizing” an expression. For example, suppose you want to apply the quad-
ratic formula to three vectors containing coefficients a, b, and c. Figure 18
shows how to do this when a, b, and c are just scalars. Figure 19 shows how to
do the same thing when a, b, and c are vectors. 
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Figure 18: The quadratic formula.

Figure 19: Quadratic formula with vectors and the vectorize operator.
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The vectorize operator appears as an arrow above the quadratic formula in Fig-
ure 19. Its use is essential in this calculation. Without it, Mathcad would inter-
pret a⋅c as a vector dot product and also flag the square root of a vector as
illegal. But with the vectorize operator, both a⋅c and the square root are per-
formed element by element.

Here are the properties of the vectorize operator: 

The vectorize operator changes the meaning of the other operators and func-
tions to which it applies. It does not change the meaning of the actual names
and numbers. If you apply the vectorize operator to a single name, it simply
draws an arrow over the name. You can use this arrow just for cosmetic pur-
poses.

Since operations between two arrays are performed element by element, all
arrays under a vectorize operator must be the same size. Operations between
an array and a scalar are performed by applying the scalar to each element of
the array. For example, if v is a vector and n is a scalar, applying the vector-
ize operator to v n returns a vector whose elements are the n th powers of the
elements of v.

You cannot use any of the following matrix operations under a vectorize op-
erator: dot product, matrix multiplication, matrix powers, matrix inverse, de-
terminant, or magnitude of a vector. The vectorize operator will transform
these operations into element-by-element scalar multiplication, exponentia-
tion, or absolute value, as appropriate.

The vectorize operator has no effect on operators and functions that require
vectors or matrices: transpose, cross product, sum of vector elements, and
functions like mean. These operators and functions have no scalar meaning.

The vectorize operator applies only to the final, scalar arguments of interp
and linterp. The other arguments are unaffected. See “Interpolation func-
tions” in Chapter 13, “Statistical Functions.”

Simultaneous definitions 

You can use vectors and matrices to define several variables at once. You do
this by placing an array of variable names on the left side of a :=, and a corre-
sponding array of values to the right. Mathcad assigns the values on the right to
the corresponding names on the left. Figure 20 shows two such definitions.
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Figure 20: Simultaneous definitions.

The left side of a simultaneous definition is a vector or matrix whose elements
are either names or subscripted variable names. The right side must be a vector
or matrix expression having the same number of rows and columns as the left
side. Mathcad defines each variable on the left side with the value of the expres-
sion in the corresponding position on the right side.

Mathcad evaluates all elements on the right hand side before assigning any of
them to the left hand side. Because of this, nothing on the right hand side of an
expression can depend on what is on the left hand side. You also cannot have a
variable appear more than once on the left hand side.

Simultaneous definitions are useful for iterating several equations simultane-
ously. Several examples are described in Chapter 10, “Range Variables.”

Arrays and user-defined functions 

The arguments in a function definition need not be scalar variables. They can
also be vectors or matrices. Functions can return values that are scalars, vectors,
or matrices.

Figure 21 shows some examples of functions with vector and matrix arguments
and results.
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Figure 21: User functions used with vectors and matrices.

Note that if a function expects a vector or a matrix for an argument, it will not
work on a scalar argument. In the example in Figure 21, trying to evaluate 
extent(3) will flag the equation with the an error message indicating that the ar-
gument must be an array.

If a function returns a vector or matrix as a result, you use the subscript and su-
perscript operators to extract specific numbers. For example, in Figure 21, you
could evaluate:

rotate (0)1,0 = 0

rotate (0)<1> = 

0
1





Nested arrays

An array element need not be a scalar. It’s possible to make an array element it-
self be another array. This allows you to create arrays within arrays.

These arrays behave very much like arrays whose elements are all scalars. How-
ever there are some distinctions:

You cannot use the Matrix command from the Insert menu to insert an array
into a placeholder that’s already inside an array.

You cannot display the entire nested array. You will instead see a string like
“{3,2}” to indicate that a 3 × 2 array is present in a particular array location.
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Most math operators and functions do not make sense in the context of nested
arrays.

The following sections explore these differences in some detail.

Defining a nested array

You define a nested array in much the same way you would define any array.
The only difference is that you cannot use the Matrix command from the Insert
menu when you’ve selected a placeholder within an existing array. You can,
however, click on a placeholder in an array and type the name of another array
as shown in Figure 22. 

Figure 22 shows three ways to define a matrix of matrices: using range vari-
ables, element by element, and with the Matrix command from the Insert
menu. 

In addition to those methods shown in Figure 22, you can also use the READPRN
function in the array of empty placeholders created using the Matrix command.
Keep in mind, however, that you can’t use READPRN on the same file more than
once in a given matrix. The READPRN function is discussed more fully in chap-
ter 18, “Data Files.”

Figure 22: Defining nested arrays.
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Displaying nested arrays

When you display a nested array using the equal sign, you won’t actually see
every element in every nested array. Such a display would be very cumbersome,
especially when you consider that an array inside an array may itself contain ar-
rays within it. 

Instead, whenever an array element is itself an array, Mathcad indicates this by
showing the number of rows and columns rather than the array itself. Figure 23
shows how the arrays created in Figure 22 would appear when displayed. Each
array element is displayed either:

As a number when the array element is simply a number, or

As an ordered pair m, n where m and n are the number of rows and columns
in the array which occupying that array element.

Note that the B array contains an element, B2, which is itself a nested array. To
view this array, you would simply nest your subscripts as shown in the lower-
right corner of Figure 22.

Figure 23: Displaying nested arrays.
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Operators and functions for nested arrays

Most operators and functions do not work with nested arrays. This is because
there is no universally accepted definition of what the correct behavior should
be in this context. For example, there is no clear definition of what it means to
“invert” such an array. When you attempt to perform the usual arithmetic opera-
tions on nested arrays, you will get either an error message or a meaningless re-
sult. For the most part, nested arrays are designed only for storing and accessing
data in a convenient way.

Certain operators and functions are nevertheless useful and appropriate for
nested arrays. For example, transpose does something meaningful as shown at
the bottom of Figure 23. Operators which make sense in the context of nested ar-
rays are:

Operation Appearance Keystroke Description

Transpose AT [Ctrl]1 Interchanges row and col-
umns of A.

Superscript A< n > [Ctrl]6 n
 th

 column of array A. Re-
turns a vector.

Vector
subscript

vn [ n
 th

 element of a vector.

Matrix
subscript

Am,n [ (m, n) th element of a matrix.

Boolean 
equals

w = z [Ctrl]= Boolean equals. Returns 1 if
the two nested arrays, along
with all nested arrays con-
tained within them, are identi-
cal; otherwise returns 0.
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Useful functions for nested arrays tend to be those having to do with the number
of rows and columns in an array or those used for joining or dividing arrays. In
particular, you can use the rows and cols functions to distinguish between scalar
array elements and array elements which are themselves arrays. Both these func-
tions return a zero in the former case and the appropriate number in the latter.
The functions you’ll find useful when working with nested arrays are:

Function Name Returns...

rows(A) Number of rows in matrix A.

cols(A) Number of columns in matrix A. 

length(v) Number of elements in vector v. 

last(v) Index of last element in vector v. 

augment(A, B) An array formed by placing A and B side by side. The ar-
rays A and B must have the same number of rows.

stack(A, B) An array formed by placing A above B. The arrays A and
B must have the same number of columns.

submatrix(A, ir, jr, ic, jc) A submatrix of A consisting of all elements contained in
rows ir through jr and columns ic through jc. To maintain
order of rows and/or columns, make sure ir ≤ jr and ic ≤ jc,
otherwise order of rows and/or columns will be reversed.
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Chapter 10
Range Variables

A range variable is a variable that takes on a range of values each
time you use it. Range variables greatly extend Mathcad’s
capabilities by allowing you to iterate, or loop, through repetitive
calculations.

This chapter describes range variables and shows how to use them
to perform iterative calculations, display tables of numbers, and
facilitate the entry of many data values into a table.

The following sections make up this chapter.

Range variables
How to step through a range of numbers by defining a range variable.

Output tables
How to display a table of numbers.

Entering a table of numbers
How to use range variables to enter a table of numbers.

Iterative calculations
How to perform iteration with one or two range variables.

Seeded iteration
How to perform iteration when values in one step depend on the values
in the previous step. Recursive techniques such as this provide the foun-
dation for solving difference equations with Mathcad.

Vector notation 
When to use the “vectorize” operator rather than subscripts.
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Range variables 

All iterative processes in Mathcad depend on range variables. Except for the
way it’s defined, a range variable looks just like a conventional variable. The dif-
ference is that a conventional variable takes on only one value. A range variable,
on the other hand, takes on a range of values separated by uniform steps. For ex-
ample, you could define a range variable to go from –4 through 4 in steps of 2.
If you now use this range variable in an expression, Mathcad evaluates that ex-
pression five times, once for each value taken by the range variable.

Range variables are crucial to exploiting Mathcad’s capabilities to their fullest.
This section shows how to define and use range variables to perform iteration.

Defining and using range variables 

To define a range variable, type the variable name followed by a colon and a
range of values. For example, here’s how to define the variable j ranging from 0
to 15:

Type j and then press the colon
key (:). The empty placeholder in-
dicates that Mathcad expects a defi-
nition for j. At this point, Mathcad
does not know whether j is to be a
conventional variable or a range
variable. 

Type 0. Then press the semicolon
key (;). This tells Mathcad that
you are defining a range variable.
Mathcad shows the semicolon as
two periods “..” to indicate a range.
Complete the range variable defini-
tion by typing 15 in the remaining
placeholder.

This definition indicates that j now takes on the values 0, 1, 2 . . . 15. To define a
range variable that changes in steps other than 1, see the section “Types of
ranges” later in this chapter. 

Once you define a range variable, it takes on its complete range of values every
time you use it. If you use a range variable in an equation, for example, Mathcad
must evaluate that equation once for each value of the range variable.

You must define a range variable exactly as shown above. There must be:

a variable name on the left,

either a “:=” or a “≡” in the middle, and

a valid range on the right.
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In particular, you cannot define a variable in terms of a range variable. For ex-
ample, if after having defined j as shown you now define i := j + 1, Mathcad as-
sumes you are trying to set a scalar variable equal to a range variable and marks
the equation with an appropriate error message.

One application of range variables is to fill up the elements of a vector or ma-
trix. You can define vector elements by using a range variable as a subscript.
For example, to define xj for each value of j:

Type x[j:j^2[Space]+1.

Figure 1 shows the vector of values computed by this equation. Since j is a
range variable, the entire equation is evaluated once for each value of j. This de-
fines xj for each value of j from 0 to 15. The effect is exactly the same as if you
had typed 

x0 := 02 + 1

x1 := 12 + 1

.

.

.
x15 := 152 + 1

Figure 1: Using a range variable to define the values of the vector x.
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To understand how Mathcad computes with range variables, keep in mind this
fundamental principle: 

If you use a range variable in an expression, Mathcad evaluates the expression
once for each value of the range variable.    

This principle sums up the difference between expressions with and without
range variables. Expressions that involve no range variables have only one
value. Expressions that involve range variables take on many values, one for
each value of each range variable. 

If you use two or more range variables in an equation, Mathcad evaluates the
equation once for each value of each range variable. The section “Iterative calcu-
lations” later in this chapter discusses this in more detail.

Mathcad takes longer to compute equations with ranged expressions since there
are many computations for each equation. While Mathcad is computing, the
mouse pointer changes its appearance. To learn how to interrupt a calculation in
progress, see the section “Interupting calculations” on page 152.

Types of ranges 

The definition of j in the previous section, ranging from 0 to 15, is the simplest
type of range definition. Mathcad permits range variables with values ranging
from any value to any other value, using any constant increment or decrement.

To define an arbitrary range variable, type an equation of this form:

k:1,1.1;2

This appears in your document window as:

k := 1, 1.1 .. 2

In this range definition: 

The variable k is the name of the range variable itself. It must be a simple
name. No subscripts or function definitions are allowed.

The number 1 is the first value taken by the range variable k.

The number 1.1 is the second value in the range. Note that this is not the step-
size. The stepsize in this example is 0.1, the difference between 1.1 and 1. If
you omit the comma and the 1.1, Mathcad assumes a step size of one in what-
ever direction (up or down) is appropriate.

The number 2 is the last value in the range. In this example, the range values
are constantly increasing. If instead you had defined k := 10 ..1, then k would
count down from 10 to 1. Even if the third number in the range definition is
not an even number of increments from the starting value, the range will not
go beyond it. For example, if you define k := 10, 20 ..65, k will take values
10, 20, 30 . . . 60.
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You can use arbitrary scalar expressions in place of 1, 1.1, and 2. However,
these values must always be real numbers. Complex numbers do not make sense
in range variable definitions because given two complex numbers, there is an in-
finite number of paths connecting them. Figure 2 shows the results of various
range variable definitions.

Figure 2: Some valid definitions for range variables.

Note that if you use a fractional increment for a range variable, you will not be
able to use that range variable as a subscript. This is because subscripts must be
integers. 
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Output tables 

Whenever you type “=” after an expression involving range variables, Mathcad
shows the computed values in an output table. Figure 2 shows the values of sev-
eral range variables displayed as output tables.

Figure 3 shows some output tables for slightly more complicated expressions in-
volving range variables. 

Figure 3: Typing “=” after an expression with range variables gives an output ta-
ble.

To create the three tables in Figure 3, first define the range variable. Then type
these equations:

i=

x[i=
i*10=

Whenever you type an expression followed by “=” Mathcad displays:

a number, if the result is a scalar (a single number).

a vector or a matrix, if the result is a vector or a matrix and the expression to
the left of the “=” contains no range variables.

a table like that shown in Figure 3 if the expression to the left of the “=” con-
tains range variables.
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A scrolling output table if the result is a vector or a matrix, the expression to
the left of the “=” contains no range variables, and the result has more than
nine rows or columns. Scrolling output tables are discussed on page 192.

Since both x= and x[i= display the same numbers, you can think of tables as
another way of viewing the contents of a vector. Tables are particularly conven-
ient for viewing selected parts of a vector. For example, if you’ve defined a vec-
tor v, you can view every other element of that vector by typing:

i := 0, 2 ..last(v)
vi =

Here are some facts about output tables in Mathcad:

Mathcad shows only the first 50 values of a ranged expression in a table. For
example, even if i ranges from 1 to 100, typing i^2= will show only the val-
ues from 12 up to 502 in a table. To see more than 50 values, use several
range variables and several tables. You could, for example, define j1 from 1
to 50 and j2 from 51 to 100, and then show tables for j1^2= and j2^2=,
side by side.

To format the numbers in a table, click in the table and choose Number from
the Format menu. Then specify your formatting preferences in the dialog
box as you would for an equation with a single numeric result. For more infor-
mation on number formatting, see Chapter 5, “Equation and Result Format-
ting.”

There are three ways to show the values in a vector. If you use a vector name
with a subscript like xj =, Mathcad shows an output table. If instead you type
a vector name without a subscript like x =, Mathcad shows the vector as a vec-
tor rather than as an output table. If you type a vector name without a sub-
script and the vector has more than nine elements, you see a scrolling output
table as described on page 192. Keep in mind that these are just three differ-
ent ways of looking at the same thing: an ordered collection of numbers.

You cannot use units with a table as you would with a single scalar answer. If
the results in a table have dimensions, Mathcad shows the dimensions on
each value in the table. To avoid this display, divide the ranged expression by
the desired units. Figure 4 shows an example.
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Figure 4: Units in a table.

Entering a table of numbers 

 When you enter a table of numbers, you are actually assigning elements to a vec-
tor. This section discusses how to do this using input tables and range variables.
To enter an input table, enter a definition with a subscripted variable on one side
and a sequence of values separated by commas on the other. For example:

To define i to run through four val-
ues, type i:1;4. Note that i must
take integer values only. Otherwise
it can’t be used as a subscript in the
next step.

Click in a new spot and type x[i:
The placeholder indicates that
Mathcad is expecting a value for x1.

Type 3 and press the comma key.
Mathcad shows another place-
holder to indicate that Mathcad
now expects a value for x2.
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Type 5,15,20 to supply values
for x2, x3 and x4.

Once you have created an input table, you can do any of the following:

Insert a value in the middle of a table. Click on the value immediately
above wherever you want to insert the new value. Then type a comma. Under
the selected value in the table, Mathcad creates a placeholder surrounded by a
box. To enter another number, just type it into this placeholder.

Extend the table to hold additional values. Click on the last value in the ta-
ble and follow the steps above for inserting a value in the table.

Replace or delete a value from the table. Place the value you want to re-
place or delete between the two editing lines and choose Cut from the Edit
menu. Mathcad replaces the value with an empty placeholder. Type a new
value in this placeholder to replace the old one. To delete the value com-
pletely and decrease the array length by one in the process, backspace over
the placeholder.

Some notes about input tables:

Each value in an input table must be either a number or an expression that re-
turns a number, the name of an array or an expression that returns an array.
Expressions involving range variables and expressions created by using the
Matrix command on the Insert menu are not permitted. 

All expressions in an input table must have the same dimensions if any. If
you want each expression to be in meters, for example, you may have to in-
clude the abbreviation for meters in each table entry. A shortcut is to enter the
numbers without units and redefine the vector with units by typing something
like x := x⋅m/sec2.

An input table ordinarily has one entry for each value of the range variable
used in defining it. If the table has too few entries, Mathcad will define only
as many values as are present. If the table has too many entries, the extra en-
tries will be ignored.

Input tables assign values only to those elements specified by the range vari-
able. If in the previous example, the range variable definition had been
i := 10, 20 .. 40, Mathcad would have assigned values to x10, x20, x30 and x40.
Mathcad would then pad the unassigned entries, namely x0 through x9, x11
through x19, and so on, with zeros. You will see these zeros if you display the
vector by typing “x=.” It is possible to inadvertently create large tables this
way. 
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Input tables are limited to 50 elements. If you want to enter more than 50 ele-
ments, enter them using several tables. You could, for example, define j1
from 1 to 50 and j2 from 51 to 100, type x[j1: followed by the first fifty
numbers, then type x[j2: followed by the second fifty numbers.

When confronted with a very large number of data values, consider reading
them in from a data file stored on your disk as an alternative to typing them in
with input tables. Chapter 18 on data files discusses this in more detail.

Figure 5 shows some input tables. Note how typing x= and y= displays the ele-
ments of x and y in vector form. Mathcad ignores the last number in the input ta-
ble for y since this entry would have index 5 and the range variable i stops at 4.
Contrast this with typing x[i= as shown in Figure 3 of the previous section.

Figure 5: Input tables.

Note that the first element of both vectors is zero. This is because Mathcad’s ar-
ray origin is set to zero by default. Since the range variable i starts at 1, the
zeroth element is never explicitly defined. In the absence of an explicit defini-
tion, Mathcad assumes a value of zero.
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Iterative calculations 

 This section shows how to use range variables to perform iteration.

Iteration over a range 

The simplest kind of iteration in Mathcad is just a generalization of scalar calcu-
lations. Any calculation you can perform once, you can perform over a range of
values.

For example, suppose you want to create a list of x and y values for points on the
polar curve r = cos(θ) + 1. The basic idea is as follows:

θ should take on values between 0 and 2π.

For each θ, the corresponding r is given by r = cos(θ) + 1.

For each r and θ, there is a corresponding x and y given by x = r ⋅ cos(θ) and
y = r ⋅ sin(θ).

The strategy for solving this problem is simple: create a range variable i and
then compute θ, r, x, and y for each value of i. The formula for θi defines θ to
run from 0 to 2π in steps of 2π/N. To create the other formulas, just put the sub-
script i on each variable in the formula. Figure 6 shows the result.

Figure 6: Using iteration to create a draw a polar curve using an X-Y plot.
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Notice that in this example i, not θ, is defined as the range variable. Since i takes
on only whole-number values, it is a valid subscript. On the other hand, θ takes
on fractional values. It therefore cannot be used as a subscript. In many cases,
you can avoid this extra step by using functions instead of vectors. Figure 7
shows how to generate the cardioid shown in Figure 6 with functions instead of
vectors.

Figure 7: Using a function to do the same thing as shown in Figure 6.

By using vector notation and the vectorize operator, you can eliminate the use of
a subscript in the last three equations in Figure 6. Figure 8 shows an example of
how to do this. 
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Figure 8: Using the vectorize operator to create a polar plot.

Equations that use vector notation instead of subscripts typically compute much
more quickly. For more information, see Chapter 9, “Vectors and Matrices.”

Multiple range variables and double subscripts 

 If you use two range variables in an equation, Mathcad runs through each value
of each range variable. This is useful for defining matrices. For example, to de-
fine a 5 × 5 matrix whose ij th element is i + j, type these equations:

i:0;4

j:0;4
x[i,j:i+j

Note that you don’t need to type [Space] to leave the subscript in this case.
Typing : leaves the subscript and creates the definition symbol.

Figure 9 shows the result of typing the above equations. It is usually best to dis-
play the matrix in the form shown in Figure 9. If instead of typing x= you were
to type x[i,j=, Mathcad would show one long output table with 25 numbers.
Such a table is often difficult to interpret. A similar problem arises when you
use a pair of range variables in a graph.
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Figure 9: Defining a matrix.

The xi, j equation is evaluated for each value of each range variable, for a total of
25 evaluations. The result is the matrix shown at the bottom, with 5 rows and 5
columns. The element in the i th row and j th column of this matrix is i + j.

Note that if the two range variables have m and n values, respectively, then an
equation using both range variables will calculate m⋅n results. If you try to use
two range variables in an output table, Mathcad will show these m⋅n results in a
long table with one entry for each result. If you use two range variables in a
graph, Mathcad will plot one point for each of the m⋅n results. 
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Seeded iteration 

Seeded iteration is a recursive technique for solving difference equations such
as those that arise in compound interest problems, Markov processes, and many
state variable equations. It can also be used for obtaining approximate solutions
for certain differential equations. In a seeded iteration, you specify the first ele-
ment of an array and then compute successive elements based on the first ele-
ment. This section describes three types of seeded iteration: iterating a single
variable, iterating multiple variables, and iterating a vector.

Seeded iteration on one variable 

The classical method for estimating square roots arithmetically is as follows:

To find √a , begin with a guess value.

Compute a new guess based on the old guess, with this formula:

NewGuess = 
OldGuess + a ⁄ OldGuess

2

Continue until the guesses converge to an answer.

Figure 10 shows how to implement this method in Mathcad.

Figure 10: Using seeded iteration to estimate a square root.
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The important characteristics of this example are:

The seed value is defined as the zeroth element of the array, guess0.

Each guessi + 1 is defined in terms of a previously computed element.

It is this dependence of array elements on previously computed array elements
that distinguishes seeded iteration from the more straightforward iteration dis-
cussed in the previous section.

Seeded iteration on several variables 

 You can use Mathcad’s vector notation to iterate several variables simultane-
ously. This variation on simple seeded iteration is a powerful method for solving
a system of simultaneous difference equations.

When you iterate several variables, each step computes the value of the vari-
ables from all of their previous values. You can’t accomplish this with several
equations because when Mathcad sees an equation with range variables, it at-
tempts to evaluate it for each value of the range variable before going on to the
next equation. You must, therefore, create one equation that performs all the it-
erations simultaneously.

For example, consider an infection model with four variables: i for the number
of individuals infected, s for the number susceptible, d for the number deceased,
and r for the number recovered and hence immune. The four equations that re-
late these four variables over time are:

it+1 = 0.0001 ⋅ st ⋅ it
st+1 = st − 0.0001 ⋅ st ⋅ it

dt+1 = dt + 0.55 ⋅ it
rt+1 = rt + 0.45 ⋅ it

Figure 11 shows how to perform a simultaneous iteration using these equations.

The single most important thing about this example is that all the t + 1 subscripts
are on the left-hand side of the matrix equation. The right-hand side contains
only the subscript t. Mathcad evaluates all the expressions on the right-hand side
before performing any assignments to the left-hand side. This means that noth-
ing on the right-hand side can depend on something on the left-hand side.
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Figure 11: Simultaneous iteration to model an infection.

Seeded iteration on a vector 

You can also perform seeded iteration starting with a vector and computing a
new vector each time. This type of iteration uses a seed vector and Mathcad’s su-
perscript operator.

A Markov process is an example of a problem that involves iteration on a vec-
tor. A Markov process begins with a vector v that represents the starting values
of some quantities, for example, the number of voters planning to vote for differ-
ent candidates, the number of trucks at regional offices of a truck rental com-
pany, or the market share of different companies. Each step in the Markov
process computes a new vector by multiplying the previous vector by a “state
transition” matrix A. 

Figure 12 shows how to set up a Markov process. This technique uses super-
scripts to index an entire column of a matrix at once. To create a superscript,
press [Ctrl]6. This generates a placeholder between angle brackets: <>.

Here’s how to enter the equations in Figure 12:

First, define the state transition ma-
trix A. Type A, press the colon key
(:), and create a 3×3 matrix. To
create a matrix, choose Matrix
from the Insert menu.
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Click to the right of the matrix and
type v. Then press [Ctrl]6. Type
0 in the placeholder for the super-
script.

Now complete the definition of the
initial vector. First press the colon
key (:). Then choose Matrix from
the Insert menu. Specify that you
want to create a matrix with three
rows and one column. Then fill in
the matrix entries.

Type k:1;8. This defines a range
variable k to count eight iterations.

To define the k th vector in terms of
the (k − 1) th, type v[Ctrl]6 k.
Then type a colon (:) for the defini-
tion symbol. Complete the equation
by typing this expression after the
definition symbol: A*v[Ctrl]6
k-1

To see the eighth (last) column of
the matrix, type v [Ctrl]6 8 = .

To see all the vectors as columns of
a matrix, type v= . Note that not all
the columns are displayed in the
picture to the right.

The superscript operator actually retrieves or defines one column in a matrix.
When you define v< k > in terms of v< k − 1 >, you are actually defining each col-
umn of a matrix in terms of the preceding column. The last equation in Figure
12 shows the matrix composed from these columns.
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Figure 12: Iterating a vector to model a Markov process.

Vector or subscript notation 

 This chapter has shown many examples using subscript notation and range vari-
ables. Chapter 9, “Vectors and Matrices,” showed many examples using vector
notation without subscripts. This distinction is important. If you use subscripts
when they are not required, or vice versa, you probably won’t get the answer
you’re looking for.

Subscripts refer to individual array elements. When you use range variables as
subscripts like Mi,j, Mathcad runs through the individual elements of the array
one at a time.

Without subscripts, the variable name refers to the whole array.

Here are some rules of thumb for when to use subscripts:

To refer to an individual array element, use numbers as subscripts. For exam-
ple, to see matrix element (2,3), type M[2,3=.

To refer to an array as a whole, use the array name without subscripts. (The
term array means either a vector or a matrix.) The array name with no sub-
scripts is appropriate for multiplying one matrix by another, applying the
mean function to an array, or viewing a whole vector or matrix — all cases
where you want to treat the array as a whole. For example, to view the whole
matrix M in Figure 13, type M=.
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To refer to each of the array elements in succession, use the array name with
a range variable subscript. This is useful when defining the matrix elements
using some sort of formula. For example, to define the matrix M in Figure 13,
type three equations:

i:0;3

j:0;3
M[i,j:i*j

Figure 13 shows some examples of using array names with and without sub-
scripts.

Figure 13: Array names with and without subscripts.
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Iterative calculations with and without subscripts 

It’s often faster to use vector operations to perform iterative calculations than it
is to do them element by element with a range variable. This is discussed in
more detail in the section “Doing calculations in parallel” in Chapter 9. Unfortu-
nately, not all iterative calculations can be done as vector operations. For exam-
ple, the seeded iteration technique discussed earlier in this chapter cannot be
done with vector operations.

To tell if an equation with subscripts could be rewritten using vector notation
and the vectorize operator, check the following:

If all the subscripts in the calculation are the same, then the calculation can
probably be done quickly using vector operations. For example, consider this
equation:

xi := ri⋅cos(θi)

Since this equation contains no subscript other than i, it can be rewritten with
the vectorize operator ([Ctrl][-]) instead of with subscripts:

x := (r⋅cos(θ))
________→

If the subscripts in a calculation vary or if there is arithmetic involved in com-
puting the subscript, then the calculation probably cannot be done using vec-
tor operations. For example, seeded iteration involves the subscripts i and i–1
in the same equation. Since the subscripts are not the same, and since the sec-
ond subscript involves arithmetic, this calculation cannot be done using vec-
tor operations.

If the range variable appears anywhere in an equation other than in a sub-
script, the equation cannot be written using vector operations. For example,
the variable θ below cannot be defined using the vectorize operator. Although
the range variable appears on the left side as a subscript, its presence in an ex-
pression on the right disqualifies the entire equation.

θi := 0.1⋅i

Figure 14 shows the polar coordinate conversions from Figure 6 computed two
ways: using subscripts and using vector operations. The second method is much
faster in Mathcad.
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Figure 14: Changing an iterative process to vector operations.
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Chapter 11
Operators

Mathcad includes ordinary operators like + and /, matrix operators
like transpose and determinant, and special operators like iterated
sum, iterated product, integrals, and derivatives. 

This chapter contains a list of Mathcad operators and describes
how to enter and use the special operators.

This chapter contains the following sections:

List of operators
List of Mathcad’s operators in order of precedence.

Summations and products
How to use Mathcad’s summation and product operators.

Derivatives
How to use Mathcad’s derivative operators.

Integrals
How to use Mathcad’s definite integral operator.

Boolean operators
How to use Mathcad’s boolean operators such as “>” and “<.”

Customizing operators
How to define your own operators just the way you define your own
functions. 

239



List of operators 

  This is a list of Mathcad operators in order of precedence. For information on ar-
ray operators, see Chapter 9. Most of the following operators are available by
clicking on one of the operator palettes. To open the operator palettes, click on
the buttons on the button strip directly below the menu commands.  

In this table:

A and B represent arrays, either vector or matrix.

u and v represent vectors with real or complex elements.

M represents a square matrix.

z and w represent real or complex numbers.

x and y represent real numbers.

m and n represent integers.

i represents a range variable.

t represents any variable name.

f represents a function.

X and Y represent variables or expressions of any type.

Operation Appearance Keystroke Description

Parentheses ( X ) ’ Grouping operator.

Vector
Subscript

vn [ Returns indicated element of a vector.

Matrix
Subscript

Am, n [ Returns indicated element of a matrix.

Superscript A< n > [Ctrl ]6 Extracts column n from array A. Returns a vector.

Vectorize X 
→

[Ctrl ]– Forces operations in expression X to take place
element by element. All vectors or matrices in X
must be the same size.

Factorial n! ! Returns n⋅(n − 1)⋅(n − 2)… The integer n cannot
be negative.

Complex 
conjugate 

 X 
___

" Inverts the sign of the imaginary part of X.

Transpose AT [Ctrl ]1 Returns a matrix whose rows are the columns of
A and whose columns are the rows of A. A can
be a vector or a matrix.

Power z w ^ Raises z to the power w. 
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Operation Appearance Keystroke Description

Powers of
matrix,
matrix inverse 

M n ^ n th power of square matrix M (using matrix mul-
tiplication). n must be a whole number. M −1 is
the inverse of M. Other negative powers are pow-
ers of the inverse. Returns a square matrix.

Negation −X – Multiplies X by –1.

Vector sum Σv [Ctrl]4 Sums elements of vector v; returns a scalar.

Square root √z \ Returns positive square root for positive z; princi-
pal value for negative or complex z.

nth root n√z [Ctrl]\ Returns nth root of z; returns a real valued root
whenever possible.

Magnitude, 
Absolute value 

| z | | Returns √Re(z)2+Im(z)2 . 

Magnitude
of vector 

| v | | Returns the magnitude of the vector v: √v ⋅ v  if
all elements in v are real. Returns √v ⋅ v

_
 if any

element in v is complex.

Determinant | M | | Returns the determinant of the square matrix M.
Result is a scalar.

Division X
z

/ Divides the expression X by the non-zero scalar
z. If X is an array, divides each element  by z.

Multiplication X⋅Y * Returns the product of X and Y if both X and Y
are scalars. Multiplies each element of Y by X if
Y is an array and X is a scalar. Returns the dot
product (inner product) if X and Y are vectors of
the same size. Performs matrix multiplication if
X and Y are conformable matrices.

Cross 
product

u × v [Ctrl]8 Returns cross-product (vector product) for the
three-element vectors u and v.

Summation
∑ X

i = m

n [Ctrl]
[Shift]4

Performs summation of X over
i = m, m + 1, . . . n. X can be any expression. It
need not involve i but it usually does. m and n
must be integers.

Product
∏ X
i = m

n [Ctrl]
[Shift]3

Performs iterated product of X for
i = m, m + 1, . . . n. X can be any expression. It
need not involve i but it usually does. m and n
must be integers.

Range sum ∑ X
i

$ Returns a summation of X over the range variable
i. X can be any expression. It need not involve i
but it usually does.
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Operation Appearance Keystroke Description

Range product ∏ X
i

# Returns the iterated product of X over the range
variable i.  X can be any expression. It need not
involve i but it usually does.

Integral
∫ f(t) dt

a

b & Returns the definite integral of f(t) over the inter-
val [a, b]. a and b must be real scalars. All vari-
ables in the expression f(t), except the variable of
integration t, must be defined. The integrand, f(t),
cannot return an array.

Derivative d
dt

f(t) ? Returns the derivative of f(t) evaluated at t. All
variables in the expression f(t) must be defined.
The variable t must be a scalar value. The func-
tion f(t) must return a scalar.

nth Derivative dn

dtn
f(t)

[Ctrl]? Returns the nth derivative of f(t) evaluated at t.
All variables in f(t) must be defined. The variable
t must be a scalar value. The function f(t) must re-
turn a scalar. n must be an integer between 0 and
5 for numerical evaluation or a positive integer
for symbolic evaluation.

Addition X + Y + Scalar addition if X, Y, or both are scalars. Ele-
ment by element addition if X and Y are vectors
or matrices of the same size. If X is an array and
Y is a scalar, adds Y to each element of X.

Subtraction X − Y – Performs scalar subtraction if X, Y, or both are
scalars. Performs element by element subtraction
if X and Y are vectors or matrices of the same
size. If X is an array and Y is a scalar, subtracts Y
from each element of X.

Addition with 
line break

X …
  + Y

[Ctrl ][↵] Same as addition. Line break is purely cosmetic.

Greater than x > y > Returns 1 if x > y, 0 otherwise. x and y must be
real scalars.

Less than x < y < Returns 1 if x < y, 0 otherwise. x and y must be
real scalars. 

Greater than 
or equal

x ≥ y [Ctrl ]0 Returns 1 if x ≥ y, 0 otherwise. x and y must be
real scalars. 

Less than 
or equal

x ≤ y [Ctrl ]9 Returns 1 if x ≤ y, 0 otherwise. x and y must be
real scalars. 

Not equal to z ≠ w [Ctrl ]3 Returns 1 if z ≠ w, 0 otherwise. z and w must be
scalars. 

Equal to X = Y [Ctrl ]= Returns 1 if z = w, 0 otherwise. Appears as a bold
= on the screen. 
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Help with typing operators

 You can avoid having to remember the keystrokes that go with each operator by
using the operator palettes. To open the operator palettes, click on the buttons on
the strip just below the menus. Each button opens a palette of operators grouped
loosely by function.

The icons on the operator palette buttons indicate what operator appears when
you click on that button. You can also hold the mouse pointer momentarily over
a button to see a balloon indicating what the button does.

To type any operator from the table on the previous pages, just click wherever
you want to put the operator, then click on its button on the appropriate operator
palette.

In general, operator palettes only work in math regions. To use the operator pal-
ettes in text, you must first click in the text and choose Math Region from the
Insert menu. This will create a math placeholder in the text into which you can
insert operators using the palettes.

Summations and products

  The summation operator sums an expression over all values of an index. The it-
erated product operator works much the same way. It takes the product of an ex-
pression over all values of an index.

To create a summation operator in your worksheet:

Click in a blank space. Then type
[Ctrl][Shift]4. A summation
sign with four placeholders appears.

In the placeholder to the left of the
equal sign, type a variable name.
This variable is the index of sum-
mation. It is defined only within the
summation operator and therefore
has no effect on, and is not influ-
enced by, variable definitions out-
side the summation operator.

In the placeholder to the right of
the equal sign, type an integer or
any expression that evaluates to an
integer.
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In the single placeholder above the
sigma, type an integer or any ex-
pression that evaluates to an inte-
ger. 

In the remaining placeholder, type
the expression you want to sum.
Usually, this expression will in-
volve the index of summation. If
this expression has several terms,
type an apostrophe (’ ) to create a
pair of parentheses around the
placeholder.

Iterated products are similar. Just type [Ctrl ][Shift ]3 and fill in the place-
holders as described earlier.

Figure 1 shows some examples of how to use the summation and product opera-
tors. You can use a summation or an iterated product just as you would any
other expression. 

To evaluate multiple summations, place another summation in the final place-
holder of the first summation. An example of this appears at the bottom of Fig-
ure 1.

 

Figure 1: Summations and products.
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When you use the summation operator shown in Figure 1, the summation must
be carried out over integers and in steps of one. Mathcad provides more general
versions of these operators that can use any range variable you define as an in-
dex of summation. To use these operators, first define a range variable. In the
following example type i:1,2;10. Then do the following:

Click in a blank space. Then type
$. A summation sign with two
placeholders appears.

Click on the bottom placeholder
and type the name of a range vari-
able. The range variable you use
here should already have been de-
fined earlier in the worksheet.

Click on the placeholder to the
right of the summation sign and
type an expression involving the
range variable. If this expression
has several terms, type an apostro-
phe (’ ) to create a pair of parenthe-
ses around the placeholder.

Press the equals sign (=) to see the
result.

If you don’t want to take the time to click in each placeholder, you can enter the
previous expression by typing i$i^2. 

A generalized version of the iterated product  also exists. To use it, type #. Then
fill in the two placeholders.

Figure 2 shows some examples of how to apply the range sum and range prod-
uct operators. These operators, unlike the summation and product operators cre-
ated with [Ctrl][Shift]4 and [Ctrl][Shift]3, cannot stand alone. They
require the existence of a range variable. Note however, that a single range vari-
able can be used with any number of these operators. 

You can use summations and iterated products just as you would any other ex-
pression. To evaluate multiple summations, use two range variables as shown in
Figure 2.
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Figure 2: Range sums and range products. 

Variable upper limit of summation

Mathcad’s range summation operator runs through each value of the range vari-
able you place in the bottom placeholder. It is possible, by judicious use of
boolean expressions, to sum only up to a particular value. In Figure 3, the term
i ≤ x returns the value 1 whenever it is true and 0 whenever it is false. Although
the summation operator still sums over each value of the index of summation,
those terms for which i > x are multiplied by 0 and hence do not contribute to
the summation.

You can also use the four-placeholder summation and product operators to com-
pute sums and products with a variable upper limit, but note that the upper limit
in these operators must be an integer.
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Figure 3: A variable upper limit of summation.

The vector-sum operator 

The operation of summing the elements of a vector is so common that Mathcad
provides a special operator for it. While the ordinary summation operator sums a
ranged expression, the vector sum operator sums the elements of a vector with-
out needing a range variable.

To sum all the elements of a vector v defined elsewhere in your worksheet, fol-
low these steps:

Click in blank space or on a place-
holder. Then press [Ctrl]4.

Type the name of a vector or vec-
tor-valued expression. Mathcad re-
turns the sum of all the elements in
the vector. In this example, the vec-
tor used is that shown in
Figure 2.
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Derivatives 

 You can use Mathcad’s derivative operator to evaluate the derivative of a func-
tion at a particular point. 

As an example, here’s how you would evaluate the derivative of x 3 with respect
to x at the point x = 2:

First define the point at which you
want to evaluate the derivative.
Type x:2 .

Click below the definition of x.
Then type ?. A derivative operator
appears, with a placeholder in the
denominator and another to the
right.

Click on the bottom placeholder
and type x. You are differentiating
with respect to this variable. 

Click on the placeholder to the
right of the d/dx and type x^3 .
This is the expression to be differ-
entiated.

Press the equals sign = to see the
derivative of the expression at the
indicated point.

Figure 4 shows examples of differentiation in Mathcad.

With Mathcad’s derivative algorithm, you can expect the first derivative to be
accurate to within 7 or 8 significant digits, provided that the value at which you
evaluate the derivative is not too close to a singularity of the function. The accu-
racy of this algorithm tends to decrease by one significant digit for each increase
in the order of the derivative (refer to the subsection on higher order derivatives
which follows).

248 Chapter 11  Operators



Figure 4: Examples of Mathcad differentiation.

Keep in mind that the result of differentiating is not a function, but a single num-
ber: the computed derivative at the indicated value of the differentiation vari-
able. In the previous example, the derivative of x 3 is not the expression 3x 2 but
3x 2 evaluated at x = 2. If you want to evaluate derivatives symbolically, see
Chapter 17, “Symbolic Calculation.”

Although differentiation returns just one number, you can still define one func-
tion as the derivative of another. For example:

f(x) := 
d
dx

 g(x)

Evaluating f(x) will return the numerically computed derivative of g(x) at x.

You can use this technique to evaluate the derivative of a function at many
points. An example of this is shown in Figure 5.
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Figure 5: Evaluating the derivative of a function at several points.

Figure 6: Evaluating the derivative of a function at several values stored as ele-
ments of a vector.
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There are some important things to remember about differentiation in Mathcad:

The expression to be differentiated can be either real or complex.

The differentiation variable must be a single variable name. If you want to
evaluate the derivative at several different values stored in a vector, use the
technique illustrated in Figure 6.

Derivatives of higher order

 Mathcad has an additional derivative operator for evaluating the nth order deriva-
tive of a function at a particular point.

As an example, here’s how you would evaluate the third derivative of x 9 with re-
spect to x at the point x = 2:

First define the point at which you
want to evaluate the derivative.
Type x:2.

Click below the definition of x.
Then type [Ctrl]?. A derivative
operator appears, with two place-
holders in the denominator, one in
the numerator, and another to the
right.

Click on the bottom placeholder
and type x. You are differentiating
with respect to this variable. 

Click on the expression above and
to the right of the previous place-
holder and type 3. This must be an
integer between 0 and 5 inclusive.
Note that the placeholder in the nu-
merator automatically mirrors what-
ever you’ve typed.

Click on the placeholder to the
right of the d/dx and type x^9.
This is the expression to be differ-
entiated.

Press the equals sign = to see the
third derivative of the expression at
the indicated point.

For n = 1, this operator gives the same answer as the first-derivative operator dis-
cussed above. For n = 0, it simply returns the value of the function itself.
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Integrals 

You can use Mathcad’s integral operator to numerically evaluate the definite in-
tegral of a function over some interval.

As an example, here’s how you would evaluate the definite integral of sin(x)2

from 0 to π⁄4, follow these steps:

Click in a blank space and type &.
An integral appears, with placehold-
ers for the integrand, the limits of
integration, and the variable of inte-
gration.

Click on the bottom placeholder
and type 0. Click on the top place-
holder and type [Ctrl]p/4. These
are the upper and lower limits of in-
tegration.

Click on the placeholder between
the integral sign and the “d.” Then
type sin(x)^2. This is the ex-
pression to be integrated.

Click on the remaining placeholder
and type x. This is the variable of
integration. Then press the equals
sign (=) to see the result.

Mathcad uses a numerical algorithm called Romberg integration to approximate
the integral of an expression over an interval of real numbers.

There are some important things to remember about integration in Mathcad:

The limits of integration must be real. The expression to be integrated can,
however, be either real or complex.

Except for the integrating variable, all variables in the integrand must have
been defined elsewhere in the worksheet.

The integrating variable must be a single variable name. 

If the integrating variable involves units, the upper and lower limits of integra-
tion must have the same units.
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Like all numerical methods, Mathcad’s integration algorithm can have difficulty
with ill-behaved integrands. If the expression to be integrated has singularities,
discontinuities, or large and rapid fluctuations, Mathcad’s solution may be inac-
curate. 

Because Mathcad’s integration method divides the interval into four subinter-
vals and then successively doubles the number of points, it can return incorrect
answers for periodic functions with having periods 1/2n times the length of the
interval. To avoid this problem, divide the interval into two uneven subintervals
and integrate over each subinterval separately.

In some cases, you may be able to find an exact numerical value for your inte-
gral by using Mathcad’s symbolic integration capability. You can also use this
capability to evaluate indefinite integrals. See Chapter 17, “Symbolic Calcula-
tion.”  

Variable limits of integration

Although the result of an integration is a single number, you can always use an
integral with a range variable to obtain results for many numbers at once. You
might do this, for example, when you set up a variable limit of integration. Fig-
ure 7 shows how to do this.

Figure 7: Variable limits of integration. 

Keep in mind that calculations such as those shown in Figure 7 may require re-
peatedly evaluating an integral. This may take considerable time depending on
the complexity of the integrals, the length of the interval, and the value of TOL
(see the next section).
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Changing the tolerance for integrals 

 Mathcad’s numerical integration algorithm makes successive estimates of the
value of the integral and returns a value when the two most recent estimates dif-
fer by less than the value of the built-in variable TOL. Figure 8 shows how
changing TOL affects the accuracy of integral calculations. To display many dig-
its of precision, see Chapter 5, “Equation and Result Formatting.” 

Figure 8: Effects of tolerance on integral calculations.

You can change the value of the tolerance by including definitions for TOL di-
rectly in your worksheet as shown on Figure 8. You can also change the toler-
ance by choosing Options ⇒Built-In Variables from the Math menu. To see
the effect of changing the tolerance, choose Calculate Document from the
Math menu to recalculate all the equations in the worksheet.

If Mathcad’s approximations to an integral fail to converge to an answer, Math-
cad marks the integral with an appropriate error message. Failure to converge
can occhur when the function has singularities or “spikes” in the interval or
when the interval is extremely long.  

When you change the tolerance, keep in mind the tradeoff between accuracy and
computation time. If you decrease (tighten) the tolerance, Mathcad will compute
integrals more accurately. However, because this requires more work, Mathcad
will take longer to return a result. Conversely, if you increase (loosen) the toler-
ance, Mathcad will compute more quickly, but the answers will be less accurate.
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Contour integrals and double integrals 

You can use Mathcad to evaluate complex contour integrals. To do so, first para-
metrize the contour. Then integrate over the parameter. If the parameter is some-
thing other than arc length, you must also include the derivative of the
parametrization as a correction factor. Figure 9 shows an example. Note that the
imaginary unit i used in specifying the path must be typed as 1i. 

Figure 9: How to do a complex contour integral in Mathcad.

You can also use Mathcad to evaluate double or multiple integrals. To set up a
double integral, press & twice. Fill in the integrand, the limits, and the integrat-
ing variable for each integral. Figure 10 shows an example. 
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Figure 10: Double integrals.

Keep in mind that double integrals take much longer to converge to an answer
than single integrals. Wherever possible, use an equivalent single integral in
place of a double integral.
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Boolean operators

Unlike other operators, the boolean operators can return only a zero or a one. De-
spite this, they can be very useful. You have already seen an example in Figure
3 showing how a boolean operator made a variable upper limit of summation
possible. Figure 11 shows how a boolean operator makes it possible to deter-
mine the array index of a particular element. The Treasury of Methods and For-
mulas, an Electronic Book available from MathSoft, provides a wealth of
examples illustrating this and other methods of getting the most out of Mathcad.

The following table lists the boolean operators:

Condition How to type Description

w = z [Ctrl]= Boolean equals. Returns 1 if expressions are
equal; otherwise 0.

x > y > Greater than. 

x < y < Less than.

x ≥ y [Ctrl]0 Greater than or equal to. 

x ≤ y [Ctrl]9 Less than or equal to. 

w ≠ z [Ctrl]3 Not equal to. 

The four operators >, <, ≤, and ≥ cannot take complex numbers because the con-
cepts of greater than and less than lose their meaning in the complex plane.
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Figure 11: Using boolean operators.

Customizing operators

You can think of operators and functions as really being the same thing. A func-
tion takes “arguments” and returns a result. An operator, likewise, takes “oper-
ands” and returns a result. The differences are merely cosmetic: 

Functions have names you can spell, like tan or spline; operators are gener-
ally symbols like “+” or “×”.

Arguments to a function are enclosed by parentheses, they come after the
function’s name, and they’re separated by commas. Operands on the other
hand, can appear elsewhere. For example, you’ll often see “f(x, y)” but you’ll
rarely see “x f y”. Similarly, you’ll often find “x + y” but you’ll rarely find
“+(x, y)”.

Since operators and functions are fundamentally the same, and since you can de-
fine your own functions, there’s no reason why you can’t define your own cus-
tomized operators as well. With Mathcad PLUS, you’ll be able to do just that.

The first section describes how to define a new operator. This is followed by a
section on how to use the operator you’ve just defined. The last section brings to-
gether these ideas by showing how functions can themselves be displayed as if
they were operators.
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Defining a custom operator

You define an operator just as if you were defining a function. You’d type the
operator name followed by a pair of parentheses. The operands (two at the most)
would go between the parentheses. On the other side of the “:=” you’d type an
expression describing what you want the operator to do with its operands. These
steps are described in detail in the section “Defining a function” on page 139. 

Since operators tend to have names that aren’t found on a keyboard, a problem
arises when you try and type the name. For example, suppose you want to define
a new division operator using “÷”. You first have to know how to put a “÷” into
your worksheet. The simplest way to do this is to drag the symbol from the
“Math Symbols” QuickSheet. 

We recommend that you save your custom operators by dragging them into a
QuickSheet. Open the QuickSheets as described on page 31. Then click on “Per-
sonal QuickSheets” at the bottom of the table of contents. Click on “My Opera-
tors”. Then drag the definitions into the this QuickSheet. The next time you
need them, you’ll be able to drag them off the same QuickSheet rather than hav-
ing to redefine them.

When you paste the character, it
will appear in the default math font
as shown on the right.

To see the “÷,” you’ll need to
change this into the Symbol font.
Press the [Ins] key if necessary to
move the vertical arm of the inser-
tion point directly in front of the
character as shown.

Press [Ctrl]G to display the char-
acter in the Symbol font.

You can now continue as if you were defining a function of two variables that
happens to have an unusual looking “name”.

Type a left parenthesis followed by
two names separated by a comma.
Complete this argument list by typ-
ing a right parenthesis.

Press the colon (:) key. You see
the definition symbol, “:=,” fol-
lowed by a placeholder.
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Type the function definition in the
placeholder.

At this point, you’ve defined a function which behaves in every way like the
user-defined functions described in Chapter 6. You could, if you wanted to, type
“÷(1, 2) =” in your worksheet and see the result “0.5” on the other side of the
equal sign. 

The difference between functions and operators lies not so much in the way
they’re defined but in the way they’re displayed. This is discussed further in the
next section. 

Using a custom operator 

Once you’ve defined a new operator, you can use it in your calculations just as
you would use one of Mathcad’s built-in operators. You can’t, however, just
type the name of your operator since Mathcad has no way of knowing whether
you intend to use your new operator or whether you just want to define a vari-
able having the same name.

The procedure for inserting a custom operator depends on whether the operator
has one operand (like “−1” or “5!” for example) or two (like “1÷2”). In either
case, you’ll need to click on the button labelled “=?” just below the menu com-
mands. This opens a palette that you’ll need in the following procedures.

To insert an operator having two operands:

Click on the button labelled “xfy”
on the palette. You’ll see three
empty placeholders.

In the middle placeholder, insert
the name of the operator. You may
find it more convenient to copy the
name from the operator definition
and paste it into the placeholder.

In the remaining two placeholders,
place the two operands.

Press = to evaluate the expression.
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Another way to display an operator having two operands is to use the other but-
ton showing the letters “x”, “f” and “y” arranged like a water molecule. If you
follow the preceding steps using this operator, you’ll see the tree shaped display
shown in the lower-left corner of Figure 12.

To insert an operator having only one operand, decide first whether you want
the operator to appear before the operand, as in “−1”, or after the operand as in
“5!”. The former is called a prefix operator; the latter is a postfix operator. The
example below shows how to use a prefix operator. The steps for creating a post-
fix operator are almost identical.

In the following example, the symbol “¬” comes from the Symbol font. Look
on the Character Map dialog box just below the “÷”. Before you can reproduce
the steps in this example, you’ll first have to define an operator “¬(x)”. To do
so, follow the steps for defining ÷(x, y) in the previous section, substituting the
symbol “¬” for “ ÷” and using only one argument instead of two.

To make a prefix operator click on
the button labelled “fx” on the sym-
bol palette. Otherwise, click on the
“xf” button. In either case, you’ll
see two empty placeholders.

If you clicked the “fx” button, put
the operator name in the first place-
holder. Otherwise put it in the sec-
ond placeholder. In either case, you
may find it more convenient to
copy the name from the operator
definition and paste it into the
placeholder.

In the remaining placeholder, place
the operand.

Press = to evaluate the expression.

Be careful when you use operators this way. Since the placeholders look identi-
cal, there are no visual cues to tell you where the operands go and where the op-
erator goes. 
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The most convenient way to use operators like this is create them once and then
save them in a QuickSheet. To do this, open the QuickSheets as described on
page 31. Then click on “Math Symbols” to see a selection of common math sym-
bols. You can drag any of these to your worksheet to help you define a new op-
erator. Once you’ve defined the new operator, click on “Personal QuickSheets”
and drag its definition into the QuickSheet. When you need to use this operator
again, just open your Personal QuickSheet and drag it back off.

Figure 12: Defining your own operators.

Display of functions as operators

As noted earlier, there is really no fundamental difference between functions
and operators. The steps given in the section “Defining a custom operator” ex-
actly parallel the steps given on page 139 for defining a function. 

Since you define an operator just as if it were a function, you might expect to be
able to display that operator as if it were a function as well. Figure 13 shows that
this is indeed true. Although notation like “÷(1, 2)” is very unconventional, noth-
ing stops you from using it. 

Conversely, you can display a function as if it were an operator. For example,
many publishers prefer to omit parentheses around the arguments to certain func-
tions (sin x rather than sin(x)). You can do the same thing by treating the sin
function as an operator with one operand and following the steps in the section
“Using a custom operator”. The lower half of Figure 13 shows an example of
this.
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Figure 13: Displaying an operator as a function and a function as an operator.
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Chapter 12
Built-in Functions

This chapter lists and describes many of Mathcad’s built-in
functions. Functions associated with Mathcad’s statistical and data
analysis features are described in Chapter 13, “Statistical
Functions.” Functions used for working with vectors are described
in Chapter 9, “Vectors and Matrices”.

The following sections make up this chapter:

Inserting built-in functions
Using the Insert Function dialog box to see all available functions and
get help on what they do.

Transcendental functions
Basic trigonometric, exponential, hyperbolic and Bessel functions.

Truncation and round-off functions
Functions which extract something from a number, including the real
or imaginary part, the mantissa, or the modulo function.

Discrete transform functions
Functions for discrete complex Fourier transforms and wavelet trans-
forms.

Sorting functions
Functions to sort elements of vectors and matrices.

Piecewise continuous functions
Using piecewise continuous functions to perform conditional branching
and iteration.
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Inserting built-in functions 

This section describes how to see a list of all functions available to you together
with a brief description of each function. Mathcad’s set of built-in functions can
change depending on whether you’ve installed additional function packs or
whether you’ve written your own built-in functions.  These functions can come
from four sources:

Built-in Mathcad functions 
This is the core set of functions that come with Mathcad. These functions are
all documented in other parts of this User’s Guide. 

Mathcad Function Packs. 
A Function Pack consists of a collection of advanced functions geared to a
particular area of application. Documentation for these functions comes with
the Function Pack itself. The list of available Function Packs is constantly ex-
panding and includes collections for image processing, numerical analysis
and advanced statistical analysis. To find out more about Mathcad’s library
of Function Packs, call 617-577-1017. (From inside the USA, call 1-800-
MATHCAD.)

Electronic Books 
Some but not all Electronic Books come with additional functions. Docu-
mentation for any of these functions is in the Electronic Book itself.

Functions you write yourself 

Using a 32 bit C-compiler, you can write your own functions for performing
specialized tasks. Mathcad PLUS can then use these functions just as if they
were built-in Mathcad functions. See Appendix F, “Creating a User DLL”,
for more details.

To see the list of built-in functions available with your copy of Mathcad, choose
Function from the Insert menu. Although built-in function names are not font
sensitive, they are case sensitive. You must type the names of built-in functions
exactly as shown in the following tables: uppercase, lowercase, or mixed, as in-
dicated. Alternatively, you can use the Insert Function dialog box to insert a
function together with placeholders for its arguments. To do so: 

Click in a blank area of your document or on a placeholder. 

Choose Function from the Insert menu. Mathcad opens the Insert Function
dialog box shown on the following page.

Double-click on the function you want to insert from the left-hand scrolling
list.

Close the dialog box if you no longer need it by clicking the “Cancel” button.
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The left-hand scrolling list of the Insert Function dialog box shows all of Math-
cad’s built-in functions along with their arguments. The box on the right gives a
description of the currently selected function.

To apply a function to an expression you have already entered, place the expres-
sion between the two editing lines and follow the steps given on the preceding
page.

Transcendental functions

This section describes Mathcad’s trigonometric, hyperbolic, and exponential
functions together with all their inverses. It also describes Mathcad’s built-in cy-
lindrical Bessel functions. 

Trigonometric functions and their inverses

Mathcad’s trig functions and their inverses accept any scalar argument: real,
complex or imaginary. They also return complex numbers wherever appropriate.
Complex arguments and results are computed using the identities:

sin(z) = 
ei⋅z − e−i⋅z

2⋅i

cos(z) = 
ei⋅z + e− i⋅z

2

ei⋅z = cos(z) + i⋅sin(z)

If you want to apply one of these functions to every element of a vector or ma-
trix, use the vectorize operator as described on page 206.

Note that all of these trig functions expect their arguments in radians. To pass
degrees, use the built-in unit deg. For example, to evaluate the sine of 45 de-
grees, type sin(45*deg).
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Keep in mind that because of round-off errors inherent in a computer, Mathcad
may return a very large number where you would ordinarily expect a singular-
ity. In general, you should be cautious whenever you encounter any such singu-
larity.

sin(z) Returns the sine of z. In a right triangle, this is the ratio of the
length of the side opposite the angle over the length of the hypote-
nuse.

cos(z) Returns the cosine of z. In a right triangle, this is the ratio of the
length of the side adjacent to the angle over the length of the hy-
potenuse.

tan(z) Returns (sin(z)/cos(z)), the tangent of z.  In a right triangle, this is
the ratio of the length of the side opposite the angle over the length
of the side adjacent to the angle. z should not be an odd multiple of
π/2.

csc(z) Returns 1/sin(z), the cosecant of z . z should not be an even multi-
ple of π.

sec(z) Returns 1/cos(z), the secant of z. z should not be an odd multiple of
π/2.

cot(z) Returns 1/tan(z), the cotangent of z. z should not be an even multi-
ple of π.

The inverse trigonometric functions below all return an angle in radians between
0 and 2⋅π. To convert this result into degrees, you can either divide by the built-
in unit deg or type deg in the units placeholder as described on page 175.

Because of roundoff error inherent in computers, you may find that atan of a
very large number returns π/2. As a general rule, it’s best to avoid numerical
computations near such singularities.

asin(z) Returns the angle (in radians) whose sine is z.

acos(z) Returns the angle (in radians) whose cosine is z.

atan(z) Returns the angle (in radians) whose tangent is z.
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Hyperbolic functions 

The hyperbolic functions sinh and cosh are given by:

sinh(z) = 
ez − e−z

2

cosh(z) = 
ez + e−z

2

Both these functions will accept and return complex arguments. As the above
identities indicate, when you use complex arguments, the hyperbolic functions
behave very much like like trigonometric functions. In fact:

sinh(i⋅z) = i⋅sin(z)
cosh(i⋅z) = cos(z)

 

sinh(z) Returns the hyperbolic sine of z.

cosh(z) Returns the hyperbolic cosine of z.

tanh(z) Returns sinh(z)/cosh(z), the hyperbolic tangent of z.

csch(z) Returns 1/sinh(z), the hyperbolic cosecant of z.

sech(z) Returns 1/cosh(z), the hyperbolic secant of z.

coth(z) Returns 1(z)/tanh(z), the hyperbolic cotangent of z.

asinh(z) Returns the number whose hyperbolic sine is z.

acosh(z) Returns the number whose hyperbolic cosine is z.

atanh(z) Returns the number whose hyperbolic tangent is z.

Log and exponential functions 

Mathcad’s exponential and logarithmic functions will accept and return complex
arguments. Complex arguments to the exponential are given by:

e x + i⋅y = e x⋅(cos( y) + i⋅sin( y))

In general, a complex argument to the natural log function returns:

ln(x + i⋅y) = ln|x + i⋅y| + atan( y/x)⋅i + 2⋅n⋅π⋅i

Mathcad’s ln function returns the value corresponding to n = 0. Namely:

ln(x + i⋅y) = ln|x + i⋅y| + atan( y/x)⋅i

This is called the principal branch of the natural log function. Figure 1 illus-
trates some of the basic properties of log functions.
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exp(z) Returns e raised to the power z.

ln(z) Returns the natural log of z. (z ≠ 0).

log(z) Returns the base 10 log of z. (z ≠ 0).

Figure 1 shows how you can use these functions to easily find the log to any
base.

Figure 1: Using logarithmic functions.

Bessel functions 

These functions typically arise as solutions to the wave equation subject to cylin-
drical boundary conditions. 

Bessel functions of the first kind and second kind, Jn(x) and Yn(x), are solutions
to the differential equation:

x2⋅d
 2 y

dx2
 + x⋅dy

dx
 + (x2 − n2)⋅y = 0

Modified Bessel functions of the first and second kind, I
n
(x) and K

n
(x), are solu-

tions to the slightly different differential equation:

x2⋅d
 2 y

dx2
 + x⋅dy

dx
 − (x2 + n2)⋅y = 0
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J0(x) Returns J0(x). x real.

J1(x) Returns J1(x). x real.

Jn(m, x) Returns Jm(x). x real, 0 ≤ m ≤ 100.

Y0(x) Returns Y0(x). x real, x > 0.

Y1(x) Returns Y1(x). x real, x > 0.

Yn(m, x) Returns Ym(x). x > 0, 0 ≤ m ≤ 100.

I0(x) Returns I0(x). x real.

I1(x) Returns I1(x). x real.

In(m, x) Returns Im(x). x real, 0 ≤ m ≤ 100.

K0(x) Returns K0(x). x real, x > 0.

K1(x) Returns K1(x). x real, x > 0.

Kn(m, x) Returns Km(x). x > 0, 0 ≤ m ≤ 100.

Special functions

The following functions arise in a wide variety of problems. 

erf(x) Returns the value of the error function at x:

erf(x) = ∫  
0

 x 2
√π

 e−t2 dt

x must be real.

Γ(z) Returns the value of the Euler gamma function at z. For real z, the
values of this function coincide with the following integral:

Γ(z) = ∫  
0

 ∞
t z−1e−t dt

For complex z, the values are the analytic continuation of the real
function. Euler’s gamma function is undefined for z = 0, −1, −2,…

Euler’s gamma function satisfies the recurrence relationship:

Γ(z + 1) = zΓ(z)

which means that when z is a positive integer:

Γ(z + 1) = z!

Transcendental functions 271



The error function arises frequently in statistics. You can also use it to define the
complementary error function as:

erfc(x) := 1 − erf(x)

Truncation and round-off functions 

 These functions all have in common the fact that they extract something from
their arguments. 

The functions Re, Im, and arg extract the corresponding part of a complex num-
ber. For more information on these functions, see Chapter 7, “Variables and
Constants.”

The functions ceil and floor will return the next integer above and below their ar-
guments respectively. You can use these functions to create a function that re-
turns just the mantissa of a number: 

mantissa(x) := x - floor(x) 

Figure 2 shows how you can use the floor and ceil functions to round off num-
bers.

Figure 2: Creating a round-off function.
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Re(z) Real part of z.

Im(z) Imaginary part of z.

arg(z) Argument of z: the value of θ when z is written as r⋅e i⋅θ. Result is
between −π and π.

floor(x) Greatest integer ≤ x (x real). 

ceil(x) Least integer ≥ x (x real).

mod(x, y) Remainder on dividing x by y. Result has same sign as x.

angle(x, y) Angle (in radians) from positive x-axis to the point (x, y) in the x-y
plane. Arguments must be real. Returns a value between zero and
2π.

Discrete transform functions

Mathcad contains a variety of functions for performing discrete transforms. All
these functions require vectors as arguments. When you define a vector v for use
with Fourier or wavelet transforms, be sure to start with v0. If you do not define
v0, Mathcad automatically sets it to zero. This can distort the results of the trans-
form functions.

Introduction to Discrete Fourier transforms 

    Mathcad comes with two types of Fourier transform pairs: fft / ifft and cfft / icfft.
These functions are discrete: they apply to and return vectors and matrices only.
You cannot use them with other functions. 

Use the fft and ifft functions if:

The data values in the time domain are real, and

the data vector has 2m elements.

Use the cfft and icfft functions in all other cases.

The first condition is required because the fft/ifft pair takes advantage of the fact
that, for real data, the second half of the transform is just the conjugate of the
first. Mathcad discards the second half of the result vector. This saves both time
and memory. The cfft/icfft pair does not assume symmetry in the transform. For
this reason, you must use this pair for complex valued data. Since the real num-
bers are just a subset of the complex numbers, you can use the cfft/icfft pair for
real numbers as well.
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The second condition is required because the fft/ifft Fourier transform pair uses a
highly efficient fast Fourier transform algorithm. In order to do so, the vector
you use with fft must have 2m elements. The cfft/icfft Fourier transform pair uses
an algorithm that permits vectors as well as matrices of arbitrary size. When you
use this transform pair with a matrix, you get back a two-dimensional Fourier
transform.

Note that if you used fft to get to the frequency domain, you must use ifft to get
back to the time domain. Similarly, if you used cfft to get to the frequency do-
main, you must use icfft to get back to the time domain.

Different sources use different conventions concerning the initial factor of the
Fourier transform and whether to conjugate the results of either the transform or
the inverse transform. The functions fft, ifft, cfft, and icfft use 1/√N  as a normaliz-
ing factor and a positive exponent in going from the time to the frequency do-
main. The functions FFT, IFFT, CFFT, and ICFFT use 1/N as a normalizing
factor and a negative exponent in going from the time to the frequency domain.
Be sure to use these functions in pairs. For example, if you used CFFT to go
from the time domain to the frequency domain, you must use ICFFT to transform
back to the time domain.

Fourier transforms on real data

With 2m real-valued data points, you can use the fft/ifft Fourier transform pair.
These functions take advantage of symmetry conditions present only when the
data is real. This saves both time and memory.

fft(v) This function returns the Fourier transform of a 2m element vector of
real data representing measurements at regular intervals in the time
domain. 

The vector v must have 2m elements. The result is a vector of 1 + 2m − 1 complex
coefficients representing values in the frequency domain. If v contains other
than 2m elements, Mathcad returns an error message.

The elements of the vector returned by fft satisfy the following equation:

cj = 
1

√n
 ∑ 
k = 0

n − 1

vk e 2πi( j/n)k

In this formula, n is the number of elements in v and i is the imaginary unit. 
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The elements in the vector returned by the fft function correspond to different
frequencies. To recover the actual frequency, you must know the sampling fre-
quency of the original signal. If v is an n element vector passed to the fft func-
tion, and the sampling frequency is fs, the frequency corresponding to ck is 

fk = 
k
n

 ⋅ fs

Note that this makes it impossible to detect frequencies above the sampling fre-
quency. This is a limitation not of Mathcad, but of the underlying mathematics
itself. In order to correctly recover a signal from the Fourier transform of its sam-
ples, you must sample the signal with a frequency of at least twice its band-
width. A thorough discussion of this phenomenon is outside the scope of this
manual but within that of any textbook on digital signal processing.

ifft(v) This function returns the inverse Fourier transform of a vector of data
representing values in the frequency domain. The inverse transform
will be pure real.

The vector v must have 1 + 2m elements for m integer. The result is a vector of
2m + 1 complex coefficients representing values in the frequency domain. If v
contains other than 1 + 2m elements, Mathcad returns an error message.

The argument v is a vector similar to those generated by the fft function. To com-
pute the result, Mathcad first creates a new vector w by taking the conjugates of
the elements of v and appending them to the vector v. Then Mathcad computes a
vector d whose elements satisfy this formula:

dj = 
1

√n
 ∑ 
k = 0

n − 1

wk e −2πi( j/n)k

This is the same formula as the fft formula, except for the minus sign in the exp
function. The fft and ifft functions are exact inverses. For all real v,
ifft(fft(v)) = v.

Fourier transforms on complex data

There are two reasons why you may not be able to use the fft/ifft transform pair
discussed in the previous section:

The data may be complex valued. This means that Mathcad can no longer ex-
ploit the symmetry present in the real valued case.

The data vector might not have 2m data points in it. This means Mathcad can-
not take advantage of the highly efficient FFT algorithm used by the fft/ifft
Fourier transform pair.
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Complex Fourier transforms require the following functions:

cfft(A) Returns the fast Fourier transform of a vector or matrix of complex
data representing equally spaced measurements in the time domain.
The array returned is the same size as the array you used as an argu-
ment.

icfft(A) Returns the inverse Fourier transform of a vector or matrix of data
representing values in the frequency domain. The result is an array
representing values in the time domain. The icfft function is the in-
verse of the cfft function. Like cfft, this function returns an array of
the same size as its argument.

Although the cfft/icfft Fourier transform pair will work on arrays of any size,
they work significantly faster when the number of rows and columns contains
many smaller factors. Vectors with length 2m fall into this category. So do vec-
tors having lengths like 100 or 120. On the other hand, a vector whose length is
a large prime number will slow down the Fourier transform algorithm. 

The cfft and icfft functions are exact inverses. That is, icfft(cfft(v)) = v. Figure 3
shows an example of Fourier transforms in Mathcad.

When you use the cfft with a matrix, the result is the two-dimensional Fourier
transform of the input matrix.

Figure 3: Use of fast Fourier transforms in Mathcad.
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Alternate forms of the Fourier transform

The definitions for the Fourier transform discussed earlier are not the only ones
used. For example, the following definitions for the discrete Fourier transform
and its inverse appear in Ronald Bracewell’s The Fourier Transform and Its Ap-
plications (McGraw-Hill, 1986):

F(ν) = 
1
n

 ∑ 
τ = 1

n

f(τ)e−2πi(ν/n)τ

f(τ) = ∑ 
ν = 1

n

F(ν)e2πi(τ/n)ν

These definitions are very common in the engineering literature. To use these
definitions rather than those presented in the last section, use the functions FFT,
IFFT, CFFT, and ICFFT. These differ from those discussed in the last section as
follows:

Instead of a factor of 1/√n  in front of both forms, there is a factor of 1/n in
front of the transform and no factor in front of the inverse.

The minus sign appears in the exponent of the transform instead of in its in-
verse.

The functions FFT, IFFT, CFFT, and ICFFT are used in exactly the same way as
the functions discussed in the previous section. 

Wavelet transforms

 Mathcad PLUS includes two wavelet transforms for performing the one-dimen-
sional discrete wavelet transform and its inverse. The transform is performed us-
ing the Daubechies four-coefficient wavelet basis. 

⊕ wave(v) Returns the discrete wavelet transform of v, a 2m element vector
containing real data. The vector returned is the same size as v.

⊕ iwave(v) Returns the inverse discrete wavelet transform of v, a 2m element
vector containing real data. The vector returned is the same size as
v.
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Sorting functions 

      Mathcad includes three functions shown in Figure 4 for sorting arrays and one
for reversing the order of their elements:

sort(v) Returns the elements of the vector v sorted in ascending order.

csort(A, n) Sorts the rows of the matrix A so as to place the elements in col-
umn n in ascending order. The result has the same size as A.

rsort(A, n) Sorts the columns of the matrix A so as to place the elements in
row n in ascending order. The result has the same size as A.

reverse(v)
reverse(A)

Reverses the order of the elements of the vector v or the rows of
the matrix A.

The above sorting functions accept matrices and vectors with complex elements.
However in sorting them, Mathcad ignores the imaginary part.

To sort a vector or matrix in descending order, first sort in ascending order, then
use reverse. For example, reverse(sort(v)) returns the elements of v sorted in de-
scending order.

Unless you change the value of ORIGIN, matrices are numbered starting with
row zero and column zero. If you forget this, it’s easy to make the error of sort-
ing a matrix on the wrong row or column by specifying an incorrect n argument
for rsort and csort. To sort on the first column of a matrix, for example, you
must use csort(A, 0). 
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Figure 4: Sorting functions.

Piecewise continuous functions

Piecewise continuous functions are useful for branching and iteration. There are
five Mathcad functions falling into this category. The if function is useful for
choosing one of two values based on a condition. The Heaviside step function,
Φ(x), and the Kronecker Delta function, δ(m,n), are special cases of the if func-
tion. 

The until function is used to drive iteration. It is unique among Mathcad func-
tions because it is designed to work only with range variables. This is the only
Mathcad function which can actually halt iteration upon the occurrence of a con-
dition.

The last function is ε, the completely anti-symmetric tensor function. This re-
turns a 0, 1 or −1 depending on the permutation of its arguments. Although this
function is of limited applicability, it would be difficult to perform this function
using any other combination of Mathcad functions.

The if function

Use if to define a function that behaves one way below a certain number and be-
haves completely differently above that number. That point of discontinuity is
specified by its first argument, cond. The remaining two arguments let you spec-
ify the behavior of the function on either side of that discontinuity.

Piecewise continuous functions 279



if(cond, tval, fval) Returns tval if cond is nonzero (true)
Returns fval if cond is zero (false).

Although the argument cond can be any expression at all, it is usually more con-
venient to use a boolean expression from the table below. In the following table,
x and y must be real scalars, while w and z can be complex scalars.  

Condition How to type Description

w = z [Ctrl]= Boolean equals. Returns 1 if expressions are
equal; otherwise 0.

x > y > Greater than. 

x < y < Less than.

x ≥ y [Ctrl]0 Greater than or equal to. 

x ≤ y [Ctrl]9 Less than or equal to. 

w ≠ z [Ctrl]3 Not equal to. 

Note that boolean expressions involving inequalities cannot be used with com-
plex numbers. This is because it is meaningless to speak of one complex number
being “larger” or “smaller” than another.

To save time, Mathcad only evaluates those arguments it has to. For example, if
cond is false, there is no need to evaluate tval since it will not be returned any-
way. Because of this, errors in the unevaluated argument can escape detection.
For example, Mathcad will never detect the the fact that ln(0) is undefined in the
expression below:

if(|x| < 0,ln(0),ln(x))

Figure 5 shows several equations using the if function. You can combine
boolean operators to create more complicated conditions. For example, the con-
dition

(x < 1)⋅(x > 0)

acts like an “and” gate, returning 1 only if x is between 0 and 1. Similarly, the
expression

(x > 1) + (x < 0)

acts like an “or” gate, returning a 1 if either x > 1 or x < 0, but not if x is between
0 and 1.
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Figure 5: Conditionals in Mathcad.

The until function

  Mathcad’s until function allows you to halt an iteration when a particular condi-
tion is met. The until function has no effect when its first argument involves no
range variables. When the first argument does involve a range variable, Mathcad
will iterate until the first argument evaluates to a negative value. When this hap-
pens, Mathcad halts iteration.

until(x, z) Returns z until the test expression x becomes negative. x should be
an expression involving a range variable. 

Do not use the until function in equations with more than one range variable (for
example, multiple summations). Mathcad will halt all iteration on all range vari-
ables the first time that the first argument of until is negative. This usually does
not produce the desired result. 

The until function is useful in iterative processes with a specified convergence
condition. For example, Figure 6 shows how to use the until function to test an
iterative process for convergence. The iteration in the equation for xi continues
until xi is within err of a. Figure 6 also shows how to use the last function to de-
tect when iteration has halted and to compute the size of the resulting array.
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Figure 6: Using the until function to halt an iteration.

When you use the until function, be sure that the value of the test expression
does in fact change somewhere in the iteration. Otherwise, you may find your-
self in an infinite loop. If this does occur, press the [Esc] key to interrupt calcu-
lation.

Impulse and step functions

These two functions are special cases of the if function. The Heaviside step func-
tion is equivalent to:

Φ(x) := if(x < 0,0,1)

For integer m and n, the Kronecker delta function is equivalent to 

δ(m,n) := if(m = n,1,0)

Φ(x) Heaviside step function. 1 if x ≥ 0; otherwise, 0.

δ(m, n) Kronecker’s delta function. Returns 1 if m = n; otherwise, 0. Both
arguments must be integer.

You can use the Heaviside step function to define a pulse of width w by defining:

pulse(x,w) := Φ(x) - Φ(x-w) 

A lowpass and highpass filter having width 2⋅w could then be defined as:
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lowpass(x,w) := pulse(x+w, 2*w)

highpass(x,w) := 1 - pulse(x+w, 2*w)

Figure 7 illustrates the use of the Heaviside step function for creating filters.

Figure 7: Using the step function for filtering.

Antisymmetric tensor function

The arguments to this function are three integers between 0 and 2 inclusive. It
basically determines how many times you have to swap two numbers in order to
get back to the sequence [0, 1, 2] from whatever sequence [i, j, k] you passed to
it. 

More generally, ε(i, j, k) = 1 if [i, j, k] is an even permutation of [0, 1, 2] (an
even number of swaps), and ε(i, j, k) = −1 if [i, j, k] is an odd permutation of
[0, 1, 2] (an odd number of swaps). This explains why ε(0, 1, 2) = 1.

For example, ε(2, 0, 1) = 1 because to get from [2, 0, 1] back to [0, 1, 2] you’ll
have to swap twice. On the other hand, ε(0, 2, 1) = −1 because to get from
[0, 2, 1] back to [0, 1, 2] you only have to swap once. If two numbers are the
same, for example ε(0, 1, 1), you can never get back to [0, 1, 2], so the function
just returns 0. 

Although this function is not used very often, it is truly indispensable when you
need it. It is very difficult to perform this same feat using any other combination
of Mathcad functions.
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ε(i, j, k) Completely antisymmetric tensor of rank 3. i, j, and k must be inte-
gers between 0 and 2 inclusive (or between ORIGIN and ORIGIN+2
inclusive if ORIGIN ≠ 0). Result is 0 if any two are the same, 1 for
even permutations, −1 for odd permutations.
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Chapter 13
Statistical functions

This chapter lists and describes many of Mathcad’s built-in
functions. These functions perform a wide variety of
computational tasks, including statistical analysis, interpolation,
and regression. 

The following sections make up this chapter:

Population statistics
Functions for computing the mean, variance, standard deviation, and
correlation of sample data.

Probability distributions
Functions for evaluating probability densities, cumulative probability
distributions and their inverses for over a dozen common distribution
functions.

Histograms
How to count the number of data values falling into specified intervals.

Random numbers
Generating random numbers having various distributions.

Interpolation and prediction functions
Linear and cubic spline interpolation. Functions for multivariate inter-
polation.

Regression functions
Functions for linear regression, polynomial regression, and regression
using combinations of arbitrary functions.

Smoothing functions
Functions for smoothing time series with either a running median, a
Gaussian kernel, or an adaptive linear least squares method.
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Population statistics

 Mathcad includes six functions for population statistics. In the following descrip-
tions, m and n represent the number of rows and columns in the specified arrays.
In the formulas below, the built-in variable ORIGIN is set to its default value of
zero.

mean(A) Returns the mean of the elements of an m × n array A using the for-
mula:

mean(A) = 
1

mn
 ∑ 
i=0

m−1

  ∑ 
j=0

n−1

Ai, j

median(A) Returns the median of the elements of an m × n array A. This is the
value above and below which there are an equal number of values.
If A has an even number of elements, this is the arithmetic mean of
the two central values.

var(A) Returns the variance of the elements of an m × n array A using the
formula:

var(A) = 
1

mn
 ∑ 
i=0

m−1

  ∑ 
j=0

n−1

|Ai, j − mean(A)|2

cvar(A, B) Returns the covariance of the elements in the m × n arrays A and B
using the formula:

cvar(A, B) = 
1

mn
 ∑ 
i=0

m−1

  ∑ 
j=0

n−1

[Ai, j − mean(A)] [Bi, j − mean(B)]
______________

where the bar indicates complex conjugation.

stdev(A) Returns the standard deviation (square root of the variance) of the
elements of the m × n array A: 

stdev(A) = √var(A)

corr(A, B) Returns a scalar: the correlation coefficient (Pearson’s r) for the
two m × n arrays A and B.
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Probability distributions

Mathcad includes several functions for working with several common prob-
ability densities. These functions fall into three classes:

Probability densities: These give the likelihood that a random variable will
take on a particular value. 

Cumulative probability distributions: These give the probability that a ran-
dom variable will take on a value less than or equal to a specified value.
These are obtained by simply integrating (or summing when appropriate) the
corresponding probability density over an appropriate range. 

Inverse cumulative probability distributions: These functions take a prob-
ability as an argument and return a value such that the probability that a ran-
dom variable will be less than or equal to that value is whatever probability
you supplied as an argument.

Probability densities

These functions return the likelihood that a random variable will take on a par-
ticular value. The probability density functions are the derivatives of the corre-
sponding cumulative distribution functions discussed in the next section. 

⊕dbeta(x, s1, s2) Returns the probability density for the beta distribution:

Γ(s1 + s2)
Γ(s1)⋅Γ(s2)⋅x s1 − 1⋅(1 − x) s2 − 1

in which (s1, s2 > 0) are the shape parameters. (0 < x < 1).

dbinom(k, n, p) Returns P(X = k) when the random variable X has the binomial
distribution:

n!
k! (n − k)! p k (1 − p)n − k

in which n and k are integers satisfying 0 ≤ k ≤ n. p satisfies
0 ≤ p ≤ 1.

⊕ dcauchy(x, l, s) Returns the probability density for the Cauchy distribution:

(π s (1 + ((x − l) /s)2))−1

in which l is a location parameter and s > 0 is a scale parame-
ter.
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dchisq(x, d) Returns the probability density for the chi-squared distribution:

e−x/2

2Γ(d/2) 



x
2





(d/2 − 1)

in which d > 0 is the degrees of freedom and x > 0.

⊕ dexp(x, r) Returns the probability density for the exponential distribution:

re−rx

in which r > 0 is the rate and x > 0.

dF(x, d1, d2) Returns the probability density for the F distribution:

d1
 0.5d1 d2

 0.5d2 Γ((d1 + d2)/2) 
Γ(d1/2)Γ(d2/2) ⋅ x 0.5(d1 − 2)

(d2 + d1x) 0.5(d1 + d2)

in which d1,d2 > 0 are the degrees of freedom and x > 0.

⊕ dgamma(x, s) Returns the probability density for the Gamma distribution:

x s − 1e−x

Γ(s)

in which s > 0 is the shape parameter and x ≥ 0.

⊕ dgeom(k, p) Returns P(X = k) when the random variable X has the geomet-
ric distribution:

p (1 − p)k

in which 0 < p ≤ 1 is the probability of success and k is a non-
negative integer.

⊕ dlnorm(x, µ, σ) Returns the probability density for the log normal distribution:

1
√2πσx

exp



− 1

2σ2
(ln(x) − µ)2




⊕ dlogis(x, l, s) Returns the probability density for the logistic distribution:

exp(−(x − l ) /s)
s(1 + exp(−(x − l ) /s))2

in which l is the location parameter and s > 0 is the scale pa-
rameter.
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⊕ dnbinom(k, n, p) Returns P(X = k) when the random variable X has the negative
binomial distribution:




n + k − 1

k



 p n (1 − p) k

in which 0 < p ≤ 1 and n and k are integers, n > 0 and k ≥ 0

dnorm(x, µ, σ) Returns the probability density for the normal distribution:

1
√2πσexp




− 1

2σ2
(x − µ)2




in which µ and σ are the mean and standard deviation. σ > 0.

dpois(k, λ) Returns P(X = k) when the random variable X has the Poisson
distribution:

λk

k!
e−λ

in which λ > 0 and k is a nonnegative integer.

dt(x, d) Returns the probability density for the Student’s t distribution:

Γ((d + 1)/ 2)
Γ(d/ 2)√πd

 



1 + 

x 2

d





−0.5(d + 1)

in which d is the degrees of freedom, d > 0 and x is real.

dunif(x, a, b) Returns the probability density for the uniform distribution:
1

b − a
in which b and a are the endpoints of the interval with a < b
and a ≤ x ≤ b.

⊕ dweibull(x, s) Returns the probability density for the Weibull distribution:

sx s − 1 exp(−x s )

in which s > 0 is the shape parameter and x > 0.

Cumulative probability distributions

These functions return the probability that a random variable is less than or
equal to a specified value. The cumulative probability distribution is simply the
probability density function integrated from −∞ to the specified value. For inte-
ger random variables, the integral is replaced by a summation over the appropri-
ate range.
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The probability density functions corresponding to each of the following cumu-
lative distributions are given in the section “Probability distributions” beginning
on page 287.

Figure 1 at the end of this section illustrates the relationship between these three
functions.

cnorm(x) Returns the cumulative standard normal distribution function.
Equivalent to pnorm(x, 0, 1).

⊕ pbeta(x, s1, s2) Returns the cumulative beta distribution with shape parame-
ters s1 and s2. (s1, s2 > 0).

pbinom(k, n, p) Returns the cumulative binomial distribution for k successes
in n trials. n is a positive integer. p is the probability of suc-
cess, 0 ≤ p ≤ 1.

⊕ pcauchy(x, l, s) Returns the cumulative Cauchy distribution with scale parame-
ter s and location parameter l. s > 0.

pchisq(x, d) Returns the cumulative chi-squared distribution in which d > 0
is the degrees of freedom.

⊕ pexp(x, r) Returns the cumulative exponential distribution in which r > 0
is the rate.

pF(x, d1, d2) Returns the cumulative F distribution in which d1,d2 > 0 are
the degrees of freedom.

⊕ pgamma(x, s) Returns the cumulative Gamma distribution in which s > 0 is
the shape parameter.

⊕ pgeom(k, p) Returns the cumulative geometric distribution. p is the prob-
ability of success. 0 < p ≤ 1.

⊕ plnorm(x, µ, σ) Returns the cumulative log normal distribution. This is the dis-
tribution whose natural log is a normal distribution having
mean µ and standard deviation σ > 0.

⊕ plogis(x, l, s) Returns the cumulative logistic distribution. l is the location
parameter. s > 0 is the scale parameter.

⊕ pnbinom(k, n, p) Returns the cumulative negative binomial distribution in
which 0 < p ≤ 1. n must be a positive integer.

pnorm(x, µ, σ) Returns the cumulative normal distribution with mean µ and
standard deviation σ. σ > 0.

ppois(k, λ) Returns the cumulative Poisson distribution. λ > 0.

pt(x, d) Returns the cumulative Student’s t distribution. d is the de-
grees of freedom. d > 0.
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punif(x, a, b) Returns the cumulative uniform distribution. b and a are the
endpoints of the interval. a < b.

⊕ pweibull(x, s) Returns the cumulative Weibull distribution. s > 0.

Inverse cumulative probability distributions

These functions take a probability p as an argument and return the value of x
such that P(X ≤ x) = p. 

The probability density functions corresponding to each of the following inverse
cumulative distributions are given in the section “Probability distributions” be-
ginning on page 287.

⊕qbeta(p, s1, s2) Returns the inverse beta distribution with shape parameters s1
and s2. (0 ≤ p ≤ 1) (s1, s2 > 0).

qbinom(p, n, r) Returns the number of successes in n trials of the Bernoulli
process such that the probability of at most that number of suc-
cesses is p. r is the probability of success on a single trial.
0 ≤ r ≤ 1 and 0 ≤ p ≤ 1. n must be an integer greater than zero.

⊕ qcauchy(p, l, s) Returns the inverse Cauchy distribution with scale parameter s
and location parameter l. s > 0. 0 < p < 1.

qchisq(p, n) Returns the inverse chi-squared distribution in which d > 0 is
the degrees of freedom. 0 ≤ p < 1.

⊕ qexp(p, r) Returns the inverse exponential distribution in which r > 0 is
the rate. 0 ≤ p < 1.

qF(p, d1, d2) Returns the inverse F distribution in which d1,d2 > 0 are the
degrees of freedom. 0 ≤ p < 1.

⊕ qgamma(p, s) Returns the inverse Gamma distribution in which s > 0 is the
shape parameter. 0 ≤ p < 1.

⊕ qgeom(p, r) Returns the inverse geometric distribution. r is the probability
of success on a single trial. 0 < p < 1 and 0 < r < 1.

⊕ qlnorm(p, µ, σ) Returns the inverse log normal distribution. The log normal
distribution is a distribution whose natural log is the normal
distribution having mean µ and standard deviation σ > 0.
0 ≤ p < 1.

⊕ qlogis(p, l, s) Returns the inverse logistic distribution. l is the location pa-
rameter. s > 0 is the scale parameter. 0 < p < 1.

⊕ qnbinom(p, n, r) Returns the inverse negative binomial distribution with size n
and probability of success r. 0 < r ≤ 1 and 0 ≤ p ≤ 1.
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qnorm(p, µ, σ) Returns the inverse normal distribution with mean µ and stand-
ard deviation σ. 0 < p < 1 and σ > 0.

qpois(p, λ) Returns the inverse Poisson distribution. λ > 0 and 0 ≤ p ≤ 1.

qt(p, d) Returns the inverse Student’s t distribution. d is the degrees of
freedom. d > 0 and 0 < p < 1.

qunif(p, a, b) Returns the inverse uniform distribution. b and a are the end-
points of the interval. a < b and 0 ≤ p ≤ 1.

⊕ qweibull(p, s) Returns the inverse Weibull distribution. s > 0 and 0 < p < 1.

Figure 1: Relationship between probability densities, cumulative distributions
and their inverses.
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Histogram function

Mathcad includes one function, hist, for computing frequency distributions for
histograms:

hist(int, A) Returns a vector representing the frequencies with which values in
A fall in the intervals represented by the int vector. The elements
in both int and A must be real. In addition, the elements of int
must be in ascending order. The resulting vector is one element
shorter than int.

Mathcad interprets int as a set of points defining a sequence of intervals in a his-
togram. The values in int must should be in ascending order. The result of this
function is a vector f, in which fi is the number of values in A satisfying the con-
dition:

int i ≤ value < int i + 1

Mathcad ignores data points less than the first value in int or greater than the
last value in int. Figure 2 shows how to use histograms in Mathcad.

Figure 2: A histogram.
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Random numbers 

 Mathcad comes with a number of functions for generating random numbers hav-
ing a variety of probability distributions. The functional forms of the distribu-
tions associated with the following functions are given in the section
“Probability distributions” beginning on page 287.

⊕ rbeta(m, s1, s2) Returns a vector of m random numbers having the beta distri-
bution. s1,s2 > 0 are the shape parameters.

rbinom(m, n, p) Returns a vector of m random numbers having the binomial
distribution. 0 ≤ p ≤ 1. n is an integer satisfying n > 0.

⊕ rcauchy(m, l, s) Returns a vector of m random numbers having the Cauchy dis-
tribution. s > 0 is the scale parameter. l is the location parame-
ter.

rchisq(m, d) Returns a vector of m random numbers having the chi-squared
distribution. d > 0 is the degrees of freedom.

⊕ rexp(m, r) Returns a vector of m random numbers having the exponential
distribution. r > 0 is the rate.

rF(m, d1, d2) Returns a vector of m random numbers having the F distribu-
tion. d1,d2 > 0 are the degrees of freedom.

⊕ rgamma(m, s) Returns a vector of m random numbers having the gamma dis-
tribution. s > 0 is the shape parameter.

⊕ rgeom(m, p) Returns a vector of m random numbers having the geometric
distribution. 0 < p ≤ 1.

⊕ rlnorm(m, µ, σ ) Returns a vector of m random numbers having the log normal
distribution. This is the distribution whose log is the normal
distribution having mean µ and standard deviation σ > 0.

⊕ rlogis(m, l, s) Returns a vector of m random numbers having the logistic dis-
tribution in which l is the location parameter and s > 0 is the
scale parameter.

⊕ rnbinom(m, n, p) Returns a vector of m random numbers having the negative bi-
nomial distribution. 0 < p ≤ 1. n is an integer satisfying n > 0.

rnorm(m, µ, σ) Returns a vector of m random numbers having the normal dis-
tribution. σ > 0.

rpois(m, λ) Returns a vector of m random numbers having the Poisson dis-
tribution. λ > 0.

rt(m, d) Returns a vector of m random numbers having the Student’s t
distribution. d > 0.
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runif(m, a, b) Returns a vector of m random numbers having the uniform dis-
tribution in which b and a are the endpoints of the interval and
a < b.

rnd(x) Returns a uniformly distributed random number between 0
and x. Equivalent to runif(1, 0, x).

⊕ rweibull(m, s) Returns a vector of m random numbers having the Weibull dis-
tribution in which s > 0 is the shape parameter.

Each time you recalculate an equation containing one of these functions, Math-
cad generates new random numbers. To force Mathcad to generate new random
numbers, click on the equation containing the function and choose Calculate
from the Math menu. Figure 3 shows an example of how to use Mathcad’s ran-
dom number generator. Figure 4 shows how to generate a large vector of ran-
dom numbers having a specified distribution.

These functions have a “seed value” associated with them. Each time you reset
the seed, Mathcad generates new random numbers based on that seed. A given
seed value will always generate the same sequence of random numbers. Choos-
ing Calculate from the Math menu advances Mathcad along this random num-
ber sequence. Changing the seed value however, advances Mathcad along an
altogether different random number sequence.

To change the seed value, choose Options ⇒Randomize from the Math menu
and change the value of “seed” in the dialog box. Be sure to supply an integer.

To reset Mathcad’s random number generator without changing the seed value,
choose Options ⇒Randomize from the Math menu and click “OK” to accept
the current seed. Then click on the equation containing the random number gen-
erating function and choose Calculate from the Math menu. Since the random-
izer has been reset, Mathcad generates the same random numbers it would
generate if you restarted Mathcad.
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Figure 3: Uniformly distributed random numbers. Since the random number gen-
erator generates different numbers every time, it’s unlikely that you’ll be able to
reproduce this example exactly as you see it here.

Figure 4: A vector of normally distributed random numbers. Since the random
numbers are different every time, it’s unlikely that you’ll be able to reproduce
this example exactly as you see it here.

296 Chapter 13  Statistical functions



If you want to check a test case several times with the same random numbers, re-
set the random number generator between calculations as described above.

To see a new set of random numbers, change the seed value as described above.
This causes Mathcad to generate a different set of random numbers from what
you see when you start Mathcad. Each time you want to reset Mathcad to regen-
erate these random numbers, reset the seed as described above. To see a differ-
ent set of random numbers, change the seed value.

Interpolation and prediction functions 

   Interpolation involves using existing data points to predict values between these
data points. Mathcad allows you to either connect the data points with straight
lines (linear interpolation) or to connect them with sections of a cubic polyno-
mial (cubic spline interpolation).

Unlike the regression functions discussed in the next section, these interpolation
functions return a curve which must pass through the points you specify. Be-
cause of this, the resulting function is very sensitive to spurious data points. If
your data is noisy, you should consider using the regression functions instead.

Linear prediction involves using existing data values to predict values beyond
the existing ones. Mathcad provides a function which allows you to predict fu-
ture data points based on past data points.

Whenever you use arrays in any of the functions described in this section, be
sure that every element in the array contains a data value. Since every element
in a array must have a value, Mathcad assigns 0 to any elements you have not ex-
plicitly assigned.

Linear interpolation

 In linear interpolation, Mathcad connects the existing datapoints with straight
lines. This is accomplished by the linterp function described below.

linterp(vx, vy, x) Uses the data vectors vx and vy to return a linearly interpo-
lated y value corresponding to the third argument x. The argu-
ments vx and vy must be vectors of the same length. The
vector vx must contain real values in ascending order. 

To find the interpolated value for a particular x, Mathcad finds the two points be-
tween which the value falls and returns the corresponding y value on the straight
line between the two points. 
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For x values before the first point in vx, Mathcad extrapolates the straight line
between the first two data points. For x values beyond the last point in vx, Math-
cad extrapolates the straight line between the last two data points. 

For best results, the value of x should be between the largest and smallest values
in the vector vx. The linterp function is intended for interpolation, not extrapola-
tion. Consequently, computed values for x outside this range are unlikely to be
useful. Figure 5 shows some examples of linear interpolation. 

Figure 5: Examples of linear interpolation. Since the random number generator
gives different numbers every time, you may not be able to recreate this exam-
ple exactly as you see it.

Cubic spline interpolation

    Cubic spline interpolation lets you pass a curve through a set of points in such a
way that the first and second derivatives of the curve are continuous across each
point. This curve is assembled by taking three adjacent points and constructing a
cubic polynomial passing through those points. These cubic polynomials are
then strung together to form the completed curve.

To fit a cubic spline curve through a set of points: 

Create the vectors vx and vy containing the x and y coordinates through
which you want the cubic spline to pass. The elements of vx should be in as-
cending order. (Although we use the names vx, vy and vs, there is nothing
special about these variable names; you can use whatever names you prefer in
your own work.)
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Generate the vector vs := cspline(vx,vy) The vector vs is a vector of interme-
diate results designed to be used with interp.

To evaluate the cubic spline at an arbitrary point, say x0, evaluate
interp(vs, vx, vy, x0) where vs, vx and vy are the vectors described earlier.

Note that you could have accomplished the same task by evaluating:

interp(cspline(vx, vy), vx, vy, x0)

As a practical matter though, you’ll probably be evaluating interp for many dif-
ferent points. Since the call to cspline can be time-consuming, and since the re-
sult won’t change from one point to the next, it makes sense to do it once and
just keep re-using the result as described above.

Figure 6 shows how to compute the spline curve for the example in Figure 5.

Figure 6: Spline curve for the points stored in x and y. Since the random number
generator gives different numbers every time, you may not be able to recreate
this example exactly as you see it.

Here is a description of the steps involved in the example in Figure 6:

The equation with the cspline function computes the array vs containing, among
other things, the second derivatives for the spline curve used to fit the points in
vx and vy.

Once the vs array is computed, the interp function computes the interpolated val-
ues of the curve.
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Note that the vs array needs to be computed only once, even for multiple interpo-
lations. Since the spline calculations that lead to vs are time-consuming, it is
more efficient to store these intermediate results as a vector than it is to recalcu-
late them as needed.

In addition to cspline, Mathcad comes with two other cubic spline functions.
The three spline functions are:

cspline(vx, vy)
pspline(vx, vy)
lspline(vx, vy)

These all return a vector of intermediate results which we’ll
call vs. This vector, vs, is used in the interp function described
below. The arguments vx and vy must be real vectors of the
same length. The values in vx must be real and in ascending
order. 

These three functions differ only in the boundary conditions:

The lspline function generates a spline curve that approaches a straight line at
the endpoints.

The pspline function generates a spline curve that approaches a parabola at
the endpoints.

The cspline function generates a spline curve that can be fully cubic at the
endpoints.

interp(vs, vx, vy, x) Returns the interpolated y value corresponding to the
argument x. The vector vs is a vector of intermediate
results obtained by evaluating lspline, pspline, or
cspline using the data vectors vx and vy.

To find the interpolated value for a particular x, Mathcad finds the two points be-
tween which it falls. It then returns the y value on the cubic section enclosed by
these two points. For x values before the first point in vx, Mathcad extrapolates
the cubic section connecting the first two points of vx. Similarly, for x values be-
yond the last point in vx, Mathcad extrapolates the cubic section connecting the
last two points of vx. 

For best results, do not use the interp function on values of x far from the fitted
points. Splines are intended for interpolation, not extrapolation. Consequently,
computed values for such x values are unlikely to be useful.
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Interpolating a vector of points

You can use the vectorize operator to return a whole vector of interpolated val-
ues corresponding to a vector of data points. This works with both interp and lin-
terp.

Figure 7 shows how to perform this operation. To apply the vectorize operator
to the function, click on the function name and press [Space] until the function
is between the two editing lines. Then press [Ctrl]- (hold down the [Ctrl]
key and press the minus sign).

Figure 7: Interpolating a vector of points. Note that since these are random num-
bers, it’s unlikely you’ll be able to reproduce this example exactly as you see
here.

Mutivariate cubic spline interpolation

      Mathcad handles two dimensional cubic spline interpolation in much the same
way as the one-dimensional case discussed earlier. Instead of passing a curve
through a set of points in such a way that the first and second derivatives of the
curve are continuous across each point, Mathcad passes a surface through a grid
of points. This surface corresponds to a cubic polynomial in x and y in which the
first and second partial derivatives are continuous in the corresponding direction
across each grid point.
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The first step in two-dimensional spline interpolation is exactly the same as that
in the one-dimensional case: specify the points through which the surface is to
pass. The procedure, however, is more complicated because you now have to
specify a grid of points:   

Create the n × 2 matrix Mxy whose elements, Mxyi, 0 and Mxyi, 1 specify the
x and y coordinates along the diagonal of a rectangular grid. This matrix
plays the exactly the same role as vx in the one-dimensional case described
earlier. Since these points describe a diagonal, the elements in each column of
Mxy be in ascending order (Mxyi,k < Mxyj,k whenever i < j).

Create the n × n matrix Mz whose ijth element is the z coordinate correspond-
ing to the point x = Mxyi,0 and y = Mxyj,1. This plays exactly the same role as
vy in the one-dimensional case described earlier.

Generate the vector vs := cspline(Mxy, Mz) The vector vs is a vector of inter-
mediate results designed to be used with interp.

To evaluate the cubic spline at an arbitrary point, say (x0, y0) evaluate 

interp(vs, Mxy, Mz, 

x0
y0




 ) 

where vs, Mxy and Mz are the arrays described earlier. The result is the
value of the interpolating surface corresponding to the arbitrary point
(x0, y0).

Note that you could have accomplished exactly the same task by evaluating:

interp(cspline(Mxy, Mz), Mxy, Mz, 

x0
y0




 ) 

As a practical matter though, you’ll probably be evaluating interp for many dif-
ferent points. Since the call to cspline can be time-consuming, and since the re-
sult won’t change from one point to the next, it makes sense to call it once and
just keep re-using the result as described above.

In addition to cspline, Mathcad comes with two other cubic spline functions.
The three spline functions are:

cspline(Mxy, Mz)
pspline(Mxy, Mz)
lspline(Mxy, Mz)

These all return a vector of intermediate results
which we’ll call vs. This vector, vs, is used in the in-
terp function described below. Mxy is an n × 2 ma-
trix whose elements Mxyi,0 and Mxyi,1 specify points
on the diagonal of an n × n grid. The ij th element of
the n × n matrix Mz specifies the value of the interpo-
lating surface at (Mxyi,0, Mxyj,1).
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These three functions differ only in the boundary conditions:

The lspline function generates a spline curve that approaches a plane along
the edges.

The pspline function generates a spline curve that approaches a second de-
gree polynomial in x and y along the edges.

The cspline function generates a spline curve that that approaches a third de-
gree polynomial in x and y along the edges.

interp(vs, Mxy, Mz, v) Returns the interpolated z value corresponding to the
point x = v0 and y = v1. The vector vs comes from
evaluating lspline, pspline, or cspline using the data
matrices Mxy and Mz.

For best results, do not use the interp function on values of x and y far from the
grid points. Splines are intended for interpolation, not extrapolation. Conse-
quently, computed values for such x and y values are unlikely to be useful.

Linear prediction

  The functions described so far in this section allow you to find data points lying
between existing data points. However, you may need to find data points that lie
beyond your existing ones. Mathcad provides the function predict which uses
some of your existing data to predict data points lying beyond the existing ones.
This function uses a linear prediction algorithm which is useful when your data
is smooth and oscillatory, though not necessarily periodic. Linear prediction can
be seen as a kind of extrapolation method but should not be confused with linear
or polynomial extrapolation.

⊕ predict(v, m, n) Returns n predicted values based on m consecutive
values from the data vector v. Elements in v should
represent samples taken at equal intervals.

The predict function uses the last m of the original data values to compute pre-
diction coefficients. Once it has these coefficients, it uses the last m points to
predict the coordinates of the (m + 1)th point, in effect creating a moving win-
dow m points wide.
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Figure 8: Using predict to find future data values.

Regression functions

  Mathcad includes a number of functions for performing regression. Typically,
these functions generate a curve or surface of a specified type which in some
sense minimizes the error between itself and the data you supply. The functions
differ primarily in the type of curve or surface they use to fit the data. 

Unlike the interpolation functions discussed in the previous section, these func-
tions do not require that the fitted curve or surface pass through the data points
you supply. The regression functions in this section are therefore far less sensi-
tive to spurious data than the interpolation functions.

Unlike the smoothing functions in the next section, the end result of a regression
is an actual function, one that can be evaluated at points in between the points
you supply. 

Whenever you use arrays in any of the functions described in this section, be
sure that every element in the array contains a data value. Since every element
in a array must have a value, Mathcad assigns 0 to any elements you have not ex-
plicitly assigned.
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Linear regression

These functions return the slope and intercept of the line that best fits your data
in a least square sense. If you place your x values in the vector vx and your sam-
pled y values in vy, that line is given by:

y = slope(vx, vy)⋅x + intercept(vx, vy)

Figure 9 shows how you can use these functions to fit a line through a set of
data points.

slope(vx, vy) Returns a scalar: the slope of the least-squares regres-
sion line for the data points in vx and vy.

intercept(vx, vy) Returns a scalar: the y-intercept of the least-squares
regression line for the data points in vx and vy. 

These functions are useful not only when your data is inherently linear but when
it is exponential as well. More specifically, if your x and y are related by:

y = Aekx

You can apply these functions to the log of your data values and make use of the
fact that:

log( y) = log(A) + kx

In which case:

A  = exp(intercept(vx, vy)) and k = slope(vx, vy)

The resulting fit weighs the errors differently from a least-squares exponential
fit but is usually a good approximation.
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Figure 9: Using slope and intercept for linear regression.

Polynomial regression

These functions are useful when you have set of measured y values correspond-
ing to x values and you want to fit a polynomial through those y values.   

Use regress when you want to use a single polynomial to fit all your data values.
The regress function lets you fit a polynomial of any order. However as a practi-
cal matter, you would rarely need to go beyond n = 4. 

Since regress tries to accommodate all your data points using a single polyno-
mial, it will not work well when your data does not behave like a single polyno-
mial. For example, suppose you expect your yi to be linear from x1 to x10 and to
behave like a cubic equation from x11 to x20. If you use regress with n = 3 (a cu-
bic), you may get a good fit for the second half but a terrible fit for the the first
half.

The loess function alleviates these kinds of problems by performing a more lo-
calized regression. Instead of generating a single polynomial the way regress
does, loess generates a different second order polynomial depending on where
you are on the curve. It does this by examining the data in a small neighborhood
of the point you’re interested in. The argument span controls the size of this
neighborhood. As span gets larger, loess becomes equivalent to regress with
n = 2. A good default value is span = 0.75. 

Figure 10 shows how span affects the fit generated by the loess function. Note
how a smaller value of span makes the fitted curve track fluctuations in data
more effectively. A larger value of span tends to smear out fluctuations in data
and generate a smoother fit.
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regress(vx, vy, n) A vector required by the interp function to find the
nth order polynomial that best fits data vectors vx and
vy. vx is an m element vector containing x coordi-
nates. vy is an m element vector containing the y co-
ordinates corresponding to the m points specified in
vx. 

⊕ loess(vx, vy, span) A vector required by the interp function to find the
set of second order polynomials that best fit particu-
lar neighborhoods of data points specified in vectors
vx and vy. vx is an m element vector containing x co-
ordinates. vy is an m element vector containing the y
coordinates corresponding to the m points specified
in vx. The argument span, (span > 0), specifies how
large a neighborhood loess will consider in perform-
ing this local regression. 

interp(vs, vx, vy, x) Returns the interpolated y value corresponding to the
x. The vector vs comes from evaluating loess or re-
gress using the data matrices vx and vy.

Figure 10: Effect of different spans on the loess function. Note that since these
are random numbers, it’s unlikely you’ll be able to reproduce this example ex-
actly as you see here.
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Multivariate polynomial regression

The loess and regress functions discussed in the previous section are also useful
when you have set of measured z values corresponding to x and y values and
you want to fit a polynomial surface through those z values.    

The properties of these functions are described in the previous section. When us-
ing these functions to fit z values corresponding to two independent variables x
and y, the meanings of the arguments must be generalized. Specifically:

The argument vx which was an m-element vector of x values becomes an m-
row and 2 column array, Mxy. Each row of Mxy contains an x in the first col-
umn and a corresponding y value in the second column.

The argument x for the interp function becomes a 2-element vector v whose
elements are the x and y values at which you want to evaluate the polynomial
surface representing the best fit to the data points in Mxy and vz.

regress(Mxy, vz, k) A vector required by the interp function to find the
kth order polynomial that best fits data arrays Mxy
and vz. Mxy is an m × 2 matrix containing x-y coordi-
nates. vz is an m element vector containing the z coor-
dinates corresponding to the m points specified in
Mxy. 

⊕ loess(Mxy, vz, span) A vector required by the interp function to find the
set of second order polynomials that best fit particu-
lar neighborhoods of data points specified in arrays
Mxy and vz. Mxy is an m × 2 matrix containing x-y
coordinates. vz is an m element vector containing the
z coordinates corresponding to the m points specified
in Mxy. The argument span (span > 0 specifies how
large a neighborhood loess will consider in perform-
ing this local regression.) 

interp(vs, Mxy, vz, v) Returns the interpolated z value corresponding to the
point x = v0 and y = v1. The vector vs comes from
evaluating loess or regress using the data matrices
Mxy and vz.

You can add independent variables by simply adding columns to the Mxy array.
You would then add a corresponding number of rows to the vector v that you
pass to the interp function. The regress function can have as many independent
variables as you want. However, regress will calculate more slowly and require
more memory when the number of independent variables and the degree are
greater than four. The loess function is restricted to at most four independent
variables.
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Keep in mind that for regress, the number of data values, m must satisfy

m > 

n + k − 1

k



 ⋅ n + k

n

where n is the number of independent variables (hence the number of columns
in Mxy), k is the degree of the desired polynomial, and m is the number of data
values (hence the number of rows in vz). For example, if you have five explana-
tory variables and a fourth degree polynomial, you will need more than 126 ob-
servations. 

Generalized regression
Unfortunately, not all data sets can be modeled by lines or polynomials. There
are times when you need to model your data with a linear combination of arbi-
trary functions, none of which represent terms of a polynomial. For example, in
a Fourier series you try to approximate data using a linear combination of com-
plex exponentials. Or you may believe your data can be modeled by a weighted
combination of Legendre polynomials, but you just don’t know what weights to
assign.  

The linfit function is designed to solve these kinds of problems. If you believe
your data could be modeled by a linear combination of arbitrary functions:

y = a0⋅f0(x) + a1⋅f1(x) + . . . + an⋅fn(x)

you should use linfit to evaluate the ai. Figure 11 shows an example in which a
linear combination of three functions: x, x2, and (x + 1)−1 is used to model some
data.

There are times however when the flexibility of linfit is still not enough. Your
data may have to be modeled not by a linear combination of data but by some
function whose parameters must be chosen. For example, if your data can be
modeled by the sum: 

f(x) = a1⋅sin(2x) + a2⋅tanh(3x)

and all you need to do is solve for the unknown weights a1 and a2, then you
have a linfit type of problem.

By contrast, if instead your data is to be modeled by the sum:

f(x) = 2⋅sin(a1x) + 3⋅tanh(a2x)

and you now have to solve for the unknown parameters a1 and a2, you would
have a genfit problem. 
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Anything you can do with linfit you can also do, albeit less conveniently, with
genfit. The difference between these two functions is the difference between
solving a system of linear equations and solving a system of nonlinear equa-
tions. The former is easily done using the methods of linear algebra. The latter is
far more difficult and generally must be solved by iteration. This explains why
genfit needs a vector of guess values as an argument and linfit does not.

Figure 12 shows an example in which genfit is used to find the exponent that
best fits a set of data. 

linfit(vx, vy, F) Returns a vector containing the coefficients used to
create a linear combination of the functions in F
which best approximates the data in vectors vx and
vy. F is a function which returns a vector consisting
of the functions to be linearly combined.

⊕ genfit(vx, vy, vg, F) A vector containing the parameters that make a func-
tion f of x and n parameters u0,u1,...,un − 1 best ap-
proximate the data in vx and vy. F is a function that
returns an n + 1 element vector containing f and its
partial derivatives with respect to its n parameters. vg
is an n-element vector of guess values for the n pa-
rameters.

Figure 11:  Using linfit to find coefficients for a linear combination of functions
that best fits the data. 

310 Chapter 13  Statistical functions



Figure 12:  Using genfit for finding the parameters of a function so that it best
fits the data.

Smoothing functions

Smoothing involves taking a set of y (and possibly x) values and returning a new
set of y values that is smoother than the original set. Unlike the regression and
interpolation functions discussed earlier, smoothing results in a new set of y val-
ues, not a function that can be evaluated between the data points you specify.
Thus, if you are interested in y values between the y values you specify, you
should use a regression or interpolation function.

Whenever you use vectors in any of the functions described in this section, be
sure that every element in the vector contains a data value. Since every element
in a vector must have a value, Mathcad assigns 0 to any elements you have not
explicitly assigned.

The medsmooth function is the most robust of the three since it is least likely to
be affected by spurious data points. This function uses a running median
smoother, computes the residuals, smoothes the residuals the same way, and
adds these two smoothed vectors together. The details are as follows:

Evaluation of medsmooth(vy, n) begins with the running median of the input
vector vy. We’ll call this vy′. The ith element is given by:
vy′i = median(vyi−n−1

2
, . . . vyi, . . . vyi+n−1

2
).

It then evaluates the residuals: vr = vy − vy′.
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The residual vector, vr, is smoothed using the same procedure described in
step 1. This creates a smoothed residual vector, vr ′.

The medsmooth function returns the sum of these two smoothed vectors:
medsmooth(vy, n) = vy′ + vr ′.

Note that medsmooth will leave the first and last (n − 1)/2 points unchanged. In
practice, the length of the smoothing window, n, should be small compared to
the length of the data set.

The ksmooth function uses a Gaussian kernel to compute local weighted aver-
ages of the input vector vy. This smoother is most useful when your data lies
along a band of relatively constant width. If your data lies scattered along a band
whose width fluctuates considerably, you should use an adaptive smoother like
supsmooth.

For each vyi in the n-element vector vy, the ksmooth function returns a new vy′i
given by:

vy′i = 

∑ 
j=1

n

K




vxi − vxj

b




 vyj

∑ 
j=1

n

K




vxi − vxj

b





where:

K(t) = 
1

√2π⋅(0.37)
⋅exp




− t2

2⋅(0.37)2




and b is a bandwidth which you supply to the ksmooth function. The bandwidth
is usually set to a few times the spacing between data points on the x axis de-
pending on how big a window you want to use when smoothing.

The supsmooth function uses a symmetric k nearest neighbor linear least square
fitting procedure to make a series of line segments through your data. Unlike
ksmooth which uses a fixed bandwidth for all your data, supsmooth will adap-
tively choose different bandwidths for different portions of your data. 
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medsmooth(vy, n) Returns an m-element vector created by smoothing
vy with running medians. vy is an m-element vector
of real numbers. n is the width of the window over
which smoothing occurs. n must be an odd number
less than the number of elements in vy.

⊕ ksmooth(vx,vy, b) Returns an n-element vector created by using a
Gaussian kernel to return weighted averages of vy.
vy and vx are n-element vectors of real numbers. The
bandwidth b controls the smoothing window and
should be set to a few times the spacing between
your x data points.

⊕ supsmooth(vx,vy) Returns an n-element vector created by the piecewise
use of a symmetric k-nearest neighbor linear least
square fitting procedure in which k is adaptively cho-
sen. vy and vx are n-element vectors of real numbers.
The elements of vx must be in increasing order.

Figure 13: Smoothing noisy data with supsmooth.
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Chapter 14
Programming

With Mathcad PLUS, you’ll be able to write your own programs. A
Mathcad program is an expression which is itself made up of other
expressions. A Mathcad program has many attributes associated
with programming languages including conditional branching,
looping constructs, local scoping of variables, the ability to use
other programs as subroutines, and the ability to call itself
recursively.

Mathcad programs make it easy to do tasks that are either
impossible or very inconvenient to do in any other way.

This chapter contains the following sections:

Defining a program
How to create simple programs. Local assignment statements.

Conditional statements
Using a condition to suppress execution of a statement.

Looping
Using “while” loops and “for” loops to control iteration.

Programs within programs
Using subroutines and recursion in a Mathcad program.

Programming examples
A sampling of programs illustrating useful techniques and displaying
some of the power of Mathcad’s approach to programming.
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Defining a program

A Mathcad program is a special kind of Mathcad expression. Like any expres-
sion, a program returns a value when followed by an equals sign. Just as you can
define a variable or function in terms of an expression, you can also define it in
terms of a program.

The main difference between a program and an expression is the way you tell
Mathcad how to compute an answer. When you use an expression, you have to
describe how to compute the answer in one statement. But when you use a pro-
gram, you can use as many statements as you want to describe how to compute
the answer. In effect, you can think of a program as being a “compound expres-
sion.”

The following example shows how to make a simple program to define the func-
tion: 

f(x, w) = log




x
w





Although the example chosen is so simple as to render programming uneces-
sary, it does illustrate how to separate the statements making up the program and
how to use the local assignment operator, “←”. 

Type the left side of the function
definition, followed by a “:=”.
Make sure the placeholder is se-
lected.

Open the programming palette by
clicking on the programming but-
ton in the palette controls. Then
click on the “Add line” button. Al-
ternatively, press ]. You’ll see a
vertical bar with two placeholders.
These placeholders will hold the
statements making up your pro-
gram. You can continue adding
placeholders for statements as you
need them by repeatedly clicking
the “Add Line” button.

Press [Tab] to move to the top
placeholder. In the top placeholder,
type z, and click on the “←” but-
ton on the programming palette. Al-
ternatively, press { to insert a “←”.
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In the placeholder to the right of
the “←”, type x/w. 

The remaining placeholder is the
actual value to be returned by the
program. Type log(z).

You can now use this function just as you would any other function. Figure 1
shows this function along with an equivalent function defined on one line in-
stead of two. Note that z is undefined everywhere outside the program. The defi-
nition of z inside the program is local to the program. It has no effect anywhere
else.

A program can have any number of statements. To add an additional statement,
click the “Add Line” button on the toolbar again. Mathcad inserts a placeholder
below whatever statement you’ve selected. To delete the placeholder, click on it
and backspace over it.

Figure 2 shows a more complex example involving the quadratic formula. Al-
though you can define the quadratic formula with a single statement as shown in
the top half of the figure, you may find it simpler to define it with a series of sim-
ple statements as shown in the bottom half. This lets you avoid having to edit
very complicated expressions.
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Figure 1: A function defined both in terms of a program and in terms of an ex-
pression.

Figure 2: A more complex function defined in terms of both an expression and a
program.
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A Mathcad program, therefore, is an expression made up of a sequence of state-
ments, each one of which is an expression in itself. Like any expression, a Math-
cad program must have a value. This value is simply the value of the expression
forming the last statement executed by the program. It could be a single number
as shown in Figures 1 and 2, or it could be an array of numbers as shown in Fig-
ure 6. It could even be a mixture of the two as described in the section “Nested
arrays” in Chapter 9.

The remaining sections describe how to use conditional statements and how to
use various looping structures to control program flow.

Conditional statements

In general, Mathcad evaluates each statement in your program from the top
down. There may be times, however, when you want Mathcad to evaluate a
statement only when a particular condition is met. You can do this by including
an “if” statement in your program. For example, suppose you want to define a
function that forms a semi-circle around the origin but is otherwise constant. To
do this:

Type the left side of the function
definition, followed by a “:=”.
Make sure the placeholder is se-
lected.

Click the “Add Line” button on the
programming palette. Alterna-
tively, press ]. You’ll see a vertical
bar with two placeholders. These
placeholders will hold the state-
ments making up your program.

In the top placeholder, click the
“if” button on the programming pal-
ette. Alternatively, press }. 

In the right placeholder, type a
boolean expression: an expression
that’s either true or false. In the left
placeholder, type the value you
want the expression to take when-
ever the expression in the right
placeholder is true.
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Select the remaining placeholder
and click the “otherwise” button on
the programming palette.

In the remaining placeholder, type
the value you want the program to
return if the condition in the first
statement is not met.

Figure 3 shows a plot of this function. Note that since this function only has two
branches, it’s not hard to define it using the if function as shown in Figure 3.
However, as the number of branches exceeds two, the if function rapidly be-
comes unwieldy. An example is shown in Figure 4.

 

Figure 3: Using the “if” statement to define a piecewise continuous function.
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Figure 4: Comparing the “if” statement in a program with the built-in “if” func-
tion.

Looping

One of the greatest strengths of programmability is the ability to execute a se-
quence of statements over and over again in a loop. Mathcad provides two such
loops. The choice of which loop to use depends on how you plan to tell the loop
to stop executing.

If you know exactly how many times a loop is to execute, you can use a for
loop. 

If you want the loop to stop upon the occurrence of a condition, but you don’t
know when that condition will occur, use a while loop.

“while” loops

A while loop is driven by the truth of some condition. Because of this, you don’t
need to know in advance how many times the loop is to execute. It is important,
however, to have a statement somewhere, either within the loop or elsewhere in
the program, that eventually makes the condition false. Otherwise, the loop will
execute indefinitely. If you do find yourself in an endless loop, you can interrupt
it using the method given on page 152.

To create a while loop:
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Click the button labelled “while”
on the programming palette.

In the top placeholder, type a condi-
tion. This would typically be a
boolean expression like the one
shown.

In the remaining placeholder, type
the expression you want evaluated
repeatedly. If necessary, you can
add additional placeholders by
clicking the “Add Line” button on
the programming palette.

Figure 5 shows a larger program incorporating the above loop. Upon encounter-
ing a while loop, Mathcad checks the condition. If the condition is true, Mathcad
executes the body of the loop and checks the condition again. If the condition is
false, Mathcad exits the loop.

Figure 5: Using a “while” loop to find the first occurrence of a particular num-
ber in a matrix. 
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The “break” statement

It is often convenient to break out of a loop or stop program execution upon the
occurrence of some condition. For example, there is a possibility of a runaway it-
eration in the program in Figure 5. If every element in v is less than thresh, the
condition will never become false and iteration will continue past the end of the
vector. This will result in an error message indicating that the index is pointing
to a non-existent array element. To prevent this from being a problem, you can
use a break statement as shown in Figure 6.

The program in Figure 6 will return 0 if no elements larger than thresh were
found. Otherwise it returns the index and value of the first element exceeding
thresh. 

Figure 6: Example in Figure 5 modified to return both the index and the actual
array value. Note the use of “break” to prevent an error arising when thresh is
too large.

To insert the break statement, click on the “break” button in the programming
palette. Note that in Figure 6, you would click the “break” button first, then
click “if”.

“for” loops

A for loop is a loop that terminates after a predetermined number of iterations. It-
eration is controlled by an iteration variable defined at the top of the loop. 

To create a for loop:
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Click the button labelled “for” on
the programming palette.

In the placeholder to the left of the
∈, type the name of the iteration
variable. 

In the placeholder to the right of
the “∈”, enter the range of values
the iteration variable should take.
You specify this range the same
way you would for a range vari-
able. See Chapter 10, “Range vari-
ables,” for more details.

In the remaining placeholder, type
the expression you want to evaluate
repeatedly. This expresssion gener-
ally involves the iteration variable.
If necessary, you can add addi-
tional placeholders by clicking the
“Add Line” button on the program-
ming palette.

The upper half of Figure 7 shows this for loop being used to add a sequence of
integers. The undefined variable in Figure 7 shows that the definition of an itera-
tion variable is local to the program. It has no effect anywhere outside the pro-
gram.

The lower half shows an example in which the iteration variable is defined not
in terms of a range but in terms of the elements of a vector. Although the expres-
sion to the right of the “∈” is usually a range, it can also be a vector, a list of sca-
lars, ranges and vectors separated by commas.

324 Chapter 14  Programming PLUS



Figure 7: Using a “for” loop with two different kinds of iteration variables.

Programs within programs

The examples in previous sections have been chosen more for their simplicity
than their power. This section shows some examples of more complicated pro-
grams capable of performing tasks that would be difficult if not impossible with-
out the availability of these programming features. 

Much of the flexibility inherent in programming arises from the ability to embed
programming structures inside one another. In Mathcad, you can do this in three
ways:

You can make one of the statements in a program be another program.

You can define a program elsewhere and call it from within another program
as if it were a subroutine.

You can define a function recursively.

The remainder of this section illustrates these techniques by example.
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Subroutines

Recall that a program is just an expression made up of statements, each one of
which contains an expression. Since a program statement must be an expression,
and since a program is itself an expression, it follows that a program statement
can be another program.

Figure 8 shows two examples of programs containing a statement which is itself
a program. The example on the right-hand side of Figure 8 shows how to nest
programs even more deeply. In principle, there is no limit to how deeply nested
a program can be. As a practical matter, however, programs containing deeply
nested programs can become too complicated to understand at a glance.

One way many programmers avoid overly complicated programs is to bury the
complexity in a “subroutine.” Figure 9 shows how you can do something similar
in Mathcad. By defining intsimp elsewhere and using it within adapt, the pro-
gram used to define adapt becomes considerably simpler. Imagine how compli-
cated the definition for adapt would be if both occurrences of intsimp within it
had to be replaced by the lengthy definition for intsimp at the top of the figure.

The function adapt carries out an adaptive quadrature or integration routine by
using intsimp to approximate the area in each subinterval. If you look at the last
line, you’ll notice that adapt actually calls itself. In other words, it’s defined re-
cursively. The following section discusses recursive function definitions in more
detail.

Figure 8: Programs in which statements are themselves programs.

326 Chapter 14  Programming PLUS



  

Figure 9: Using a subroutine to manage complexity. 

Recursion

Recursion is a powerful programming technique that involves defining a func-
tion in terms of itself as shown in Figure 10. Recursive function definitions
should always have at least two parts:

An initial condition to prevent the recursion from going forever, and

A definition of the function in terms of a previous value of the function.

The idea is similar to that underlying mathematical induction: if you can get
f(n + 1) from f(n), and you know f(0), then you know all there is to know about f.
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Figure 10: Defining a function recursively.

Keep in mind however, that recursive function definitions, despite their ele-
gance and conciseness, are not always the most computationally efficient defini-
tions. You may find that an equivalent definition using one of the iterative loops
described earlier will evaluate more quickly.

Programming examples

With only seven buttons on the programming palette, Mathcad’s programming
environment is easy to use. Nevertheless, this simplicity conceals a surprising
amount of programming power. When combined with Mathcad’s rich numerical
functionality and used in conjunction with the abstract data structures provided
by Mathcad’s nested arrays, these seven operators enable you to write sophisti-
cated programs in Mathcad.

The following figures illustrate just a few of the possibilities. As you experiment
with programming in Mathcad, you’ll discover many new applications. For fur-
ther programming examples, see the corresponding QuickSheets by clicking on
the QuickSheet button on the toolbar.
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Figure 11: Program to generate a sequence of binomial trials.

Figure 12: Program to find the numbers common to two vectors.
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Figure 13: Using the sieve of Eratosthenes to find prime numbers.

Figure 14: Powers of a random transition matrix.
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Figure 15: Smoothing a matrix.
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Chapter 15
Solving Equations

This chapter describes how to solve equations ranging from a
single equation in one unknown to systems of up to fifty equations
in fifty unknowns.

The following sections make up this chapter:

Solving one equation
How to use Mathcad’s root functions to numerically solve one equation
in one unknown.

Systems of equations
How to use “solve blocks” to solve systems of n equations in n un-
knowns.

Using the solver effectively
Examples of how to efficiently solve systems of equations for various
values of a parameter.
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Solving one equation

 To solve a single equation in a single unknown, use the root function. This func-
tion takes an expression and one of the variables from the expression. It then var-
ies that variable until the expression is equal to zero. Once this is done, the
function returns the value that makes the expression equal zero.

root( f(z), z) Returns the value of z at which the expression or function f(z) is
equal to 0. Both arguments to this function must be scalar. The
function returns a scalar. 

The first argument is either a function defined elsewhere in the worksheet, or an
expression. It must return a scalar value. 

The second argument is a variable name that appears in the expression. It is this
variable that Mathcad will vary to make the expression go to zero. You should
assign a number to this variable before using the root function. Mathcad uses
this as a starting value in its search for a solution.

For example, to define a as the solution to the equation ex = x3, follow these
steps:

Define a guess value for x. Type
x:3. Your choice of guess value
determines which root Mathcad re-
turns. 

0aaROOT.PNT

Set the whole expression equal to zero. In other words, rewrite x 3 = e x as
x 3 − e x = 0. It is this expression that you give the root function.

Type
a:root(x^3[Space]-
e^x[Space],x) 
This defines the variable a to be a
root of the desired equation. 

0abROOT.PNT

Type a= to see the root.0acROOT.PNT

When you use the root function, keep these suggestions in mind:

Make sure that the variable is defined with a guess value before you use the
root function. 

For expressions with several roots, for example x2 − 1 = 0, your guess value
determines which root Mathcad will return. Figure 1 shows an example in
which the root function returns several different values, each of which de-
pends on the initial guess value.
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Mathcad will solve for complex roots as well as real roots. To find a complex
root, you must start with a complex value for the initial guess.

Solving an equation of the form f(x) = g(x) is equivalent to using the root
function as follows:

root( f(x) − g(x), x)

The root function can solve only one equation in one unknown. To solve several
equations simultaneously, use the technique described in the next section, “Sys-
tems of Equations.” To solve an equation symbolically, or to find an exact nu-
merical answer in terms of elementary functions, choose Solve for Variable
from the Symbolic menu. See Chapter 17, “Symbolic Calculation.”

S010ROOT.PNT

Figure 1: Using a plot and the root function to find roots of an expression.

   

What to do when the root function does not converge

Mathcad evaluates the root function using the secant method. The guess value
you supply for x becomes the starting point for successive approximations to the
root value. When the magnitude of f(x) evaluated at the proposed root is less
than the value of the predefined variable TOL, the root function returns a result.

If after many approximations Mathcad still cannot find an acceptable answer, it
marks the root function with an error message indicating its inability to con-
verge to a result. This error can be caused by any of the following: 

The expression has no roots.
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The roots of the expression are far from the initial guess.

The expression has local maxima or minima between the initial guess and the
roots.

The expression has discontinuities between the initial guess and the roots.

The expression has a complex root but the initial guess was real (or vice
versa).

To find the cause of the error, try plotting the expression. This will help deter-
mine whether or not the expression crosses the x-axis and if so, approximately
where it does so. In general, the closer your initial guess is to where the expres-
sion crosses the x-axis, the more quickly the root function will converge on an
acceptable result. 

Hints on using the root function

Here are some hints on getting the most out of the root function:

To change the accuracy of the root function, change the value of the built-in
variable TOL. If you increase TOL, the root function will converge more
quickly, but the answer will be less accurate. If you decrease TOL, the root
function will converge more slowly, but the answer will be more accurate. To
change TOL at a specified point in the worksheet, include a definition like
TOL := 0.01. To change TOL for the whole worksheet, choose Options
⇒Built-In Variables from the Math menu and replace the number in the
text box beside “TOL.” After you click “OK,” choose Calculate Worksheet
from the Math menu to update the entire worksheet using the new value of
TOL

If an expression has multiple roots, try different guess values to find them.
Plotting the function is a good way to determine how many roots there are,
where they are, and what initial guesses are likely to find them. Figure 1
shows an example of this. If two roots are close together, you may have to re-
duce TOL to distinguish between them.

If f(x) has a small slope near its root, then root( f(x), x) may converge to a
value r that is relatively far from the actual root. In such cases, even though
|f(r)| < TOL, r may be far from the point where f(r) = 0. To find a more accu-
rate root, decrease the value of TOL. Or, try finding root(g(x), x), where 

g(x) = 
f(x)

d
dx

 f(x)

For an expression f(x) with a known root a, solving for additional roots of f(x)
is equivalent to solving for roots of h(x) = f(x)/(x−a). Dividing out known
roots like this is useful for resolving two roots that may be close together. It’s
often easier to solve for roots of h(x) as defined here than it is to try to find
other roots for f(x) with different guesses.

336 Chapter 15  Solving Equations



Solving an equation repeatedly 

 Suppose you want to solve an equation many times while varying one of the pa-
rameters in the equation. For example, suppose you want to solve the equation
ex = a⋅x2 for several different values of the parameter a. The simplest way to do
this is to define a function:

f(a, x) := root(e x − a⋅x 2, x)

To solve the equation for a particular value of a, supply both a and a guess
value, x, as arguments to this function. Then evaluate the function by typing
f(a,x)=.

Figure 2 shows an example of how such a function can be used to find several
solutions to the root function. Note that since the guess value, x, is passed into
the function itself, there is no need to define it elsewhere in the worksheet. 

S020UFRT.PNT

Figure 2: Defining a user function with the root function.
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Finding the roots of a polynomial

To find the roots of an expression having the form:

 vnxn + . . . + v2x2 + v1x + v0, 

you can use the polyroots function rather than the root function. Unlike root,
polyroots does not require a guess value. Moreover, polyroots returns all roots at
once, whether real or complex. Figures 3 and 4 show examples.

polyroots(v) Returns the roots of an nth degree polynomial whose coefficients
are in v, a vector of length n + 1. Returns a vector of length n.

Figure 3: Using polyroots to do the example shown in Figure 1. 

The polyroots function will always return numerical values for the roots of a
polynomial. To find the roots symbolically, use Solve for Variable from the
Symbolic menu. See Chapter 17, “Symbolic Calculation.”
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Figure 4: Using polyroots to find the roots of a polynomial.

Systems of equations 

    Mathcad lets you solve a system of up to fifty simultaneous equations in fifty un-
knowns. The first part of this section sketches the procedure. The remainder con-
tains several examples as well as a discussion of some common errors. The
method given here will always return numbers for the unknown variables. To
see the unknowns in terms of the other variables and constants, use the symbolic
solve blocks discussed on page 404.

There are four steps to solving a system of simultaneous equations. These are:

Provide an initial guess for all the unknowns you intend to solve for. Mathcad
solves equations by making a series of guesses which ultimately converge on
the right answer. The initial guesses you provide give Mathcad a place to start
searching for solutions.

Type the word Given. This tells Mathcad that what follows is a system of
equations. You can type Given in any combination of upper and lower case
letters, and in any font. Just be sure you don’t type it while in a text region or
paragraph. 

Now type the equations and inequalities in any order below the word Given.
Make sure you use the symbol “=” to separate the left and right sides of an
equation. Press [Ctrl]= to type “=.” You can separate the left and right sides
of an inequality with any of the symbols <, >, ≤ and ≥. 
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Type any equation that involves the Find function. Like Given, you can use
any combination of upper and lowercase letters. You can also use any font,
size or style.  

Find(z1, z2, z3, . . . ) Returns the solution to a system of equations. Num-
ber of arguments matches the number of unknowns.   

The Find function returns values as follows:

If Find has one argument, it returns the value of that variable that solves the
equation between it and the Given.

If Find has more than one argument, it returns a vector of answers. For exam-
ple, Find(z1, z2) returns a vector containing the values of z1 and z2 that solve
the system of equations.

The word Given, the equations and inequalities that follow, and whatever expres-
sion involves the Find function, form a “solve block.” 

Figure 5 shows a worksheet that contains a solve block for one equation in one
unknown. Since there is only one equation, only one equation appears between
the word Given and the expression involving Find. Since there is only one un-
known, the Find function has only one argument. For one equation in one un-
known, you can also use the root function shown below.

a := root(x 2 + 10 − e x, x)
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Figure 5: A solve block with one equation in one unknown.

Mathcad is very specific about the types of expressions that can appear between
the Given and the Find. The table below lists all the expressions that can be
placed in a solve block. These expressions are often called “constraints.” In the
table below, x and y represent real-valued scalar expressions, z and w represent
arbitrary scalar expressions.     

Condition Keystroke Description

z = w [Ctrl]= Constrained to be equal.

x > y > Greater than. 

x < y < Less than.

x ≥ y [Ctrl]0 Greater than or equal to. 

x ≤ y [Ctrl]9 Less than or equal to. 

Note that Mathcad does not allow the following inside a solve block:

Constraints with “≠” in solve blocks. 

Range variables or expressions involving range variables of any kind. 

Inequalities of the form a < b < c.

If you want to include the outcome of a solve block in an iterative calculation,
see the section “Using the solver effectively” later in this chapter.
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Solve blocks cannot be nested inside each other. Each solve block can have only
one Given and one Find. You can however, define a function like f(x) := Find(x)
at the end of one solve block and use this same function in another solve block.
This too is discussed in the section “Using the solver effectively” later in this
chapter.

As a rule, you should never use assignment statements (statements like x :=
1) inside a solve block. Mathcad marks assignment statements inside solve
blocks with an appropriate error message.

Figure 6 shows a solve block with several kinds of constraints. There are two
equations and two unknowns. As a result, the Find function contains two argu-
ments, x and y, and returns a vector with two components. 

040CONS.PNT

Figure 6: A solve block with both equations and inequalities.

What to do with your solution

The Find function that terminates a solve block behaves like any other function.
There are three things you can do with it:

You can display it with an equation like Find(variable) =. An example is
shown in the top half of Figure 7. If you have several variables, you can dis-
play a vector of results with an equation like:Find(var1, var2, . . .) =. An ex-
ample of how this would look for a system of two equations in two unknowns
is shown in Figure 8.
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You can define a variable in terms of it by ending the solve block with an
equation like a := Find(x). This is useful when you want to use the solution of
a system of equations elsewhere in the worksheet. Once you make this defini-
tion, a has the solved value of the variable. An example of this is shown in
the lower half of Figure 7. If the Find returns a vector of values, you can en-
ter an equation like variable := Find(var1, var2, . . .). If you do this, variable
will end up being a vector instead of a scalar. You can also define variables
as shown in Figure 6. 

Finally, you can define another function in terms of it by ending the solve
block with an equation like f(a, b, c, . . .) := Find(x, y, z, . . .). This construc-
tion is useful for solving system of equations repeatedly for different values
of some parameters a, b, c, . . . that appear within the system of equations it-
self. This method is described in the section “Using the solver effectively,”
later in this chapter.

S0501ANS.PNT

Figure 7: You can display the result of a solve block directly, or you can put the
result in a variable name for later use.
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Figure 8: When there are two or more unknowns, the Find function no longer re-
turns a scalar. Instead, it returns a vector with as many elements as there are un-
knowns.

Mathcad can return only one solution for a solve block. There may, however, be
multiple solutions to a set of equations. To find a different solution, try different
starting values or enter an additional inequality constraint that the current solu-
tion does not satisfy. Figure 9 shows how different starting values can yield a so-
lution different from that shown in Figure 8. Figure 10 shows how to add an
inequality to force Mathcad to find a different solution.   
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Figure 9: A different guess leads to a solution different from that shown in Fig-
ure 8.

S100NCST.PNT

Figure 10: Adding a constraint forces a different solution.
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What to do when the solver does not reach a solution 

 If the solver cannot make any further improvements to the solution but the con-
straints are not all satisfied, then the solver stops and marks the Find with an er-
ror message indicating that it was unable to find a solution.   

If you are having difficulty finding a solution, it often helps to plot the curve or
curves in question. Plotting can provide graphical insight into where the solution
might be. This will help you choose appropriate initial guesses for the variables.

Figure 11 shows a problem for which Mathcad could not find a solution.

110NSLN.PNT

Figure 11: A problem in which the solver fails to find a solution.

The solver gives up trying to solve a system of equations whenever the differ-
ence between successive approximations to the solution is greater than TOL and:

The solver reaches a point where it cannot reduce the error any further.

The solver reaches a point from which there is no preferred direction. Be-
cause of this, the solver has no basis on which to make further iterations.

The solver reaches the limit of its accuracy. Roundoff errors make it unlikely
that further computation would increase accuracy of the solution. This often
happens if you set TOL to a value below 10−15.

The following problems may cause this sort of failure:

There may actually be no solution. 
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You may have given real guesses for an equation with no real solution. If the
solution for a variable is complex, the solver will not find it unless the start-
ing value for that variable is also complex. Figure 11 shows an example.

The solver may have become trapped in a local minimum for the error values.
The solving method that Mathcad uses will sometimes reach a point from
which it cannot minimize the errors any further. To find the actual solution,
try using different starting values or add an inequality to keep Mathcad from
being trapped in the local minimum.

The solver may have become trapped on a point that is not a local minimum,
but from which it cannot determine where to go next. The strategies for avoid-
ing this problem are the same as those for avoiding a local minimum: change
the initial guesses or add an inequality to avoid the undesirable stopping point.

It may not be possible to solve the constraints to within the desired tolerance.
If the value of TOL is relatively small, Mathcad may have reached something
very close to a solution but still be unable to solve all the constraints to an er-
ror less than TOL. Try defining TOL with a larger value somewhere above the
solve block. Increasing the tolerance changes what Mathcad considers close
enough to call a solution.

What to do when there are too few constraints 

 If there are fewer constraints than variables, Mathcad cannot run the solver at
all. Mathcad then marks the Find with an appropriate error message.

A problem like that shown in Figure 12 is underdetermined. The constraints do
not give enough information to find a solution. Because there are five arguments
in the Find function, Mathcad thinks that you want to solve two equations with
five unknowns. In general, such a problem has an infinite number of solutions.

To use the solver in Mathcad, you must provide at least as many equations as
there are variables to solve for. If you specify the value of some of the variables,
you may be able to solve for the remaining variables. Figure 13 shows how to
fix the problem in Figure 12. Because the Find function contains only the argu-
ments z and w, Mathcad knows that you want x, y, and v to be held constant at
10, 50 and 0 respectively. A solve block with two equations becomes legitimate
because there are now only two unknowns, z and w. 
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Figure 12: Five arguments in the Find make the solver think you want to solve
two equations in five unknowns.

130NCOK.PNT

Figure 13: The problem can be solved with fewer variables as arguments to Find.
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Using the solver effectively 

This section provides some ideas on how to effectively exploit Mathcad’s ability
to solve systems of simultaneous equations. 

Repeatedly solving an equation 

   The techniques given thus far, while they are effective for solving a particular
system of equations, are limited by two things:

Every time you use a Find, you must have the rest of the solve block to go
with it.

If you want to change some of the parameters or constants in your system of
equations to see how these affect the solution, you have to go all the way
back to the solve block to change them.

Both these drawbacks are overcome by Mathcad’s ability to define a function in
terms of a solve block. 

If you define a function with Find somewhere on the right hand side, this func-
tion will solve the system of equations each time you use it. This overcomes the
first problem.

If this function has as its arguments the same parameters that you want to vary
in the solve block, you can simply change the parameters by changing the num-
bers you place in the function’s argument list. This overcomes the second prob-
lem.

Figure 14 shows a concrete example. The friction factor, f, of a pipe depends on
the pipe’s diameter D, its roughness ε, and the Reynolds number R. It’s quite
conceivable that you would want to experiment with different size pipes (D)
made of different types of concrete (ε). 

The equation in Figure 14 shows the relationship between these parameters. The
equation is too complicated to define a function of R, D and ε simply by solving
for f in terms of R, D and ε. 

You can, however, define a function in terms of a solve block. Whenever you
ask Mathcad to evaluate the function FricFac(ε, D, R), Mathcad takes the ε, D,
and R that you supply, replaces the corresponding variables in the solve block,
solves for f, and returns the value. 
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Figure 14: Defining a function in terms of a solve block. 

Suppose that you’ve settled on a pipe size and material (D and ε), and you now
want to try several different values of the Reynolds numbers. Although the
FricFac function in Figure 14 was defined in terms of a solve block, it still is a
function like any other. As such, you can use it with range variables.

Figure 15 shows how to solve for and plot the friction factor for many different
values of the Reynolds number. Note that when you use range variables in con-
junction with a solve block this way, you are actually solving the system of equa-
tions once for each value of the range variable. As a result, this type of
calculation has the potential to be quite time consuming.
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Figure 15: A vector of solutions.

The previous example involves only one equation in one unknown. It is possible
to solve a system of equations iteratively as well, however you must be careful
not to ask Mathcad to display a table in which each entry in the table is some-
thing other than a single number. The example shown in Figure 16, a variation
of Figure 10, shows how you can do this.

Suppose you are looking for the intersection of a line and a circle of varying ra-
dius, R. In keeping with the example of Figure 15, you could define a function
in terms of a solve block. In this case, the appropriate function is
F(R) := Find(x, y). This function returns a vector whose elements are the x and y
coordinates of the intersection.

The key difference is that this function returns a vector of two values for each
value of R. Therefore when you ask for the answers by typing F(R)=, you are
asking not for a table of numbers, but a table in which each element is a vector
of two numbers. Since Mathcad has no way to display such a thing on your
screen it returns an error message.

The solution is to display a table of the components F(R)0 and F(R)1 separately.
By typing F(R)[0=, you get a table of all the x values of the intersection
points. Similarly, by typing F(R)[1=, you get a table of all the y values of the
intersection points.
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Figure 16: How to display three solutions, each of which is a two element vector.

Solving the same problem for different variables 

You will occasionally run into a problem in which you want to change the roles
of knowns and unknowns in an equation. For example, consider the equation
that relates interest rate, loan amount, term of loan, and payments. If you know
three of these four quantities, you can solve for the missing one. 

The worksheet in Figure 17 shows that for a 12% loan on a 30-year mortgage
and a payment of $1000 per month, the largest possible loan is $97,218.33.
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Figure 17: Solving for the loan in a mortgage.

With a few simple changes, the same worksheet can be used to solve for the in-
terest rate. Suppose now that the amount of the loan is known to be $120,000.
How far would interest rates have to drop to before the payments dropped to
$1000 per month? Figure 18 shows the answer.

If you compare Figures 17 and 18, you’ll see that they are very much the same.
The main difference lies in the argument of the Find function. To change what is
fixed and what is variable in an equation, simply change the arguments of the
Find function. 
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Figure 18: Solving for the interest rate in a mortgage.

Approximate solutions

 Mathcad supplies a function very similar to Find called Minerr. This function
uses exactly the same algorithm as Find. The difference is that if the solver can-
not make any further improvements to the solution, Minerr returns a value any-
way. The Find function on the other hand, will return an error message
indicating that it could not find a solution. You use Minerr exactly the way you
would use Find.

Minerr(z1, z2, z3, . . . ) Returns the solution to a system of equations. Num-
ber of arguments matches the number of unknowns.

Minerr usually returns an answer that minimizes the errors in the constraints.
However, Minerr cannot verify that its answers represent an absolute minimum
for the errors in the constraints. If you use Minerr in a solve block, you should
always include additional checks on the reasonableness of the results. The built-
in variable ERR gives the size of the error vector for the approximate solution.
There is no built-in variable for determining the size of the error for individual
solutions to the unknowns.
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Minerr is particularly useful for solving certain non-linear least squares prob-
lems. Figure 19 shows an example in which Minerr is used to obtain the un-
known parameters in a Weibull distribution. The function genfit is also useful
for solving non-linear least squares problems. See Chapter 12 for more informa-
tion on genfit.

SMINERR

Figure 19: Using the minerr function to do non-linear least squares fitting.

Using the symbolic solver

You can usually find numerical roots quickly and accurately with Mathcad’s
root function. But there are some circumstances in which you might want to use
Mathcad’s symbolic solver find exact or approximate roots:

If the equation you’re solving has a parameter, a symbolic solution may allow
you to express the answer directly in terms of the parameter. Then instead of
solving the equation over again for each new value of the parameter, you can
just substitute its value into your symbolic solution. 

If you need all the complex roots of a polynomial of degree 4 or less, the sym-
bolic solver will give them to you in a single vector, either exactly or numeri-
cally. The symbolic solver will also find complete solutions for some
polynomials of higher degree. 
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Chapter 16
Solving Differential Equations

This chapter describes how to solve both ordinary and partial
differential equations having real valued solutions. Mathcad comes
with a variety of functions for solving differential equations. Some
of these exploit properties of the differential equation to improve
speed and accuracy. Others are useful when you intend to plot the
solution rather than simply evaluate it at an endpoint.

The following sections make up this chapter:

Solving ordinary differential equations

Using the rkfixed function to solve an nth order ordinary differential
equation with initial conditions. This section is a prerequisite for all
other sections in this chapter.

Systems of differential equations
How to adapt the rkfixed function to solve systems of differential equa-
tions with initial conditions.

Specialized differential equation solvers
A description of additional differential equation solving functions and
when you may want to use them.

Boundary value problems
How to solve boundary value problems involving multivariate func-
tions.
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Solving ordinary differential equations

In a differential equation, you solve for an unknown function rather than just a
number. For ordinary differential equations, the unknown function is a function
of one variable. Partial differential equations are differential equations in which
the unknown is a function of two or more variables.

Mathcad has a variety of functions for returning the solution to an ordinary dif-
ferential equation. Each of these functions solves differential equations numeri-
cally. You’ll always get back a matrix containing the values of the function
evaluated over a set of points. These functions differ in the particular algorithm
each uses for solving differential equations. Despite these differences however,
each of these functions requires you to specify at least three things:

The initial conditions.

A range of points over which you want the solution to be evaluated.

The differential equation itself, written in the particular form discussed in this
chapter.

This section shows how to solve a single ordinary differential equation using the
function rkfixed. It begins with an example of how to solve a simple first order
differential equation and then proceeds to show how to solve higher order differ-
ential equations.

First order differential equations

A first order differential equation is one in which the highest order derivative of
the unknown function is the first derivative. Figure 1 shows an example of how
to solve the relatively simple differential equation:

dy
dx

 + 3⋅y = 0

subject to the initial condition:

y(0) = 4

The function rkfixed in Figure 1 uses the Fourth order Runge-Kutta method to re-
turn a two column matrix in which:

The left hand column contains the points at which the solution to the differen-
tial equation is evaluated.

The right hand column contains the corresponding values of the solution. 

358 Chapter 16  Solving Differential Equations PLUS



Figure 1: Solving a first order differential equation. 

The arguments to the rkfixed  function are:

rkfixed( y, x1, x2, npoints, D)

y =A vector of n initial values where n is the order of the differential
equation or the size of the system of equations you’re solving. For a
first order differential equation like that in Figure 1, the vector de-
generates to one point, y0 = y(x1). 

x1, x2 = The endpoints of the interval on which the solution to the differen-
tial equations will be evaluated. The initial values in y are the val-
ues at x1.

npoints = The number of points beyond the initial point at which the solution
is to be approximated. This controls the number of rows
(1 + npoints) in the matrix returned by rkfixed.

D(x, y) = An n-element vector-valued function containing the first derivatives
of the unknown functions.
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The most difficult part of solving a differential equation is solving for the first
derivative so you can define the function D(x, y). In Figure 1 it was easy to
solve for y′(x). Sometimes, however, particularly with non-linear differential
equations, it can be difficult. In such cases, you can sometimes solve for y′(x)
symbolically and paste it into the definition for D(x, y). To do so, use the Solve
for Variable command from the Symbolic menu as discussed on page 401.

Figure 2: A more complicated example involving a non-linear differential equa-
tion. 

Second order differential equations

Once you know how to solve a first order differential equation, you’re most of
the way to knowing how to solve higher order differential equations. We start
with a second order equation. The key differences are:

The vector of initial values y now has two elements: the value of the function
and its first derivative at the starting value, x1.

The function D(t, y) is now a vector with two elements:

D(t, y) = 



y′(t)
y′′(t)





The solution matrix contains three columns: the left-hand one for the t values;
the middle one for y(t); and the right-hand one for y′(t).
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The example in Figure 3 shows how to solve the second order differential equa-
tion:

y′′ = −y′ + 2⋅y
y(0) = 1       y′(0) = 3

Figure 3: Solving a second order differential equation.

Higher order equations

The procedure for solving higher order differential equations is an extension of
that used for second order differential equations. The main difference is that: 

The vector of initial values y now has n elements for specifying initial condi-
tions of y, y′, y′′ . . .y(n − 1).

The function D is now a vector with n elements:

D(t,y) = 
















y′(t)
y′′(t)
.
.
.
y(n)(t)
















The solution matrix contains n columns: the left-hand one for the t values and
the remaining columns for values of y(t), y′(t), y′′(t) . . . y(n − 1)(t).
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The example in Figure 4 shows how to solve the fourth order differential equa-
tion:

y′′′′ − 2k2 y′′ + k4y = 0 

subject to the initial conditions:

y(0) = 0    y′(0) = 1    y′′(0) = 2    y′′′(0) = 3

Figure 4: Solving a higher order differential equation.

Systems of differential equations

The procedure for solving a coupled system of differential equations follows
closely that for solving a higher order differential equation. In fact, you can
think of solving a higher order differential equation as just a special case of solv-
ing a system of differential equations.

Systems of first order differential equations

To solve a system of first order differential equations:

Define a vector containing the initial values of each unknown function.

Define a vector-valued function containing the first derivatives of each of the
unknown functions.

Decide which points you want to evaluate the solutions at.
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Pass all this information into rkfixed.

The rkfixed function will return a matrix whose first column contains the points
at which the solutions are evaluated and whose remaining columns contain the
solution functions evaluated at the corresponding point. Figure 5 shows an exam-
ple solving the equations:

x′0(t) = µ⋅x0(t) − x1(t) − (x0(t)2 + x1(t)2)⋅x0(t)

x′1(t) = µ⋅x1(t) + x0(t) − (x0(t)2 + x1(t)2)⋅x1(t)

with initial conditions:

x0(0) = 0 and x1(0) = 1

Figure 5: A system of first order linear equations.

Systems of higher order differential equations

The procedure for solving a system of nth-order differential equations is similar
to the procedure for solving a system of first order differential equations. The
main differences are:

The vector of initial conditions must contain initial values for the n − 1 deriva-
tives of each unknown function in addition to initial values for the functions
themselves.

The vector-valued function must contain expressions for the n − 1 derivatives
of each unknown function in addition to the nth-derivative.
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The example in Figure 6 shows how to go about solving the system of second or-
der differential equations:

u′′(t) = 2v(t)
v′′(t) = 4v(t) − 2u(t)

Figure 6: A system of second order linear differential equations. 

The function rkfixed  returns a matrix in which:

The first column contains the values at which the solutions and their deriva-
tives are to be evaluated.

The remaining columns contain the solutions and their derivatives evaluated
at the corresponding point in the first column. The order in which the solution
and its derivatives appear matches the order in which you put them into the
vector of initial conditions that you passed into rkfixed.
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Specialized differential equation solvers

The rkfixed function discussed thus far is a good general purpose differential
equation solver. Although it is not always the fastest method, the Runge-Kutta
technique used by this function nearly always succeeds. However there are
cases in which you may want to use one of Mathcad’s more specialized differen-
tial equation solvers. These cases fall into three broad categories:

Your system of differential equations may have certain properties which are
best exploited by functions other than rkfixed. The system may be stiff (Stiffb,
Stiffr); the functions could be smooth (Bulstoer) or slowly varying (Rkadapt),

You may have a boundary value rather than an initial value problem (sbval
and bvalfit),

You may be interested in evaluating the solution only at one point (bulstoer,
rkadapt, stiffb and stiffr).

You may also want to try several methods on the same differential equation to
see which one works the best. Sometimes there are subtle differences between
differential equations that make one method better than another.

The following sections describe the use of the various differential equation
solvers and the circumstances in which they are likely to be useful.

Smooth systems

When you know the solution is smooth, use the Bulstoer function instead of
rkfixed. The Bulstoer function uses the Bulirsch-Stoer method rather than the
Runge-Kutta method used by rkfixed. Under these circumstances, the solution
will be slightly more accurate than that returned by rkfixed.

The argument list and the matrix returned by Bulstoer is identical to that for
rkfixed.
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Bulstoer( y, x1, x2, npoints, D) 

y = A vector of n initial values.

x1, x2 = The endpoints of the interval on which the solution to the differen-
tial equations will be evaluated. The initial values in y are the val-
ues at x1.

npoints = The number of points beyond the initial point at which the solution
is to be approximated. This controls the number of rows
(1 + npoints) in the matrix returned by Bulstoer.

D(x, y) = An n-element vector-valued function containing the first derivatives
of the unknown functions.

Slowly varying solutions

Given a fixed number of points, you can approximate a function more accu-
rately if you evaluate it frequently wherever it’s changing fast and infrequently
wherever it’s changing more slowly. If you know that the solution has this prop-
erty, you may be better off using Rkadapt. Unlike rkfixed which evaluates a solu-
tion at equally spaced intervals, Rkadapt examines how fast the solution is
changing and adapts its step-size accordingly. This “adaptive stepsize control”
enables Rkadapt to focus on those parts of the integration domain where the
function is rapidly changing rather than wasting time integrating a function
where it isn’t changing all that rapidly.

Note that although Rkadapt will use nonuniform step sizes internally when it
solves the differential equation, it will nevertheless return the solution at equally
spaced points.
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Rkadapt takes the same arguments as rkfixed. The matrix returned by Rkadapt is
identical in form to that returned by rkfixed.

Rkadapt( y, x1, x2, npoints, D) 

y = A vector of n initial values.

x1, x2 = The endpoints of the interval on which the solution to the differen-
tial equations will be evaluated. The initial values in y are the val-
ues at x1.

npoints = The number of points beyond the initial point at which the solution
is to be approximated. This controls the number of rows
(1 + npoints) in the matrix returned by Rkadapt.

D(x, y) = An n-element vector-valued function containing the first derivatives
of the unknown functions.

Stiff systems

A system of differential equations expressed in the form:

y = A⋅x

is a stiff system if the matrix A is nearly singular. Under these conditions, the so-
lution returned by rkfixed may oscillate or be unstable. When solving a stiff sys-
tem, you should use one of the two differential equation solvers specifically
designed for stiff systems: Stiffb and Stiffr. These use the Bulirsch-Stoer method
and the Rosenbrock method for stiff systems respectively.

The form of the matrix returned by these functions is identical to that returned
by rkfixed. However, Stiffb and Stiffr require an extra argument in the following
section:
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Stiffb( y, x1, x2, npoints, D, J) 
Stiffr( y, x1, x2, npoints, D, J) 

y = A vector of n initial values.

x1, x2 = The endpoints of the interval on which the solution to the differen-
tial equations will be evaluated. The initial values in y are the val-
ues at x1.

npoints = The number of points beyond the initial point at which the solution
is to be approximated. This controls the number of rows
(1 + npoints) in the matrix returned by Stiffb or Stiffr.

D(x, y) = An n-element vector-valued function containing the first derivatives
of the unknown functions.

J(x, y) = A function which returns the n × (n + 1) matrix whose first column
contains the derivatives ∂D/∂x and whose remaining rows and col-
umns form the Jacobian matrix (∂D/∂yk) for the system of differen-
tial equations. For example, if:

D(x,y) = 




x⋅y1
−2⋅y1⋅y0




   then   J(x,y) = 





y1
0

    
0

−2⋅y1
    

x

−2⋅y0




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Evaluating only the final value

The differential equation functions discussed so far presuppose that you’re inter-
ested in seeing the solution y(x) over a number of uniformly spaced x values in
the integration interval bounded by x1 and x2. There may be times, however,
when all you want is the value of the solution at the endpoint, y(x2). Although
the functions discussed so far will certainly give you y(x2), they also do a lot of
unecessary work returning intermediate values of y(x) in which you have no in-
terest.

If you’re only interested in the value of y(x2), use the functions listed below.
Each function corresponds to one of those already discussed. The properties of
each of these functions are identical to those of the corresponding function in
the previous sections.

bulstoer( y, x1, x2, acc, D, kmax, save)
rkadapt( y, x1, x2, acc, D, kmax, save) 
stiffb( y, x1, x2, acc, D, J, kmax, save) 
stiffr( y, x1, x2, acc, D, J, kmax, save) 

y = A vector of n initial values.

x1, x2 = The endpoints of the interval on which the solution to the differen-
tial equations will be evaluated. The initial values in y are the val-
ues at x1.

acc = Controls the accuracy of the solution. A small value of acc forces
the algorithm to take smaller steps along the trajectory, thereby in-
creasing the accuracy of the solution. Values of acc around 0.001
will generally yield accurate solutions.

D(x, y) = An n-element vector-valued function containing the first derivatives
of the unknown functions.

J(x, y) = A function which returns the n × (n + 1) matrix whose first column
contains the derivatives ∂D/∂x and whose remaining rows and col-
umns form the Jacobian matrix (∂D/∂yk) for the system of differen-
tial equations. See page 368

kmax = The maximum number of intermediate points at which the solution
will be approximated. The value of kmax places an upper bound on
the number of rows of the matrix returned by these functions. 

save = The smallest allowable spacing between the values at which the so-
lutions are to be approximated. This places a lower bound on the
difference between any two numbers in the first column of the ma-
trix returned by the function.
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Boundary value problems

So far, all the functions discussed in this chapter assume that you know the
value taken by the solutions and their derivatives at the beginning of the interval
of integration. In other words, these functions are useful for solving initial value
problems. 

In many cases, however, you may know the value taken by the solution at the
endpoints of the interval of integration. A good example is a stretched string con-
strained at both ends. Problems such as this are referred to as boundary value
problems. The first section discusses two-point boundary value problems: one di-
mensional systems of differential equations in which the solution is a function of
a single variable and the value of the solution is known at two points. The sec-
tion following this discusses the more general case involving partial differential
equations.

Two-point boundary value problems

The functions described so far involve finding the solution to an nth order differ-
ential equation when you know the value of the solution and its first n − 1 de-
rivatives at the beginning of the interval of integration. This section discusses
what happens if you don’t have all this information about the solution at the be-
ginning of the interval of integration but you do know something about the solu-
tion elsewhere in the interval. In particular:

You have an nth order differential equation.

You know some but not all of the values of the solution and its first n − 1 de-
rivatives at the beginning of the interval of integration, x1.

You know some but not all of the values of the solution and its first n − 1 de-
rivatives at the end of the interval of integration, x2.

Between what you know about the solution at x1 and what you know about it
at x2, you have n known values.

When this is the case, you should use sbval to evaluate the missing initial values
at x1. Once you have these missing initial values, you will have an initial value
problem rather than a two-point boundary value problem. You can then proceed
to solve this using any of the functions discussed earlier in this chapter.

The example in Figure 7 shows how to use sbval. Note that sbval does not actu-
ally return a solution to a differential equation. It merely computes the initial val-
ues the solution must have in order for the solution to match the final values you
specify. You must then take the initial values returned by sbval and solve the re-
sulting initial value problem as discussed earlier in this chapter.

The sbval function returns a vector containing those initial values left unspeci-
fied at x1. The arguments to sbval are:
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sbval( v, x1, x2, D, load, score)

v = Vector of guesses for initial values left unspecified at x1.

x1, x2 = The endpoints of the interval on which the solution to the differen-
tial equations will be evaluated.

D(x, y) = An n-element vector-valued function containing the first derivatives
of the unknown functions.

load(x1, v) = A vector-valued function whose n elements correspond to the val-
ues of the n unknown functions at x1. Some of these values will be
constants specified by your initial conditions. Others will be un-
known at the outset but will be found by sbval. If a value is un-
known you should use the corresponding guess value from v.

score(x2, y) = A vector-valued function having the same number of elements as v.
Each element is the difference between an initial condition at x2, as
originally specified, and the corresponding estimate from the solu-
tion. The score vector measures how closely the proposed solution
matches the initial conditions at x2. A value of 0 for any element in-
dicates a perfect match between the corresponding initial condition
and that returned by sbval.

Figure 7: Using sbval to obtain initial values corresponding to given final values
of a solution to a differential equation.
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It’s also possible that you don’t have all the information you need to use sbval
but you do know something about the solution and its first n −1 derivatives at
some intermediate value, xf. This is the exactly the situation contemplated by
bvalfit.

This function solves a two-point boundary value problem of this type by shoot-
ing from the endpoints and matching the trajectories of the solution and its de-
rivatives at the intermediate point.

bvalfit( v1, v2, x1, x2, xf, D, load1, load2, score)

v1, v2 = Vector v1 contains guesses for initial values left unspecified at x1.
Vector v2 contains guesses for initial values left unspecified at x2.

x1, x2 = The endpoints of the interval on which the solution to the differen-
tial equations will be evaluated.

xf = A point between x1 and x2 at which the trajectories of the solutions
beginning at x1 and those beginning at x2 are constrained to be
equal.

D(x, y) = An n-element vector-valued function containing the first derivatives
of the unknown functions.

load1(x1, v1) = A vector-valued function whose n elements correspond to the val-
ues of the n unknown functions at x1. Some of these values will be
constants specified by your initial conditions. If a value is unknown
you should use the corresponding guess value from v1.

load2(x2, v2) = Analogous to load1 but for values taken by the n unknown func-
tions at x2.

score(xf, y) = An n element vector valued function used to specify how you want
the solutions to match at xf. You’ll usually want to define score(xf,
y) := y to make the solutions to all unknown functions match up at
xf.

This method becomes especially useful when derivative has a discontinuity
somewhere in the integration interval as the example in Figure 8 illustrates.
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Figure 8: Using bvalfit to match solutions in the middle of the integration inter-
val.

Partial differential equations

A second type of boundary value problem arises when you are solving a partial
differential equation. Rather than fixing the value of a solution at two points as
was done in the previous section, we now fix the solution at a whole continuum
of points representing some boundary.

Two partial differential equations that arise often in the analysis of physical sys-
tems are Poisson’s equation:

∂2u
∂x2 + 

∂2u
∂y2

 = ρ(x, y)

and its homogeneous form, Laplace’s equation.

Mathcad has two functions for solving these equations over a square boundary.
You should use the relax function if you know the value taken by the unknown
function u(x, y) on all four sides of a square region.

If u(x, y) is zero on all four sides of the square, you can use multigrid function in-
stead. This function will often solve the problem faster than relax. Note that if
the boundary condition is the same on all four sides, you can simply transform
the equation to an equivalent one in which the value is zero on all four sides.

The relax function returns a square matrix in which:

An element’s location in the matrix corresponds to its location within the
square region, and 
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Its value approximates the value of the solution at that point. 

This function uses the relaxation method to converge to the solution. Poisson’s
equation on a square domain is represented by:

aj, kuj + 1, k + bj, kuj − 1, k + cj, kuj, k + 1 + dj, kuj, k − 1 + ej, kuj, k = fj, k

The arguments taken by these functions are shown below:

relax(a, b, c, d, e, f, u, rjac)

a, b, c, d, e = Square matrices all of the same size containing coefficients of the
above equation.

f = Square matrix containing the source term at each point in the region
in which the solution is sought.

u = Square matrix containing boundary values along the edges of the re-
gion and initial guesses for the solution inside the region.

rjac = Spectral radius of the Jacobi iteration. This number between 0 and
1 controls the convergence of the relaxation algorithm. Its optimal
value depends on the details of your problem.

If the boundary condition is zero on all four sides of the square integration do-
main, use the multigrid function instead. An example is shown in Figure 9. The
same problem solved with the relax function instead is shown in Figure 10.

multigrid(M, ncycle)

M = 1 + 2n row square matrix whose elements correspond to the source
term at the corresponding point in the square domain.

ncycle = The number of cycles at each level of the multigrid iteration. A
value of 2 will generally give a good approximation of the solution.
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Figure 9: Using multigrid to solve a Poisson’s equation in a square domain.

Figure 10: Using relax to solve the same problem as that shown in Figure 9.
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Chapter 17
Symbolic Calculation

This chapter describes symbolic processing in Mathcad. The
chapter includes the following sections:

What is symbolic math?
An overview of Mathcad’s symbolic math features.

Live symbolic evaluation
Using the symbolic equal sign to perform a variety of symbolic transfor-
mations.

Symbolic algebra
Using menu commands to manipulate expressions algebraically.

Symbolic calculus
Evaluating indefinite integrals, derivatives and limits symbolically.

Solving equations symbolically
Algebraic solution of equations or systems of equations.

Symbolic matrix manipulation
Finding the symbolic transpose, inverse, and determinant of a matrix.

Symbolic transforms
Fourier, Laplace and z-transforms.

Displaying symbolic results
Controlling the display of symbolic results.

Symbolic optimization
Symbolically simplifying complex equations before numerically evalu-
ating them.

Using functions and variables
Differences in how the symbolic and numerical processors work with
variables and functions.

Limits to symbolic processing
Difficulties you may encounter in symbolic processing and what to do
about them.
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What is symbolic math?

Up until now, you’ve seen Mathcad engaging in numerical mathematics. This
means that whenever you evaluate an expression, Mathcad returns one or more
numbers as shown at the top of Figure 1. Although these numbers are quite use-
ful, they provide little insight into the underlying relationship between the com-
ponents in an expression. 

When Mathcad engages in symbolic mathematics, however, the result of evaluat-
ing an expression is generally another expression as shown in the bottom of Fig-
ure 1. The form of this second expression is to a great extent under your control.
You can factor the original expression, integrate it, expand it into a series, and
so on. The way you control the form of that second expression is the subject of
this chapter.

Figure 1: A numerical and symbolic evaluation of the same expression.

There are three ways to perform a symbolic transformation on an expression.

You can use the symbolic equal sign as described in the section “Live sym-
bolic evaluation.” This method feels very much as if you’re engaging in nu-
merical math. 

If you need more control over the symbolic transformation, you can use the
individual commands described in the section “Using the Symbolic menu”

You can make the numerical and symbolic processors work together; the lat-
ter simplifying an expression behind the scenes so that the former can work
with it more efficiently. This is discussed in the section “Symbolic optimiza-
tion.”
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Symbolic processing also raises some subtle issues concerning the use of func-
tions and variables. These are described in the section “Using functions and vari-
ables.”

Finally, there are some fundamental limits inherent in computer based symbolic
processing generally. These arise because nobody really knows how the human
brain does symbolic processing. As a result, nobody really knows how to teach a
computer to do it. These limits are discussed in the last section “Limitations of
symbolic processing.”

Live symbolic evaluation 

  The symbolic equal sign provides a way to extend Mathcad’s live document in-
terface beyond the numerical evaluation of expressions. You can think of it as
being analogous to the equal sign “=”. Unlike the equal sign, which always
gives a number on the right hand side, the symbolic equal sign is capable of giv-
ing expressions.

To use the symbolic equal sign to simplify an expression:

Make sure the Automatic Mode command on the Math menu has a check-
mark beside it. If it doesn’t choose it from the menu.

Make sure the Live Symbolics command on the Math menu has a check-
mark beside it. If it doesn’t choose it from the menu. Note that this command
is gray until the Automatic Mode command from the Math menu is checked.

Enter the expression you want to simplify.

Press [Ctrl]. (the control key followed by a period). Mathcad displays an
arrow, “→”.

Click outside the expression. Mathcad displays a simplified version of the
original expression. If an expression cannot be simplified further, Mathcad
simply repeats it to the right of the arrow.

The symbolic equal sign is a live operator just like any Mathcad operator. When
you make a change anywhere above or to the left of it, Mathcad updates the re-
sult. The symbolic equal sign “knows” about previously defined functions and
variables and uses them wherever appropriate. You can force the symbolic equal
sign to ignore prior definitions of functions and variables by using the assume
keyword as shown in Figure 4.

Figure 2 shows some examples of how to use this operator. Note that the “→”
only applies to an entire expression. You cannot, for example, use the “→” to
transform only part of an expression. Nor can you apply the “→” to the result of
a previous “→”.
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Figure 2: Using the symbolic equal sign.

Customizing the symbolic equal sign

The “→” takes the left-hand side and places a simplified version of it on the
right-hand side. By default, it simplifies the left-hand side just as if you had cho-
sen Evaluate⇒Symbolically from the Symbolic menu (see page 387). 

Of course, exactly what “simplify” means is a matter of opinion. As a result,
you can, to a limited extent, control how the “→” transforms the expression by
putting one of the following keywords before the expression containing it. For
more comprehensive control over symbolic transformations, you must use the
Symbolic menu.

Keyword Function

simplify Simplifies the expression, performing arithmetic, canceling
common factors and using basic trigonometric and inverse
function identities.

expand Expands all powers and products of sums in the selected ex-
pression.

series Expands an expression in one or more variables around a
specified point. By default, the expansion is a polynomial
of order six.

factor Factors the selected expression into a product, if the entire
expression can be written as a product.
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assume Tells Mathcad to treat the variable which follows as an un-
defined variable even though it may have had a number as-
signed to it. Also used to specify constraints to be used in
the evaluation of the expression.

complex Tells Mathcad to carry out symbolic evaluation in the com-
plex domain. Result will usually be in the form a + i⋅b. 

float Tells Mathcad to display a floating point value whenever
possible.

literally Prevents the symbolic processor from attempting to opti-
mize whatever equation immediately follows.

Keywords are case sensitive and must therefore be typed exactly as shown.
They are not, however, font sensitive.

Figure 3 shows some examples of how to use these keywords. Note that a key-
word acts only on the very next occurrence of a “→”. 

Figure 3: Using keywords with a symbolic equal sign.
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When you use the symbolic equal sign to evaluate an expression, Mathcad
checks all the variables and functions making up that expression to see if
they’ve been defined earlier in the worksheet. If Mathcad does find a definition,
it uses it. Any other variables and functions are evaluated symbolically. 

There are three exceptions to this, all of which are illustrated in Figure 4. In
evaluating an expression made up of previously defined variables and functions,
Mathcad ignores prior definitions:

when the variable is defined as a number containing a decimal point,

when the keyword assume precedes the definition, or

when the variable has been defined as a range variable. 

You can also use the keyword assume to assume constraints on the variables in
the expression. The last example in Figure 4 illustrates how an integral can be
made to converge by assuming a variable is positive. Note that in order to spec-
ify more than one condition, you simply separate the conditions with a comma
as shown in the last example in Figure 4.

The keyword assume must precede any other keywords applied to an expres-
sion. This is because a keyword will apply only to the expression immediately
following it. An example is shown in the middle of Figure 4. 

Figure 4: The keyword assume controls whether or not Mathcad substitutes
values for variable and function names into an expression.

The keywords complex and float provide some additional control over the
form in which Mathcad displays a symbolic result.
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The keyword complex before an expression causes Mathcad to return a result
in the form a + i⋅b. This generally yields an unnecessarily complicated expres-
sion when all parameters are real. However when one or more parameters are
complex, the ability to see this more general representation becomes useful. Fig-
ure 5 compares some transformations with and without the complex keyword.

The float keyword will make the next symbolic result display as a floating
point number whenever possible. You can control the precision of this number
by following float with an appropriate integer as shown in Figure 6. In Figure
6, Mathcad can display the term π/2 in floating point. The float keyword has
no effect on X, however. Since X is not defined, Mathcad cannot display it as
anything but X. 

Figure 5: The keyword complex controls whether or not Mathcad tries to re-
turn a result in the form a + i⋅b.
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Figure 6: Use the float keyword to display results in terms of numbers when-
ever possible.

The series keyword is used to expand an expression around a particular com-
bination of variables. By default, Mathcad expands a series around zero and in-
cludes all terms whose exponents sum to less than six. You can, however,
specify the points around which to expand a series as shown in Figure 7. This is
particularly useful when an expression has a singularity at 0. You can also spec-
ify the order of the expansion as shown in the last example in Figure 7.

Occasionally, a series will contain coefficients displayed in rather lengthy sym-
bolic form. You may want to use the float keyword in conjunction with 
series as shown in Figure 7. In the expansion shown, you would get an ex-
pression involving exp(1) in the absence of the float keyword.
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Figure 7: Use the series keyword to expand an expression around a particu-
lar point.

Using the Symbolic menu

Although the symbolic equal sign discussed in the last section is convenient to
use, its repertoire of symbolic transformations is limited. The commands on the
Symbolic menu provide considerably more control over the kinds of symbolic
transformation you can do.

The basic steps for using the Symbolic menu are the same for all the menu com-
mands:

Place whatever you want to transform between the two editing lines.

Choose the appropriate command from the Symbolic menu.

Mathcad will place the transformed expression into your document.

There is an important difference between symbolic evaluation using the Sym-
bolic menu and using the symbolic equal sign as described in the previous sec-
tion. Results to the right of a symbolic equal sign are re-evaluated whenever you
make a change to your worksheet. A result obtained through the Symbolic
menu, on the other hand, will not update automatically.
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For example, suppose that after selecting an expression you choose Factor from
the Symbolic menu. Mathcad inserts the factored result. If you now edit the
original expression, the symbolic answer won’t change. To get a new answer,
you must select the expression you just changed and choose Factor from the
menu again. Mathcad inserts a new result and pushes down the old result.

The following sections describe the various Symbolic menu commands in detail.

Symbolic algebra 

Certain commands from the Symbolic menu allow you to manipulate expres-
sions algebraically. You can simplify, expand, and factor expressions. You can
also collect like terms of an expression, find the coefficients of a polynomial, ex-
pand an expression into a series, or change all occurrences of a variable to what-
ever is on the clipboard. 

Symbolic evaluation

       In general, to evaluate an expression symbolically follow these steps:

Enter the expression.

Place the expression between the two editing lines by pressing [Space].

Press [Command]Y.

There are two additional ways to evaluate an expression: 

You can choose Evaluate⇒Complex Evaluation to express results in com-
plex form whenever possible.

You can choose Evaluate⇒Floating Point Evaluation to express a result as
a number whenever possible.

When evaluating expressions containing complex numbers, you may want to
choose Evaluate⇒Complex Evaluation from the Symbolic menu. This will
force Mathcad to express results in the form a + b⋅i. Figure 8 shows an example.

Ordinarily, the symbolic processor returns results by rearranging variables.
Thus, when Mathcad evaluates an expression involving π or e, it will usually re-
turn another expression involving π or exp(x). To force Mathcad to return a num-
ber instead, choose Evaluate⇒Floating Point Evaluation from the Symbolic
menu. This brings up a dialog box in which you can specify the number of digits
to the right of the decimal point. By default, this number is set to 20.
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Figure 8: Evaluating expressions symbolically using additional commands from
the Evaluate pull-right menu.

The symbolic processor treats numbers containing a decimal point differently
from numbers without a decimal point. The general rule is as follows:

When you send numbers with decimal points to the symbolic processor, any
numerical results you get back will be decimal approximations to the exact
answer. 

When you send numbers without decimal points to the symbolic processor,
any numerical results you get back will be expressed without decimal points
whenever possible. 

Figure 9 shows some examples of how the decimal point affects the answers
you get from the symbolic processor. In this example, note how √17  comes
back unchanged since there is no rational square root of 17. But √17.0  comes
back as a decimal approximation to the irrational number √17. 

When a symbolic operation gives an approximate decimal answer, this answer is
always displayed with 20 significant digits. This display is not affected by Math-
cad’s local or global numerical formats.
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Figure 9: Numerical answers in symbolic calculations.

Simplifying an expression

The Simplify command carries out basic algebraic and trigonometric simplifica-
tion of the selected expression. Simplify performs arithmetic, cancels common
factors, uses basic trigonometric and inverse function identities, and simplifies
square roots and powers. 

You can simplify parts of expressions (for example, the denominator of a frac-
tion, or one term of a sum) as well as entire expressions. You can also simplify
expressions involving arrays such as sums or products of matrices. To do so,
place the expression you want to simplify between the two editing lines before
choosing Simplify.

Mathcad may sometimes be able to simplify parts of an expression even when it
cannot simplify the entire expression. If selecting the entire expression and
choosing Simplify doesn’t give the answer you want, try selecting and simplify-
ing subexpressions. If Mathcad can’t simplify an expression any further, you’ll
just get the original expression back as the answer. Figure 10 illustrates some re-
sults of applying the Simplify command. 
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Figure 10: Some results of simplifying.

In general, when you simplify an expression, the simplified result will have the
same numerical behavior as the original expression. However, when the expres-
sion includes functions with more than one branch, such as square root or the in-
verse trigonometric functions, the symbolic answer may differ from a numerical
answer. For example, simplifying asin(sin(θ)) yields θ, but this equation holds
true numerically in Mathcad only when θ is a number between −π/2 and π/2. 

Expanding an expression

The Expand command from the Symbolic menu expands all powers and prod-
ucts of sums in the selected expression. If the expression is a fraction, the nu-
merator will be expanded and the expression will be written as a sum of
fractions. Sines, cosines and tangents of sums of variables, or integer multiples
of variables will be expanded as far as possible into expressions involving only
sines and cosines of single variables. See Figure 12 for some examples.

Expanding an expression to a series

     This section describes how to use the Expand command from the Symbolic
menu to expand an expression to a series.

To use the Expand command: 

Select a variable in the function or expression for which you want to find a se-
ries expansion. 

Choose Expand. A dialog box will prompt you for the order of the series.
This determines the number of terms, and hence the error in the series.
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Mathcad will then generate the corresponding series. The order is the order of
the error term in the expansion. For example, if you select the x in sin(x) and ask
for a series of order 6, you will get an expansion of the sine function in powers
of x in which the highest power is x 5. The error is thus O(x 6). The answers you
get from Series show this error term using the O notation. Before you use the se-
ries for further calculations you will need to delete this error term.

The Expand command is limited to series in a single variable; any other vari-
ables in the expression will be treated as constants. Mathcad will find Taylor se-
ries (series in nonnegative powers of the variable) for functions that are analytic
at 0, and Laurent series for functions that have a pole of finite order at 0. To de-
velop a series with a center other than 0, you can translate. For example, to get a
series for the log function around 1:

Apply Expand to ln(x + 1). 

Use Variable⇒Substitute to substitute x − 1 for x. 

Figure 11 shows some examples of series generated with this menu command.
For an alternative method for generating series expansions, see the section on
the series keyword in the section “Live symbolic evaluation” earlier in this chap-
ter.

In using the approximations you get from the Expand command, keep in mind
that the Taylor series for a function may converge only in some small interval
around the center. Furthermore, functions like sin or exp have series with infi-
nitely many terms, while the polynomials returned by Expand have only a few
terms (how many depends on the order you select). Thus, when you approxi-
mate a function by the polynomial returned by Expand, the approximation will
be reasonably accurate close to the center, but may be quite inaccurate for val-
ues far from the center.
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Figure 11: Generating a series.

Factoring an expression

The Factor command from the Symbolic menu factors the selected expression.
If this expression is a single integer, Mathcad will factor it into powers of
primes. Otherwise, Mathcad will attempt to convert the expression into a prod-
uct. This command will combine a sum of fractions into a single fraction and
will often simplify a complex fraction with more than one fraction bar.

Note that Mathcad factors only what is selected when you use this command.
For example, if you select the entire expression 

a⋅b + a⋅c + x

and choose Factor, Mathcad will return this expression unchanged as its an-
swer, because the whole expression selected is not factorable. But if you select
just the first two terms, Mathcad will return

a⋅(b + c) + x

When you’re simplifying by factoring, you may be able to simplify your expres-
sion quite a bit by selecting and factoring subexpressions even if the expression
taken as a whole can’t be factored. Choose Factor to combine a sum of frac-
tions into a single fraction or to simplify a complex fraction. See the examples
in Figure 12. 
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Collecting like terms

The Collect menu command collects terms containing like powers of the subex-
pression you’ve selected. The result is a polynomial in the subexpression. The
subexpression you select must be a single variable or a built-in function together
with its argument. See Figure 12 for an example.

Figure 12: Expanding to a polynomial, factoring, and collecting terms.

Partial fraction decomposition

To convert an expression to a partial fraction:

Select a variable in the denominator of the expression.

Choose Variable⇒Convert to Partial Fraction from the Symbolic menu.

The symbolic processor will try to factor the denominator of the expression into
linear or quadratic factors having integer coefficients. If it succeeds, it will ex-
pand the expression into a sum of fractions with these factors as denominators.
All constants in the selected expression must be integers or fractions; Mathcad
will not expand an expression that contains decimal points. See Figure 13 for
some examples.
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Figure 13: Partial fraction decomposition.

Finding coefficients of a polynomial

Many expressions can be rewritten as polynomials, either in a particular variable
or with respect to a subexpression. To do so:

Select the variable in which you want your expression to be regarded as a
polynomial. 

Choose Polynomial Coefficients from the Symbolic menu.

Mathcad returns a vector containing the coefficients of the equivalent polyno-
mial. The first element of the vector is the constant term. The first expression in
Figure 14 shows an example.

You can also enclose place the function between the two editing lines if you
want the symbolic processor to regard your expression as a polynomial with re-
spect to a function. The second expression in Figure 14 shows an example of a
polynomial in the function sin(x). 
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Figure 14: Finding the coefficients of some polynomials.

Substituting an expression for a variable

This command substitutes a selected expression for each occurrence of a vari-
able. To use this command: 

Select the expression that will replace the variable.

Copy it to the clipboard by choosing Copy from the Edit menu.

Select an occurrence of the variable you want to replace and choose Vari-
able⇒Substitute from the Symbolic menu. 

Mathcad will substitute the expression on the clipboard for the selected variable.
If the variable occurs more than once in the expression you are transforming,
each occurrence Mathcad replaces each occurrence. Figure 15 shows some ex-
amples.

Note that Variable⇒Substitute will not substitute a vector or a matrix for a vari-
able. To substitute a scalar expression for a variable that occurs in a matrix, put
the expression in the clipboard with Copy. Then for each matrix element that
contains the variable, click on the element and choose Variable⇒Substitute.
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Figure 15: Substituting an expression for a variable.

Evaluating a summation

 To evaluate a sum symbolically, you can use Mathcad’s summation operator:

Create the summation operator by typing [Ctrl][Shift]4.

Enter the expression you want to sum in the placeholder to the right of the
“Σ”. 

Enter the index variable and summation range in the placeholders above and
below the “Σ” as shown in Figure 16. 

Place the entire expression between the two editing lines and press [Com-
mand]Y.

The procedure is the same for a product over a range, except that you type
[Ctrl][Shift]3 to get the product operator. If you use numerical limits in a
summation or product range, be sure that the upper limit of the range is greater
than or equal to the lower limit. 

Note that as with all symbolic operations, the symbolic processor doesn’t know
about any variable definitions in your worksheet. Thus if you’ve defined a 10
element vector v, symbolic summation of vi over the range i = 0 . . 9 will just
give you the formal sum v0 + v1 + . . . + v9. If all you want is a numerical an-
swer, use the sum and product operators described in Chapter 11.
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Evaluating other functions and operators 

In general, you can symbolically evaluate any of the Mathcad built-in functions
described in the previous section. If the result can be computed exactly (sin(π)
for example), you’ll see an exact answer. Otherwise Mathcad will return the
original expression as the answer. Figure 16 illustrates various results of sym-
bolic evaluation.

Figure 16: Symbolic evaluation of sums, products, and functions.

Symbolic calculus

This section describes how evaluate definite and indefinite integrals, how to
evaluate derivatives and how to take limits.

Derivatives

 To evaluate a derivative symbolically, you can use Mathcad’s derivative opera-
tor as shown in Figure 17:

Type ? to create the derivative operator or type [Ctrl]? to create the higher
order derivative operator.

In the placeholders, enter the expression you want to differentiate and the
variable with respect to which you are differentiating. 

Press [Command]Y.
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Figure 17: Evaluating integrals and derivatives symbolically.

Figure 18 shows you how to differentiate an expression without using the deriva-
tive operator. The menu command Variable⇒Differentiate differentiates an ex-
pression with respect to a selected variable. For example, to differentiate
2⋅x 2 + y with respect to x: 

Select the x. 

Choose Variable⇒Differentiate from the Symbolic menu. Mathcad will dis-
play the derivative, 4⋅x. 

If you selected the variable y instead of x, you would get the answer 1. Mathcad
treats all variables except the one you’ve selected as constants.

If you’ve selected neither x nor y the menu command will be gray. Mathcad
can’t differentiate the expression because you haven’t specified a differentiation
variable. 

If the expression in which you’ve selected a variable is one element of an array,
Mathcad will differentiate only that array element. To differentiate an entire ar-
ray, differentiate each element individually by selecting a variable in that ele-
ment and choosing Variable⇒Differentiate.

The symbolic processor treats functions that are not on the list of built-in func-
tions as unknown. When you differentiate such a function, the symbolic proces-
sor will usually express the answer in terms of derivative operators.
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Indefinite integrals

    Mathcad provides the symbolic indefinite integral operator shown in Figure 17.
To use this operator:

Type [Ctrl]I to insert the indefinite integral operator and its placeholders.

Fill in the placeholder for the integrand.

Place the integration variable in the placeholder next to the “d.” This can be
any variable name.

Place the entire expression between the two editing lines by pressing
[Space] one or more times.

Press [Command]Y.

Figure 18 shows how to integrate an expression without using the indefinite inte-
gral operator. The menu command Variable⇒Integrate integrates an expres-
sion with respect to a selected variable. For example, to integrate 2⋅x 2 + y with
respect to x: 

Select the x. 

Choose Variable⇒Integrate from the Symbolic menu. Mathcad will display
the integral. 

The Variable⇒Integrate command integrates an expression with respect to a
selected variable. If you don’t have a variable selected, this command will be
gray. Mathcad cannot integrate without knowing the variable of integration. 

If the symbolic processor can’t find a closed-form indefinite integral, you’ll see
an appropriate error message. Keep in mind that many simple expressions don’t
have a closed-form indefinite integral that can be written in terms of polyno-
mials or elementary functions. For example e−x3

 has no elementary integral. If
the integral is too big to display, Mathcad puts the answer, in text form, on the
clipboard. See the section “Long answers” on page 420 to learn what to do when
this happens.

When evaluating an indefinite integral, remember that the answer to an integra-
tion problem is not unique. If f(x) is an integral of a given function, so is f(x) + C
for any constant C. Thus, the answer you get from Mathcad may differ by a con-
stant from the answer you find in tables. If you differentiate a function and then
integrate the result, you won’t necessarily get the original function back as your
answer.
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Figure 18: Differentiating and integrating expressions.

Definite integrals

To symbolically evaluate a definite integral:

Type & to create the integral operator with its empty placeholders.

Fill in the placeholders for the limits of integration. These can be variables,
constants, or expressions.

Fill in the placeholder for the integrand.

Fill in the placeholder next to the “d.” This is the variable of integration. 

Place the entire expression between the two editing lines by pressing
[Space] one or more times.

Press [Command]Y.

The symbolic processor will attempt to find an indefinite integral of your inte-
grand before substituting the limits you specified. If the symbolic processor
can’t find a closed form for the integral, you’ll see an appropriate error message.

If the symbolic integration succeeds and the limits of integration are integers,
fractions, or exact constants like π, you’ll get an exact value for your integral. If
the integrand or one of the limits contains a decimal point, the symbolic answer
will be a number displayed with twenty significant digits.
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This answer will in general agree with the answer you get by evaluating the
same integral numerically. The symbolic and numerical answers are, however,
obtained in very different ways. Mathcad’s symbolic processor:

Finds an indefinite integral.

Subtracts its value at the lower limit of integration from its value at the upper
limit. 

The numerical integration routine, on the other hand: 

Samples the integrand at many points in the interval of integration.

Uses these samples to approximate the integral. 

The accuracy of this numerical integration depends on the value you set for the
variable TOL and on the smoothness of the function you are integrating. 

Of course, many functions do not have a closed form integral, and definite inte-
grals involving these functions can only be calculated numerically. Integrals for
which the integrand is not smooth (has a discontinuous derivative) might not be
evaluated correctly by the symbolic processor. See Chapter 11 for more on
Mathcad’s numerical integration.

Limits

Mathcad PLUS provides three limit operators. These can only be evaluated sym-
bolically. They cannot be evaluated numerically. To use the limit operators:

Press [Ctrl]L to create the limit operator. To create operators for limits
from the left or right, press [Ctrl]B or [Ctrl]A.

Enter the expression in the placeholder to the right of the “lim.”

Enter the limiting variable in the left-hand placeholder below the “lim.”

Enter the limiting value in the right-hand placeholder below the “lim.”

Place the entire expression between the two editing lines by pressing
[Space] one or more times.

Press [Command]Y.

Mathcad will return a result for the limit. If the limit does not exist, Mathcad re-
turns an error message. Figure 19 shows some examples of evaluating limits.
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Figure 19: Evaluating limits.

Solving equations symbolically

This section discusses how to symbolically solve an equation for a variable, find
the symbolic roots of an expression, and solve a system of equations symboli-
cally. The Variable⇒Solve command from the Symbolic menu lets you solve
an equation for a variable and find the roots of an expression. 

Solving equations symbolically is far more difficult than solving them numeri-
cally. You may find that the symbolic solver does not give a solution. This may
happen for a variety of reasons discussed in the section “Limitations of symbolic
solving” on page 420.

Solving an equation for a variable

To solve an equation for a variable:

Type the equation. Make sure you use [Ctrl]= to create the equals sign.

Select the variable you want to solve for by clicking on it.

Choose Variable⇒Solve from the Symbolic menu.

Mathcad will solve for the variable and paste the result into your worksheet.
Note that if the variable was squared in the original equation, you may get two
answers back when you solve. Mathcad displays these in a vector. Figure 20
shows an example.
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Figure 20: Rearranging an expression to solve for a variable.

You can also solve an inequality entered using the symbols <, >, ≤, and ≥. Solu-
tions to inequalities will be displayed in terms of Mathcad boolean expressions.
If there is more than one solution, Mathcad places them in a vector. A Mathcad
boolean expression such as x < 2 has the value 1 if it is true and 0 if it is false.
Thus the solution “x is less than 2 and greater than −2” would be represented by
the expression (x < 2) ⋅ (−2 < x).

Finding the roots of an expression

The procedure for finding the roots of an expression is analogous to the more
general problem of solving an equation for a variable. To find the roots of an ex-
pression:

Type the expression.

Select any occurrence of the variable for which you are solving.

Choose Variable⇒Solve from the Symbolic menu.

Note that there is no need to set the expression equal to zero. When Mathcad
doesn’t find an equals sign, it assumes you mean to set the expression equal to
zero.
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Figure 21: Examples of finding roots and solving inequalities.

Figure 22: Some uses for symbolic solving.
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Solving a system of equations symbolically

     In Chapter 15, “Solving Equations,” you learned how to use a solve block to
solve a system of equations. Using the Find function gave you numerical values
for the unknowns in a system of equations. In this section, you’ll learn a similar
technique for finding symbolic answers for the unknowns in a system of equa-
tions.

To solve a system of equations symbolically:

Type the word Given. This tells Mathcad that what follows is a system of
equations. You can type Given in any combination of upper and lower case
letters, and in any font. Just be sure you don’t type it while in a text region or
paragraph.

Now type the equations in any order below the word Given. Make sure you
press [Ctrl]= to type “=.”

Type the Find function as appropriate for your system of equations. This func-
tion is described on page 340. The arguments of the function are the variables
for which you are solving.

Press [Ctrl]. (the control key followed by a period). Mathcad displays the
symbolic equal sign.

Click outside the Find function.

Mathcad displays the solutions to the system of equations to the right of the ar-
row. If the Find function has one argument, Mathcad returns one result. If the
Find has more than one argument, Mathcad returns a vector of results. For exam-
ple, Find(x, y) returns a vector containing the expressions for x and y that solve
the system of equations. Note that if your system is an overdetermined non-lin-
ear system, the Find function will not return a solution. Use the Minerr function
instead of Find. Minerr will return an answer that minimizes the errors in the
constraints.

Most of the guidelines for solve blocks described in Chapter 15 apply to the
symbolic solution of systems of equations. The main difference is that when you
solve equations symbolically, you need not enter guess values for the solutions.

Figure 23 shows an example of a solve block used to solve a system of equa-
tions symbolically. For more information on solve blocks, see Chapter 15, “Solv-
ing Equations.”

404 Chapter 17  Symbolic Calculation



Figure 23: Solving a system of equations symbolically.

Symbolic matrix manipulation

When you choose Matrices from the Symbolic menu, you’ll see four com-
mands on a pull-right menu. This section describes how to use these commands
to find the symbolic transpose, inverse, and determinant of a matrix. 

Before using these commands, make sure that the entire matrix is between the
two editing lines. Click anywhere in the matrix and press [Space] to lengthen
the editing lines until they enclose the matrix.

Finding the symbolic transpose

To find the symbolic transpose of a matrix: 

Place the entire matrix between the two editing lines by clicking [Space]
one or more times.

Choose Matrix Operations⇒Transpose Matrix from the Symbolic menu.

Mathcad returns the matrix with its rows and columns swapped.

Finding the symbolic inverse

To find the symbolic inverse of a square matrix: 

Place the entire matrix between the two editing lines by clicking [Space]
one or more times.
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Choose Matrix Operations⇒Invert Matrix from the Symbolic menu.

Mathcad will return a symbolic representation for the inverse of the selected ma-
trix. 

Finding the symbolic determinant

To find the symbolic determinant of a square matrix: 

Place the entire matrix between the two editing lines by clicking [Space]
one or more times.

Choose Matrix Operations⇒Determinant of Matrix from the Symbolic
menu.

Mathcad will return a symbolic representation for the determinant of the se-
lected matrix. Keep in mind that this is usually a lengthy expression.

Figure 24: Symbolic matrix operations.
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Symbolic transforms

This section describes how to use the Transforms commands from the Sym-
bolic menu command to perform the Fourier, Laplace, and z-transforms, and
their inverses.

Figure 25 shows some examples on how to use Mathcad’s symbolic transforma-
tions. Note that the result may contain functions that are recognized by Math-
cad’s symbolic processor but not by its numeric processor. An example is the
function Dirac at the bottom of Figure 25. You’ll find numerical definitions for
this and other such functions at the end of this chapter.

Figure 25: Performing symbolic transforms.

Fourier and inverse Fourier transformations

  To evaluate the Fourier transform of a function:

Enter the expression to be transformed.

Click on the transform variable.

Choose Transforms⇒Fourier from the Symbolic menu.

Mathcad returns a function of ω given by:

∫   f(t) e−iωt dt
− ∞

+ ∞

where f(t) is the expression to be transformed. 
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Mathcad returns a function in the variable ω when you perform a Fourier trans-
form since this is a commonly used variable name in this context. If the expres-
sion you are transforming already contains an ω, Mathcad avoids ambiguity by
returning a function of the variable ωω instead. 

You can substitute a different variable or expression for ω by placing the vari-
able or expression on the clipboard, clicking on the ω and choosing Vari-
able⇒Substitute from the Symbolic menu.

To evaluate the inverse Fourier transform of a function:

Enter the expression to be transformed.

Click on the transform variable.

Choose Transforms⇒Inverse Fourier from the Symbolic menu.

Mathcad returns a function of t given by:

1
2π∫ F(ω) eiωt dω

− ∞

+ ∞

where F(ω) is the expression to be transformed. 

Mathcad returns a function in the variable t when you perform an inverse
Fourier transform since this is a commonly used variable name in this context. If
the expression you are transforming already contains a t, Mathcad avoids ambi-
guity by returning a function of the variable tt instead. 

You can substitute a different variable or expression for t by placing the variable
or expression on the clipboard, clicking on the t and choosing Variable⇒Substi-
tute from the Symbolic menu.

Laplace and inverse Laplace transformations

 To evaluate the Laplace transform of a function:

Enter the expression to be transformed.

Click on the transform variable.

Choose Transforms⇒Laplace from the Symbolic menu.

Mathcad returns a function of s given by:

∫   f(t) e−st dt
0

+ ∞

where f(t) is the expression to be transformed. 

Mathcad returns a function in the variable s when you perform a Laplace trans-
form since this is a commonly used variable name in this context. If the expres-
sion you are transforming already contains an s, Mathcad avoids ambiguity by
returning a function of the variable ss instead. 
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You can substitute a different variable or expression for s by placing the vari-
able or expression on the clipboard, clicking on the s and choosing Vari-
able⇒Substitute from the Symbolic menu.

To evaluate the inverse Laplace transform of a function:

Enter the expression to be transformed.

Click on the transform variable.

Choose Transforms⇒Inverse Laplace from the Symbolic menu.

Mathcad returns a function of t given by:

1
2πi

 ∫ F(s) est ds
σ − i∞

σ + i∞

where F(s) is the expression to be transformed and all singularities of F(s) are to
the left of the line Re(s) = σ.

Mathcad returns a function in the variable t when you perform an inverse
Laplace transform since this is a commonly used variable name in this context.
If the expression you are transforming already contains a t, Mathcad avoids am-
biguity by returning a function of the variable tt instead. 

You can substitute a different variable or expression for t by placing the variable
or expression on the clipboard, clicking on the t and choosing Variable⇒Substi-
tute from the Symbolic menu.

z and inverse z-transformations

To evaluate the z-transform of a function:

Enter the expression to be transformed.

Click on the transform variable.

Choose Transforms⇒Z from the Symbolic menu.

Mathcad returns a function of z given by:

∑ 
n = 0

+ ∞

 f(n)z−n

where f(n) is the expression to be transformed. 

Mathcad returns a function in the variable z when you perform a z-transform
since this is a commonly used variable name in this context. If the expression
you are transforming already contains a z, Mathcad avoids ambiguity by return-
ing a function of the variable zz instead. 

You can substitute a different variable or expression for z by placing the vari-
able or expression on the clipboard, clicking on the z and choosing Vari-
able⇒Substitute from the Symbolic menu.
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To evaluate the inverse z-transform of a function:

Enter the expression to be transformed.

Click on the transform variable.

Choose Transforms⇒Inverse Z from the Symbolic menu.

Mathcad returns a function of n given by a contour integral around the origin:

1
2πi∫ F(z) zn − 1

C
 dz

where F(z) is the expression to be transformed and C is a contour enclosing all
singularities of the integrand. 

Mathcad returns a function in the variable n when you perform an inverse z-
transform since this is a commonly used variable name in this context. If the ex-
pression you are transforming already contains an n, Mathcad avoids ambiguity
by returning a function of the variable nn instead. 

You can substitute a different variable or expression for n by placing the vari-
able or expression on the clipboard, clicking on the n and choosing Vari-
able⇒Substitute from the Symbolic menu.

Displaying symbolic results

Two commands from the Symbolic menu can be used to determine how sym-
bolic results are presented. Before performing any symbolic math you might
want to use these commands.

Evaluation Style

 If you’re using the symbolic equal sign, “→”, the result of a symbolic transfor-
mation will always go to the right of the “→”. However, when you use the Sym-
bolic menu, you can tell Mathcad to place the symbolic reults in one of the
following ways:

The symbolic result can go below the original expression.

The symbolic result can go to the right of the original expression.

The symbolic result can simply replace the original expression.

In addition, you can also choose whether or not you want Mathcad to generate
text describing what had to be done to get from the original expression to the
symbolic result. This text would go between the original expression and the sym-
bolic result, in effect creating a narrative for the symbolic evaluation. These text
regions are referred to as “evaluation comments.”
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To control both the placement of the symbolic result and the presence of narra-
tive text, choose Evaluation Style from the Symbolic menu. This brings up the
following dialog box. 

The check box at the top of the dialog box shows whether Mathcad will automat-
ically generate evaluation comments at each step of the evaluation. Click in this
box to toggle these comments on or off.

The three option buttons control where symbolic results are placed. These op-
tions do the following:

“Show evaluation steps vertically, without inserting lines” is useful when you
want to show two parallel derivations side by side. In this mode, you can posi-
tion expressions arbitrarily. New answers may, however, overwrite old ones. 

“Show derivation steps vertically, inserting lines” is useful when you expect
lengthy intermediate results and you want to reserve an entire line for them.

“Show derivation steps horizontally” is useful if you want to place the sym-
bolic result to the right of the expression being transformed, click on the op-
tion button  See Figure 26 for some examples.

Evaluate in Place

Sometimes you don’t care about saving the steps of a derivation. You may just
want to transform an expression in place, for example to make a substitution, or
to factor the numerator of a fraction. In this case you can choose Evaluate in
Place from the Symbolic menu. This tells Mathcad to replace the old expression
with the new one. Under these circumstances, evaluation comments are inappro-
priate and therefore omitted altogether.
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Figure 26: Placement of symbolic results and comments.

Symbolic optimization

           In general, Mathcad’s symbolic processor and Mathcad’s numerical processor
don’t communicate with one another. Because of this, it’s possible to set up a
complicated numerical calculation without knowing that you could have re-
duced it to an equivalent but much simpler problem by judicious use of the sym-
bolic processor.

You can, however, make the numerical processor ask the symbolic processor for
advice before starting what could be a needlessly complex calculation. In effect,
the symbolic processor acts like the numerical processor’s consultant, examin-
ing each expression and recommending a better way to evaluate it whenever pos-
sible. It does this for each expression in the worksheet except for those you
specificaly tell it to ignore.

For example, if you were to evaluate an expression such as:

∫  
0

u

∫  
0

v

∫ x2
0

w
 + y2 + z2 dx dy dz

Mathcad would undertake the laborious task of evaluating a numerical approxi-
mation of the triple integral even though one could arrive at an exact solution by
first performing a few elementary calculus operations. 
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This happens because by itself, Mathcad’s numerical processor does not know
enough to simplify before plunging ahead into the calculation. Although Math-
cad’s symbolic processor knows all about simplifying complicated expressions,
these two processors do not consult with each other. To make these two proces-
sors talk to each other by choosing Optimization from the Math menu. 

Once you’ve done this, Mathcad’s live symbolic processor steps in and simpli-
fies all expressions to the right of a “:=” before the numerical processor gets a
chance to begin its calculations. It will continue to do so until you choose Opti-
mization from the Math menu once more to remove the checkmark. 

If Mathcad finds a simpler form for the expression, it responds by doing the fol-
lowing: 

It marks the region with a red asterisk. 

It internally replaces what you’ve typed with a simplified form. The expres-
sion you typed is left unchanged; Mathcad simply works with an equivalent
expression that happens to be better suited for numerical analysis.

Mathcad evaluates this equivalent expression instead of the expression you
specified. To see this equivalent expression, double-click on the red asterisk
beside the region.

In the previous example, the symbolic processor would examine the triple inte-
gral and return the equivalent, but much simpler expression:

1
3

(w3vu + wv3u + wvu3)

To see this expression in a pop-up window double-click on the red asterisk (see
Figure 27). To dismiss the pop-up, click anywhere in your worksheet.
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Figure 27: A pop-up window showing the equivalent expression that Mathcad
actually evaluates.

Since this simplified form contains no integral, Mathcad’s numerical processor
no longer needs to use a lengthy numerical algorithm to evaluate the integral.
This offers two advantages:

By avoiding time-consuming integration, Mathcad’s numerical processor can
evaluate the expression far more quickly.

Mathcad avoids all the computation issues inherent in numerical integration.

There may be times when you don’t want Mathcad’s symbolic processor to ex-
amine a particular equation. You may want to evaluate an expression exactly as
you’ve typed it. To do so, precede the expression with the keyword liter-
ally. When the symbolic processor encounters this keyword, it makes no at-
tempt to simplify the expression immediately following it.

Using functions and variables

Mathcad’s symbolic processor does not treat functions and variables in exactly
the same way as its numerical processor. These differences revolve around the
answers to the following question:

Does the symbolic processor “know” that a function or variable is defined
elsewhere?
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The answer to this depends on two things:

Is the function or variable built-in or is it defined somewhere on the work-
sheet?

Are you using the symbolic equal sign or a menu command?

The next two sections describe what Mathcad does with variables and functions
in a symbolic transformation.

A related question is the converse. Symbolic transformations can sometimes re-
turn functions and constants which do not exist in Mathcad’s list of built-in func-
tions and constants. These are described in the last section, “Special functions”.

Built-in functions and variables

As a general rule, built-in functions retain their meanings when used in sym-
bolic transformations provided that it makes sense for them to do so. For exam-
ple, functions like sin and log keep their meanings because these have a
commonly accepted mathematical meaning. Other functions like linterp or rnd
lack any commonly accepted meaning so Mathcad doesn’t attempt to assign one.

Built-in functions that do retain their meanings when used in symbolic calcula-
tions include: trigonometric and hyperbolic functions and their inverses; logarith-
mic and exponential functions; the Re and Im functions; the erf function; the Γ
function; the mod function; Φ (the Heaviside step function); max and min; and
the identity and eigenvals functions for matrices..

In general, these functions mean the same thing for both numerical evaluations
and symbolic transformations. There are three subtle differences:

Unlike the numerical mod function, the symbolic mod function requires an in-
teger modulus, and can accept a polynomial as its first argument (see Figure
16). 

Certain of the inverse trigonometric functions use different branches in the
complex plane. 

The eigenvals function will work symbolically for complex as well as real
matrices; numerical evaluation of eigenvals works only for real matrices.

As a general rule, built-in constants also retain their meanings when used in sym-
bolic transformations provided that it makes sense for them to do so. The sym-
bolic processor will recognize π, e and ∞. Moreover, these will have their exact
meanings when used symbolically. When symbolic transformations are in-
volved, there is no need to limit ∞ to 10307 or to limit π to only fifteen digits of
precision. 

Built-in constants lacking an intuitive mathematical meaning are not recognized
by the symbolic processor. For example, TOL and ORIGIN will not have their
usual meanings in symbolic transformations. They will be treated like any other
undefined variable.
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Figure 28 shows the difference in the way Mathcad treats functions in symbolic
transformations. Note that the symbolic processor will recognize and evaluate
the sin function, but when asked to evaluate rnd(3) the symbolic processor sim-
ply returns rnd(3).

Figure 28: Some functions retain their numerical meanings while others lose
them.

User-defined functions and variables

Functions and variables you define yourself are recognized by the symbolic
processor when you use the symbolic equal sign discussed in the next section.
They are not, however, recognized when you use menu commands. Figure 29
shows the difference.
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Figure 29: Functions and variables you define yourself are only recognized
when you use the symbolic equal sign.

Special functions

A symbolic transformation sometimes comes back in terms of a function which
isn’t part of Mathcad’s list of built-in functions. The list below gives definitions
for those special functions. Except for Ei, erf, and Zeta, all of which involve infi-
nite sums, and W, you can use these definitions to calculate numerical values.

γ is Euler’s constant, approximately 0.5772156649.

Chi(x) = γ + ln(x) + ∫ 
0

x
  
cosh(t) − 1

t
 dt

Ci(x) = γ + ln(x) + ∫ 
0

x
  
cos(t) − 1

t
 dt

csgn(z) = 1 if Re(z) > 0 or (Re(z) = 0 and Im(z) ≥ 0); −1 otherwise. De-
fine in Mathcad as: if(Re(z) ≠ 0, 2Φ(Re(z)) − 1, 2Φ(Im(z)) − 1)

dilog(x) = ∫ 
1

x
  

ln(t)
1 − t

 dt

Dirac(x) = ∞ if x = 0 and 0 otherwise.

Ei(x) = γ + ln(x) + ∑ 
n = 1

∞
x n

n⋅n!
 (x > 0)
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erf(z) = 
2

√π  ∑ 
n = 0

∞
(−1) nz 2n + 1

n! (2n + 1)  (for complex z)

FresnelC(x) = ∫ 
0

x
 cos




π
2

 t 2



 dt

FresnelS(x) = ∫ 
0

x
 sin




π
2

 t 2



 dt

LegendreE(x, k) = ∫ 


1 − k2⋅t2

1 − t2




1/2

dt
0

x

LegendreEc(k) = LegendreE(1, k)

LegendreEc1(k) = LegendreEc√1 − k2 

LegendreF(x, k) = ∫ 1
√(1 − t2)(1 − k2⋅t2)

dt
0

x

LegendreKc(k) = LegendreF(1, k)

LegendreKc1(k) = LegendreKc√1 − k2  

LegendrePi(x, n, k) = ∫ 1
(1 − n2⋅t2)√(1 − t2)(1 − k2⋅t2)

dt
0

x

LegendrePic(n, k) = LegendrePi(1, n, k)

LegendrePic1(n, k) = LegendrePicn, √1 − k2 

Psi(n, x) = 
d n Psi(x)

dx n

Psi(x) = 
d ln(Γ(x))

dx

Shi(x) = ∫ 
0

x
  

sinh(t)
t

 dt

Si(x) = ∫ 
0

x
  

sin(t)
t

 dt

signum(x) = 1 if x = 0, x/|x| otherwise; calculate in Mathcad as
(x = 0) + x/|x|

W(x) =  the principal branch of a function satisfying W(x)⋅exp(W(x)) = x.

W(n, x) =  the nth branch of W(x).
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Zeta(s) = ∑ 
n = 1

∞
1
n s

 (s > 1)

The functions arcsec, arccsc, arccot, arcsech, arcscsh, arccoth can be calcu-
lated by taking reciprocals and using the Mathcad built-in functions acos, asin,
etc. For example:

arcsec(x) := acos



1
x





The Psi function and Γ appear frequently in the results of indefinite sums and
products. If you use a single variable name rather than a full range in the index
placeholder of a summation or product, and you choose Evaluate Symbolically
or one of the other symbolic evaluation commands, Mathcad will attempt to cal-
culate an indefinite sum or product of the expression in the main placeholder.
The indefinite sum of f(i) is an expression S(i) for which

S(i + 1) − S(i) = f(i)

The indefinite product of f(i) is an expression P(i) for which

P(i +1)
P(i)  = f(i)

Limits to symbolic processing

As you work with the symbolic processor, you will undoubtedly discover two
things:

many problems can only be solved numerically, and

many more problems yield such lengthy expressions that you’ll wish you had
solved them numerically.

For a computer, symbolic operations are, in general, much more difficult than
the corresponding numerical operations. In fact, if you write down a compli-
cated function at random, the chance is very small that either its roots or its inte-
gral can be expressed in a simple closed form. For example, there is no formula
for the roots of a general polynomial of degree 5 or higher, even though exact
roots can be found for some special cases. 

Many deceptively simple-looking functions made up of elementary pieces like
powers and roots, exponentials, logs, and trigonometric functions, have no
closed-form integral that can be expressed in terms of these same functions. 
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Limitations of symbolic solving

As you use the symbolic solver, remember that symbolic solution is a very dif-
ferent operation from numerical solution. The symbolic solver may not find an
solution even if one exists. This is because many equations that can easily be
solved numerically have no exact symbolic solution. For example, there is no
formula like the quadratic formula that gives the roots of a polynomial of degree
5 or higher. Even some simple equations like x = cos(x) can’t be solved symboli-
cally.

When an equation has several solutions, Mathcad sometimes returns only a par-
tial solution and asks if you want this result placed in the clipboard. If you click
“OK,” Mathcad shows a vector containing the solutions found and the word
“Root”. In the clipboard, in place of the word “Root” you will see an expression
of the form “RootOf (function_of_Z)”. The roots of the indicated function are
solutions of the original equation.

As with other symbolic operations, the answers you get depend on whether the
constants in your equation contain decimal points. If your constants are pure ra-
tional numbers like 1/2 or 4, the symbolic solver will try to find an exact solu-
tion. For example, the solution to the first quadratic equation in Figure 21 is
exact; in fact it’s just the quadratic formula. But if you had typed “.5” instead of
“1/2”, Mathcad would have given approximate numerical values for the roots. 

Long answers

 Symbolic calculations can easily produce answers so long that they don’t fit con-
veniently in your window. If the answer consists of the sum of several terms,
you can reformat such an answer by using Mathcad’s “Break with Plus” opera-
tor.

To break an expression with plus signs: 

Select the leftmost term. 

Press [Space] until the plus sign you want to break on and the term follow-
ing it are held between the two editing lines. 

Press [BkSp]. The last plus sign held between the two editing lines will be re-
placed with an operand placeholder. 

Now type [Ctrl][↵] to insert the plus with break.

You can repeat this process if there are several terms connected by plus signs.

Sometimes, a symbolic answer will be so long that you can’t conveniently dis-
play it in your worksheet. When this happens, Mathcad will ask if you want the
answer placed in the clipboard. If you click “OK,” Mathcad places a string repre-
senting the answer on the clipboard. To see this string:

Open the Main group in the Program Manager window.

Double-click on the Clipboard icon.
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You’ll see an answer written in a Fortran-like syntax as shown in Figure 30.
This syntax uses the following conventions:

The symbols +, −, *, and / stand for the basic arithmetic operations. Exponen-
tiation is denoted by “**”.

The derivative of f(x) with respect to x is written “diff( f(x), x)”. The n th de-
rivative is “diff( f(x), x$n)”.

A “D” also stands for the partial derivative operator. The n th derivative is
“( D, n )”. The partial derivative of a function with respect to its n th argument
is “( D [ n ] )”.

The integral of f(x) with respect to x is written “int( f(x), x)”. 

The summation and product operators appear as “sum( )” and “product( )”.

The operator “@” denotes function composition. For example, (sin@exp)(x)
is the same as sin(exp(x)). A “@@” represents repeated composition, so (
f@@2)(x) is the same as f( f(x)).

“RootOf(equation)” stands for any root of an algebraic equation. (For exam-
ple, “RootOf(Z**2 + 1)” represents either i or −i.)

You may see embedded font codes (like “MFNT_03_”) preceding the vari-
able name to indicate the font in which the variable name is to appear.

To insert the answer as text into your Mathcad worksheet: 

Click in an empty area. 

Choose Paste from the Edit menu.

To save a long clipboard answer as a separate text file, choose Save As from the
Clipboard’s File menu.
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Figure 30: A long symbolic answer in the clipboard.
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Chapter 18
Data Files

Mathcad reads and writes data files — ASCII text files containing
numerical data. By reading data files, you can pull in data from
other sources and analyze it in Mathcad. By writing data files, you
can export Mathcad’s results to word processors, spreadsheets, and
other applications.

Mathcad includes two sets of functions for reading and writing
data. READ, WRITE, and APPEND read or write a single value at a
time. READPRN, WRITEPRN, and APPENDPRN read a whole matrix from
a file with rows and columns of data or write such a file from a
matrix in Mathcad.

This chapter contains the following sections:

Data files and file functions
Format of data files; description of file-access functions.

Importing data from other directories
Using the Associate command to specify which file to read from or
write to.

Unstructured files
How to use READ, WRITE, and APPEND.

Structured files
Reading and writing arrays with READPRN, WRITEPRN, and APPENDPRN.

Graphics files
Reading and writing images with READRGB and WRITERGB.



Data files and file functions 

 A Mathcad data file must be a text file in plain ASCII format. Mathcad reads
files that consist of numbers separated by commas, spaces, or carriage returns.
The following are some examples of files that Mathcad can read, assuming they
are in ASCII format:

A file containing experimental data captured with data-acquisition hardware
and software.

A file created by printing from a spreadsheet program to the disk.

A column of numbers typed into a word processor and saved in plain ASCII
format.

Output from a BASIC program.

Data downloaded from a mainframe database.

The numbers in the data files can be integers like 3 or –1, floating-point num-
bers like 2.54, or E-format numbers like 4.51E–4 (for 4.51⋅10−4). 

For example, this list of numbers would be a valid line in a Mathcad data file:

200, 50 25.1256, 16E–2, –16.125E15

Mathcad also saves data in ASCII files. Data files saved by Mathcad contain
numbers separated by spaces and carriage returns.

Note: Mathcad documents themselves are not valid data files. The only way to
create a data file from Mathcad is by using file-access functions as described in
this chapter.

File-access functions

Mathcad includes six functions for accessing numerical data stored in a file:
READ, WRITE, APPEND, READPRN, WRITEPRN, and APPENDPRN. They share
the following properties:

You must type the function name all in uppercase. Alternatively, you may in-
sert the function into your document by choosing Function from the Insert
menu and double-clicking on the function name.

The argument of these functions must be a single variable name. To read
from data files in other folders, or from files having names that are not valid
Mathcad variable names, use file association as described in the next section.

If Mathcad cannot find a data file, it marks the file-access function with an er-
ror message indicating that it could not find the file you specified. If Mathcad
tries to read a file and the format is incorrect, it marks the function with an er-
ror message.

The WRITE, APPEND, WRITEPRN, and APPENDPRN functions must appear
alone on the left side of a definition.



Each new equation reopens the data file. When you read data, for example,
each new equation starts reading at the beginning of the file.

A file can only be opened once per equation. This means that if you use
READ on the same argument twice in the same equation, the second READ
will begin reading where the first left off. Since READPRN reads the entire file
at once, this means you can’t use READPRN on the same file more than once
in an equation; there will be nothing left for the second READPRN to read.

If two equations in the same document use WRITE or WRITEPRN with the
same file variable, the data from the second equation will overwrite the data
from the first. Use APPEND or APPENDPRN when you don’t want to over-
write data. These functions add to an existing file instead of overwriting it.

The table below describes these six functions. In this table:

A represents an array, either vector or matrix.

vi represent the individual elements of vector v.

file is any valid filename on your file system.

i is a range variable.

The functions READ, WRITE and APPEND can be used with range variables. The
remaining functions never use range variables.

Function Meaning

READ( file) Read a value from a data file. Returns a scalar. Usually
used as follows:
vi := READ( file)

WRITE( file) Write a value to a data file. If file already exists, replace it
with new file. Must be used in a definition of the following
form:
WRITE( file) := vi

APPEND( file) Append a value to an existing file. Must be used in a defini-
tion of the following form:
APPEND( file) := vi

READPRN( file) Read a structured data file. Returns a matrix. Each line in
the data file becomes a row in the matrix. The number of
elements in each row must be the same. Usually used as fol-
lows:
A := READPRN( file)

WRITEPRN( file) Write a matrix into a data file. Each row becomes a line in
the file. Must be used in a definition of theform:
WRITEPRN( file) :=  A 



APPENDPRN( file) Append a matrix to an existing file. Each row in the matrix
becomes a new line in the data file. Must be used in a defi-
nition of the following form:
APPENDPRN( file) :=  A
Existing data must have as many columns as A.

Arguments to file access functions

The arguments of all functions in the previous table are called file variables.
When evaluated, a file variable doesn’t return a number like most variables, it re-
turns the name of a file. By default, the name of the file returned is the same as
the file variable. 

If the file you want to read from or write to: 

is located in a folder other than the default folder, or 

has a name containing spaces, or

has a name containing characters which Mathcad interprets as operators, 

you must associate that file with the file variable in much the same you have
been associating a number with a variable all along. This procedure is discussed
in the next section.

Importing data from other directories

 Mathcad’s file access functions read from and write to the current folder. The de-
fault filename is the file variable. Thus, if you use READPRN( Papageno), Math-
cad searches for “Papageno” in your default folder.

You can make a file-access function read from or write to a file other than the
one that matches its argument in the current folder. The following example
shows how to access a file called “Papageno” in the “Big Birds” folder :

Choose Associate from the File menu. A file dialog box appears, as shown
below.



In the text box under “Mathcad Variable,” type the file variable. If, for exam-
ple, you use READPRN(Aviarium) to access the data, the file variable is Aviar-
ium. Keep in mind that Mathcad variable names are case-sensitive. You must
type the variable name just as it appears in your document.

Use the scrolling list of files to find and open the “Big Birds” folder. Then
double click on the name “Papageno” in the scrolling list.

Click the “Associate” button. Mathcad will now access the file named “Pa-
pageno” in the “Big Birds” folder whenever it encounters a file access func-
tion with the file variable Aviarium.

Choose Calculate Document from the Math menu to update your document. 

Equations involving file access functions are not automatically updated like
other equations. If you make a change to a data file or change a filename associa-
tion, it will not affect calculations until you click in the equation and choose Cal-
culate Document from the Math menu. Think of file access functions as
always being in manual mode.

Since Mathcad can have only a finite number of files open at once, you may
want to sever the link between a variable and its associated file when it is no
longer needed. This may be necessary if you see an error message indicating
that too many files are open. To do so, choose Associate from the File menu
and type the name of the variable you want to disassociate from a file on your
disk. Then click the “Dissociate” button. 



Unstructured files 

This section discusses how to use READ, WRITE, and APPEND to read and write
data in unstructured files. An unstructured data file is a file that contains num-
bers, but not necessarily in rows and columns.

Reading data with the READ function 

Figure 1 shows two ways to use READ to read data from a file.

Figure 1: The READ function.

The first READ equation defines N as the first value in the data file Sizefile. The
second READ equation fills the array y with the first 100 numbers in the data file
Papageno.

When Mathcad reads data with the READ function:

Each new equation reopens the file and starts reading from the beginning.
You cannot read two successive sets of data from the same file by using two
separate READ equations.

In an equation with READ and a range variable, Mathcad reads one value for
each value of the range variable. If the data runs out before the range vari-
able, Mathcad just stops looking for more data. If the range variable ends be-
fore the end of the data, Mathcad ignores the extra data in the file.

An equation cannot include more than one READ function.



To read from a file other than the one that matches the variable name in paren-
theses, choose Associate from the File menu. Also choose Associate to read
from a file that is not in your Mathcad folder. See the section “Importing data
from other directories” earlier in this chapter for more information.

Writing data with the WRITE and APPEND functions 

Figure 2 shows how to use the WRITE function to write data to a data file.

Figure 2: Writing data with the WRITE function.

The first WRITE equation writes a single number to the data file Sizefile. The sec-
ond WRITE equation writes N numbers to the data file Papageno, one number
for each value of the range variable i.

When Mathcad writes data to a file, it separates successive numbers with spaces.
Mathcad also inserts line breaks to keep the lines shorter than 80 characters.
When you use WRITE, all values are saved to the file with maximum precision,
regardless of the global format of the document.

Mathcad ignores units when it writes data to a data file.

Like the READ function, the WRITE function reopens the file and starts at the be-
ginning for each new equation. If you want to write data to a file from several
different equations, use the APPEND function instead of the WRITE function in
the second and subsequent equations.

Warning: If you use the WRITE function on the same file in two separate equa-
tions, the data from the second equation will overwrite the data from the first
equation.



Figure 3 shows a document that reads data from a file, performs some computa-
tions, and writes the results out to another file.

Figure 3: Reading and writing data files.

Structured files 

This section discusses how to use READPRN, WRITEPRN, and APPENDPRN to
read and write data in structured files. A structured data file is a data file with a
fixed number of values per line. For example, if you print a rectangular area
from a spreadsheet into a file, the resulting rows and columns of numbers will
be a structured file.

Reading a matrix with the READPRN function 

   Suppose you have an ASCII text file containing the data shown below. These
numbers could come from a spreadsheet or from any other source.

Figure 4 shows a Mathcad document that reads these numbers into a matrix.



Figure 4: Reading spreadsheet data into a matrix.

The READPRN function reads the entire data file, determines the number of rows
and columns, and creates a matrix out of the data.

When Mathcad reads data with the READPRN function:

Each instance of the READPRN function reads an entire data file.

All lines in the data file must have the same number of values. (Lines contain-
ing no values are ignored.) If the lines in the file have differing numbers of
values, Mathcad marks the READPRN equation with an error message.

The READPRN function ignores text in the data file.

The result of reading the data file is an m-by-n matrix, where m is the number
of lines containing data in the file and n is the number of values per line. To
define a matrix out of the numbers in a data file, use an equation like
M := READPRN( file). Do not use subscripts on M. READPRN returns a ma-
trix, so no subscripts are necessary.

To read from a file other than the one that matches the argument of READPRN
or to read from a file that is not in your Mathcad folder, use the Associate
command on the File menu. See the section “Changing file associations,” ear-
lier in this chapter.

Warning: Each line in the data file must contain the same number of values. If
you leave gaps where Mathcad expects numbers, the READPRN function will not
be able to read the file. Mathcad determines where one number ends and the
next begins by looking for spaces or commas.



Sometimes each column of values in a data file represents a different variable.
Figure 5 shows how to use superscripts to create a vector from each column in
the data file.

Figure 5: Assigning a variable to each column of data from a data file.



Writing data with the WRITEPRN and APPENDPRN functions 

    Figure 6 shows how to use the WRITEPRN function to write data to a structured
data file.

Figure 6: Writing data to a structured data file.

When you calculate the document in Figure 6, Mathcad creates a data file con-
taining the following numbers:

Unlike the WRITE function, the WRITEPRN function writes out the data in col-
umns. Note that since the PRNPRECISION is set to four, the numbers are shown
to four decimal places. Since PRNCOLWIDTH is set to eight, each column has
space for eight characters. Since PRNPRECISION and PRNCOLWIDTH can be var-
ied independently, you must take care to choose them in such a way that the col-
umn width can accommodate all the digits, together with a space to separate the
columns.



When you use WRITEPRN:

Equations using WRITEPRN must be in a specified form as follows: On the
left should be WRITEPRN( file), where file is a variable name. This is followed
by a definition symbol (:=) and a matrix expression. Do not use range vari-
ables or subscripts with WRITEPRN.

Each new equation writes a new file. If two equations write to the same file,
the data written by the second equation will overwrite the data written by the
first. Use APPENDPRN if you want to append values to a file instead of over-
writing the file.

The built-in variables PRNCOLWIDTH  and PRNPRECISION determine the for-
mat of the data file that Mathcad creates. The current value of PRNCOL-
WIDTH specifies the width of the columns (in characters). The current value
of PRNPRECISION specifies the number of significant digits used. By default,
PRNCOLWIDTH = 8 and PRNPRECISION = 4. To change these values, choose
Options ⇒Built-In Variables from the Math menu, or enter definitions in
your Mathcad document above the WRITEPRN function, as shown in Figure 7.
 

If the array you are writing is either a nested array (an array whose elements
are themselves arrays) or a complex array (an array whose elements are com-
plex) then WRITEPRN will not create a simple ASCII file. Instead, WRITEPRN
creates a file using a special format unlikely to be readable by other applica-
tions. This file can, however, be read by Mathcad’s READPRN function.

Figure 7: A document that creates a data file with columns 10 characters wide
containing numbers with 5 significant digits.



By using the augment function, you can concatenate several variables and write
them all to a data file. Figure 8 demonstrates how to do this. 

Figure 8: Writing several concatenated vectors.

Advantages of using READPRN and WRITEPRN

 READPRN is generally preferable to READ. When the data values are regularly
listed out in columns, READPRN brings the data into Mathcad in a readily acces-
sible form. 

If some lines in a data file have more data values than others, data values may
be missing. Use a text editor to replace the missing values with zeros before you
use READPRN.

READ is required for files in which numbers for a single variable are scattered
across several lines in the file. This includes files created by the WRITE function,
in which there are as many numbers on each line as will fit.

Remember: use a range variable subscript to read with READ; do not use a sub-
script to read with READPRN.

WRITEPRN generally produces more readable files than WRITE because the data
values are neatly lined up in rows and columns. However, WRITE produces
smaller files than WRITEPRN because it doesn’t have to add spaces to line up the
numbers.

Use WRITE instead of WRITEPRN when you want to crowd as many values as
possible into a small data file. WRITE creates a data file with only one space be-
tween each value and the next. 



Graphics files

To import a file as data into Mathcad, use one of these functions:

READBMP(file) to create a matrix containing a grayscale representation of the
bitmap image in file. Each element in the matrix corresponds to a pixel. The
value of a matrix element determines the shade of gray associated with the
corresponding pixel. Each element is an integer between 0 (black) and 255
(white).

READRGB(file) to create a matrix in which the color information in file is rep-
resented by the appropriate values of red, green, and blue. This matrix con-
sists of three submatrices, each with the same number of columns and rows.
Three matrix elements, rather than one, correspond to each pixel. Each ele-
ment is an integer between 0 and 255. The three corresponding elements,
when taken together, establish the color of the pixel. 

Each of these functions takes the single argument file, the name of the file con-
taining the image. Each function returns a matrix of numbers used to represent
the image. 

To create the matrix, type either M:=READBMP(filename) or
M:=READRGB(filename).

To read from a file other than the one that matches the argument of READBMP or
READRGB or to read from a file that is not in your Mathcad folder, use the Asso-
ciate command on the File menu. See the section Importing files from other di-
rectories,” earlier in this chapter.

To divide the matrix for a color image into its three components, you can use the
formulas shown in Figure 9.



Figure 9: Breaking an RGB matrix into three submatrices.

The processing in Figure 9 converts the color.bmp bitmap file into three subma-
trices: red, green, and blue. 

Once you have read the file into Mathcad, you can use the picture operator to
view it. Choose Picture from the Insert menu. Type the name of the matrix in
the placeholder. If necessary use the Associate command on the File menu.

To display an image in color, you must provide the three matrices containing the
red, green and blue color values of the image. Otherwise, the displayed image
will be in grayscale. For example, to display the image in Figure 9, you would
choose Picture from the Insert menu and type red,green,blue into the
placeholder. If you want to display only the red components of the image that
was used for Figure 9, you still must include the green and blue submatrices, but
they both should contain only zeros.

Keep in mind that the colors of the image that you ultimately see may be dis-
torted to the extent that you don’t display 256 colors on your monitor. 

If you have been working with submatrices for a color file, you can recombine
them by using by defining an augment3(X, Y, Z) function:

augment3(X,Y,Z):=augment(X,augment(Y,Z))

X, Y, and Z are the names of the submatrices and must have the same number of
rows. The resulting matrix has the same number of rows as X but three times the
number of columns. 

Once you finish processing a matrix,you may want to save it to disk for later
use. To do this, use one of the following functions:



WRITEBMP(file) to create a grayscale BMP file out of the matrix.

WRITERGB(file) to create a colored BMP file out of a matrix in which the im-
age is stored in RGB format.

You can use the augment function to combine submatrices at the time you are
saving a file to your disk. For example, the following function saves the subma-
trices that were created in Figure 9 as one 24-bit color image called “new-
color.bmp”:

WRITERGB(newcolor):=augment(red, aug-
ment(green,blue))



Graphics Features





Chapter 19
Graphs

 Mathcad graphs are both versatile and easy to use. To create a
graph, click where you want to insert the graph, choose
Graph⇒X-Y Plot from the Insert menu, and fill in the
placeholders. You can modify the format extensively, including
reformatting the axes and curves and using a variety of different
types of labels.

The following sections describe the use of Mathcad graphs:

Creating a graph
Basic steps in creating a graph.

Graphing functions
Procedures for graphing functions.

Graphing a vector
Procedures for graphing vectors.

Graphing more than one expression 
Procedures for creating graphs with multiple traces.

Formatting the axes 
Procedures for modifying the formats of the x- and y-axes.

Formatting individual curves 
 Procedures for modifying the formats of curves or traces in a graph.

Setting and restoring default formats 
 Procedures for using default format settings.

Labeling your graph
Procedures for working with titles, axis labels, and other labels.

Modifying the graph’s perspective 
Procedures for changing the size of the graph, zooming in on a portion
of the graph, and finding coordinates in it.

Gallery of graphs
A set of sample graphs illustrating the options for creating graphs.
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Creating a graph 

To create a graph:

Click wherever you want the graph to appear. 

Choose Graph⇒X-Y Plot from the Insert menu. Mathcad creates an empty
graph with six placeholders, three on each axis.

To see the graph, fill in the placeholders: 

The placeholder at the middle of the horizontal axis holds the variable to
graph against. Enter a range variable, a subscripted variable, or any other ex-
pression involving a range variable in this placeholder.

The placeholder at the middle of the vertical axis holds an expression to
graph. Enter a range variable, subscripted variable, or any other expression in-
volving the range variable on the horizontal axis.

The other four placeholders can be used to override Mathcad’s automatic
choices of axis limits. For more information about axis limits, see the section
“Setting limits for axes” on page 451.

Graphs typically have one or more expressions involving range variables on
each axis. Mathcad graphs one point for each value of the range variable. Range
variables are discussed in Chapter 10.

Be aware that it’s usually an error to use two different range variables in the
same curve, or trace, on a graph. If you use two range variables in the same
trace, Mathcad tries to graph one point for each value of each range variable.
For example, if i ranges through 20 points and j through 30, and you try to plot
yi against xj, Mathcad tries to graph a total of 600 points. It is, however, permis-
sible to use different range variables in different traces on the same graph.

Just as with an equation, Mathcad does not process a graph until you click out-
side the graph region. When Mathcad processes the graph, it draws one point for
each value of each range variable in the x or y axis expressions and, unless you
specify otherwise, connects them with straight lines. 
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Figure 1 shows a typical graph with the placeholders filled in. Note the line that
appears under the yj. This indicates the trace type and color used to display the
curve. See the section “Formatting individual curves” later in this chapter to
learn how to control this.

Figure 1: Mathcad graphs a Lissajous figure.

If an expression is complex, Mathcad graphs only the real part. The imaginary
part is ignored. Note that no error message will be displayed.

Graphing functions 

Each trace on a graph depends on a range variable. This range variable must ap-
pear in both the x-axis expression and the y-axis expression. Mathcad graphs
one point for each value of the range variable.

Graphing a function 

The easiest graph to create shows values of a function over a range. The first
graph in Figure 2, below, illustrates this type of plot. To create this graph, do the
following:

Define a range variable x that ranges over the values you want to graph.

Type the expression you want to plot in the middle placeholder of the y-axis
and type x in the middle placeholder of the x-axis.

Choose Calculate from the Math menu to see the graph.
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Figure 2: Graphing an expression against a range variable.

You can also define a function f(x) and place it in the middle placeholder of the
y-axis. This is particularly useful when the expression you want to plot becomes
large and unwieldy. The second graph in Figure 2, above, shows the same plot
as the first graph in the figure, except that it is made with a function definition.

You can drag, cut, copy and paste a graph just as you would an equation. See
Chapter 2,“Editing Equations,” for details. 

To delete a graph from your worksheet:

Press and hold down the mouse button just outside the plot.

With the button still pressed, drag the mouse cursor so as to enclose the graph-
ics region in the dashed selection rectangle.

Choose Cut from the Edit menu.

To move a graph, follow the instructions above for deleting it. Then click the
mouse wherever you want the graph and choose Paste from the Edit menu. Al-
ternatively, you can drag a plot as you would an equation. See Chapter 2 for de-
tails. 
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Using functions for polar plots

By creatively using the tools presented in this chapter, you can plot a wide vari-
ety of closed curves. The example in Figure 3 illustrates how to transform polar
into rectangular coordinates. This technique lets you create polar plots, or even
paths in the complex plane. In Figure 3, the equation for the cardioid in polar co-
ordinates is given by r(θ). The equations for x(θ) and y(θ) are the usual transfor-
mation from polar to rectangular coordinates. See Chapter 20,“Polar Plots,” for
a description of Mathcad’s built-in polar plotting capabilities. 

Figure 3: Two functions computed independently.

Graphing a vector 

You can also graph the elements of a vector. Such a graph is shown in Figure 4
on the following page. To create this graph, do the following:

Define a range variable i that references the subscript of each element you
want to plot. 

Define a vector yi. Use the left bracket key, [, to create the subscript.

Press @ to create an empty plot region.

Place yi in the middle placeholder of the vertical axis and i in the middle
placeholder of the horizontal axis.

Choose Calculate from the Math menu to see the graph.
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Figure 4: Graphing a vector.

Subscripts must be non-negative integers (or integers greater than or equal to
ORIGIN, if ORIGIN ≠ 0.) Τhis means that the x-axis variable used in a graph like
Figure 4 can run through whole-number values only. If you want to graph frac-
tional or negative values on the x-axis, graph a function as in Figure 2, or graph
two vectors as described in the next section.

If you have a handful of data points that don’t have a convenient functional rela-
tionship as in Figure 4 but there are too few of them for you to use data files,
you might want to use an input table to create a vector. For more information,
see “Entering a table of numbers” on page 224.

Graphing one vector against another 

Figure 5 shows how to graph two vectors against each other. The vectors need
not be the same length. The only requirements are: 

The two vectors must share the same subscript. For example, you cannot plot
xi against yj because i and j are not the same subscript.

Each value of the subscript must correspond to an element in each vector. For
example, if x has only two elements and y has eight elements, and the range
variable goes from 0 through 7, you will get an error indicating that the index
is out of bounds.

To create the plot shown in Figure 5, do the following:

Define a range variable i that references on the subscript of each element you
want to plot. 
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Define the arrays xi and yi. Use the left bracket key, [, to create the subscript.

Press @ to create an empty graph region.

Place yi in the middle placeholder of the y-axis and xi in the middle place-
holder of the x-axis.

Choose Calculate from the Math menu to see the graph.

Figure 5: Graphing two vectors.

Although the x vector in Figure 5 is a list of evenly spaced values, this need not
be the case. Only the i values are required to be evenly spaced integers. No such
restriction exists for the xi. This allows you to plot something besides integers
on the x-axis while still satisfying the requirement for integers as subscripts.

In Figure 5, the yi came directly from the xi. Other applications might compute x
and y independently from a third variable. As long as the two vectors use the
same range variable, you can graph them on the same graph. Figure 6 shows a
polar graph in which both x and y depend on the variables r and θ. Figure 6 uses
vectors to do what was done with functions in Figure 3. 
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Figure 6: Two vectors computed independently.

Note that in Figure 6, the range variable i must have integer values and must be
used to define a vector, namely θ, of equally spaced non-integer values. In Fig-
ure 3, however, we could define θ directly as a range variable. This is because
functions do not require integer arguments the way vectors require integer sub-
scripts.

Graphing data files

You don’t have to use Mathcad to generate the vectors that you plot as shown in
Figure 1. You can also use Mathcad’s READ and READPRN functions to import
data from ASCII text files generated from any spreadsheet, database, or word
processing program capable of exporting data in ASCII format. Once imported,
Mathcad plots the data just as it would data created in Mathcad.

For example, you can plot data from a spreadsheet by doing the following:

Save the spreadsheet as an ASCII text file, with the extension .prn.

Use the READPRN function to import the .prn file into Mathcad as a matrix.
See the section “Reading a matrix with the READPRN function” in Chapter 18.

Figure 7 shows the process for plotting vectors from the data imported from a
.prn file.
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Figure 7: Plotting vectors from imported data.

See Chapter 18, “Data Files,” for a detailed discussion of importing data files.

Graphing other expressions

Figures 2 through 6 show some of the most common types of graphs. However,
graphs are not limited to following these examples. You can graph any expres-
sion against any other expression, as long as they share the same range vari-
ables. For example, see Figure 12 for an example of graphing a constant to be
used as a marker on the graph of another function.

Graphing more than one expression 

 You can graph several traces on the same graph. A graph can show several y-
axis expressions against the same x-axis expression, or it can match up several y-
axis expressions with corresponding x-axis expressions.

To graph several y-axis expressions versus one x-axis expression, enter the first
y-axis expression followed by a comma. You’ll see a placeholder immediately
below this first expression. Enter the second expression here, followed by an-
other comma to get another empty placeholder. Enter the next expression. All
the expressions should use the same range variable (Figure 8).
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Figure 8: Graph with multiple y-axis expressions.

To graph several independent curves on the same set of axes, enter two or more
expressions separated by commas on the x-axis and the same number of expres-
sions on the y-axis. Mathcad matches up the expressions in pairs – first x-axis
expression with first y-axis expression, the second with the second, and so on. It
then draws a trace for each pair. Each matching pair of expressions should use
the same range variable. The range variable for one pair need not match the
range variables for the other pairs.

You can plot up to 16 arguments on the y-axis against 1 argument on the x-axis.
However, if you have the same number of x arguments as y arguments, you can
only plot up to 10 traces.

Figure 9 shows an example in which the range variables differ for each pair.
Note however, that all traces on a graph share the same axis limits. For each
axis, all expressions and limits on that axis must have compatible units.
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Figure 9: Graph with multiple expressions on both axes.

Formatting the axes 

You can reformat your graph’s axes, using the X-Y Axes page of the Formatting
Currently Selected X-Y Plot dialog box.  

To change a graph’s format:

Click in the graph to select it.

Double-click in the graph. Alternatively, choose Graph⇒X-Y Plot from the
Format menu. You’ll see the dialog box for formatting X-Y plots. 

If necessary, click the X-Y Axes tab to display the X-Y Axes page, shown be-
low.

There is a complete group of settings for each axis. Change the appropriate
settings.

Click “OK” to accept your changes and close the dialog box. Mathcad re-
draws the graph with the new settings in effect. Alternatively, click “Apply”
to see the graph redrawn without closing the dialog box. Click “Close” to
close the dialog box.
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If you initiate this process by double-clicking on an axis, you’ll see an equiva-
lent dialog box for that axis alone.

The rest of this section describes the settings on the X-Y Axes page of the dia-
log box for formatting X-Y Plots. It then provides detailed discussions about op-
tions for setting axis limits and for adding horizontal and vertical reference lines
to your graph.

Axis settings

Each axis has the following settings associated with it:

Log Scale
When this box is checked, the selected axis is logarithmic and the axis limits
must be positive. The bottom-right-hand graph in Figure 16 on page 467 il-
lustrates a graph with a logarithmic axis.

Grid Lines
When this box is checked, the tick marks on the selected axis are replaced by
grid lines. The top-right-hand graph in Figure 16 on page 467 illustrates a
graph that uses grid lines rather than tick marks.   

Numbered
When this box is checked, the tick marks on the selected axis are numbered.

Autoscale
This controls axis limits that you don’t otherwise specify. When this box is
checked, Mathcad rounds the axis limit to the next major tick mark. When
unchecked, Mathcad sets the axis limit to the data limit. For a discussion of
Autoscale and the other ways to set axis limits, see “Setting limits for axes”
later in this section.  
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Show Markers
When this box is checked, you can add reference lines to your graph. For a
discussion of Show Markers and another way to create horizontal and verti-
cal reference lines, see “Adding horizontal and vertical lines” later in this
section.

Auto Grid
When this box is checked, Mathcad automatically selects the number of grid
intervals created by tick marks or grid lines on the axes. When the box is un-
checked, you choose the number of grid intervals by typing in the box la-
beled “No. of Grids”. Enter a number from 2 to 99. You can specify the
number of grid intervals only when Log Scale is unchecked. Figure 20 on
page 469 illustrates the effect of Auto Grid. 

In addition to these check boxes, the X-Y Axes page contains the following:

No. of Grids
When available, this text box indicates the number of grid intervals on the as-
sociated axis. You can enter a number between 2 and 99, inclusive. This box
is only available when Auto Grid and Log Scale are unchecked.

Axes Style
These buttons define the style in which the graph will show the axes. Boxed
axes are crossed in the bottom left corner of the graph. Crossed axes are
crossed in the center of the graph. If you select None, no axes will be dis-
played on the graph. Figure 21 on page 469 illustrates the use of crossed
axes.   

See the section “Setting default formats,” on page 457 to learn how to:

Quickly restore the graph to its default format settings.

Use a particular graph as a model for all future graphs.

Setting limits for axes

Mathcad provides the following ways to set limits for axes:

Automatically, with Autoscale turned on.

Automatically, with Autoscale turned off.

Manually, by entering the limits directly on the graph.

Manually, by entering the limits in the Axis Format dialog box.
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By default, a plot you create in Mathcad is autoscaled. With Autoscale on, Math-
cad automatically sets each axis limit to the first major tick mark beyond the end
of the data. This will be a reasonably round number large enough to display
every point being graphed. With Autoscale off, Mathcad automatically sets the
axis limits exactly at the data limits.  

Figure 10 shows how turning Autoscale on and then off changes the way the
graph looks.

Figure 10: The effects of having Autoscale turned on and off.

To turn Autoscale off and have the axis limits automatically coincide with the
end of the data:

Click on the graph to select it and then choose Graph⇒X-Y Plot from the
Format menu. Mathcad displays the dialog box for formatting X-Y graphs,
shown on page 450. Click the X-Y Axes tab if the X-Y Axes page is not dis-
played. (You can also double-click on the axis itself to see a similar dialog
box.)  

Click on Autoscale for the appropriate axis to remove the check and to toggle
Autoscale off. 

You may want to use axis limits other than those set by Mathcad. You can over-
ride Mathcad’s automatic limits by entering limits directly on the graph. To do
so:

Click the graph to select it. Mathcad displays four additional numbers, one by
each axis limit. These numbers are enclosed within corner symbols, as illus-
trated in the selected plot in Figure 11. 
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To set the axis limit on the horizontal axis, click on the number underneath
the appropriate x-axis limit and type the number at which you want the axis to
end. To set an axis limit for the vertical axis, do the same thing to the number
to the left of the appropriate y-axis limit.

Click outside the graph. Mathcad redraws it using the axis limits you speci-
fied. Figure 11 shows the effect of manually setting limits on a graph.

Figure 11: Data limits set manually and automatically.

Adding horizontal and vertical lines 

 Mathcad places linearly or logarithmically spaced tick marks or grid lines on a
graph. The spaces between these markings are relatively round numbers that
span the range of values on each axis. There may, however, be occasions when
you need to place a line somewhere other than where Mathcad would normally
place a grid line. 

To add a horizontal or vertical line to a plot:

Click in the plot to select it.

Choose Graph⇒X-Y Plot from the Format menu or double-click on the
graph to bring up the dialog box for formatting X-Y graphs.

If necessary, click on the X-Y Axes tab to display the X-Y Axes page, as
shown on page 450.
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For a vertical line, click on Show Markers in the X-axis column to add a
check; for a horizontal line, click on Show Markers in the Y-axis column to
add a check. Click “OK”. Mathcad shows two additional placeholders on
each axis for which you have Show Markers checked.  

To add a vertical line, click on one of the placeholders under the x-axis and
type in a value at which you want a line drawn. For a horizontal line, do the
same thing in one of the placeholders under the y-axis.

When you click outside the graph, Mathcad draws a dashed line at each number
you specify. The number you type appears at the end of the line. To move the
dashed line, click on the number in the placeholder and change it. To delete the
line, delete this number or click on Show Markers for the appropriate axis to
uncheck it.

By using the Show Markers function, you can add to each axis one or two
dashed lines stretching across the plot. When you need to place more than two
lines or you need more control over the appearance of a line, you can add lines
by plotting a constant expression.

To create a horizontal line, place a range variable on the the middle place-
holder of the x-axis and the constant expression on the y-axis. Mathcad will
plot a horizontal line across the plot at whatever value the constant value hap-
pens to be. The expression you place on the y-axis need not depend on the
range variable you place on the x-axis.

To create a vertical reference line, reverse the roles of the x- and y-axes. Place
a range variable on the middle placeholder of the y-axis and the constant ex-
pression on the x-axis.

Figure 12 compares graphs having reference lines created by plotting constant
expressions and by using the Show Markers option.
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Figure 12: Graphs with reference lines.

Formatting individual curves

  You can reformat the traces on your graph, using the Traces page of the dialog
box for formatting X-Y graphs.

To reformat a graph’s traces:

Click in the graph to select it.

Double-click in the graph. Alternatively, choose Graph⇒X-Y Plot from the
Format menu. Mathcad displays the dialog box for formatting X-Y graphs.

If necessary, click the Traces tab to display the Traces page.

Click on the line in the scrolling list box for that trace. To change the name of
the trace, type the new name in the text box under the “Legend Label” col-
umn. To change the symbol or marker, line type, color, trace type, or line
weight of this trace, click on the arrow beside each text box to see a drop-
down list of options, and then click on the option you want. See the next sec-
tion, “Trace settings,” for complete explanations of the various options in
these lists.

Click “OK” to accept your changes and close the dialog box. Mathcad re-
draws the graph with the new settings in effect. Alternatively, click “Apply”
to preview your changes without closing the dialog box.
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Trace settings

A graph can have up to sixteen individual traces. Each trace is described by a
line in the scrolling list. Mathcad uses these lines as needed, assigning one for
each trace in your graph. Each line has six fields: 

Legend Label
This is the name of the trace as it would appear in the legend beneath the
plot. See the section “Displaying or hiding arguments and legends” on page
462 for more information about legends. 

Symbol
This controls whether each point on the curve is marked with a symbol. You
can mark each point with either an “×”, a “+”, a hollow box, a hollow dia-
mond, a circle, or no symbol at all. If you have a lot of points packed closely
together, you should probably select “none.” Figure 18 on page 468 shows
an example in which each data point is marked by with an “×”. 

Line
This controls whether the line is solid, dotted, dashed, or whether it consists
of alternating dashes and dots. This feature provides a useful way to distin-
guish unmarked curves in black and white printouts.

Color
This controls whether the selected trace is red, blue, green, magenta, cyan (a
light blue), brown, black, or white. Mathcad ignores this on monochrome ter-
minals.
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Type
This controls the type of trace that will be displayed. Mathcad can generate
the following types of plots: curves, bar charts, stepped curves, error bars,
and points. For an example of a bar chart, see the bottom left-hand graph in
Figure 16, on page 467. Figure 17 on page 467 has examples of step graphs
and error bars.

Weight
This controls the weight or thickness of the trace. Select from 1 to 9 (thin-
nest to thickest). Select “p” for a trace that is one device pixel wide. Al-
though this may look like weight 1 on your screen, a high resolution printer
will print it as a very fine line. This field also controls the size of the sym-
bols marking data points, if you have selected a symbol other than “none”. If
you have selected trace type points, this field sets the weight of the dot plot-
ted at each data point.

See the “Setting default formats” section on page 457 to learn how to:

Quickly restore the graph to its default format settings.

Use a particular graph as a model for all future graphs.

In addition to the scrolling list and its associated text box and lists, the Trace
page has two check boxes: Hide Arguments and Hide Legend. These are ex-
plained fully in the “Displaying or hiding arguments and legends” section on
page 462.

Setting default formats

Mathcad uses default settings to format the axes and traces of new graphs as you
create them. You can change these defaults in two ways:

By saving as defaults the settings of your current graph. 

By using the Setting Default Formats for X-Y Plots dialog box, if you don’t
want to use an existing graph.

Changing defaults only affects new graphs; previously existing graphs are unaf-
fected.

Copying defaults from an existing graph

One way to create a new set of defaults is to use the format settings of an exist-
ing graph. The advantage of this method is that you can actually see how the for-
mat settings look as you define them.

To use the format of a particular graph as the default graph format:   

Click in the graph to select it.
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Choose Graph⇒X-Y Plot from the Format menu or double-click on the se-
lected graph. Mathcad displays the dialog box for formatting X-Y graphs. If
necessary, click on the Defaults tab to see the Defaults page. 

If the Use for Defaults check box doesn’t contain a check, click on it to add
one. When you close the dialog box, Mathcad saves these settings as your de-
fault settings.

 

Setting defaults without using a graph

You don’t have to use an existing graph to create or revise default formats. In-
stead, you can use the X-Y Axes page on the dialog box for setting X-Y plot de-
faults. To set defaults this way:

Make sure that you don’t have any graphs selected.

Choose Graph⇒X-Y Plot from the Format menu. You’ll see the dialog box
for setting X-Y graph defaults. The following figure shows an example of this
dialog box with the X-Y Axes page displayed.  

Change the appropriate settings on the X-Y Axes and Traces pages.

Click “OK” to accept your changes and close the dialog box.
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Using default graph settings

If you want to reverse the format changes that have been made to a graph since
it was created, you can restore its original default settings. To restore the origi-
nal defaults:

Click the Defaults tab on the dialog box for formatting X-Y graphs. (See the
figure on page 458.)

Click “Change to Defaults.”

Click “OK” to close the dialog box.

Mathcad redraws the graph, using the default format settings that were in place
when the graph was first created. Mathcad does not use any defaults you might
have set using the Use for Defaults check box at any time after the creation of
this graph. 

Labeling your graph

Mathcad provides several ways to help you to identify what it is that you’ve plot-
ted. You can choose to display:  

A title, either above or below the graph.

Axis labels to describe what’s plotted on each axis.

Legends to identify the individual traces.

Arguments showing what you typed into the x- and y-axis place holders.

Figure 13 shows the relative locations of each of these types of labels on a
boxed axes graph and on a crossed axes graph.
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Figure 13: Graphs with different labels.

You can use these labels all together or in any combination. By default, Math-
cad shows neither title nor axis labels, displays the arguments, and hides legends.

Working with titles

 To add a title to a graph, follow these steps:

Click in the graph to select it.

Choose Graph⇒X-Y Plot from the Format menu or double-click on the se-
lected graph. Mathcad displays the dialog box for formatting X-Y graphs. If
necessary, click on the Labels tab. 

Type a title for your graph into the Title text box. 

Click on either the Above or Below button, depending upon where you want
to put the title. Note, however, that Mathcad doesn’t display the title until you
click “Apply” or close the dialog box.

Make sure that the Show Title check box is checked. If it isn’t, Mathcad still
remembers the title but won’t display it.

Click “OK” to accept your changes. Mathcad redraws the graph with the title
in place. Alternatively, click “Apply” to preview your title without closing
the dialog box.
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To edit a graph’s title, follow these steps:

Click in the graph to select it.

Choose Graph⇒X-Y Plot from the Format menu or double-click on the se-
lected graph. Mathcad displays the dialog box for formatting X-Y graphs. If
necessary, click the Labels page. (You can also double-click on the title itself
to display an equivalent dialog box.) 

Edit the information for the title as appropriate.

Backspace over the title to delete it.

 Click “OK” to close the dialog box.

Labeling axes on a graph 

 You can also label one or both axes of a graph in much the same way as you add
a title to a graph. The x-axis label appears directly below the x-axis, and the y-
axis label appears just to the left of the y-axis. To label an axis, follow these
steps:

Click in the graph to select it.

Choose Graph⇒X-Y Plot from the Format menu or double-click on the se-
lected graph. Mathcad displays the dialog box for formatting X-Y graphs. If
necessary, click on the Labels tab to see that page, as shown in the preceding
section.

Type the axis labels into the appropriate text boxes. 

To save the label name without having it appear on the graph, click X-Axis or
Y-Axis to remove the check.
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 Click “OK” to accept your changes and close the dialog box. Mathcad re-
draws the graph with the new settings in effect. Alternatively, click “Apply”
to preview your changes without closing the dialog box.

To edit an axis label, follow these steps:

Click in the graph to select it.

Choose Graph⇒X-Y Plot from the Format menu or double-click on the se-
lected graph. Mathcad displays the dialog box for formatting X-Y graphs. If
necessary, click the Labels page. (You can also double-click on the label it-
self to display an equivalent dialog box.)

Edit the information for the title as appropriate.

To remove a label, delete it from the text box.

Click “OK” to close the dialog box.

Displaying or hiding arguments and legends

Mathcad provides both arguments and legends for identifying specific traces on
a graph:

Arguments are the expressions that you typed into the placeholders of the x-
and y-axes to create the graph. By default, Mathcad displays arguments.

Legends are labels that appear underneath the graph containing a name and
an example of the line and symbols used to draw the trace. By default, leg-
ends are hidden.

To display or hide arguments and legends:

Click on the graph to select it. 

Choose Graph⇒X-Y Plot from the Format menu or double-click on the
graph. Mathcad displays the dialog box for formatting X-Y graphs, as shown
below. If necessary, click on the Traces tab. 

To suppress the display of the arguments, click on Hide Arguments to add a
check.

To show the legend, click on Hide Legend to remove the check.

Modifying your graph’s perspective

Mathcad provides options for manipulating the presentation of your graph:

You can resize the graph, making it proportionally larger or smaller or stretch-
ing the x-axis or y-axis for emphasis.

You can zoom in on a portion of the graph.
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You can get the coordinates for any point that was plotted to construct the
graph.

You can get the coordinates for any location within the graph.

The rest of this section shows how to use these features.

Resizing a graph

Resizing a graph is very much like resizing a window:

Click in the graph to select it.

Move the mouse pointer to one of the three handles along the edge of the
graph. The pointer will change to a double-headed arrow.

Press and hold down the mouse button and move the mouse in the direction
that you want the graph’s dimension to change.

Once the graph is the right size, let go of the mouse button. 

Click outside the graph to deselect it.

Note that when you change the size of a graph for which the  Auto Grid is set,
Mathcad may add or delete tick marks or grid lines to maintain the default spac-
ing.

Zooming in on a graph 

Mathcad allows you to select a region of a graph and magnify it. To zoom in on
a portion of a graph, follow these steps:

Click in the graph to select it.

Choose Graph⇒Zoom from the Format menu. The X-Y Zoom dialog box
appears. 
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If necessary, reposition the X-Y Zoom dialog box so that you can see the en-
tire region of the graph you want to zoom.

In the graph region, click the mouse at one corner of the region you want to
magnify.

Press and hold down the mouse button and drag the mouse. A dashed selec-
tion rectangle emerges from the anchor point.

When the selection rectangle just encloses the region you want to magnify,
let go of the mouse button. 

The coordinates of the selected region are listed in the Min: and Max: text
boxes of the X-Y Zoom dialog box. Click the “Zoom” button to redraw the
graph. The axis limits are temporarily set to the coordinates specified in the
X-Y Zoom dialog box. To make these axis limits permanent, click “Accept.” 

Before you make these axis limits permanent, you can select another region to
zoom by enclosing another selection rectangle around a new region. Press “Un-
zoom” to undo the zoom you’ve just made. If you’re working with a graph that
has already been zoomed, you may want to view the original graph as it was be-
fore any zooming took place. To do so, click on “Full View.”

Figure 14 shows the effects of zooming in on a portion of a graph.
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Figure 14: A zoomed-in region of a graph.

Getting a readout of graph coordinates 

 To see a readout of graph coordinates of the specific points that make up a trace,
follow these steps:

Click in the graph to select it.

Choose Graph⇒Trace from the the Format menu to show the X-Y Trace
dialog box. Note that the Track Data Points check box is checked.

If necessary, reposition the X-Y Trace dialog box so that you can see the en-
tire region of the graph.

In the graph region, click and drag the mouse along the trace whose coordi-
nates you want to see. A dotted crosshair jumps from one point to the next as
you move the pointer along the trace.

If you release the mouse button, you can now use the left and right arrows to
move to the previous and next data points. Use the up and down arrows to
move to other traces.
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As the pointer reaches each point on the trace, Mathcad displays the x and y
values of that point in the X-Value and Y-Value boxes.

The x and y values of the last point selected are shown in the X-Value and Y-
Value boxes. The crosshair remains until you click outside the graph. 

To copy a coordinate to the clipboard, 

Click “Copy X” or “Copy Y”. You can then paste that value into a math re-
gion or a text region on your Mathcad worksheet, into a spreadsheet, or into
any other application that allows pasting from the clipboard. 

Double-click on the control box in the upper-left-hand corner to close the X-
Y Trace dialog box. The crosshair will remain on your graph until you click
anywhere outside the graph.

To see a readout of graph coordinates for any location in a graph:

Follow the above procedures to call up the X-Y Trace dialog box.

Click on Track Data Points to uncheck it.

In the graph region, click and drag the mouse pointer over the points whose
coordinates you want to see. A dotted crosshair follows the pointer as you
drag it over the graph. Mathcad displays the coordinates of the pointer in the
X-Value and Y-Value boxes. The x and y values change continuously to re-
flect the current pointer position.

When you release the mouse button, the X-Value and Y-Value boxes show
the x and y values of the last pixel selected.

Figure 15: Reading coordinates from a graph.

466 Chapter 19  Graphs



Gallery of graphs

Figure 16: Different graph formats on the same graph.

Figure 17: Step graphs and error bars from the scrolling list under “Trace type.”
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Figure 18: Choosing from the scrolling lists under “Line” and “Symbol.”

  

Figure 19: Hiding and showing the legend on the same graph.
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Figure 20: Unchecking Auto Grid option to vary the number of tick marks.

Figure 21: Using the “Crossed Axes” option to cross axes in the center of the
plot.
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Chapter 20
Polar Plots

 In addition to Cartesian plots, Mathcad worksheets can contain
polar plots. Using polar coordinates, you can quickly and easily
display angle-dependent data. 

The following sections describe how to create, use, and format
polar plots:

Creating a polar plot
Basic steps in creating a polar plot.

Plotting more than one expression 
Procedures for creating polar plots with multiple traces.

Formatting the axes 
Procedures for modifying the radial and angular axes.

Formatting individual curves 
Procedures for modifying curves or traces in a polar plot.

Setting and restoring default formats 
Procedures for using default format settings for polar plots.

Labeling your polar plot
Procedures for working with titles, legends, and other labels.

Modifying the polar plot’s perspective 
Procedures for changing the size of the plot, zooming in on a portion of
the plot, and finding coordinates in it.

Gallery of polar plots
A set of sample polar plots illustrating the options for creating polar
plots.
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Creating a polar plot 

You can easily use Mathcad to plot functions that do not lend themselves well to
Cartesian coordinates. For example, you could plot circular antenna patterns or
electric field intensities around an object.

To create a polar plot:

Click where you want the polar plot to appear.

Choose Graph⇒Polar Plot from the Insert menu. Mathcad shows a circle
with four placeholders as shown in Figure 1.

Above the plot region, define an angle θ and a function of the angle, r(θ). 

The bottom placeholder holds the angle variable to plot against. Enter a range
variable or any expression involving a range variable in this placeholder.

The left placeholder holds a radial expression to plot.

The two placeholders to the right hold the upper and lower radial limits.
Mathcad fills in these placeholders by default. If you want, you can modify
these limits. See the section “Formatting the axes.”

Figure 1: Empty placeholders in a polar plot region.

Just as with an equation, Mathcad will not process the polar plot until you click
outside the plot. 

In Mathcad, polar plots are drawn by mapping r and θ onto x and y using the
standard transformations x = r cos(θ) and y = r sin(θ). r and θ can assume posi-
tive or negative values.
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You can specify many of the characteristics of the polar plot including the size,
the number of grid lines and the upper and lower radial axis limits. The proce-
dures for specifying these characteristics are later in this chapter.

A typical polar plot shows the value of a radial expression versus an angular ex-
pression. To see such a plot, you must first create a function, then create a polar
plot of that function. Here are the typical steps in plotting a function like the one
shown in Figure 2:

Define a range.

Define an increment for θ.

Define r(θ), a function of θ.

Show r(θ) in a polar plot.

Figure 2: Polar plot of a function of θ. 

Graphing more than one expression 

 Just as you can graph several expressions on a Cartesian plot, you can graph sev-
eral expressions on the same polar plot. Each expression generates a trace. A po-
lar plot can show several r expressions against the same θ expression, or it can
match up several r expressions with corresponding θ expressions.
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To graph several r expressions versus one θ expression, enter the first r expres-
sion followed by a comma. You’ll see a placeholder immediately below this
first expression. Enter the second expression here, followed by another comma
to get another empty placeholder. All the expressions should use the same range
variable, as shown in Figure 3. Figure 3 also shows how to define an angle
range in degrees.

Figure 3: Polar plot with multiple expressions.

To graph several independent curves on the same polar plot, enter two or more
expressions separated by commas in the bottom placeholder and the same num-
ber of expressions in the left placeholder. For example, to plot r(θ) against θ and
s(φ) against φ you could type “r(θ), s(φ)” in one placeholder and “θ, φ” in the
other. Mathcad matches the expressions in pairs—r(θ) with θ and s(φ) with φ. It
then draws a trace for each pair. Each matching pair of expressions should use
the same range variable. The range variable for one pair need not match the
range variables for the other pairs.

474 Chapter 20 Polar Plots



As with x-y plots, you can plot one vector of values against another, using a
range variable to index the two vectors. This is illustrated in Figure 4.

Figure 4: Plotting one vector against another.

Formatting the axes 

  You can reformat your polar plot’s axes, using the Polar Axes page of the dialog
box for formatting polar plots.

To change a polar plot’s format:

Click in the polar plot to select it.

Double-click in the polar plot. Alternatively, choose Graph⇒Polar Plot
from the Format menu. You’ll see the dialog box for formatting polar plots. 

If necessary, click the Polar Axes tab.

There is a complete group of settings for each axis. Change the appropriate
settings.

Click “OK” to accept your changes and close the dialog box. Mathcad re-
draws the polar plot with the new settings in effect. Alternatively, click “Ap-
ply” to see the plot redrawn without closing the dialog box.
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Axis settings

Each axis has the following settings associated with it:

Log Scale
When this box is checked, the radial axis is logarithmic. Axis limits must be
positive. This setting is available only for the radial axis. Figure 13 on page
492 illustrates a polar plot with a logarithmic axis.

Grid Lines
When this box is checked, the tick marks on the selected axis are replaced by
grid lines. If the axis is logarithmic, then logarithmically spaced grid lines
are added if space permits. Radial grid lines are circles of fixed radius; angu-
lar grid lines radiate out from the origin at a fixed angle. Figure 11 on page
491 compares a plot with tick marks to the same plot with grid lines.    

Numbered
When this box is checked, the selected grid lines are numbered. Figure 11 on
page 491 illustrates numbers being used with grid lines.

Show Markers
When this box is checked, you can add reference lines to your polar plot. For
a discussion of Show Markers, see “Adding radial reference lines” later in
this section.

Auto Grid
When this box is checked, Mathcad automatically selects the number of grid
markings (tick marks or grid lines). When the box is unchecked, you choose
the number of grid markings (from 2 to 99) by typing a number in the No. of
Grids text box. You can specify the number of grid markings only when Log
Scale is unchecked. Figure 12 on page 491 illustrates the effect of Auto Grid.
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In addition to these check boxes, the dialog boxes contain the following:

No. of Grids
When available, this text box indicates the number of tick marks or grid lines
on the associated axis. You can enter a number between 2 and 99, inclusive.
This box is only available when Auto Grid and Log Scale are unchecked.
Figure 12 on page 491 shows the effects of defining the number of grid lines
on both the radial and the angular axes.

Axes Style
These buttons let you choose between crossed axes, no axes at all, and a plot
enclosed by a circle (perimeter). Figure 14 on page 492 illustrates the differ-
ence between perimeter and crossed axes.   

See the section “Setting default formats” on page 481 to learn how to:

Quickly restore a polar plot to its default format settings.

Use a particular plot as a model for all future polar plots.

Setting limits for axes

Mathcad sets the upper and lower radial axis limits by default. For a linear scale,
the upper limit is the maximum radial value of whatever is plotted. The lower
limit is zero. For a logarithmic scale, the upper limit is set to the next higher inte-
ger power of ten above the maximum of the data. The lower limit on a logarith-
mic scale is set to the next integer power of ten below the minimum of the data. 

You may want to use axis limits other than those set by Mathcad. You can over-
ride Mathcad’s limits by entering limits directly on the graph. To do so:

Click in the polar plot to select it. Mathcad shows two additional numbers on
the upper right of the polar plot. These numbers are enclosed within corner
symbols, as illustrated by the selected plot in Figure 5, below.

Mathcad treats a negative radial limit as a positive value. To set the maxi-
mum value of the radial axis, click on the number in the top placeholder and
type in a new number. While there’s rarely a reason to change the minimum
value, you can do this by clicking on the lower number and typing a new
number. 

Click outside the plot, Mathcad immediately redraws it using the axis limits
you specify. Figure 5 shows the effect of manually setting limits on a polar
plot.
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Figure 5: Manually setting axis limits.

Adding radial reference lines 

 Mathcad places linearly or logarithmically spaced radial grid lines on a polar
plot. The spaces between grid lines are relatively round numbers that span the
range of values on the angular axis. There may, however, be occasions when
you need to place a radial line somewhere other than where Mathcad would nor-
mally place a grid line. 

To add a radial reference line to the polar plot:

Click in the polar plot to select it.

Choose Graph⇒Polar Plot from the Format menu or double-click on the
plot to display the dialog box for formatting polar plots. If necessary, click on
the Polar Axes page.

Click the Show Markers check box in the radial axis column to add a check.
Click “OK”. Mathcad shows two additional placeholders on the upper-left
side of the plot.

Click on one of the placeholders and type in the value at which you want the
radial reference line drawn. Repeat this process with the other placeholder to
add two radial reference lines.
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When you click outside the graph, Mathcad draws a dashed circle at each num-
ber that you specified. The number that you typed appears on this dashed circle.
To move the dashed circle, click on the appropriate number and change it. To de-
lete the circle, delete this number or click on the Show Markers check box to re-
move the check. Figure 6 illustrates the use of radial reference lines.

Figure 6: Adding radial reference lines to a polar plot.

Formatting individual curves

  You can reformat the traces on your polar plot, using the Traces page of the dia-
log box for formatting polar plots.

To reformat a plot’s traces:

Click in the polar plot to select it.

Double-click in the polar plot. Alternatively, choose Graph⇒Polar Plot
from the Format menu. Mathcad displays the dialog box for formatting polar
plots. 

If necessary, click the Traces tab.
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Click on the appropriate line in the scrolling list box to select a trace. To
change the name of the trace, type the new name in the text box under the
“Legend Label” column. To assign a symbol or marker, line type, color, trace
type, and line weight to this trace, click on the arrow beside each text box to
see a drop-down list of options, and then click on the option you want. See
the next section, “Trace settings,” for complete explanations of these fields.

Click “OK” to accept your changes and close the dialog box. Mathcad re-
draws the plot with the new settings in effect. Alternatively, click “Apply” to
preview your changes without closing the dialog box.

Trace settings

A graph can have up to sixteen individual traces. Each trace is described by a
line in the scrolling list. Mathcad uses these lines as needed, assigning one for
each trace in your plot. Each line has six fields: 

Legend Label
This is the name of the trace as it would appear in the legend beneath the
plot. See the section “Displaying or hiding arguments and legends” on page
485 for more information about legends.  

Symbol
This controls whether each point on the curve is marked with a symbol. If y
you choose, you can mark each point with either an “×”, a “+”, a hollow
box, or a hollow diamond. If you have a lot of points packed closely to-
gether, you should probably select “none.” Figure 15 on page 493 shows an
example in which each data point is marked by with an “×”.  

Line
This controls whether the line is solid, dotted, or dashed or whether it con-
sists of alternating dashes and dots. This feature provides a useful way to dis-
tinguish unmarked curves in black and white printouts.  
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Color
This controls whether the selected trace is red, blue, green, magenta, cyan (a
light blue), brown, black, or white. Mathcad ignores this on monochrome ter-
minals.

Type
This controls the type of trace that will be displayed. Mathcad can generate
the following types of plots: curves, bar charts, stepped curves, error bars,
and points. (You must have at least two traces to use error bars.) Figure 16
on page 493 illustrates the same polar plot, displayed with a variety of trace
types.

Weight
This controls the weight or thickness of the trace. Select from 1 to 9 (thin-
nest to thickest). Select “p” for the lightest (single-pixel) trace.  Although
this may look like weight 1 on your screen, a high resolution printer will
print it as a very fine line. This field also controls the size of the symbols
marking data points, if you have selected a symbol other than “none”. If you
have selected trace type points, this field sets the weight of the dot plotted at
each data point.

See “Setting default formats” on page 481 to learn how to: 

Quickly restore a polar plot to its default format settings.

Use a particular plot as a model for all future polar plots.

In addition to the scrolling list and its associated text box and lists, the Trace
page has two check boxes: Hide Arguments and Hide Legend. These are ex-
plained fully in the section “Displaying or hiding arguments and legends” on
page 485 . 

Setting default formats

Mathcad uses default settings to format the axes and traces of new polar plots as
you create them. You can change these defaults in two ways:

By saving as defaults the settings of your current plot.

By using the Setting Default Formats for Polar Plots dialog box to set de-
faults, if you don’t want to use an existing plot. 

Changing defaults only affects new polar plots; previously existing plots are un-
affected. 
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Copying defaults from an existing plot

One way to create a new set of defaults is to use the format settings of an exist-
ing polar plot. The advantage of this method is that you can use “Apply” to see
how the format settings look while you define them.

To use the format of a particular polar plot as the default polar plot settings:   

Select the graph by clicking on it.

Click the Defaults tab on the dialog box for formatting polar plots. The De-
faults page appears, as shown below.

If the Use for Defaults check box isn’t checked, click on it to add one. When
you close the dialog box, Mathcad saves these settings as your default set-
tings.

 

Setting defaults without using a polar plot

You don’t have to use an existing polar plot to create or revise default formats.
Instead, you can use the dialog box for polar plot defaults. To set defaults this
way: 

Make sure that you don’t have any plots selected.

Choose Graph⇒Polar Plot from the Format menu. You’ll see the dialog
box for polar plot defaults. The following figure shows an example of this dia-
log box with the Polar Axes page displayed.   

Change the appropriate settings on the Polar Axes and Traces pages.

Click “OK” to accept your changes and close the dialog box.
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Using default graph settings

If you don’t want the format changes made to your polar plot since creating the
last set of default settings, you can restore the plot to its current default settings.
To do so: 

Click the Defaults tab on the dialog box for polar plots.

Click “Change to Defaults”.

Click “OK” to close the dialog box.

Mathcad redraws the plot, using the most recent set of default format settings.
Mathcad does not use any defaults you might have set using the Use for De-
faults check box at any time after the creation of this plot. 

Labeling your polar plot

Mathcad provides several ways to help you to identify what it is you’ve plotted.
You can display:   

A title centered above or below the polar plot. 

A legend identifying each trace.

The arguments you used to create the plot.

Figure 7 shows the relative locations of each of these labels on a perimeter
graph and on a crossed axes graph.
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Figure 7: Graphs with different labels.

You can use these labels all together or in any combination. By default, Math-
cad hides the title, displays arguments, and hides the legend. 

Working with titles

 To add a title to a polar plot, follow these steps:

Click in the polar plot to select it.

Choose Graph⇒Polar Plot from the Format menu or double-click on the se-
lected plot. Mathcad displays the dialog box for formatting polar plots. If nec-
essary, click on the Labels tab to see the Labels page, as shown below. 

Type a title for your polar plot into the Title text box. 

Click on either the Above or Below button, depending upon where you want
to put the title. 

Make sure that the Show Title check box is checked. If it isn’t, Mathcad still
remembers the title but won’t display it.

Click “OK” to accept your changes. Mathcad redraws the polar plot with the
title in place. Alternatively, click “Apply” to preview your title without clos-
ing the dialog box.

To change the title’s text or position, edit the information in the Title group as
appropriate. To delete the title, highlight it in the text box and press [Del].
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Displaying or hiding arguments and legends

Mathcad provides both arguments and legends for identifying specific traces on
a polar plot:

Arguments are the expressions that you typed into the placeholders to create
the polar plot. By default, Mathcad displays arguments.

Legends are labels that appear underneath the polar plot. They contain a
name and an example of the line and symbols used to draw the trace. By de-
fault, Mathcad hides legends.

To display or hide arguments and legends:

Click in the polar plot to select it.

Choose Graph⇒Polar Plot from the Format menu or double-click on the
graph. Mathcad displays the dialog box for formatting polar plots. If neces-
sary, click on the Traces tab.

To suppress the display of the arguments, click on the Hide Arguments check
box to add a check.

To show the legend, click on the Hide Legend check box to remove the
check.  
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Modifying your polar plot’s perspective

Mathcad provides options for manipulating the presentation of your polar plot:

You can make the plot larger or smaller.

You can zoom in on a portion of the plot.

You can get the coordinates for any point that was plotted to construct the
plot.

You can get the coordinates for any location within the plot.

The rest of this section shows how to use these features.

Resizing a polar plot

Resizing a polar plot is very much like resizing a window:

Click in the polar plot to select it.

Move the mouse pointer to one of the three handles along the edge of the po-
lar plot. The pointer will change to a double-headed arrow.

Press and hold down the mouse button and move the mouse in the direction
in which you want the polar plot’s dimensions to change.

Once the polar plot is the right size, let go of the mouse button. 

Click outside the polar plot to deselect it.

Zooming in on a polar plot 

Mathcad allows you to select a region of a polar plot and magnify it. To zoom in
on a portion of a plot, follow these steps:

Click in the polar plot to select it. 

Choose Graph⇒Zoom from the Format menu. The Polar Zoom dialog box
appears. 
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If necessary, reposition the Polar Zoom dialog box so that you can see the en-
tire region of the graph you want to zoom.

Click in the polar plot region and drag the mouse while holding down the
mouse button. A dashed selection circle is centered in the plot.

When the selection circle just encloses the region you want to magnify, let go
of the mouse button. 

The radius of the selected region is shown in the Radius box of the Polar Plot
Zoom dialog box. Click the “Zoom” button to redraw the plot. The axis limits
are temporarily set to the coordinates specified in the Polar Plot Zoom dialog
box.

Before you make these axis limits permanent, you can select another region to
zoom by enclosing another selection circle around the new region. Click “Un-
zoom” to start the zooming process over. If you’re working with a plot that has
already been zoomed, you may want to view the original plot as it looked before
any zooming took place. To do so, click on “Full View”.

Figure 8 shows the effects of zooming in on a portion of a polar plot.
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Figure 8: A zoomed-in region of a polar plot.

Getting a readout of polar plot coordinates 

To see a readout of polar plot coordinates of the specific points that make up a
trace, follow these steps:

Click in the polar plot to select it.

Choose Graph⇒Trace from the Format menu to show the Polar Trace dia-
log box.

If necessary, reposition the Polar Trace dialog box so that you can see the en-
tire region of the graph.

Drag the mouse along the trace whose coordinates you want to see. A dotted
crosshair jumps from one point to the next as you move the pointer along the
trace.

Use the left and right arrows to move to the previous and next data points.
Use the up and down arrows to move to other traces.
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As the pointer reaches each point on the trace, Mathcad displays the coordi-
nates of the pointer location in the Radius and Angle boxes.

When you release the mouse button, the radius and angle settings of the last
point selected are shown in the Radius and Angle boxes. The crosshair re-
mains until you click outside the polar plot. 

Double-click on the control box in the upper-left-hand corner to close the Po-
lar Trace dialog box. The crosshair will remain on your plot until you click
anywhere outside it.

To copy a coordinate to the clipboard: 

Click “Copy Radius” or “Copy Angle”. 

You can then paste that value into either a math or text region of your Math-
cad worksheet, into a spreadsheet, or into any other application that allows
pasting from the clipboard. 

To see a readout of coordinates for any location in a polar plot:

Follow the above procedures to call up the Polar Trace dialog box.

Click on Track Data Points to uncheck it.

In the polar plot region, click and drag the mouse pointer over the points
whose coordinates you want to see. A dotted crosshair follows the pointer as
you drag it over the plot. Mathcad displays the coordinates of the pointer in
the Radius and Angle boxes. The radius and angle values change continu-
ously to reflect the current pointer position.

When you release the mouse button, the Radius and Angle boxes show the r
and θ values of the last pixel selected.

Figure 9 shows an example of the Trace option being used.
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Figure 9: Reading coordinates from a polar plot using the Polar Trace dialog
box.
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Gallery of polar plots

Figure 10: Different axis formats on the same polar plot.

Figure 11: Using Auto Grid on the same polar plot.
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Figure 12: Polar plot with a logarithmic axis.

Figure 13: Using perimeter and crossed axes styles on the same polar plot.
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Figure 14: Using symbols and lines on the same polar chart.

Figure 15: Presenting the same plot formatted as lines and symbols and then as
error bars.
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Chapter 21
Surface Plots

 Mathcad worksheets can include both two-dimensional plots and
three-dimensional plots. Unlike the two-dimensional plots, which
work with range variables and functions, three-dimensional plots
require a matrix of values. This chapter shows how a matrix can be
represented as a surface plot in which you can see a
three-dimensional illustration of its values.

This chapter describes how to create, use, and format
three-dimensional surface plots. The chapters that follow describe
how to work with the other types of plots.

This chapter contains the following sections:

Creating a surface plot
Basic steps for creating surface plots; procedures for creating surface
plots for functions of two variables and for creating parametric surface
plots.

Resizing surface plots
Procedures for changing the size of surface plots.

Formatting surface plots
Procedures for changing surface plots: setting the viewpoint, size, and
magnification; adding labels; and formatting lines, colors, and axes.
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Creating a surface plot

To create a surface plot:

Define a matrix of values to plot. Mathcad will use the rows and column num-
bers of the matrix as x- and y-axes. The matrix elements will be plotted as
heights above or below the xy plane.

Choose Graph⇒Surface Plot from the Insert menu. Mathcad shows a box
with a single placeholder, as shown below in Figure 1.

Type the name of the matrix in the placeholder. Just as with an equation,
Mathcad will not process the surface plot until you click outside the plot.

 Figure 1: An empty placeholder in a surface plot region awaits the name of a
matrix.

What you see is a visual representation of the matrix. Mathcad draws a perspec-
tive view of the matrix as a two-dimensional grid lying flat in three-dimensional
space. Each matrix element is represented as a point at a specified height above
or below this grid. The height is proportional to the value of the matrix element.
In the default perspective, the first row of the matrix extends from the back left
corner of the grid to the right, while the first column extends from the back left
corner out toward the viewer. 

Mathcad draws lines to connect the points in the plot. These lines define the sur-
face. The perspective for this rendering of the surface depends on the location of
the viewer with respect to the surface. You can specify this view by changing
the plot’s tilt or rotation, as described in the subsection “Changing your view of
the surface plot,” later in this chapter.
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Plotting a function of two variables 

 A typical surface plot shows the values of a function of two variables. To see
such a plot, you must first create a matrix that holds the values of the function,
then create a surface plot of that matrix. Here are the typical steps in plotting a
function of two variables such as that shown in Figure 2:

Define a function of two variables.

Decide how many points you want to plot in the x and y directions. Set up
range variables i and j to index these points. For example, if you want to plot
10 points in each direction, enter:

i := 0 ..9       j := 0 ..9

Define xi and yj as evenly spaced points on the x- and y-axes.

Fill the matrix M with the values of f(xi , yj).

Choose Graph⇒Surface Plot from the Insert menu.

Type M in the placeholder and click outside the region.

Figure 2: Surface plot of a function of two variables.
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Creating parametric surface plots

To use Mathcad’s surface plot operator to draw parametric surface plots: 

Type the names of three matrices having the same number of rows and col-
umns into the placeholders at the bottom of the surface plot. 

Mathcad interprets these three matrices as the x-, y-, and z-coordinates of
points on a surface and draws this surface from the viewing angle prescribed
by the Rotation and Tilt settings. 

The underlying parameter space is a rectangular sheet covered by a uniform
mesh. In effect, the three matrices map this sheet into three-dimensional space.
For example, the matrices X, Y, and Z defined in Figure 3 carry out a mapping
that rolls the sheet into a tube and then joins the ends of the tube to form a torus.

Figure 3: Parametric surface plots.

You can’t convert parametric surface plots into any other type of 3D plot.
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Resizing surface plots

To change the size of a surface plot, follow these steps:

Click in the surface plot to select it.

Move the mouse pointer to one of the three handles along the edge of the sur-
face plot. The pointer will change to a double-headed arrow.

Press and hold down the mouse button. While holding down the button, move
the mouse. The surface plot region will stretch in the direction of motion.

Once the surface plot is the right size, let go of the mouse button. 

Click outside the surface plot to deselect it.

Formatting surface plots

Mathcad provides many ways to change the way a surface plot looks. These can
be categorized in four groups:

Viewing characteristics: the type of plot being displayed; the perspective or
point of view from which you see the surface; how “bumpy” the surface
looks; and the presence or absence of borders, enclosing boxes, axes, and co-
ordinate planes.

Color and line formatting: whether the z-coordinates of the surface are indi-
cated by shades of gray or by color; whether the surface is opaque or transpar-
ent; and whether the surface patches form a smooth surface or form parallel
patches.

Axis formatting: whether to show tick marks or grid marks on each axis.

Title characteristics: how the surface plot will display titles.
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To change any of these plot characteristics, start with the 3D Plot Format dialog
box:

Choose Graph⇒3D Plot from the Format menu. Alternatively, double-click
on the plot itself. Mathcad brings up the 3D Plot Format dialog box. The
View Page of this dialog box is shown below. The remaining three tabs take
you to three additional pages.

If necessary, click the tab for the page you want to work with.

Make the appropriate changes in the dialog box.

To see the effect of your changes without closing the dialog box, click “Ap-
ply”. When you’re satisfied, click “Close”. 

When you’re finished, close the dialog by clicking “OK” or “Close”. 

Changing your view of the surface plot 

The View page of the 3D Plot Format dialog box lets you modify the general
presentation of your plot. 

To change your plot from a surface plot to another type of 3D plot, click on the
appropriate button in the Display As group. You can convert any surface plot
(except for parametric plots) into a contour plot or a 3D bar chart. These plot
types are fully discussed in the corresponding chapters of this User’s Guide.
You can also display just the points making up the surface without displaying
the surface itself. To do so, click on Data Points. You can change how the points
look by using the Colors and Lines tab of this dialog box. For more information,
see Chapter 24, “Surface plots.” 
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To change the perspective, or point of view, from which you see the surface of
your plot, adjust the figures in the Rotation and Tilt text boxes. Use an integer
between 0 to 360 degrees. Figure 4 shows the effects of varying the rotation and
tilt (as well as the scale) of a surface plot. 

Increasing the rotation turns the plot clockwise. When the rotation is set to 0,
you look straight down the first column of the matrix. The first row of the ma-
trix points to the right. When the rotation is set to 90, you look straight down
the first row of the matrix. The first column points to the left. 

Increasing the tilt raises you higher above the plot’s surface. When the tilt is
set to 0, you look edge on at the plane of the matrix. When the tilt is set to 90,
you look straight down on the surface. Think of how a mountain range looks
when you’re on the ground (tilt equals 0) and when you’re flying directly
above (tilt equals 90).

Figure 4: Different views of a surface.

To control how bumpy the plot looks, adjust the magnification of the vertical
scale by changing the number in the Vert. Scale text box. This is an integer be-
tween 1 and 100. When the vertical scale is small, the variations in height of the
surface will be barely perceptible. At 100, the variations are shown at full scale.
Figure 4 shows the effects of varying the scale (as well as the rotation and tilt)
of a surface plot.  

To add or remove a border around the surface plot region, click on Show Border
in the Frames group to add or remove a check. The border is a two-dimensional
frame around the surface plot region. 
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To enclose the surface and and the axes within a three-dimensional bounding
box, click on Show Box in the Frames group to add a check. 

You can add back planes to your surface plots: 

To show the xy, xz, and yz back planes, click on Show in the Back Planes
group.

To color the surface of the back planes, click on “Fill Color”.

To outline the edges of the back planes in a particular color, click on “Edge
Color”.

Figure 5 shows a surface plot with a border around it and with back planes show-
ing and the same plot enclosed within a box without showing back planes.

Figure 5: Using a border or a bounding box on a surface plot.
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Changing the shading of the surface

You can often make a surface plot communicate more effectively by using dif-
ferent colors to represent different values of z. Alternatively, if you intend to
print on a black and white printer, you can achieve a similar effect by using dif-
ferent shades of gray to represent the different values of z. Use the Color and
Lines page of the 3D Plot Format dialog box.     

To specify the shading of your plot, click the appropriate button in the Shading
group:

None: The surface won’t have any shading, regardless of where it is.

Grayscale: The largest values of the matrix will be in white and the smallest
values will be in black. Intermediate values will be in shades of gray.

Color: The largest values of the matrix will be in red and the smallest values
will be in blue. Intermediate values will range from yellow through green.
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Figure 6 shows the same surface plot displayed without shading and in grayscale.

Figure 6: Surface plots showing display options for lines and meshes.

If you’ve chosen to leave the surface without shading (“None”), you’ll be able
to see through the surface as if it were transparent. Depending on the surface
and on your viewpoint, you may find it distracting to see through the surface.
When this happens, you may want to render the surface opaque. Note that this
option is unnecessary when a surface is rendered in color or in shades of gray.
Such surfaces are inherently opaque.

To make the surface opaque, click Hidden Lines to add a check. Mathcad
hides any lines that are behind the surface. Such a plot takes longer to draw
since Mathcad has to determine which parts of the surface are concealed. 

To make the surface transparent, click Hidden Lines to remove the check. If
you uncheck Hidden Lines, the surface shows lines that are behind it. Such a
plot will draw more quickly than if lines were hidden, but it may be more dif-
ficult to interpret.

The upper two surface plots in Figure 6 show the same surface with and without
lines showing.

By default, Mathcad overlays a mesh on colored and grayscale surfaces. The in-
tersections of the lines making up this mesh correspond to the elements of the
underlying matrix. Each patch created by this mesh gets a color corresponding
to the value of the underlying matrix element. 

504 Chapter 21  Surface Plots



As the number of matrix elements increases, this mesh can become so dense that
it begins to obscure the colors. When this happens you may want to hide the
mesh. To do so, click Hide Mesh in the Fill Style group to add a check.

Note that Hide Mesh is only available for colored and grayscale plots. Hiding
the mesh of a plot that doesn’t have any shading would make that plot invisible.
The lower two surface plots in Figure 6 show the same surface plot with the
mesh showing and with it hidden.

By default, the patches making up the surface are free to tilt in whatever direc-
tion necessary to connect them to their neighboring patches. The result is a con-
tinuous surface. In this case, each point at which grid lines intersect is associated
with a matrix element. This means that for an m × n matrix, there will be
(m − 1)(n − 1) patches. 

To constrain these patches to be horizontal, click Patch Plot in the Fill Style
group for regular surface plots and Alternative Mesh for parametric surface
plots to add a check. The resultant discontinuous surface shows a patch for each
matrix element. This means that for an m × n matrix, there will be mn patches.

Figure 7 shows an example of the same matrix being plotted with Patch Plot
checked and not checked.

 

Figure 7: Patch plots.
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Formatting the axes

The Axes page of the 3D Plot Format dialog box lets you modify the format of
the axes of your plot. Each axis is described by its own set of check boxes and
text boxes.

  

Mathcad generates grid lines for surface plots by extending tick marks up and
down the two back planes adjacent to a given axis. Thus, x-axis grid lines repre-
sent lines of constant x drawn on the xz plane and the xy plane, the two orthogo-
nal planes whose intersections form the x-axis. The y-axis grid lines and z-axis
grid lines are defined similarly.   

Note that this makes it impossible to draw lines of constant x on only the xz
plane. Clicking Grid Lines always results in grid lines being drawn on two of
the three back planes.

To choose between using tick marks or grid lines on a selected axis, use the Grid
Lines check box for that axis. When Grid Lines is checked, Mathcad will extend
the tick marks on the selected axis into grid lines on each adjacent back plane.
For example, checking this on the z-axis will result in lines of constant z on both
the yz and the xz back planes. If you are showing grid lines, you should seriously
consider showing back planes as well. See “Changing your view of the surface
plot” on page 500. Figure 8 shows an example of a surface plot that uses grid
lines rather than tick marks.
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Figure 8: Using the different options for tick marks.

To add or remove numbers for the tick marks on an axis, use the Numbered
check box for that axis. Figure 8 shows the differences between having numbers
on the tick marks and not having numbers.

You can have Mathcad automatically select the number of grid intervals on an
axis or you can specify the number yourself. Grid intervals are the spaces be-
tween tick marks or grid lines.     

To have Mathcad select the number of grid intervals, use the Auto Grid check
box. When Auto Grid is checked, Mathcad will automatically select the num-
ber of grid intervals on the specified axis.

To specify the number of grid intervals on an axis yourself, enter an integer
from 1 to 99 in the No. of Grids text box. This text box is only available when
Auto Grid is unchecked.

By default, Mathcad autoscales the z-axis according to the range of values in the
matrix you are plotting. Sometimes you will want to fix the scaling yourself, for
example, if you are comparing views of related data or setting up a surface ani-
mation sequence. To set the z-axis limits manually, click on the Autoscale box
in the z-axis column of the Axes page to uncheck it. Then enter the maximum
and minimum values in the Max. Val. and Min. Val. text boxes.
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Since a surface plot is made by plotting the elements of a matrix, Mathcad can-
not “know” anything about x and y coordinates. By default, the coordinates on
the x- and y-axes of a surface plot will simply be rows and columns. To change
the numbers used to label the x- and y-axis, enter the new limits in the Max. Val.
and Min. Val. text boxes. If you’ve made a parametric surface plot, you won’t
be able to use these text boxes. This is because the x and y values are themselves
passed in as the first two matrices of the three matrices required for a parametric
surface plot.

Labeling the surface plot

 The Title page of the 3D Plot Format dialog box, shown below, lets you add and
modify a title for your surface plot.  

To add or edit a title for your surface plot:

Type the title for your plot into the Title text box. 

To display the title, click on Show Title to insert a check. To conceal the title
without deleting it, click on Show Title to remove the check.

To position the title, click on either the Above or Below button. Mathcad
places the title either directly above or below your plot. Figure 9 shows the
options for positioning labels on your plot.

To change the title’s text or position, edit the information in the Title group as
appropriate.

Click “OK” to close the dialog box when you have finished.

To delete the title, highlight it in the Title text box and press [Del].

If you initiate this process by double-clicking on the title itself, you’ll see an
equivalent dialog box.
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Figure 9: Positioning a title on a surface plot.
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Chapter 22
Contour Plots

A contour plot lets you quickly visualize level curves. These are
curves along which a particular quantity is constant. Using
Mathcad, you make a contour plot in the same way you make a
surface plot: by passing a matrix of z-values in which each row
and column corresponds to a particular x and y value. This chapter
describes how a matrix can be represented as a contour plot.

This chapter contains the following sections:

Creating a contour plot
Basic steps in creating a contour plot; what the plot actually shows.

Resizing a contour plot
Procedures for changing the size of contour plots.

Formatting contour plots
Procedures for changing contour plots: formatting contours and axes
and adding labels. 
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Creating a contour plot

To create a contour plot:

Define a matrix of values to plot. Mathcad will assume that the rows and col-
umns represent equally spaced intervals on the axes. Mathcad then linearly in-
terpolates the values of this matrix to form level curves. Such level curves
can represent isotherms, isobars, equipotentials, streamlines, and many other
physical phenomena.

Choose Graph⇒Contour Plot from the Insert menu. Mathcad shows a box
with a single placeholder as shown in Figure 1.

Type the name of the matrix in the placeholder. Just as with an equation,
Mathcad will not process the contour plot until you click outside the region. 

Figure 1: An empty placeholder in a contour plot region awaits the name of a
matrix.

What you see is a visual representation of the matrix’s level curves. Each level
curve, or contour, is formed in such a way that no two cross. By default, the con-
tours are labeled with their height above or below the xy  plane. Mathcad plots
the matrix by rotating it so that the (0,0) element is at the lower-left corner. Thus
the rows of the matrix correspond to values on the x axis, increasing to the right,
and the columns correspond to values along the y axis, increasing toward the
top. 
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You can specify whether or not the contours are to be numbered, how many con-
tours there are, and what labels and grid lines appear on the axes by formatting
the contour plot. This is described in the section “Formatting contour plots,”
later in this chapter.

Level curves of a function of two variables  

A typical contour plot shows the level curves of a function of two variables. To
see such a plot, you must first create a matrix that holds the values of the func-
tion, then create a contour plot of that matrix. Here are the typical steps in plot-
ting a function of two variables such as that shown in Figure 2:

Define a function of two variables.

Decide how many points you want to plot in the x and y directions. Set up
range variables i and j to index these points. For example, if you want to plot
10 points in each direction, enter:

i := 0 ..9       j := 0 ..9

Define xi and yj as evenly spaced points on the x- and y-axes.

Fill the matrix M with the values of f(xi,yj).

Show M in a contour plot.

Figure 2: Contour plot of a function of two variables.
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Note that if you plot a function as described here, the positive x-axis of the plot
extends to the right and the positive y-axis extends toward the top of the win-
dow. Since the contour plot is created by putting the heights above the xy plane
into a matrix, Mathcad has no way of knowing the actual values of the x and y
axes. For this reason, the axes on contour plots are by default normalized to ex-
tend from 1 to −1. You can manually change the axis limits from these default
values by choosing Graph⇒3D Plot from the Format menu with the contour
plot selected or by double-clicking on the plot. Then set the values you want in
the Min. Val. and Max. Val. text boxes on the Axes page.

Resizing a contour plot

To change the size of a contour plot, follow these steps:

Click in the contour plot to select it.

Move the mouse pointer to one of the three handles along the edge of the
plot. The pointer will change to a double-headed arrow.

Press and hold down the mouse button. While holding down the button, move
the mouse. The contour plot will stretch in the direction of motion.

Once the contour plot is the right size, let go of the mouse button. 

Click outside the contour plot to deselect it.
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Formatting contour plots

Mathcad gives you control over many of the visual characteristics of contour
plots. These can be categorized in four groups:

Viewing characteristics: the type of plot being displayed.

Axis formatting: whether to show tick marks or grid lines on each axis.

Color and line formatting: whether the plot uses grayscale or color to show
the height of a section and how the plot shows contours.

Title characteristics: how the plot will display titles.

To change any of these plot characteristics, start with the 3-D Plot Format dialog
box:

Click on the plot to select it.

Choose Graph⇒3D Plot from the Format menu. Alternatively, double-click
on the plot itself. Mathcad brings up the 3D Plot Format dialog box. The
View Page of this dialog box is shown below. The remaining three tabs take
you to three additional pages.

If necessary, click the tab for the page you want to work with.

Change the appropriate characteristics in the dialog box.

To see the effect of your changes without closing the dialog box, click “Ap-
ply”. 

When you’re finished, close the dialog by clicking “OK” or “Close”. 
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Changing your view of the contour plot

The View page of the 3D Plot Format dialog box lets you modify the general
presentation of your plot.      

To change your plot from a contour plot to another type of 3-D plot, click on the
appropriate button in the Display As group. You can convert a contour plot into
a Surface Plot or a 3D Bar Chart. These plot types are fully discussed in the cor-
responding chapters in this User’s Guide. You can also display just the points
making up the contours without displaying the contours themselves. To do so,
click on Data Points. You can then change how the points look by using the Col-
ors & Lines tab of this dialog box. For more information, see Chapter 24, “3D
Scatter Plots.”

Figure 3 shows the same matrix being plotted as a surface plot and as a contour
plot.

Figure 3: Matrix shown as both a surface plot and as a contour plot.
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Changing the shading of the contours

You can often make a contour plot communicate more effectively by using dif-
ferent colors to represent different values of z. Alternatively, if you intend to
print on a black and white printer, you can achieve a similar effect by using dif-
ferent shades of gray to represent different values of z. Use the Color and Lines
page of the 3D Plot Format dialog box.  

   

To specify the shading of your plot, click the appropriate button in the Shading
group:

Color: The bands between contour lines are colored. The largest values of the
matrix will be in red and the smallest values will be in blue. Intermediate val-
ues will range from yellow through green.

None: The bands between contour lines don’t have any shading. Be sure the
Contour Lines check box is checked or you won’t see any contours at all. 

Grayscale: The bands between contour lines are in shades of gray. The largest
values of the matrix will be in white and the smallest values will be in black.
Intermediate values will be in shades of gray.
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Figure 4 shows the same contour plot displayed without shading and in
grayscale.

Figure 4: No shading and grayscale versions of a contour plot.

Besides varying the colors of a contour plot, you can also choose to hide the con-
tours themselves. If you’ve chosen to leave the surface without shading
(“None”), you should have the contour lines showing. If the plot is colored or
grayscale, you can hide the contour lines and let the colors or gray shades show
the contours. To show or hide the contour lines, click Contour Lines to add or re-
move the checkmark. Figure 4 shows the same contour plot with the contour
lines hidden and showing. 

Contours can be numbered to indicate the value associated with that contour. To
add or remove numbers on most contours, use the Numbered check box. Figure
5 shows the same contour plot with numbered and unnumbered contour lines.
Note that Mathcad doesn’t number every contour when to do so would result in
overcrowding. 
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Figure 5: Changing the number of contours and turning off contour labeling.

To have Mathcad automatically select the number of contours to display, use the
Auto Contour check box. When checked, Mathcad will automatically select the
number of contours. When unchecked, you select the number of contours.

To specify the number of contours, enter an integer into the No. of Contours text
box. This text box is only available when Auto Contour is unchecked. Figure 5
shows the same contour plot with contours automatically selected by Mathcad
and with a specified number of contours.  
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Formatting the axes

The Axes page of the 3D Plot Format dialog box, shown below, lets you modify
the format of the x- and y-axis of your plot. Each axis is described by its own set
of check boxes and text boxes.    

Mathcad generates grid lines on the plot at the same positions as the tick marks.
To choose between seeing tick marks or grid lines on a selected axis, use the
Grid Lines check box. When Grid Lines is checked, Mathcad adds grid lines to
the plot. Figure 6 shows the same contour plot with and without grid lines.  

Figure 6: Effect of using the different options for tick marks.
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To add or remove numbers for the tick marks on an axis, use the Numbered
check box for that axis. The plot with grid lines in Figure 6 doesn’t have num-
bers on the axes while the plot without grid lines does have them.

You can have Mathcad automatically select the number of grid intervals on an
axis or you can specify the number yourself. Grid intervals are the spaces be-
tween tick marks or grid lines.     

To have Mathcad select the number of grid intervals, use the Auto Grid check
box. When Auto Grid is checked, Mathcad will automatically select the num-
ber of grid intervals on the specified axis.

To specify the number of grid intervals on an axis yourself, enter an integer
from 1 to 99 in the No. of Grids text box. This text box is only available when
Auto Grid is unchecked.

To set limits on the maximum or minimum values of the x- or y-axis, enter the
limit in the Max. Val. or Min. Val. text box. However, since the surface of the
plot is stored as rows and columns in a matrix, these numbers have no signifi-
cance as coordinates. They affect the display only. By default, Min and Max are
set to −1 and 1 respectively.   

Labeling the contour plot

 The Title page of the 3D Plot Format dialog box, shown below, lets you add and
modify labels on your contour plot.  

To add or edit a title for your contour plot:

Type the title for your plot into the Title text box. 

To display the title, click on Show Title to insert a check. To conceal the title
without deleting it, click on Show Title to remove the check.

To position the title, click on either the Above or Below button. Mathcad
places the title either directly above or below your plot. 

Click “OK” or “Close” to close the dialog box when you have finished.
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To change the title’s text or position, edit the information in the Title group as
appropriate. To delete the title, highlight it in the text box and press [Del].

Figure 7 shows how Mathcad positions a title on a contour plot.

Figure 7: A title on a contour plot.
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Chapter 23
3D Bar Charts

 Three-dimensional bar charts offer you additional flexibility when
displaying data. You can use them to visualize a matrix not as a
surface plot but as bars of varying heights. You can show the bars
either where they are in the matrix, stacked one on top of another,
or laid out side-by-side.

This chapter contains the following sections:

Creating a 3D bar chart
Basic steps for creating bar charts and for creating bar charts for func-
tions of two variables.

Resizing 3D bar charts
Procedures for changing the size of bar charts.

Formatting 3D bar charts
Procedures for changing bar charts: setting the viewpoint, size, and
magnification; adding titles; and formatting lines, colors, and axes.

523



Creating a 3D bar chart 

To create a bar chart:

Define a matrix of values to display. Mathcad will use the rows and column
numbers of the matrix as x- and y-axes. The matrix elements will be shown as
columns extending from the xy plane to the appropriate height.

Choose Graph⇒3D Bar Chart from the Insert menu. Mathcad shows a box
with a single placeholder, as shown below in Figure 1.

Type the name of the matrix in the placeholder. Just as with an equation,
Mathcad will not display anything until you click outside the plot region.

Figure 1: An empty placeholder in a bar chart region awaits the name of a ma-
trix.

What you see is a visual representation of the matrix. Mathcad draws a perspec-
tive view of the matrix as a two-dimensional grid lying flat in three-dimensional
space. Each matrix element is represented as a column extending above or be-
low this grid by an amount proportional to the value of the matrix element. In
the default perspective, the first row of the matrix extends from the back left cor-
ner of the grid to the right, while the first column extends from the back left cor-
ner out toward the viewer. 

The perspective on the bar chart depends on the location of the viewer with re-
spect to the surface. You can specify this view by changing the chart’s tilt or ro-
tation, as described in the subsection “Changing your view of the 3D bar chart,”
later in this chapter.
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Displaying a function of two variables 

 A typical 3D bar chart shows the values of a function of two variables. To see
such a chart, you must first create a matrix that holds the values of the function,
then create a bar chart of that matrix. Here are the typical steps in plotting a func-
tion of two variables such as that shown in Figure 2:

Define a function of two variables.

Decide how many points you want to display in the x and y directions. Set up
range variables i and j to index these points. For example, if you want to dis-
play 10 points in each direction, enter:

i := 0 ..9       j := 0 ..9

Define xi and yj as evenly spaced points on the x- and y-axes.

Fill the matrix M with the values of f(xi , yj )

Choose Graph⇒3D Bar Chart from the Format menu.

Type M in the placeholder. Then click outside the plot region.

Figure 2: 3D bar chart of a function of two variables.
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Resizing 3D bar charts

To change the size of a bar chart, follow these steps:

Click in the bar chart to select it.

Move the mouse pointer to one of the three handles along the edge of the bar
chart. The pointer will change to a double-headed arrow.

Press and hold down the mouse button. While holding down the button, move
the mouse. The bar chart will stretch in the direction of motion.

Once the bar chart is the right size, let go of the mouse button. 

Click outside the bar chart to deselect it.

Formatting 3D bar charts

Mathcad provides many ways to change the way a bar chart looks. These can be
categorized in four groups:

Viewing characteristics: the type of plot being displayed; the perspective or
point of view; how tall the tallest bars are; and the presence or absence of bor-
ders, enclosing boxes, axes, and coordinate planes.

Color and line formatting: how the bars are colored; how the bars are laid out;
spacing between the bars.

Axis formatting: whether to show tick marks or grid lines on each axis.

Title characteristics: how the bar chart will display titles.

To change any of these characteristics, start with the 3D Plot Format dialog box: 

Click on a bar chart to select it.
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Choose Graph⇒3D Plot from the Format menu. Alternatively, double-click
on the chart itself. Mathcad brings up the 3D Plot Format dialog box. The
View Page of this dialog box is shown below. The remaining three tabs take
you to three additional pages.

If necessary, click the tab for the page you want to work with.

Make the appropriate changes in the dialog box.

To see the effect of your changes without closing the dialog box, click “Ap-
ply”. 

When you’re finished, close the dialog by clicking “OK” or “Close”. 

Changing your view of the 3D bar chart

The View page of the 3D Plot Format dialog box lets you modify the general
presentation of your bar chart. 

To change from a bar chart to another type of 3D plot, click on the appropriate
button in the Display As group. You can convert a bar chart into a surface plot
or a contour plot. These plot types are fully discussed in the corresponding chap-
ters of this User’s Guide. You can also display just the points at the top of the
bars. To do so, click on Data Points. You can change how the points look by us-
ing the Colors & Lines tab of this dialog box. For more information, see Chapter
24, “3D Scatter Plots.”   

To change the perspective, or point of view, from which you see the bars on
your chart, adjust the figures in the Rotation and Tilt text boxes. Use an integer
between 0 to 360 degrees. Figure 4 shows the effects of varying the rotation and
tilt (as well as the vertical scale) of a bar chart. 

Increasing the vertical rotation turns the chart clockwise. When the rotation is
set to 0, you look straight down the first column of the matrix. The first row
of the matrix points to the right. When the rotation is set to 90, you look
straight down the first row of the matrix. The first column points to the left.
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Increasing the tilt raises you higher above the chart’s surface. When the tilt is
set to 0, you look edge on at the plane of the matrix. When the tilt is set to 90,
you look straight down on the tops of the bars. Think of how tall buildings
look when you’re on the ground (tilt equals 0) and when you’re flying di-
rectly above (tilt equals 90).

Figure 4: Different views of a bar chart.

To control how tall the tallest bars look, adjust the vertical scale by changing the
number in the Vert. Scale text box. This is an integer between 1 and 100. When
the vertical scale is small, the variations among the bars will barely be percepti-
ble. At 100, the variations are such that the chart fills almost the entire frame.
Figure 4 shows the effects of varying the scale (as well as the rotation and tilt)
of a bar chart. 

To add or remove a border around the bar chart, click on Show Border in the
Frames group. The border is a two-dimensional frame around the bar chart. 

To enclose the surface and and the axes within a three-dimensional bounding
box, click on Show Box in the Frames group. 

To show the xy, xz, and yz  back planes:

Click on Show in the Back Planes group.

To color the surface of the back planes, click on “Fill Color”.

To outline the edges of the back planes in a particular color, click on “Edge
Color”. 
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Figure 5 shows the same bar chart with back planes, with a border, and with a
bounding box.

Figure 5: Using a border or a bounding box on a bar chart.
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Changing the color and layout of the bars

You can often make a 3D bar chart communicate more effectively by using dif-
ferent colors. In addition, you can switch among several layouts of the bars to
show your data most effectively. Use the Color & Lines page of the 3D Plot For-
mat dialog box.

 

To specify the color of your chart, click the appropriate button in the Color Spec-
trum group:  

None: The bar chart doesn’t show any colors.

Increasing X: The largest values along the x-axis will be in red and the small-
est values will be in blue. Intermediate values will range from yellow through
green.

Increasing Y: The largest values along the y-axis will be in red and the small-
est values will be in blue. Intermediate values will range from yellow through
green.

Increasing Z: The largest values along the z-axis will be in red and the small-
est values will be in blue. Intermediate values will range from yellow through
green.

Use the Spacing text box to increase the space between adjacent bars on your
plot. This text box measures spacing as the percentage of the size of the grid on
which the bars are placed. The default spacing is 20%; the maximum spacing is
99%. As you increase the percentage, Mathcad makes the bars progressively
skinnier.  Figure 6 shows different spacing for plots of the same matrix.
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Figure 6 shows the same bar chart using each of the Color Spectrum options.

Figure 6: Color and spacing options for bar plots.

You can also control the placement of the bars relative to one another using the
Bar Layout buttons. The three options are: 

Matrix: The bars are arranged exactly as the corresponding numbers in the un-
derlying matrix.

Stacked: All the bars coming from the same column of the matrix are stacked
one on top of another. An m × n matrix would therefore appear as n bar clus-
ters, each formed by stacking m bars one on top of another.

Side by Side: All the bars coming from the same column of the matrix are
clustered together side-by-side. An m × n matrix would therefore appear as n
bar clusters, each of which contains m bars.

Figure 7 shows a m × n matrix being displayed using each of these three layout
options. Note that if you want to swap rows and columns, you can simply plot
the transpose of the matrix.
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Figure 7: Different bar layouts with the same bar chart matrix.

Formatting the axes

The Axes page of the 3D Plot Format dialog box lets you modify the format of
the axes of your plot. Each axis is described by its own set of check boxes and
text boxes.   

Mathcad generates grid lines for bar charts by extending tick marks up and
down the two back planes adjacent to a given axis. Thus, x-axis grid lines repre-
sent lines of constant x drawn on the xz plane and the xy plane, the two orthogo-
nal planes whose intersections form the x-axis. The y-axis grid lines and z-axis
grid lines are defined similarly.   
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To choose between using tick marks or grid lines on a selected axis, use the Grid
Lines check box for that axis. When Grid Lines is checked, Mathcad will extend
the tick marks on the selected axis into grid lines on each adjacent back plane.
For example, checking this on the z-axis will result in lines of constant z on both
the yz and the xz back planes. If you are showing grid lines, you should seriously
consider showing back planes as well. See “Changing your view of the 3D bar
chart.” Figure 8 shows an example of a bar chart that uses grid lines rather than
tick marks.

Figure 8: Using the different options for tick marks.

To add or remove numbers for the tick marks on an axis, use the Numbered
check box for that axis. Figure 8 shows the differences between having numbers
on the tick marks and not having numbers.

For bar charts, you can have Mathcad automatically select the number of grid in-
tervals on the z-axis. The grid intervals on the x and y axes always match the
rows and columns of the matrix whose elements constitute the bars being plotted.

To have Mathcad select the number of grid intervals on the z-axis, use the
Auto Grid check box. When Auto Grid is checked, Mathcad will automat-
ically select the number of grid intervals on the specified axis.    
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To specify the number of grid intervals on an axis yourself, enter an integer
from 1 to 99 in the No. of Grids text box. This text box is only available when
Auto Grid is unchecked.

By default, Mathcad autoscales the z-axis according to the range of values in the
matrix you are plotting. Sometimes you will want to fix the scaling yourself, for
example, if you are comparing views of related data or setting up a surface ani-
mation sequence. To set the z-axis limits manually, click on the Autoscale box
in the z-axis column of the Axes page to uncheck it. Then enter the  maximum
and minimum values in the Max. Val. and Min. Val. text boxes.

Labeling 3D bar charts

 The Title page of the 3D Plot Format dialog box, shown below, lets you add and
modify the title on your bar chart. 

 

To add or edit a title for your bar chart:

Type the title for your plot into the Title text box. 

To display the title, click on Show Title to insert a check. To conceal the title
without deleting it, click on Show Title to remove the check.

To position the title, click on either the Above or Below button. Mathcad
places the title either directly above or below your plot. 

To change the title’s text or position, edit the information in the Title group as
appropriate.

Click “OK” to close the dialog box when you have finished.

To delete the title, highlight it in the Title text box and press [Del].

If you initiate this process by double-clicking on the title itself, you’ll see an
equivalent dialog box.
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Figure 9: Titles on a bar chart.
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Chapter 24
3D Scatter Plots

 When using other types of 3D plots, you need to make a matrix in
which rows and columns correspond to x and y values and the
value of the matrix element is the z value. Scatter plots, on the
other hand, let you specify x, y, and z coordinates directly. This
makes them useful for drawing parametric curves or for observing
clusters of data in a 3D space. This chapter shows how three
vectors can be used to build a scatter plot.

This chapter contains the following sections:

Creating a 3D scatter plot
Basic steps in creating a scatter plot.

Resizing scatter plots
Procedures for changing the size of scatter plots.

Formatting scatter plots
Procedures for changing scatter plots: setting the viewpoint and the
presentation; adding labels; and formatting markers, lines, and axes. 
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Creating a 3D scatter plot 

Scatter plots allow you to plot an arbitrary collection of points in a three-dimen-
sional space. This is particularly useful for such tasks as identifying data clusters
or tracing a trajectory of a point. Scatter plots differ from all other 3D plots as
follows:

In all other 3D plots, you create a matrix in which the rows and columns cor-
respond to x and y coordinates and the value of the matrix element is the cor-
responding z coordinate.

In scatter plots, you create three vectors with as many elements as there are
points to plot. The x, y, and z coordinates of a point go into the three elements
of the corresponding vectors.

Unlike other 3D plots, you can easily have several z values corresponding to the
same x and y value. This is often necessary in statistical applications in which
you take the same measurement more than once. You can also easily create para-
metric curves through a three-dimensional space since the indices of the vectors
are themselves natural parameters to use.

To create a 3D scatter plot:

Define three vectors, each having as many elements as you have points to
plot. Each vector contains either the x, y, or z coordinates of all the points.

Choose Graph⇒3D Scatter Plot from the Insert menu. Mathcad shows a
box with a single placeholder as shown in Figure 1.

Type the names of the vectors, separated by commas, in the placeholder. Just
as with an equation, Mathcad will not process the scatter plot until you click
outside the region.

If you have a matrix of rows and columns corresponding to the x and y coordi-
nates that you want to show as a set of points, create a surface plot and select
Data Points in the Display As group on the View page. For more information,
see page 500.
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Figure 1: An empty placeholder in a scatter plot region awaits the name of a ma-
trix.
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Resizing scatter plots

To change the size of a scatter plot, follow these steps:

Click in the scatter plot to select it.

Move the mouse pointer to one of the three handles along the edge of the scat-
ter plot. The pointer will change to a double-headed arrow.

Press and hold down the mouse button. While holding down the button, move
the mouse. The scatter plot will stretch in the direction of motion.

Once the scatter plot is the right size, let go of the mouse button. 

Click outside the scatter plot to deselect it.

Formatting scatter plots

Mathcad gives you control over many of the visual characteristics of scatter
plots. These can be categorized in four groups:

Viewing characteristics: the type of plot being displayed, the perspective or
point of view from which you see the plot, and the presence or absence of bor-
ders, enclosing boxes, axes, and back planes.

Color and line formatting: how the plot will mark points; how markers will
be connected; and the format of any lines connecting markers.

Axis formatting: whether to show tick marks or grid lines on each axis.

Title characteristics: how the plot will display titles.

To change any of these plot characteristics, start with the 3D Plot Format dialog
box:

Click on the plot to select it.

540 Chapter 24 3D Scatter Plots



Choose Graph⇒3D Plot from the Format menu. Alternatively, double-click
on the plot itself. Mathcad brings up the 3D Plot Format dialog box. The
View Page of this dialog box is shown below. The remaining three tabs take
you to three additional pages.

If necessary, click the tab for the page you want to work with.

Make the appropriate changes in the dialog box.

To see the effect of your changes without closing the dialog box, click “Ap-
ply”. 

When you’re finished, close the dialog by clicking “OK” or “Close”. 

Changing your view of the scatter plot

The View page of the 3D Plot Format dialog box lets you modify the general
presentation of your 3D scatter plot. 

To change your plot from a scatter plot to another type of 3D plot, click on the
appropriate button in the Display As group. You can convert a scatter plot into a
Surface Plot, Contour Plot, or a 3D Bar Chart. These plot types are fully dis-
cussed in the corresponding chapters in this User’s Guide.  

When you view a scatter plot as a surface or contour plot or a 3D bar chart,
Mathcad actually interpolates a surface that approximates your scatter data, us-
ing a 21 by 21 mesh by default. To change the density of this mesh, click on the
Color & Lines tab and edit the number of rows and columns in the Interpolated
Mesh group. If your data is not well approximated by a surface, Mathcad may
be unable to compile a useful interpolation. If this occurs, Mathcad will signal
this fact with a message in the status line. 
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As you view your scatter plot, you may not be able to perceive any patterns in
your data. However, by examining the plot from another perspective, you may
be able to isolate clusters of data. To change the perspective, or point of view,
from which you see the scatter plot, change the numbers in the Rotation and Tilt
text boxes. Use an integer between 0 to 360 degrees. Figure 2 shows the effects
of varying the rotation and tilt (as well as the scale) of a scatter plot.

Increasing the rotation turns the plot clockwise. 

Tilt controls whether you see the data edge on or whether you look down
from directly overhead.

Figure 2: Changing the rotation and tilt.

To add or remove a border around the scatter plot region, click on Show Border.
The border is a two-dimensional frame around the scatter plot region.  

To enclose the plot and the axes within a three-dimensional bounding box, click
on Show Box in the Frames group to add a check. 

To show the xy, xz, and yz back planes:

Click on Show in the Back Planes group.

To color the surface of the back planes, click on “Fill Color”.

To outline the edges of the back planes in a particular color, click on “Edge
Color”.
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Figure 3 shows a scatter plot with a border around it and with back planes show-
ing together with the same plot enclosed within a box without showing back
planes. 

Figure 3: Using a border or an enclosing box on a scatter plot.

Changing the format of the markers

 You can often make your scatter plot communicate more effectively by chang-
ing one of the following:

You can mark the points with a symbol.

You can connect the points with a line.

To do either of these, use the Color & Lines page of the 3D Plot Format dialog
box.

Formatting scatter plots 543



  

To specify the type of marker your plot will use, select an option from each of
the following drop-down lists:

Symbol: Each point in the scatter plot is marked by a symbol. Select among
o’s, ×’s, +’s, boxes, and diamonds. You can also select “none”; however, if
you do and you aren’t using a connecting line, your plot will be blank.

Color: The markers can be any of the colors listed on the drop-down list, for
example, red, blue, green, magenta, cyan, brown, black, and white. 

Size: Markers can range in size from 1 (thinnest) to 10 (thickest).

Figure 4 shows the same plot with markers formatted in several ways.

Figure 4: Selecting different formatting options for the markers.
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If you are plotting data that shows progressive movement in a direction (for ex-
ample, points in a trajectory), you may want to connect the data points with a
line. Mathcad provides several options for connecting the data points:  

No line

The order in which the points occur in the matrix (row order)

Increasing x values

Increasing y values

Increasing z values

Use the buttons in the Connectivity group to choose which of these options
Mathcad should use to connect the data points. 

Once you’ve decided on the order for connecting the points, you can specify the
way the line connecting them will look. Use the buttons in the Line group to
choose:

Style: The connecting line can be solid, dashed, dotted, or alternatingly
dashed and dotted. You can also select “none”; however, if you do so and
aren’t using markers, your plot will be blank.

Color: The lines can be any of the colors on the drop-down list.

Weight: Lines can range in size from 1 (lightest) to 10 (the heaviest).

Figure 5 shows the same plot connected in different orders.

Figure 5: Passing a line through points on a scatter plot.
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Formatting the axes

The Axes page of the 3D Plot Format dialog box lets you modify the format of
the x, y, and z axes of your plot. Each axis is described by its own set of check
boxes and text boxes.   

Mathcad generates grid lines on the plot at the same positions as the tick marks.
To choose between using tick marks or grid lines on a selected axis, use the Grid
Lines check box. When Grid Lines is checked, Mathcad adds grid lines to the
plot. Figure 6 shows the same scatter plot with and without grid lines.    

Figure 6: Using the different options for axes.
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To add or remove numbers for the tick marks on an axis, use the Numbered
check box for that axis. The plot with grid lines in Figure 6 doesn’t have num-
bers on the axes while the plot without grid lines does have them.

You can have Mathcad automatically select the number of grid intervals on an
axis or you can specify the number yourself. Grid intervals are the spaces be-
tween tick marks or grid lines. 

To have Mathcad select the number of grid intervals, use the Auto Grid check
box. When Auto Grid is checked, Mathcad will automatically select the num-
ber of grid intervals on the specified axis.    

To specify the number of grid intervals on an axis yourself, enter an integer
from 1 to 99 in the No. of Grids text box. This text box is only available when
Auto Grid is unchecked.

By default, Mathcad sets the axis limits according to the data ranges in the three
input vectors. However, you can set these limits by hand as follows:

Click on the Autoscale box in the appropriate axis columns of the Axes page
to uncheck it. 

Enter the maximum and minimum values in the Max. Val. and Min. Val. text
boxes.

Fixing the axis limits in this way is useful when you are comparing plots of re-
lated data sets or setting up an animation sequence.

Labeling the scatter plot

 The Title page of the 3D Plot Format dialog box, shown below, lets you add and
modify labels on your scatter plot.  

To add or edit a title for your scatter plot:

Type the title for your plot into the Title text box. 
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To display the title, click on Show Title to insert a check. To conceal the title
without deleting it, click on Show Title to remove the check.

To position the title, click on either the Above or Below button. Mathcad
places the title either directly above or below your plot. 

To change the title’s text, edit the information in the Title group as appropri-
ate.

Click “OK” to close the dialog box when you have finished.

To delete the title, highlight it and press [Del].

If you initiate this process by double-clicking on the title itself, you’ll see an
equivalent dialog box.

Figure 7 shows how Mathcad positions titles on a scatter plot.

Figure 7: Titles on a scatter plot.
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Chapter 25
Vector Field Plots

This chapter describes how to plot a two-dimensional vector field
by representing x and y components of a vector as complex
numbers.

This chapter contains the following sections:

Creating a vector field plot
Basic steps in creating a vector field plot.

Resizing vector field plots
Procedure for changing the size of vector field plots.

Formatting vector field plots
Procedures for changing vector field plots: formatting the vector fields
and axes and adding labels.   
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Creating a vector field plot   

In a vector field plot, each point in the xy plane is assigned a two-dimensional
vector. To create a vector field plot, you must define a rectangular array of
points and assign a vector to each point. You can do this by creating a matrix of
complex numbers in which:

The rows and columns represent x and y coordinates.

The real part of each matrix element is the x component of the vector associ-
ated with that row and column.

The imaginary part of each element is the y component of the vector associ-
ated with that row and column.

To create a vector field plot:

Create a matrix as described above.

Choose Graph⇒Vector Field Plot from the Insert menu. Mathcad shows a
box with a single placeholder as shown in Figure 1.

Type the name of the matrix in the placeholder.

Just as with an equation, Mathcad will not process the vector field plot until you
click outside of it.

Figure 1: An empty placeholder in a vector field plot region awaits the name of
a matrix.
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Mathcad plots the matrix by rotating it so that the (0,0) element is at the lower-
left corner. Thus the rows of the matrix correspond to values on the x axis, in-
creasing to the right, and the columns correspond to values along the y axis,
increasing toward the top.

What you’ll see is a collection of m⋅n vectors as shown in Figure 2. The base of
each vector sits on the x and y values corresponding to its row and column. The
magnitude and direction of each vector are derived from the real and imaginary
parts of the matrix element.

Figure 2: A sample vector plot from a complex matrix.

You can also create a vector field plot by using two matrices of real numbers
rather than a single matrix of complex members. The two matrices must have
the same number of rows and columns. The first matrix should have the x com-
ponents of the vectors; the second should have the y components. Figure 3
shows the same vector field as that shown in Figure 2, but it is plotted using two
real matrices rather than a single complex matrix. 
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Figure 3: A sample vector plot from two matrices of real numbers.

You can specify what labels and grid lines appear on the axes by formatting the
vector field plot. This is described in the section “Formatting vector field plots,”
later in this chapter.

Resizing vector field plots

To change the size of a vector field plot, follow these steps:

Click in the vector field plot to select it.

Move the mouse pointer to one of the three handles along the edge of the
plot. The pointer will change to a double-headed arrow.

Press and hold down the mouse button. While holding down the button, move
the mouse. The plot will stretch in the direction of motion.
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Once the plot is the right size, let go of the mouse button. 

Click outside the vector field plot to deselect it.

Formatting vector field plots

Mathcad gives you control over many of the visual characteristics of vector field
plots. These can be categorized in three groups:

Axis formatting: whether to show tick marks or grid lines on each axis.

Title characteristics: how the plot will display titles.

To change any of these plot characteristics, start with the 3D Plot Format dialog
box: 

Click on the plot to select it.

Choose Graph⇒3D Plot from the Format menu. Alternatively, double-click
on the plot itself. Mathcad brings up the 3D Plot Format dialog box. The
Axes Page of this dialog box is shown below. The remaining tab takes you to
the Title page. The View and the Color & Lines pages are not used for these
plots.

If necessary, click the tab for the page you want to work with.

Change the appropriate characteristics in the dialog box.

To see the effect of your changes without closing the dialog box, click “Ap-
ply”.

When you’re finished, close the dialog by clicking “OK” or “Close”. 
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Formatting the axes

The Axes page of the 3D Plot Format dialog box, shown below, lets you modify
the format of the x- and y-axis of your plot. Each axis is described by its own set
of check boxes and text boxes.  

Mathcad generates grid lines on the plot at the same positions as the tick marks.
To choose between using tick marks or grid lines on a selected axis, use the Grid
Lines check box. When Grid Lines is checked, Mathcad adds grid lines to the
plot. Figure 4 shows the same vector field plot with and without grid lines.   

Figure 4: Using grid lines and tick marks.
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To add or remove numbers for the tick marks on an axis, use the Numbered
check box for that axis. The plot with grid lines in Figure 4 doesn’t have num-
bers on the axes while the plot without grid lines does have them.

You can have Mathcad automatically select the number of grid intervals on an
axis or you can specify the number yourself. Grid intervals are the spaces be-
tween tick marks or grid lines. 

To have Mathcad select the number of grid intervals, use the Auto Grid check
box. When Auto Grid is checked, Mathcad will automatically select the num-
ber of grid intervals on the specified axis. 

To specify the number of grid intervals on an axis yourself, enter an integer
from 1 to 99 in the No. of Grids text box. This text box is only available when
Auto Grid is unchecked.

Since a vector field plot is made by plotting the elements of a matrix, Mathcad
cannot “know” anything about x and y coordinates. All it knows is the vector as-
sociated with a particular row and column. By default, the coordinates on the x-
and y-axes of a vector field plot will simply be rows and columns.

To change the limits on the maximum or minimum values to be plotted on the x-
and y-axis, enter the new limit in the Max. Val. or Min. Val. text box.

Labeling the vector field plot

  The Title page of the 3D Plot Format dialog box lets you add and modify a title
on your vector field plot. 

To add or edit a title for your vector field plot:

Type the title for your plot into the Title text box. 

To display the title, click on Show Title to insert a check. To conceal the title
without deleting it, click on Show Title to remove the check.

To position the title, click on either the Above or Below button. Mathcad
places the title either directly above or below your plot. 
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Click “OK” to close the dialog box when you have finished.

To change the title’s text or position, edit the information in the Title group as
appropriate. To delete the title, highlight it in the text box and press [Del].

If you initiate this process by double-clicking on the title itself, you’ll see an
equivalent dialog box.

Figure 5 shows how Mathcad positions a title on a vector field plot.

Figure 5: Titles on a vector field plot.
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Chapter 26
Animation

This chapter describes how to use Mathcad PLUS to create and
play short animation clips by using the built-in variable FRAME.
Anything that can be made to depend on this variable can be
animated. This includes not only plots but numerical results as
well. You can play back the animation clips at different speeds or
save them for use by other applications.

The following sections make up this chapter:

Creating an animation clip
How to use the FRAME variable to create a sequence of images and how
to string this sequence together into a movie.

Playing an animation clip
Using the animation player to play back your movie.

Gallery of animations
A collection of examples showing what you can do with animation.
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Creating an animation clip

Mathcad comes with a predefined constant called FRAME whose sole purpose is
to drive animations. The steps in creating any animation are as follows:

Create an expression or plot whose appearance ultimately depends on the
value of FRAME as shown in Figure 1. This expression need not be a graph as
shown. It can be anything at all. 

Choose Animate from the View menu to bring up the following dialog box.

Select the portion of your worksheet you want to animate as shown in Figure
2.

In the dialog box, set the upper and lower limits for FRAME. The FRAME vari-
able will increment by one as it proceeds from the lower limit to the upper
limit.

In the Frames/Sec. text box, enter the playback speed.  

Click the “Animate” button in the dialog box. You’ll see a miniature rendi-
tion of your selection inside the dialog box as shown in Figure 3. Mathcad re-
draws this once for each value of FRAME. This won’t necessarily match the
playback speed since at this point, you’re just creating the animation, you’re
not yet playing it back.

At this point, an animation has been created. You can now do one of two things
with it:

You can save it as a QuickTime movie for use by other Macintosh applica-
tions.

You can play it back immediately.

To save your animation clip as a QuickTime movie, click the Save As button in
the dialog box. You’ll see the usual Save As dialog box. Since animation clips
tend to take considerable disk space, Mathcad saves them in compressed format.
Before creating the animation, you may want to choose what compression
method to use or whether to compress at all. To do so, click on the Options but-
ton. 
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To play the animation sequence back, follow the instructions in the next section.

Figure 1: An expression suitable for animation. Note the dependence of the plot
on FRAME.

Figure 2: The region to be animated has been selected.

Creating an animation clip 559



Figure 3: The animation clip has been created and is ready for playback.

Playing an animation clip

As soon as you’ve created an animation clip as described in the previous sec-
tion, Mathcad brings up the following window:
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Note that the first frame of the animation clip you just created is already in the
window. To play back the animation clip, click on the arrow button at the lower
left corner of the window. The arrow will turn into a square and the animation
will begin to play. You can control the playback speed by clicking on the button
to the right of the play button, choosing Speed from the menu and adjusting the
slider control. 

You can also play back the animation clip on a frame by frame basis, either for-
ward or backward. To do so, drag the slider below the animated picture to the
left or right.

You can resize this window the way you would any window, by dragging a cor-
ner in the appropriate direction. Keep in mind, however, that the image in the
window is a bitmap and therefore subject to distortion when resized. You can
minimize this distortion by keeping the aspect ratio (height to width) constant
when you resize. To do this conveniently, click on the button to the right of the
play button and choose View from the menu. 

Playing a previously saved animation

If you have an existing QuickTime movie on your disk, you’ll be able to play it
within Mathcad. To do so:

Choose Playback from the View menu to bring up the following dialog box: 

The window is collapsed shut since no animation clip has been opened. To open
one, click on the button to the right of the play button and choose Open from
the menu. You’ll see an Open File dialog box which you can use to locate and
open the QuickTime movie you want to play.

Once you’ve loaded a QuickTime movie, you can proceed as described in the
previous section.
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Gallery of animations

The following figures show some of the things you can do with animation using
Mathcad’s different plot types (polar, x-y, 3D scatter, vector field, parametric
surface, bar and contour). Choose QuickSheets from the ? menu and look for
“Animation examples” to see some more.

Note that since Mathcad’s plots autoscale by default, you’ll almost always have
to change the plot format to show the animation you want. For example, when
animating an x-y plot or a polar plot you should enter values into the axis limit
placeholders to fix the extent of each axis and preserve the plot scaling through-
out the course of the animation. Similarly, when an animation involves a 3D
plot, you should fix the axis limits by double-clicking on the plot to bring up the
3D Plot Format dialog box, unchecking Autoscale on the Axes page, and setting
the axis limit on each axis in such a way that all points generated in the course
of the animation are within the axis limits.

In the examples in this chapter, Figure 1 has a maximum radius in the place-
holder for the radial axis limit; Figures 6 and 8 have autoscale turned off on all
axes and appropriate limits entered.

Figure 4: Growing a four-leaf clover.
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Figure 5: Roller coaster.

Figure 6: Tornado. 
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Figure 7: Diffusion of one field across another.

Figure 8: Nested spheroids. 
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Figure 9: Barn raising. This one may take a few minutes.

Figure 10: Animated contour map. This one may take a few minutes. 
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Appendix A
Reference

This appendix lists functions, operators, menu commands, keys
and other reference material. It is made up of the following
sections:

Menu commands
Function keys
Greek letters
Operators
Built-in functions by name
Predefined variables
Suffixes for numbers
Arrow and movement keys
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Menu commands

File menu

New [Command]N Open new worksheet.

Open... [Command]O Open existing worksheet.

Save [Command]S Save current worksheet.

Save As... Save current worksheet under new
name.

Close [Command]W Close current worksheet.

Load from Web... Open a Mathcad worksheet stored on
the Internet.

Internet Setup... Change various settings associated
with Internet access.

Load Configuration... Execute configuration file.

Save Configuration... Save current configuration in a configu-
ration file.

Associate... Associate selected variable with data
file.

Page Setup... Set margins, suppress printing beyond
right margin.

Print Preview... Show worksheet as it will appear when
printed.

Print... [Command]P Print worksheet or selected regions.

Quit [Command]Q Quit Mathcad.
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Edit menu

Undo [Command]Z Undo most recent edit.

Redo Undoes the last undo.

Cut [Command]X Delete selection.

Copy [Command]C Copy selection.

Delete Delete selection from the worksheet
and leaves clipboard unaffected.

Paste [Command]V Insert selection most recently copied or
cut.

Select All [Command]A Select every region in the worksheet.

Find... [Command]F Search for math or text string.

Replace... [Command]H Search for and replace math or text
string.

Go to Page... Position the top of a specified page at
the top of your window.

Check Spelling... Search text for misspelled words.

View menu

Math Palette Hide symbol palette. When palette is
hidden, this menu item is checked.

Toolbar Hide toolbar. When toolbar is hidden,
this item is checked.

Font Bar Hide font bar. When font bar is hidden,
this menu item is checked.

Regions Toggle between boxed and unboxed
display of regions.

Zoom... Zoom in for a close-up or out for an
overall view.

Refresh [Ctrl]R Force screen redraw.

Animate... Create an animation clip.

Playback... Play an existing animation clip.
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Insert menu

Graph⇒

X-Y Plot @ Create two-dimensional Cartesian plot.

Polar Plot [Command]7 Create a plot for plotting radius against
angle.

Surface Plot [Command]2 Create a plot for displaying a surface in
three dimensions.

Contour Plot [Command]5 Create a plot for displaying the level
curves of a surface.

3D Scatter Plot Create a three-dimensional scatter plot.

3D Bar Chart Create a three-dimensional bar chart.

Vector Field Plot Create a vector field plot for two-di-
mensional vectors.

Matrix... [Command]M Create a new matrix or insert and de-
lete rows or columns from an existing
matrix.

Function... [Command]I Show a scrolling list of available built-
in functions.

Unit... [Command]U Show a scrolling list of available units.

Picture... Insert a region for graphics import.

Math Region Create a math region inside a text re-
gion or paragraph.

Text Region " Start a new text region at the crosshair
location.

Paragraph [Command]B Start a paragraph on the line containing
the crosshair.

Page Break Insert a hard pagebreak.

Link⇒

New Create a hypertext link to another work-
sheet.

Erase Deactivate any hypertext links associ-
ated with the current selection.

Reference... Make variable and function definitions
from another worksheet available in
the current worksheet.

Worksheet... Insert an existing worksheet into the
current one.
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Format menu

Number... Change precision displayed, threshold
for scientific notation, and other similar
characteristics.

Equation... Choose font used to display all vari-
ables and constants.

Text... Choose font, size, color, and style of se-
lected text.

Paragraph Change alignment and left margin for
selected paragraph.

Color⇒

Background... Change color of window background.

Highlight... Change color of highlighted equations.

Annotation... Change color of any changes made to
an Electronic Book.

Graph⇒

X-Y Plot... Change characteristics for all Cartesian
plots in current worksheet. If a plot is
selected, changes will affect only the
selected plot.

Polar Plot... Change characteristics for all future po-
lar plots in current worksheet. If a plot
is selected, changes will affect only the
selected plot.

3D Plot... Change characteristics for the currently
selected three-dimensional plot.

Trace... Read coordinates directly from the cur-
rently selected graph.

Zoom... Magnify view of a portion of the cur-
rently selected graph. 

Picture... Change characteristics of graphic im-
port region.

Highlight Equation Highlight selected equation.

Separate Regions Separate overlapping regions.

Lock Regions⇒

Set Lock Area Define extent of a write-protected area
on the worksheet.

Lock Area... Write protect selected area.

Unlock Area... Permit editing in a locked area.

Align Regions⇒
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Across Align selected regions to a horizontal
line midway between the highest and
the lowest region.

Down Align selected regions to a vertical line
midway between the rightmost and the
leftmost region.

Headers/Footers... Specify headers and footers for print-
outs.

Right Margin⇒

Set Mark right-hand boundary of printed
page.

Clear Remove right-hand boundary of
printed page.

Math menu

Calculate [Command]= Update all results on screen.

Calculate Worksheet Update all results in worksheet.

Automatic Calculation Toggle between automatic calculation
mode in which Mathcad updates screen
continuously, and manual mode.

Toggle Equation Make Mathcad ignore an equation.

Options ⇒
Built-in Variables... Set values of built-in variables.

System of Units... Choose unit system for the default dis-
play of results.

Dimensional Format... Choose the names of the fundamental
dimensions. By default, these are mass,
length, time and temperature.

Randomize... Reset random numbers.

⊕ Live Symbolics Turn live symbolics feature on or off.
This feature lets the symbolic equal
sign be used to evaluate any expression
symbolically. When the live symbolic
feature is on, this menu item is checked.

⊕ Optimization Turn optimize feature on and off. This
feature causes Mathcad to attempt to
simplify any expression to the right of
“:=” or “=”. When the optimize feature
is on, this menu item is checked.
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Symbolic menu

Evaluate ⇒

Symbolically [Command]Ψ Carry out symbolic evaluation of an ex-
pression. 

⊕ Complex 
Evaluation

Carry out symbolic evaluation of a
complex expression. The result is ex-
pressed in the form a + b⋅i.

⊕ Floating Point 
Evaluation...

Return a floating point number for con-
stants rather than a symbolic expres-
sion. A dialog box allows you to
choose the floating point precision.

Simplify Simplify the selected expression, per-
forming arithmetic, canceling common
factors and using basic trigonometric
and inverse function identities.

Expand Expand all powers and products of
sums in the selected expression.

Factor Factor the selected expression into a
product, if the entire expression can be
written as a product. To factor a subex-
pression of a larger expression, select
the subexpression.

Collect Collect terms containing like powers of
the selected subexpression, which may
be a single variable or a function to-
gether with its argument. The result is a
polynomial in the selected expression.

Polynomial Coefficients Find the coefficients of the expression
when written as a polynomial in the se-
lected variable or function.

Variable⇒

Solve Find the value of the selected variable
that makes the expression containing
the variable equal to zero. If you select
a variable in an equation or inequality,
this command solves the equation or in-
equality for the selected variable.

Substitute Substitute the contents of the clipboard
for each occurrence of a selected vari-
able in an expression. To use this menu
command, first put the expression be-
ing substituted in the clipboard by se-
lecting and choosing Copy or Cut.
Then select an occurrence of the vari-
able you are substituting for and
choose this menu command.
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Integrate Integrate the entire expression contain-
ing the selected variable with respect to
that variable.

Differentiate Differentiate the entire expression con-
taining the selected variable with re-
spect to that variable. Other variables
are treated as constants.

Expand to Series... Derive an expansion series for an ex-
pression with respect to the variable
you have selected. A dialog box allows
you to choose the order of the series.

Convert to Partial Frac-
tion

Generate a partial fraction expansion
for an expression by factoring the nu-
merator and denominator with respect
to the selected variable.

Matrix Operations ⇒

⊕ Transpose Return transpose of the selected matrix.

⊕ Invert Return symbolic inverse of the selected
square matrix.

⊕ Determinant Return symbolic determinant of the se-
lected square matrix.

Transforms ⇒

⊕ Fourier Evaluate Fourier transform of expres-
sion with respect to the selected vari-
able. Result is in terms of ω.

⊕ Inverse Fourier Evaluate the inverse Fourier transform
of the expression with respect to the se-
lected variable. Result is in terms of t.

⊕ Laplace Evaluate the Laplace transform of the
expression with respect to the selected
variable. Result is in terms of s.

⊕ Inverse Laplace Evaluate the inverse Laplace transform
of the expression with respect to the se-
lected variable. Result is in terms of t.

⊕ Z Evaluate the z-transform of the expres-
sion with respect to the selected vari-
able. Result is in terms of z.

⊕ Inverse Z Evaluate the inverse z-transform of the
expression with respect to the selected
variable. Result is in terms of n.
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Evaluation Style... Choose the format for symbolic results.
A dialog box presents the options,
which include vertically stacked dis-
play of results and comments, horizon-
tal display, and display without
evaluation comments.

Evaluate in Place Causes symbolic results to be substi-
tuted directly for the original expres-
sion.

Books menu

Open Book... Show list of available Electronic Books.

History... List all Books sections looked at since
the Book was opened.

Search... Search through all Electronic Book sec-
tions.

Annotate Book When checked, Mathcad will let you
save an annotated copy of the currently
open Electronic Book.

Annotation Options⇒

Save Edited Section Save changes in the currently open sec-
tion of the Electronic Book.

Save All Edits Save all changes made since the last
time the Electronic Book was opened.

View Original Section Show the original, unedited version of
the currently displayed section.

View Edited Section Show the annotated version of the cur-
rently displayed section.

Restore Original
Section

Permanently delete any annotations
made to the current section.

Restore Original Book Permanently delete the annotated copy
of the current Electronic Book.

Highlight Edits When checked, Mathcad displays any
changes you’ve made to an Electronic
Book in a different color.

List of Books List any Electronic Books available on
this system.
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Window menu

Cascade Stack all worksheet windows neatly,
with title bars showing.

Tile Horizontal Arrange all worksheet windows hori-
zontally so that they don’t overlap.

Tile Vertical Arrange all worksheet windows verti-
cally so that they don’t overlap.

Arrange Icons Arrange worksheet icons neatly along
lower left edge of application window.

? menu

Help Topics... [Command]/ Show index for on-line help.

Keyboard... Show help on keyboard.

Using Help... Show instructions for using Help.

QuickSheets... Open a collection of templates for per-
forming routine Mathcad calculations.

About Mathcad... Show version number and serial num-
ber.
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Function keys

Keys Actions

[F1] Help.

[Shift][F1] Context sensitive help.

[F2] Copy selected region to clipboard.

[F3] Cut selected region to clipboard.

[F4] Paste contents of clipboard.

[Ctrl][F4] Close worksheet.

[F5] Open a worksheet.

[Ctrl][F5] Search for a string.

[Shift][F5] Replace a string.

[F6] Save current worksheet.

[Ctrl][F6] Make next window active.

[F7] Open a new worksheet.

[F9] Recalculate everything on the screen. With READ, WRITE
or other file I/O function selected, forces Mathcad to read
or write to disk. 

[Ctrl][F9] Insert blank line.

[Ctrl][F10] Delete blank line.
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Greek letters

To type a Greek letter into an equation or into text, press the corresponding ro-
man equivalent from the table below, followed by [Ctrl]G. For uppercase
Greek letters, use the corresponding uppercase roman equivalent.

Name Uppercase Lowercase Roman equivalent

alpha Α α A

beta Β β B

chi Χ χ C

delta ∆ δ D

epsilon Ε ε E

eta Η η H

gamma Γ γ G

iota Ι ι I

kappa Κ κ K

lambda Λ λ L

mu Μ µ M

nu Ν ν N

omega Ω ω W

omicron Ο ο O

phi Φ φ F

pi Π π P

psi Ψ ψ Y

rho Ρ ρ R

sigma Σ σ S

tau Τ τ T

theta Θ θ Q

upsilon Υ υ U

xi Ξ ξ X

zeta Ζ ζ Z

Note: In equations, the Greek letter π is so commonly used that it has its own
keyboard shortcut: [Ctrl]P.
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Operators

In this table:

A and B represent arrays, either vector or matrix.

u and v represent vectors with real or complex elements.

M represents a square matrix.

z and w represent real or complex numbers.

x and y represent real numbers.

m and n represent integers.

i represents a range variable.

t represents any variable name.

f represents a function.

X and Y represent variables or expressions of any type.

Operation Appearance Keystroke Description

Parentheses ( X  ) ’ Grouping operator.

Subscript An [ Returns indicated element of array.

Superscript A< n > [Ctrl ]6 Extracts column n from array A. Returns a vector.

Vectorize X 
→

[Ctrl ]– Forces operations in expression X to take place
element by element. All vectors or matrices in X
must be the same size.

Factorial n! ! Returns n⋅(n − 1)⋅(n − 2)… The integer n cannot
be negative.

Complex 
conjugate

X
__

" Inverts the sign of the imaginary part of X.

Transpose AT [Ctrl ]1 Returns a matrix whose rows are the columns of
A and whose columns are the rows of A. A can
be a vector or a matrix.

Power z w ^ Raises z to the power w. 

Powers of
matrix,
matrix inverse

^ n th power of square matrix M (using matrix mul-
tiplication). n must be a whole number. M −1 rep-
resents the inverse of M. Other negative powers
are powers of the inverse. Returns a matrix.

Negation −X – Multiplies X by –1.

Vector sum Σv [Ctrl]4 Sums elements of vector v; returns a scalar.

Square root √z \ Returns positive square root for positive z; princi-
pal value for negative or complex z.
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nth root n√z [Ctrl]\ Returns nth root of z; returns a real valued root
whenever possible.

Magnitude | z | | Returns √Re(z)2+Im(z)2 . 

Magnitude
of vector

| v | | Returns √v ⋅ v  if all elements in v are real. Re-
turns √v ⋅ v

_
 if any element in v is complex.

Determinant | M | | Returns the determinant of the square matrix M.

Division X
z

/ Divides the expression X by the non-zero scalar
z. If X is an array, divides each element of the ar-
ray by z.

Multiplication X⋅Y * Returns the product of X and Y if both X and Y
are scalars. Multiplies each element of Y by X if
Y is an array and X is a scalar. Returns the dot
product (inner product) if X and Y are vectors of
the same size. Performs matrix multiplication if
X and Y are conformable matrices.

Cross 
product

u × v [Ctrl]8 Returns cross-product (vector product) for the
three-element vectors u and v.

Summation
∑X

i = m

n [Ctrl]
[Shift]4

Performs summation of X over i = m, m+1, . . . n.
X can be any expression. It need not involve i but
it usually does. m and n must be integers.

Product
∏X
i = m

n [Ctrl]
[Shift]3

Performs iterated product of X for
i = m, m+1, . . . n. X can be any expression. It
need not involve i but it usually does. m and n
must be integers.

Range sum ∑X
i

$ Returns a summation of X over the range variable
i. X can be any expression. It need not involve i
but it usually does.

Range product ∏X
i

# Returns the iterated product of X over the range
variable i. X can be any expression. It need not in-
volve i but it usually does.

⊕Limit lim
x → a

f(x) [Ctrl]L Returns the limit of f(x) as x approaches a. Must
be evaluated symbolically.

⊕Left-hand limit lim
x → a

 − f(x) [Ctrl]B Returns the limit of f(x) as x approaches a from
the left. Must be evaluated symbolically.

⊕Right-hand limit lim
x +> a

 +
f(x) [Ctrl]A Returns the limit of f(x) as x approaches a from

the right. Must be evaluated symbolically.

Integral
∫  f(t) dt

a

b & Returns the definite integral of f(t) over the inter-
val [a, b]. a and b must be real scalars. All vari-
ables in the expression f(t), except the variable of
integration t, must be defined. The integrand, f(t),
cannot return an array.

Indefinite Integral ∫  f(t) dt [Ctrl]I Returns the indefinite integral of f(t). Must be
evaluated symbolically.
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Derivative d
dt

f(t) ? Returns the derivative of f(t) evaluated at t. All
variables in the expression f(t) must be defined.
The variable t must be a scalar value. The func-
tion f(t) must return a scalar.

nth Derivative dn

dtn
f(t)

[Ctrl]? Returns the nth derivative of f(t) evaluated at t.
All variables in f(t) must be defined. The variable
t must be a scalar value. The function f(t) must re-
turn a scalar. n must be 0, 1, 2, 3, 4 or 5 for nu-
merical evaluation or any positive integer for
symbolic evaluation. 

Addition X + Y + Performs scalar addition if X, Y, or both are sca-
lars. Performs element by element addition if X
and Y are vectors or matrices of the same size. If
X is an array and Y is a scalar, adds Y to each ele-
ment of X.

Subtraction X − Y – Performs scalar subtraction if X, Y, or both are
scalars. Performs element by element subtraction
if X and Y are vectors or matrices of the same
size. If X is an array and Y is a scalar, subtracts Y
from each element of X.

Addition with 
line break

X …
  + Y

[Ctrl ][↵] Works exactly like addition. Line break is purely
cosmetic.

Greater than x > y > Returns 1 if x > y, 0 otherwise. x and y must be
real scalars.

Less than x < y < Returns 1 if x < y, 0 otherwise. x and y must be
real scalars. 

Greater than 
or equal

x ≥ y [Ctrl ]0 Returns 1 if x ≥ y, 0 otherwise. x and y must be
real scalars. 

Less than 
or equal

x ≤ y [Ctrl ]9 Returns 1 if x ≤ y, 0 otherwise. x and y must be
real scalars. 

Not equal to z ≠ w [Ctrl ]3 Returns 1 if z ≠ w, 0 otherwise. z and w must be
scalars. 

Equal to z = w [Ctrl ]= Returns 1 if z = w, 0 otherwise. z and w must be
scalars. Appears on the screen as a bold equals
sign.
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Built-in functions by name

This section lists Mathcad’s built-in functions alphabetically, with a short de-
scription of each one. For more information, see Chapter 12, “Built-in Func-
tions.” For more information on matrix or vector functions, see Chapter 9.
“Vectors and Matrices.” For a complete listing of Mathcad’s differential equa-
tion solvers, see Chapter 16, “Solving Differential Equations.”

In this table, 

x and y represent real numbers.

z represents either a real or a complex number.

m, n, i, j and k represent integers.

v, u and any names beginning with v represent vectors.

A and B represent matrices or vectors.

M and N represent square matrices.

F represents a vector-valued function.

file is either a filename or a variable associated with a filename.

Any function that expects an angle as an argument expects that angle in radians.
Similarly, any function that returns an angle as a result, returns the angle in radi-
ans. Complex or multivalued functions always return the principal value.

Function names are case sensitive. You must type them as shown here. Names
of built-in functions are not, however, font sensitive.

Function Returns...

acos(z) Inverse cosine. Result in radians. Principal value for com-
plex z.

acosh(z) Inverse hyperbolic cosine. Result in radians. Principal
value for complex z.

angle(x, y) Angle from x-axis to (x, y). x and y real. Result in radians.

APPEND( file) Single value to append to data file file.

APPENDPRN( file) Matrix to append to structured data file file.

arg(z) Angle in complex plane to number z.

asin(z) Inverse sine. Result in radians. Principal value for complex
z.

asinh(z) Inverse hyperbolic sine. Result in radians. Principal value
for complex z.

atan(z) Inverse tangent. Result in radians. Principal value for com-
plex z.

atanh(z) Inverse hyperbolic tangent. Principal value for complex z.
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augment(A, B) A matrix formed by putting the two argument matrices side
by side. A and B must have the same number of rows.
Either or both arguments may be vectors.

ceil(x) Least integer ≥ x. x must be real.

cfft(A) Fast Fourier transform of complex data. Returns an array of
same size as its argument.

CFFT(A) Identical to cfft(A), except uses a different normalizing fac-
tor and sign convention. Returns an array of same size as
its argument.

⊕ cholesky(M) A lower triangular matrix L such that L⋅LT = M. This func-
tion assumes M is symmetric and uses only the upper trian-
gular part of M.

cnorm(x) Cumulative normal distribution.

cols(A) Number of columns in array A. Returns a scalar.

⊕ cond1(M) Condition number of the matrix M based on the L1 norm.

⊕ cond2(M) Condition number of the matrix M based on the L2 norm.

⊕ conde(M) Condition number of the matrix M based on the Euclidean
norm.

⊕ condi(M) Condition number of the matrix M based on the infinity
norm.

corr(A, B) Correlation (Pearson’s r ) of two arrays A and B having the
same number of rows and columns. Returns a scalar. 

cos(z) Cosine. Argument in radians.

cosh(z) Hyperbolic cosine.

cot(z) Cotangent. Argument in radians.

coth(z) Hyperbolic cotangent.

csc(z) Cosecant. Argument in radians.

csch(z) Hyperbolic cosecant.

csort(A, n) Sort columns so as to put row n in ascending order.

cspline(vx, vy) Coefficients of cubic spline with cubic ends. vx and vy are
real vectors of same size. Elements of vx must be in ascend-
ing order.

cspline(Mxy, Mz) Vector of second derivatives for data arrays Mxy and Mz.
This vector becomes the first argument of the interp func-
tion. The resultant surface is cubic at the edges of the re-
gion spanned by Mxy.

cvar(A, B) Covariance of elements in A and B. A and B must have the
same number of rows and columns.

⊕ diag(v) Diagonal matrix containing on its diagonal the elements of
v.

⊕ dbeta(x,s1,s2) Probability density for a beta distribution.
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dbinom(k,n,p) Binomial distribution of a random variable.

⊕ dcauchy(x,l,s) Probability density for the Cauchy distribution.

dchisq(x,d) Probability density for the chi-squared distribution.

⊕ dexp(x,r) Probability density for the exponential distribution.

dF(x,d1,d2) Probability density for the F distribution.

⊕ dgamma(x,s) Probability density for the Gamma distribution.

⊕ dgeom(k, p) P(X = k) when the random variable X has the geometric dis-
tribution.

⊕ dlnorm(x, µ, σ) Probability density for the log normal distribution.

⊕ dlogis(x, l, s) Probability density for the logistic distribution.

⊕ dnbinom(k, n, p) P(X = k) when the random variable X has the negative bino-
mial distribution.

dnorm(x, µ, σ) Probability density for the normal distribution.

dpois(k, λ) P(X = k) when the random variable X has the Poisson distri-
bution.

dt(x, d) Probability density for the Student’s t distribution.

dunif(x, a, b) Probability density for the uniform distribution.

⊕ dweibull(x, s) Probability density for the Weibull distribution.

eigenvals(M) A vector of eigenvalues for the matrix M.

eigenvec(M, z) A vector containing the normalized eigenvector correspond-
ing to the eigenvalue z of the square matrix M.

⊕ eigenvecs(M) A matrix containing the normalized eigenvectors corre-
sponding to the eigenvalues of the matrix M. The nth col-
umn of the matrix is the eigenvector corresponding to the
nth eigenvalue returned by eigenvals.

erf(z) Error function.

exp(z) Exponential: e z

find(var1, var2, . . .) Values of var1, var2, . . . that solve the system of equa-
tions. Returns a scalar if only one argument; otherwise, re-
turns a vector of answers.

fft(v) Fast Fourier transform of real data. v must be a real vector
with 2 n elements, where n is an integer. Returns a vector of
size 2n − 1 + 1.

FFT(v) Identical to fft(v), except uses a different normalizing fac-
tor and sign convention. v must be a real vector with 2 n ele-
ments, where n is an integer. Returns a vector of size
2n − 1 + 1.

floor(x) Greatest integer ≤ x. x must be real.
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⊕ genfit(vx, vy, vg, F) A vector containing the parameters that make a function f
of x and n parameters u0,u1,…,un − 1 best approximate the
data in vx and vy. F is a function that returns an n + 1 ele-
ment vector containing f and its partial derivatives with re-
spect to its n parameters. vx and vy must be the same size.
vg is an n element vector of guess values for the n parame-
ters.

⊕ geninv(A) Matrix L, the left inverse of matrix A, such that L⋅A = I,
where I is the identity matrix having the same size as A.
Matrix A is an m × n real-valued matrix, where m ≥ n.

⊕ genvals(M, N) Vector v of computed eigenvalues each of which satisfies
the generalized eigenvalue problem M⋅x = vi⋅N⋅x. Matrices
M and N contain real values. Vector x contains the corre-
sponding eigenvectors.

⊕ genvecs(M, N) A matrix containing the normalized eigenvectors corre-
sponding to the eigenvalues in v, the vector returned by
genvals. The nth column of this matrix is the eigenvector x
satisfying the generalized eigenvalue problem
M⋅x = vn⋅N⋅x. Matrices M and N contain real values.

hist(intervals, data) Histogram. intervals is a vector of interval limits, in as-
cending order. data is an array of data. Returns a vector of
size one less than the size of intervals, showing how many
points of data fall in each interval.

I0(x) Bessel function I0(x). Argument must be real.

I1(x) Bessel function I1(x). Argument must be real.

In(m, x) Bessel function Im(x). x must be real; 0 ≤ m ≤100.

icfft(A) Inverse Fourier transform corresponding to cfft. Returns an
array of the same size as its argument.

ICFFT(A) Inverse transform corresponding to CFFT. Returns an array
of the same size as its argument.

identity(n) Identity matrix of size n. n must be a positive integer.

if(cond, x, y) Conditional: returns x or y depending on value of cond. If
cond is true (non-zero), returns x. If cond is false (zero), re-
turns y.

ifft(v) Inverse Fourier transform corresponding to fft. Takes a vec-
tor of size 1 + 2 n − 1, where n is an integer. Returns a real
vector of size 2 n.

IFFT(v) Inverse transform corresponding to FFT. Takes a vector of
size 1 + 2 n − 1, where n is an integer. Returns a real vector
of size 2 n.

Im(z) Imaginary part of complex number z. Also works on vec-
tors and matrix arguments.
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intercept(vx, vy) Intercept of regression line. Takes two vector arguments vx
and vy of same size. The elements of vx must be in ascend-
ing order. Returns a scalar: the y-intercept of the regression
line.

interp(vs, vx, vy, x) Interpolated value from spline coefficients. Takes three vec-
tor arguments vs, vx, and vy of same size and a scalar x at
which to interpolate; returns a scalar. The elements of vx
should be in ascending order. vs should be a vector com-
puted with cspline, lspline, or pspline.

interp(vs, Mxy, Mz, v) Spline interpolated value of Mz at the x and y coordinates
specified in v.

⊕ iwave(v) Inverse wavelet transform corresponding to wave. Takes a
2n element vector of real data, where n is an integer.

J0(x) Bessel function J0(x). Argument must be real.

J1(x) Bessel function J1(x). Argument must be real.

Jn(m, x) Bessel function Jm(x). x must be real; 0 ≤ m ≤100.

K0(x) Bessel function K0(x). Argument must be positive.

K1(x) Bessel function K1(x). Argument must be positive.

Kn(m, x) Bessel function Km(x). x must be positive; 0 ≤ m ≤100.

⊕ ksmooth(vx,vy, b) An n-element vector created by using a Gaussian kernel to
return weighted averages of vy. vy and vx are n-element
vectors of real numbers. The bandwidth b controls the
smoothing window and should be set to a few times the
spacing between your x data points. 

last(v) Index of last element in vector v. Returns a scalar.

length(v) Number of elements in vector v. Returns a scalar.

linfit(vx, vy, F) A vector containing the coefficients used to create a linear
combination of the functions in F which best approximates
the data in vx and vy. F is a function that returns a vector.

linterp(vx, vy, x) Linearly interpolated value. Takes two vector arguments vx
and vy of same size and a scalar x at which to interpolate;
returns a scalar. The elements of vx should be in ascending
order.

ln(z) Natural logarithm of z (to base e). Returns principal value
(imaginary part between π and −π) for complex z.

⊕ loess(vx, vy, span) Vector required by the interp function to find the set of sec-
ond order polynomials that best fit particular neighbor-
hoods of data points specified in arrays vx and vy. vx is an
m element vector containing x coordinates. vy is an m ele-
ment vector containing the y coordinates corresponding to
the m points specified in vx. The argument span (span > 0)
specifies how large a neighborhood loess will consider in
performing this local regression.
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⊕ loess(Mxy, vz, span) Vector required by the interp function to find the set of sec-
ond order polynomials that best fit particular neighbor-
hoods of data points specified in arrays Mxy and vz. Mxy
is an m×2 matrix containing x-y coordinates. vz is an m ele-
ment vector containing the z coordinates corresponding to
the m points specified in Mxy. The argument span
(span > 0) specifies how large a neighborhood loess will
consider in performing this local regression.

log(z) Common logarithm of z (to base 10).

⊕ lsolve(M, v) Solution vector x such that M⋅x = v.

lspline(vx, vy) Coefficients of cubic spline with linear ends. vx and vy are
real vectors of same size. Elements of vx must be in ascend-
ing order.

lspline(Mxy, Mz) Vector of second derivatives for data arrays Mxy and Mz.
This vector becomes the first argument of the interp func-
tion. The resultant surface is linear at the boundaries of the
region spanned by Mxy.

⊕ lu(M) One matrix containing the three square matrices P, L, and
U, all having the same size as M and joined together side
by side, in that order. These three matrices satisfy the equa-
tion P⋅M = L⋅U. L and U are lower and upper triangular re-
spectively.

matrix(m, n, f ) Creates a matrix in which the ijth element contains
f(i, j) where i = 0, 1,...m and j = 0, 1,...n.

max(A) Largest element in A. Returns a scalar. If A is complex, re-
turns max(Re(A)) + i⋅max(Im(A)).

mean(A) Mean of elements of an array A. Returns a scalar.

median(A) Median of elements in array A. Returns a scalar.

medsmooth(vy,n) An m-element vector created by smoothing vy with run-
ning medians. vy is an m-element vector of real numbers.
The smoothing window has size n.

min(A) Smallest element in A. Returns a scalar. If A is complex, re-
turns min(Re(A)) + i⋅min(Im(A)).

minerr(var1, var2, . . .) Values of var1, var2, . . . coming closest to solving the sys-
tem of equations. Returns a scalar if only one argument;
otherwise, returns a vector of answers. 

mod(x, modulus) Remainder on dividing x by modulus. Arguments must be
real. Result has same sign as x.

⊕ norm1(M) The L1 norm of the matrix M.

⊕ norm2(M) The L2 norm of the matrix M.

⊕ norme(M) The Euclidean norm of the matrix M.

⊕ normi(M) The infinity norm of the matrix M.

⊕ pbeta(x, s1, s2) Cumulative standard normal distribution function.
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pbinom(k, n, p) Cumulative binomial distribution for k successes in n trials.

⊕ pcauchy(x, l, s) Cumulative Cauchy distribution with scale parameters l
and s.

pchisq(x, d) Cumulative chi-squared distribution in which d > 0 is the
degrees of freedom and x > 0.

⊕ pexp(x, r) Cumulative exponential distribution in which r > 0 is the
rate and x > 0.

pF(x, d1, d2) Cumulative F distribution in which d1,d2 > 0 are the de-
grees of freedom. x > 0.

⊕ pgamma(x, s) Cumulative Gamma distribution in which s > 0 is the shape
parameter. x > 0 .

⊕ pgeom(k, p) Cumulative geometric distribution. p is the probability of
success. k ≥ 0 and 0 < p ≤ 1.

⊕ plnorm(x, µ, σ) Cumulative log normal distribution in which µ is the log of
the mean, σ > 0 is the log of the standard deviation, and
x > 0.

⊕ plogis(x, l, s) Cumulative logistic distribution. l is the location parameter.
s > 0 is the scale parameter.

⊕ pnbinom(k, n, p) Cumulative negative binomial distribution in which n > 0
and 0 < p ≤ 1.

pnorm(x, µ, σ)) Cumulative normal distribution with mean µ and standard
deviation σ.

polyroots(v) Roots of the nth degree polynomial whose coeffients are in
v, a vector of length n + 1.

ppois(k, λ) Cumulative Poisson distribution. λ > 0.

⊕ predict(v, m, n) A vector of n predicted values based on m consecutive ele-
ments in v, a vector whose values represent samples taken
at equal intervals.

pspline(vx, vy) Coefficients of cubic spline with parabolic ends. vx and vy
are real vectors of same size. Elements of vx must be in as-
cending order.

pspline(Mxy, Mz) Vector of second derivatives for data arrays Mxy and Mz.
This vector becomes the first argument of the interp func-
tion. The resultant surface is parabolic at the boundaries of
the region spanned by Mxy.

pt(x, d) Cumulative Student’s t distribution. d is the degrees of free-
dom. x > 0 and d > 0.

punif(x, a, b) Cumulative uniform distribution. b and a are the endpoints
of the interval. a < b.

⊕ pweibull(x, s) Cumulative Weibull distribution. s > 0.

⊕ qbeta(p, s1, s2) Inverse beta distribution with shape parameters s1 and s2.
0 ≤ p ≤ 1 and s1, s2 > 0.
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qbinom(p, n, q) Number of successes in n trials of the Bernoulli process
such that the probability of that number of successes is p. q
is the probability of success on a single trial. 0 ≤ q ≤ 1 and
0 ≤ p ≤ 1.

⊕ qcauchy(p, l, s) Inverse Cauchy distribution with scale parameters l and s.
s > 0 and 0 < p < 1.

qchisq(p, d) Inverse chi-squared distribution in which d > 0 is the de-
grees of freedom. 0 ≤ p < 1.

⊕ qexp(p, r) Inverse exponential distribution in which r > 0 is the rate.
0 ≤ p < 1.

qF(p, d1, d2) Inverse F distribution in which d1,d2 > 0 are the degrees of
freedom. 0 ≤ p < 1.

⊕ qgamma(p, s) Inverse Gamma distribution in which s > 0 is the shape pa-
rameter. 0 ≤ p < 1.

⊕ qgeom(p, q) Inverse geometric distribution. q is the probability of suc-
cess on a single trial. 0 < p < 1 and 0 ≤ q < 1.

⊕ qlnorm(p, µ, σ) Inverse log normal distribution in which µ is the log of the
mean, σ > 0 is the log of the standard deviation. 0 ≤ p < 1.

⊕ qlogis(p, l, s) Inverse logistic distribution. l is the location parameter.
s > 0 is the scale parameter. 0 < p < 1.

⊕ qnbinom(p, n, q) Inverse negative binomial distribution with size n and prob-
ability of failure q. 0 ≤ q ≤ 1 and 0 ≤ p ≤ 1.

qnorm(p, µ, σ) Inverse normal distribution with mean µ and standard de-
viation σ. 0 < p < 1 and σ > 0.

qpois(p, λ) Inverse Poisson distribution. λ > 0 and 0 ≤ p ≤ 1.

⊕ qr(A) A matrix whose first n columns contain the square, or-
thonormal matrix Q, and whose remaining columns contain
the upper triangular matrix, R. Matrices Q and R satisfy
the equation A = Q⋅R, where A is a real-valued array.

qt(p, d) Inverse Student’s t distribution. d is the degrees of free-
dom. d > 0 and 0 < p < 1.

qunif(p, a, b) Inverse uniform distribution. b and a are the endpoints of
the interval. a < b and 0 ≤ p ≤ 1.

⊕ qweibull(p, s) Inverse Weibull distribution. s > 0 and 0 < p < 1.

⊕ rank(A) The rank of real-valued matrix A.

⊕ rbeta(m, s1, s2) Vector of m random numbers having the beta distribution.
s1,s2 > 0 are the shape parameters.

rbinom(m, n, p) Vector of m random numbers having the binomial distribu-
tion. 0 ≤ p ≤ 1. n is an integer satisfying n > 0.

⊕ rcauchy(m, l, s) Vector of m random numbers having the Cauchy distribu-
tion. l and s > 0 are scale parameters.

rchisq(m, d) Vector of m random numbers having the schi squared distri-
bution. d > 0 is the degrees of freedom.
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Re(z) Real part of complex number z.

READ( file) Single value read from data file file.

READBMP( file) Array containing a grayscale representation of the bitmap
image in file.

READPRN( file) Matrix read from structured data file file.

READRGB( file) Array in which the color information in file is represented
by the appropriate values of red, green, and blue. This array
is formed by combining the three arrays giving the red,
green, and blue components of the image into a single array
with three times as many columns as the image.

regress(vx, vy, n) Vector required by the interp function to find the nth order
polynomial that best fits data arrays vx and vy. vx is an m
element vector containing x coordinates. vy is an m ele-
ment vector containing the y coordinates corresponding to
the m points specified in vx.

regress(Mxy,vz, n) Vector required by the interp function to find the nth order
polynomial that best fits data arrays Mxy and vz. Mxy is
an m×2 matrix containing x-y coordinates. vz is an m ele-
ment vector containing the z coordinates corresponding to
the m points specified in Mxy.

reverse(v) Reverse order of elements in v.

⊕ rexp(m, r) Vector of m random numbers having the exponential distri-
bution. r > 0 is the rate.

rF(m, d1, d2) Vector of m random numbers having the F distribution.
d1,d2 > 0 are the degrees of freedom.

⊕ rgamma(m, s) Vector of m random numbers having the gamma distribu-
tion. s > 0 is the shape parameter.

⊕ rgeom(m, p) Vector of m random numbers having the geometric distribu-
tion. 0 < p ≤ 1.

⊕ rlnorm(m, µ, σ ) Vector of m random numbers having the log normal distri-
bution in which µ is the log of the mean and σ > 0 is the
log of the standard deviation.

⊕ rlogis(m, l, s) Vector of m random numbers having the logistic distribu-
tion in which l is the location parameter and s > 0 is the
scale parameter.

⊕ rnbinom(m, n, p) Vector of m random numbers having the negative binomial
distribution. 0 < p ≤ 1. n is an integer satisfying n > 0.

rnd(x) Random number between 0 and x. x real.

rnorm(m, µ, σ) Vector of m random numbers having the normal distribu-
tion. σ > 0.

root(expr, var) Value of var where expr is zero.

rows(A) Number of rows in array A. Returns a scalar.

rpois(m, λ) Vector of m random numbers having the Poisson distribu-
tion. λ > 0.
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⊕ rref(A) A matrix representing the row-reduced echelon form of A.

rsort(A, n) Sort rows so as to put column n in ascending order.

rt(m, d) Vector of m random numbers having the Student’s t distri-
bution. d > 0.

runif(m, a, b) Vector of m random numbers having the uniform distribu-
tion in which b and a are the endpoints of the interval and
a < b.

⊕ rweibull(m, s) Vector of m random numbers having the Weibull distribu-
tion in which s > 0 is the shape parameter.

sec(z) Secant. Argument in radians.

sech(z) Hyperbolic secant.

sin(z) Sine. Argument in radians.

sinh(z) Hyperbolic sine.

slope(vx, vy) Slope of regression line. Takes two vector arguments vx
and vy of the same size. The elements of vx must be in as-
cending order.

sort(v) Sort elements in vector v.

stack(A, B) Array formed by placing A above B. The arrays A and B
must have the same number of columns.

stdev(A) Standard deviation of elements of A. Uses n in the denomi-
nator. Returns a scalar.

submatrix(A, ir, jr, ic, jc) Submatrix of A consisting of all elements common to rows
ir through jr and columns ic through jc. To maintain order
of rows and/or columns, make sure ir ≥ jr and ic ≥ jc, other-
wise order of rows and/or columns will be reversed.

⊕ supsmooth(vx,vy) An n-element vector created by the piecewise use of a sym-
metric k-nearest neighbor linear least square fitting proce-
dure in which k is adaptively chosen. vy and vx are
n-element vectors of real numbers. The elements of vx
must be in increasing order.

⊕ svd(A) One matrix containing two stacked matrices U and V,
where U is the upper m × n submatrix and V is the lower
n × n submatrix. Matrices U and V satisfy the equation
A = U⋅diag(s)⋅VT, where s is a vector containing the first n
elements returned by svds(A). A is an m × n array of real
values, where m ≥ n.

⊕ svds(A) A vector containing the singular values of the m × n real-
valued array A, where m ≥ n.

tan(z) Tangent. Argument in radians.

tanh(z) Hyperbolic tangent.

tr(M) Trace of square matrix M: sum of diagonal elements.

until(x, y) Returns y until x is negative. 
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var(A) Variance of elements of A. Uses n in the denominator. Re-
turns a scalar.

⊕ wave(v) Discrete wavelet transform of real data using Daubechies
four-coefficient wavelet filter. Vector v must contain 2n

real values, where n is an integer.

WRITE( file) Single value written to a data file file.

WRITEBMP( file) Grayscale BMP file out of a matrix.

WRITEPRN( file) Structured data file out of a matrix.

WRITERGB( file) Colored BMP bitmap file out of an array formed by juxtapos-
ing the three arrays giving the red, green, and blue values
of a bitmap image.

Y0(x) Bessel function Y0(x). Argument must be positive.

Y1(x) Bessel functionY1(x). Argument must be positive.

Yn(m, x) Bessel function Ym(x). x must be positive; 0 ≤ m ≤100.

δ(x, y) Kronecker delta function. Returns 1 if x = y; otherwise, re-
turns 0. (To type δ, press d[Ctrl]G)

ε(i, j, k) Completely antisymmetric tensor of rank three. i, j, and k
must be integers between 0 and 2 (or between ORIGIN and
ORIGIN+2, if ORIGIN≠0). Result is 0 if any two are the
same, 1 if the three arguments are an even permutation of
(0 1 2), and –1 if the three arguments are an odd permuta-
tion of (0 1 2). (To type ε, press e[Ctrl]G)

Γ(z) Euler’s gamma function. (To type Γ, press G[Ctrl]G)

Φ(x)  Heaviside step function. Returns 1 if x ≥ 0; otherwise, re-
turns 0. (To type Φ, press F[Ctrl]G)
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Predefined variables

Mathcad’s predefined variables are listed here, together with their default start-
ing values.

Constant=Value Meaning

π = 3.14159... Pi. Mathcad uses the value of π to 15 digits. To type π,
press [Ctrl]p.

e = 2.71828... The base of natural logarithms. Mathcad uses the value of e
to 15 digits.

∞ = 10 307 Infinity. This symbol represents values larger than the larg-
est real number representable in Mathcad (about 10 307).
Do not use this variable in place of actual infinities in nu-
merical formulas. To type ∞, press [Ctrl]z.

% = 0.01 Percent. Use in expressions like 10*% (appears as 10⋅%) or
as a scaling unit at the end of an equation with an equals
sign.

TOL = 10 −3 Tolerance. The tolerance Mathcad uses in numerical ap-
proximation algorithms (integrals, equation solving, etc.).
For more information, see the section on the specific opera-
tion in question.

ORIGIN = 0 Array origin. Specifies the index of the first element in ar-
rays.

PRNCOLWIDTH = 8 Column width used in writing files with WRITEPRN func-
tion.

PRNPRECISION = 4 Number of significant digits used when writing files with
the WRITEPRN function.

FRAME = 0 Used as a counter for creating animation clips.
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Suffixes for numbers

The table below shows how Mathcad interprets numbers. (A number is any
string beginning with a digit.)

Suffix Examples Meaning

i
j

4i, 1i
3 + 1.5j⋅10 −2

Imaginary

H
h

0aH
8BCh

Hexadecimal

O
o

757O
100o

Octal

L
l

1L
–2.54l

Standard length unit

M
m

1M
2.2m

Standard mass unit

T
t

1T
3600t

Standard time unit

Q
q

1Q
–100q

Standard charge unit

K
k

1K
–273k

Standard absolute temperature unit
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Arrow and movement keys

Keys Actions

[↑] Move crosshair up.
In math: move editing lines up. 
In text: move insertion point up to previous line.

[↓] Move crosshair down.
In math: move editing lines down. 
In text: move insertion point down to next line.

[←] Move crosshair left.
In math: select left operand.
In text: move insertion point one character to the left.

[→] Move crosshair right.
In math: select right operand.
In text: move insertion point one character to the right.

[Shift][↑] In math: move crosshair outside and above equation. 
In text: highlight from insertion point up to previous line.

[Shift][↓] In math: move crosshair outside and below equation. 
In text: highlight from insertion point down to next line.

[Shift][←] In math: move crosshair outside and to the left of equation. 
In text: highlight towards the left of the insertion point,
character by character.

[Shift][→] In math: move crosshair outside and to the right of equa-
tion. 
In text: highlight towards the right of the insertion point,
character by character.

[Ctrl][↑] In text: move insertion point to the beginning of a line.

[Ctrl][↓] In text: move insertion point to the beginning of next line.

[Ctrl][←] In text: move insertion point left to the beginning of a word.

[Ctrl][→] In text: move insertion point to the beginning of next word.

[Ctrl][Shift][↑] In text: highlight from insertion point up to the beginning
of a line.

[Ctrl][Shift][↓] In text: highlight from insertion point to end of the current
line.

[Ctrl][Shift][←] Highlight left from insertion point to the beginning of a
word.

[Ctrl][Shift][→] Highlight from insertion point to beginning of the next
word.
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Keys Actions

[Space] In math: cycles through different states of the editing lines.

[Tab] In text: inserts a five-character space.
In array or plot: move to next placeholder.

[Shift][Tab] In array or plot: move to previous placeholder.

[PgUp] Move up 5 lines.

[PgDn] Move down 5 lines.

[Ctrl][PgUp] Move 80% up the window.

[Ctrl][PgDn] Move 80% down the window.

[Shift][PgUp] Move up to previous pagebreak.

[Shift][PgDn] Move down to next pagebreak.

[Home] In equation, move to beginning previous region. In text,
move to beginning of current line.

[End] In equation, move to next region. In text, move to end of
current line.

[Ctrl][Home] Scroll to beginning of worksheet. In text, move insertion
point to beginning of text region or paragraph.

[Ctrl][End] Scroll to end of worksheet. In text, move insertion point to
end of text region or paragraph.

[↵] In text: start new line.
In equation or plot: move crosshair below region, even
with left edge of region.

[Shift][↵] In text, move crosshair outside and below region. 
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Appendix C
Unit Tables

Mathcad comes with three built-in systems of units. You select a
system of units by choosing Options⇒System of Units from the
Math menu as discussed in Chapter 8. 

Once you make a selection, several dozen variable names are
automatically reserved for unit definitions unique to whatever
system of units you chose. This appendix lists all the unit
definitions associated with each of the three available unit systems.

If you choose a system of units, you should try not to use the
predefined variables listed in this appendix as anything but units.
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MKS units 

Base units
m = 1L kg = 1M sec = 1T

coul = 1Q K = 1K

Angular measure
rad = 1

deg = 
π

180 ⋅ rad

Length
cm = .01 ⋅ m km = 1000 ⋅ m mm = .001 ⋅ m

ft = .3048 ⋅ m in = 2.54 ⋅ cm yd = 3 ⋅ ft

mi = 5280 ⋅ ft

Mass

gm = 10−3 ⋅ kg tonne = 1000 ⋅ kg lb = 453.59237 ⋅ gm

mg = 10−3 ⋅ gm ton = 2000 ⋅ lb slug = 32.174 ⋅ lb

oz = 
lb
16

Time
min = 60 ⋅ sec hr = 3600 ⋅ sec day = 24 ⋅ hr

yr = 365.2422 ⋅ day

Area, Volume

hectare = 104 ⋅ m2 acre = 4840 ⋅ yd2 liter = (.1 ⋅ m)3

mL = 10−3 ⋅ liter fl_oz = 29.57353 ⋅ cm3 gal = 128 ⋅ fl_oz

Velocity, Acceleration

mph = 
mi
hr

kph = 
km
hr

g = 9.80665 ⋅ m

sec2

Force, Energy, Power

newton = kg ⋅ m

sec2
dyne = 10−5 ⋅ newton lbf = g ⋅ lb

kgf = g ⋅ kg joule = newton ⋅ m erg = 10−7 ⋅ joule

cal = 4.1868 ⋅ joule
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kcal = 1000 ⋅ cal BTU = 1.05506 ⋅ 103 ⋅ joule watt = 
joule
sec

hp = 550 ⋅ ft ⋅ lbf
sec

kW = 1000 ⋅ watt

Pressure, Viscosity

Pa = 
newton

m2 psi = 
lbf

in2
atm = 1.01325 ⋅ 105 ⋅ Pa

torr = 1.33322 ⋅ 102 ⋅ Pa in_Hg = 3.38638 ⋅ 103 ⋅ Pa
stokes = 10−4 ⋅ m

2

sec

poise = .1 ⋅ Pa ⋅ sec

Electrical

volt = 
watt
amp

mV = 10−3 ⋅ volt KV = 103 ⋅ volt

ohm = 
volt
amp

mho = 
1

ohm
siemens = 

1
ohm

Ω = ohm KΩ = 103 ⋅ ohm MΩ = 106 ⋅ ohm

henry = 
weber
amp

mH = 10−3 ⋅ henry µH = 10−6 ⋅ henry

amp = 
coul
sec

µA = 10−6 ⋅ amp mA = 10−3 ⋅ amp

KA = 103 ⋅ amp farad = 
coul
volt

pF = 10−12 ⋅ farad

nF = 10−9 ⋅ farad µF = 10−6 ⋅ farad weber = volt ⋅ sec

oersted = 
1000
4 ⋅ π  ⋅ amp

m
tesla = 

weber

m2

Frequency

Hz = 
1

sec
KHz = 103 ⋅ Hz MHz = 106 ⋅ Hz

GHz = 109 ⋅ Hz

Temperature
R = 0.556⋅K
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CGS units 

Base units
cm = 1L gm = 1M sec = 1T

coul = 1Q K = 1K

Angular measure
rad = 1

deg = 
π

180 ⋅ rad

Length
m = 100 ⋅ cm km = 1000 ⋅ m mm = .1 ⋅ cm

ft = 30.48 ⋅ cm in = 2.54 ⋅ cm yd = 3 ⋅ ft

mi = 5280 ⋅ ft

Mass
kg = 1000 ⋅ gm tonne = 1000 ⋅ kg lb = 453.59237 ⋅ gm

mg = 10−3 ⋅ gm ton = 2000 ⋅ lb slug = 32.174 ⋅ lb

oz = 
lb
16

Time
min = 60 ⋅ sec hr = 3600 ⋅ sec day = 24 ⋅ hr

yr = 365.2422 ⋅ day

Area, Volume

hectare = 104 ⋅ m2 acre = 4840 ⋅ yd2 liter = 1000 ⋅ cm3

mL = cm3 fl_oz = 29.57353 ⋅ cm3 gal = 128 ⋅ fl_oz

Velocity, Acceleration

mph = 
mi
hr

kph = 
km
hr

g = 980.665 ⋅ cm

sec2

c = 2.997925 ⋅ 1010 ⋅ cm
sec

c_ = c ⋅ sec
m

Force, Energy, Power

dyne = gm ⋅ cm

sec2
newton = 105 ⋅ dyne lbf = g ⋅ lb
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kgf = g ⋅ kg erg = dyne ⋅ cm joule = 107 ⋅ erg

cal = 4.1868 ⋅ 107 ⋅ erg BTU = 1.05506 ⋅ 1010 ⋅ erg kcal = 1000 ⋅ cal

watt = 
joule
sec

kW = 1000 ⋅ watt
hp = 550 ⋅ ft ⋅ lbf

sec

Pressure, Viscosity

Pa = 10 ⋅ dyne

cm2 psi = 
lbf

in2
atm = 1.01325 ⋅ 105 ⋅ Pa

in_Hg = 3.38638 ⋅ 103 ⋅ Pa torr = 1.33322 ⋅ 102 ⋅ Pa
stokes = 

cm2

sec

poise = .1 ⋅ Pa ⋅ sec

Electrical

These are CGS-esu units, based only on mass, length, and time. The “stat” units are defined in
terms of dyne, cm, and sec.

statamp = dyne.5 ⋅ cm ⋅ sec−1 statcoul = dyne.5 ⋅ cm statvolt = dyne.5

statohm = sec ⋅ cm−1 statsiemens = cm ⋅ sec−1 statfarad = cm

statweber = dyne.5 ⋅ cm stathenry = sec2 ⋅ cm−1 stattesla = dyne.5 ⋅ sec ⋅ cm−2

Frequency

Hz = 
1

sec
KHz = 103 ⋅ Hz MHz = 106 ⋅ Hz

GHz = 109 ⋅ Hz

Temperature
R = 0.556⋅K

Conversions to SI Units

amp = 
c_
10

 ⋅ statamp volt = 
watt
amp

ohm = 
volt
amp

coul = amp ⋅ sec
farad = 

coul
volt

henry = volt ⋅ sec
amp

CGS units 625



U.S. customary units 

Base units
ft = 1L lb = 1M sec = 1T

coul = 1Q K = 1K

Angular measure
rad = 1

deg = 
π

180 ⋅ rad

Length

in = 
ft
12

m = 
ft

.3048
yd = 3 ⋅ ft

cm = .01 ⋅ m mi = 5280 ⋅ ft km = 1000 ⋅ m

mm = .001 ⋅ m

Mass
slug = 32.174 ⋅ lb

oz = 
lb
16

ton = 2000 ⋅ lb

kg = 
lb

.45359237
tonne = 1000 ⋅ kg gm = 10−3 ⋅ kg

mg = 10−3 ⋅ gm

Time
min = 60 ⋅ sec hr = 3600 ⋅ sec day = 24 ⋅ hr

yr = 365.2422 ⋅ day

Area, Volume

acre = 4840 ⋅ yd2 hectare = 104 ⋅ m2 fl_oz = 29.57353 ⋅ cm3

liter = (.1 ⋅ m)3 mL = 10−3 ⋅ liter gal = 128 ⋅ fl_oz

Velocity, Acceleration

mph = 
mi
hr

kph = 
km
hr

g = 32.174 ⋅ ft

sec2

Force, Energy, Power
lbf = g ⋅ lb

newton = kg ⋅ m

sec2
dyne = 10−5 ⋅ newton

kgf = g ⋅ kg joule = newton ⋅ m erg = 10−7 ⋅ joule
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cal = 4.1868 ⋅ joule kcal = 1000 ⋅ cal BTU = 1.05506 ⋅ 103 ⋅ joule

watt = 
joule
sec

hp = 550 ⋅ ft ⋅ lbf
sec

kW = 1000 ⋅ watt

Pressure, Viscosity

psi = 
lbf

in2 Pa = 
newton

m2
atm = 1.01325 ⋅ 105 ⋅ Pa

torr = 1.33322 ⋅ 102 ⋅ Pa in_Hg = 3.38638 ⋅ 103 ⋅ Pa
stokes = 

cm2

sec

poise = .1 ⋅ Pa ⋅ sec

Electrical

volt = 
watt
amp

mV = 10−3 ⋅ volt KV = 103 ⋅ volt

ohm = 
volt
amp

mho = 
1

ohm
siemens = 

1
ohm

Ω = ohm KΩ = 103 ⋅ ohm MΩ = 106 ⋅ ohm

henry = 
weber
amp

mH = 10−3 ⋅ henry µH = 10−6 ⋅ henry

amp = 
coul
sec

µA = 10−6 ⋅ amp mA = 10−3 ⋅ amp

KA = 103 ⋅ amp farad = 
coul
volt

pF = 10−12 ⋅ farad

nF = 10−9 ⋅ farad µF = 10−6 ⋅ farad weber = volt ⋅ sec

oersted = 
1000
4 ⋅ π

 ⋅ amp
m

tesla = 
weber

m2
gauss = 10−4 ⋅ tesla

Frequency

Hz = 
1

sec
KHz = 103 ⋅ Hz MHz = 106 ⋅ Hz

GHz = 109 ⋅ Hz

Temperature
R = 0.556⋅K
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Alphabetical list of units 

Unless otherwise specified, all units are available in MKS, CGS, and US systems.

Unit Measures... Available in...

acre area

amp current

atm pressure

BTU energy

c velocity CGS

c_ dimensionless CGS

cal energy

cm length

coul charge

day time

deg angle

dyne force

erg energy

farad capacitance

fl_oz volume

ft length

g acceleration

gal volume

gauss magnetic flux density MKS, US

GHz frequency

gm mass

hectare area

henry inductance

hp power

hr time

Hz frequency

in length

in_Hg pressure

joule energy

KA current

kcal energy

K temperature

kg mass

kgf force
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Unit Measures... Available in...

KHz frequency

km length

kph velocity

KV potential

kW power

lb mass

lbf force

liter volume

µA current

µF capacitance

µH inductance

m length

MΩ resistance

mA current

mH inductance

mho conductance

MHz frequency

mi length

min time

mg mass

mL volume

mm length

mph velocity

mV potential

newton force

nF capacitance

oersted magnetic field strength MKS, US

ohm resistance

oz mass

Pa pressure

pF capacitance

poise viscosity (dynamic)

psi pressure

R temperature

rad angle

sec time

siemens conductance MKS, US

slug mass
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Unit Measures... Available in...

statamp current CGS

statcoul charge CGS

statfarad capacitance CGS

stathenry inductance CGS

statohm resistance CGS

statsiemens conductance CGS

stattesla magnetic flux density CGS

statvolt potential CGS

statweber magnetic flux CGS

stokes viscosity (kinematic)

tesla magnetic flux density MKS, US

ton mass

tonne mass

torr pressure

volt potential

Ω resistance

watt power

weber magnetic flux MKS, US

yd length

yr time
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Appendix D
Numerical Methods

This appendix describes the details of Mathcad’s numerical
algorithms.

The following sections make up this appendix:

A note about numerical methods
The importance of understanding numerical methods.

Zero as a factor or a numerator
Efficiency issues with zero as a factor or a numerator.

Integrals
Mathcad’s Romberg integration algorithm.

Derivatives
How Mathcad computes numerical derivatives.

The root function
Finding roots with the secant method.

Solve blocks
Using the Levenberg-Marquardt algorithm to solve simultaneous equa-
tions and inequalities.

Matrix operations
Methods used for matrix inversion and determinants.

Sorting
Mathcad’s sorting algorithms.
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A note on numerical methods 

This appendix describes the numerical methods Mathcad uses for some types of
calculations, including derivatives, integrals, the root function, solve blocks, and
matrix operations.

On a computer, these calculations are inherently limited in accuracy. Since
Mathcad is a general-purpose calculation program, it uses methods that work in
a wide variety of different contexts. However, as with any numerical algorithms,
it is always possible to find specific examples for which Mathcad’s methods re-
turn inaccurate or misleading results.

You can verify the accuracy of your results and avoid numerical problems by
following these principles:

When you use a Mathcad function or operation that involves a numerical ap-
proximation (integrals, derivatives, the root function, solve blocks, matrix in-
version, or determinants), be sure your results are reasonable. For simple
calculations, just use common sense. For more complicated calculations, in-
clude redundancy checks in your documents to estimate whether results are
approximately correct.

Read the section in the User’s Guide on the operator or function in question.
The sections that describe how to use these features also mention the types of
problems that are likely to yield anomalous answers or no answer at all. In
cases where you suspect Mathcad’s methods may fail, restate the problem in
a more stable form or use Mathcad’s other features (summation, iteration, and
so on) to approximate the answer.

Set the built-in variable TOL to achieve the desired accuracy and speed for nu-
merically computed answers. TOL can take on only values between 0 and 1.
Set TOL to a number closer to zero to attain a higher degree of accuracy. Set
TOL to a number closer to 1 to calculate more quickly, but less accurately.
See the descriptions that follow for information on how Mathcad uses TOL in
its estimates.

Become familiar with the numerical methods described here and their limita-
tions. You can use these descriptions to get a better understanding of the con-
ditions under which numerical methods will fail or return inaccurate answers.
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Zero factor or numerator 

For efficiency reasons, Mathcad always assumes that for any expression x:

0⋅x = 0

and

0 / x = 0

Presented with a calculation of this type, Mathcad will not even evaluate x. This
has the following consequences:

Mathcad will instantly compute a result of zero for these expressions, even if
x requires a time-consuming calculation like an integral or a summation.

If computing x would result in an error, Mathcad will return zero without de-
tecting the error. In some cases this is desirable; in others, it isn’t.

Mathcad evaluates 0/0 as zero, not as an error.

Integrals 

  Mathcad computes definite integrals numerically using a Romberg algorithm.
The Romberg method accelerates the convergence of a sequence of simple trape-
zoidal or midpoint approximations to the integral by extrapolating the sequence
of estimates and the corresponding subinterval widths.

This section describes how Mathcad computes the integral of f(x) from a to b. In
this description, estimate0, estimate1, and so on represent Mathcad’s internal ap-
proximations to the answer. Only the last estimate, the one that passes Math-
cad’s tolerance test, is available to the user.

To compute the integral of f(x) from a to b, Mathcad follows these steps:

Calculate an estimate for the integral using the trapezoidal rule. The first
trapezoidal estimate is:

estimate0 = 
f(a) + f(b)

2
 (b − a)

The second trapezoidal estimate doubles the number of subintervals, using
two subintervals each of width b − a/ 2. To begin the algorithm, compute the
first three estimates, subdividing the interval into one, two, and four subinter-
vals, respectively.

Fit a polynomial to the sequence of trapezoidal estimates computed so far and
the corresponding subinterval widths. Extrapolate this polynomial to width
zero to produce a Romberg estimate for the integral.
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Compare the two most recent Romberg estimates according to the following
test (where reltol is the larger of TOL and TOL⋅


estimaten


:




estimaten − estimaten−1

 < reltol 

If the two most recent estimates agree according to this test, check also
whether estimaten − 1 and estimaten − 2 also agreed. If they did, then return the
most recent Romberg estimate as the value of the integral. If not, double the
number of subintervals and return to the first step.

Mathcad sets a limit on the number of times it will iterate this procedure. If the
routine reaches this limit without converging, or if the integrand is singular at
one or both of the endpoints of the interval of integration, then Mathcad
switches to an open-ended Romberg method. 

In the open-ended method, the preliminary estimates are obtained by using the
midpoints of subintervals, avoiding the necessity to evaluate the function at the
endpoints a and b. (See Handheld Calculator Evaluates Integrals, by William
Kahan, Ph.D., in Hewlett-Packard Journal, August 1980, for a full description.)
The sample points are concentrated near the ends of the interval of integration,
where integrands that are singular or that have an infinite derivative are likely to
to be changing most rapidly. The number of subintervals is tripled at each step. 

For its open-ended Romberg method, Mathcad follows these steps:

Calculate an open-ended estimate for the integral by summing terms com-
puted by multiplying the function value at the midpoint of a subinterval by
the width of that subinterval. Begin with one interval: the estimate is:

estimate0 = f 



a + b

2



 (b − a)

The next estimate uses three points, the next nine points, and so on. Begin by
making the first three estimates.

At each step, extrapolate the sequence of midpoint estimates to produce a
Romberg estimate.

Compare the two most recent estimates according to the following test
(where reltol is the larger of TOL and TOL⋅


estimaten


:



estimaten − estimaten−1


 < reltol  

If the two most recent estimates agree according to this test, return the most
recent open-ended estimate as the value of the integral. If not, triple the num-
ber of subintervals and return to the first step.

Again Mathcad sets a limit to the number of steps. If it reaches this limit without
returning an answer, the integral is marked with an error message indicating that
the integration is not converging.
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Mathcad can evaluate many integrals for which the integrand is singular at one
or both of the endpoints of the interval of integration. Evaluation of these inte-
grals will often be slower than for integrands that are well-behaved. For small
values of TOL, the integration may not converge even though the integral has a
finite value.

Mathcad generally will not be able to integrate functions that have singularities
in the interior of the interval of integration. Functions such as step and sawtooth
functions that have a large numbers of finite discontinuities may also lead to
nonconverging integrals. If you know where the singularities or discontinuities
in the integrand are, you can often obtain a correct numerical evaluation by split-
ting the integral into a sum of integrals with these points as limits. A plot of the
integrand may help to indicate the trouble spots.

Derivatives 

Mathcad’s derivative operator uses a variation of Ridder’s method to compute
derivatives of orders between 0 and 5 inclusive. Although Mathcad’s derivative
operator won’t compute derivatives of order greater than 5, you can nest deriva-
tive operators within each other to compute higher order derivatives.

The modified Ridder’s method begins with the determination of an initial step-
size h and the construction of a triangular array of estimates. This proceeds as
follows:

Mathcad computes the first estimate in the table using an n + 1-point divided
difference approximation. 

e0, 0 = 
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

n
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The remaining estimates in the first row of the table are computed using the
divided difference formula but with a decreasing step-size:

  e0, i = 







n

2 ⋅ h

(1.4 i)








 n

  ∑ (−1)n − k

k = 0

n

 


n
k




  f 






x − 

h
(1.4 i)

 + k⋅
2⋅ h

(1.4 i)
n








The remaining elements in this table of estimates are computed using
weighted averages of earlier elements:

ei, j = 
1.4 2i

1.4 2i − 1
 ⋅ ei − 1, j + 

−1
1.4 2i − 1

 ⋅ ei − 1, j − 1
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The error for a particular estimate of the derivative’s value is given by:

erri, j = max 



ei, j − ei − 1, j

,

ei, j − ei − 1, j − 1





Let errmin be the smallest of the erri, j and let der be the estimate of the de-
rivative’s value corresponding to errmin. Then if:

errmin < max(E, E ⋅ der),

where E is a small number depending on the order. Mathcad returns der as the
value of the derivative. Otherwise, Mathcad marks the derivative with the an er-
ror message to indicating that the differentiation is not converging.

Note that any numerical differentiation algorithm can lead to computational
problems associated with round-off and truncation. This is particularly true of
function values lying near a discontinuity or singularity in the function. With
Ridder’s algorithm, you can expect the first derivative to be accurate to within 7
or 8 significant digits, provided that the value at which you evaluate the deriva-
tive is not too close to a singularity of the function. The accuracy of this algo-
rithm tends to decrease by one significant digit for each increase in the order of
the derivative.

The root function 

  Mathcad’s root function solves for zeros using the secant method.

This section describes how Mathcad computes root( f(x), x). In this description,
estimate0, estimate1, and so on represent Mathcad’s internal approximations to
the answer. Only the last estimate, the one that passes Mathcad’s tolerance test,
is available to the user.

To compute a root of f(x) using the initial guess x, Mathcad follows these steps:

If f(x) < TOL, then x is already a root, so return x as the value of the root
function.

Set n = 1. If x ≠ 0, set h = TOL ⋅ x, otherwise, set h = TOL. Make the following
initial definitions:

estimate0 = x

estimate1 = x + h

Increase n by one. Then compute the straight line connecting the points
(estimaten − 2, f(estimaten − 2)) and (estimaten − 1, f(estimaten − 1)). Set xn to
the point where this straight line crosses the zero axis.

If f(estimaten )<TOL, return estimaten as the value of the root function. Oth-
erwise, go back to step 3.

636 Appendix D  Numerical Methods



There is a limit on the number of calculations that Mathcad will perform in
search of an answer for the root function. If it exceeds this limit without return-
ing an answer, the root function is marked with an error message indicating that
Mathcad is not converging to a solution.

Solve blocks 

    Mathcad’s solve areas use the iterative Levenberg-Marquardt method to solve
for several constraints simultaneously. Mathcad’s method is taken from the pub-
lic-domain MINPACK algorithms developed and published by the Argonne Na-
tional Laboratory in Argonne, Illinois. For more information, see the User’s
Guide to Minpack I, by Jorge J. More, Burton S. Garbow, and Kenneth E. Hill-
strom, Argonne National Laboratory publication ANL-80-74, 1980.

The error vector 

 The MINPACK algorithm attempts to find the zeros of, or at worst minimize the
sum of squares of, the value of a vector of functions relative to the values of cer-
tain variables. The vector of functions Mathcad uses is an error vector whose
elements represent the errors in the constraints. The errors are defined as fol-
lows: 

For equality constraints (constraints using “=”):

error = left_side − right_side

For inequality constraints defined with <, >, ≤, or ≥:

error = 0

if inequality is true, otherwise

error = left_side − right_side

Mathcad treats the Levenberg-Marquardt algorithm as an algorithm on real vari-
ables. When you solve for a complex variable, Mathcad treats the real and imagi-
nary parts as separate variables in the algorithm. When you solve an equality
constraint, Mathcad creates two real constraints for the algorithm, one for the
real part and one for the imaginary part.

Steps in the Levenberg-Marquardt method 

The Levenberg-Marquardt method is a quasi-Newton method (a variation on the
gradient method). At each step, Mathcad estimates the first partial derivatives of
the errors with respect to the variables to be solved to create a Jacobian matrix.
Ordinarily, Mathcad can determine the next estimate to make by computing the
Gauss-Newton step s for each variable. In matrix notation, Mathcad solves the
matrix equation:
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J ⋅s = −f(x)

In this equation, J is the Jacobian matrix, s is the step to take, and x is the vector
of current estimates for unknown variables. For the first step, x is the vector of
guesses; at each subsequent step, the new x is the old x plus s, the vector of
steps. Notice that computing this step involves inverting the Jacobian matrix J.

Computing this step is not always possible. Computing the step fails when the
Jacobian matrix cannot be inverted or when there are more constraints than vari-
ables to be solved. In these cases, Mathcad adds the additional condition that the
following quantity be reduced to a minimum:

∑Dj
  2⋅sj

  2

j

Here D is a vector of weight factors computed from the norms of the columns of
the Jacobian matrix. In these cases, s is computed to satisfy this minimization
criteria as well as solving the Newton equation with the Jacobian.

The Levenberg-Marquardt method does not work when there are fewer con-
straints than variables. In these cases, Mathcad returns the an error message indi-
cating that there are not enough constraints for the given number of unknowns.

Termination criteria 

The Levenberg-Marquardt method ends when it reaches one of the following ter-
mination criteria:

When it is no longer possible to reduce the norm of the error vector signifi-
cantly. In this context, “significantly” means by more than the larger of TOL
and TOL ⋅ |error_vector|. This criterion stops the solver when the errors can-
not be reduced further.

When s becomes relatively close to zero. In this method, “relatively close”
means a norm smaller than the larger of TOL and TOL ⋅ v. This criterion
stops the solver when there is no preferred direction to move the guesses.

When it reaches one of these termination conditions, Mathcad checks the magni-
tude of the error vector and returns an answer:

If the magnitude of the error vector is less than or equal to TOL, Mathcad re-
turns the variable values as a solution.

If the solve block ends in Find and the magnitude of the error vector is
greater than TOL, Mathcad marks the Find with the an error indicating that it
could not find a solution. If the solve block ends in Minerr, Mathcad returns
the solution anyway, even though the error vector is not close to zero.
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There is a limit on the number of calculations that Mathcad will perform in
search of an answer for a solve block. If it exceeds this limit without returning
an answer, the Find or Minerr is marked with an error indicating that Mathcad is
not converging to a solution.

In all cases, when the solver stops, Mathcad sets the value of the variable ERR to
the magnitude of the error vector.

Mathcad’s modifications to the Levenberg-Marquardt method

To make the Levenberg-Marquardt method more effective on actual problems,
Mathcad includes the following modifications to the basic method:

The first time the solver stops at a point that is not a solution, Mathcad adds a
small random amount to all the variables and tries again. This helps avoid get-
ting stuck in local minima and other points from which there is no preferred
direction. Mathcad does this only once per solve, the first time the solver
stops on a point that is not a solution.

If you include inequality constraints in a solve block, Mathcad solves the sub-
system consisting of only the inequalities first before adding in the equality
constraints and attempting a full solution. This is equivalent to moving the
guesses into an area where the inequalities are all satisfied before starting the
solver.

Matrix operations 

  This section describes Mathcad’s algorithms for computing determinants and in-
verses for square matrices.

To compute the determinant or inverse of a square matrix M, Mathcad decom-
poses it into a lower-triangular matrix L and an upper-triangular matrix U, such
that:

M = L ⋅ U

This is called the LU decomposition of the matrix.

The LU decomposition makes the solution of a system of equations M ⋅ x = y
into a matter of simple substitutions with the elements of L, U, and y.

Performing the decomposition

Mathcad performs the LU decomposition using Crout’s method with partial piv-
oting. This method is not described here. See Numerical Recipes in C by Wil-
liam H. Press, Brian P. Flannery, Saul A. Teukolosky and William T. Vetterling
(Cambridge University Press, 1986), pp. 31 to 39, for a complete description.
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Computing the inverse and the determinant

To compute the inverse, Mathcad solves the equations M⋅vj = ej, where e is a
vector with a one in element j and a zero in all other elements. The solution vec-
tors v for each j form the columns of the inverse matrix.

The determinant of the original matrix is simply the product of the diagonal ele-
ments of U, the upper-triangular matrix in the LU decomposition.

Sorting 

  Mathcad’s sort function sorts a vector into ascending order on the real parts of
the elements. If the array is purely imaginary, sort sorts on the imaginary parts.

The functions csort and rsort sort a matrix on a given column or row. The csort
function puts the elements of the given column in order by rearranging the rows
of the matrix. Thus, rows stay together in the column sort. The rsort function
similarly puts the elements of the given row in order by rearranging the columns
of the matrix.

Mathcad’s sorting routine uses a heapsort algorithm. See Numerical Recipes in
C, by William H. Press, Brian P. Flannery, Saul A. Teukolsky, and William T.
Vetterling (Cambridge University Press, 1988) for a description of heapsort algo-
rithms.

The heapsort procedure is not a stable sort. This means that if you sort a matrix
on a column that contains equal elements, the rows containing these elements
will be adjacent in the sorted array, but will appear in an arbitrary order.
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Appendix F
Creating a User DLL 

Extend Mathcad’s power by writing your own customized
functions. Your functions will have the same advanced features as
Mathcad PLUS built-in functions, such as customized error
messages, interruption, and exception handling in case of overflow
and divide by zero. Your functions will appear in the Insert
Function dialog box like all built-in functions. The functions will
operate on complex scalars and complex arrays. They will return
complex scalars, complex arrays, and error messages.

This appendix describes how to create 32-bit DLLs for Mathcad
PLUS. The following sections make up this appendix:

Creating dynamically linked libraries
An overview of how to write your function and fill out the FUNCTION-
INFO structure.

A sample DLL

A simple example of a user-created DLL with extensive comments. This
sample can be used as a template for your own DLL.

Examining a sample DLL

A detailed examination of a simple example DLL, explaining the COM-
PLEXARRAY and COMPLEXSCALAR structures, error handling and func-
tion registration. 

Handling arrays
Using the COMPLEXARRAY structure to handle arrays. 

Allocating memory
Allocating and freeing memory. 

Exception handling
How Mathcad traps the floating point exceptions. 

Structure and function definitions 
A reference guide to the structures and functions used.
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Creating dynamically linked libraries 

To create customized functions, you will first need to create source code in C or
C++, then compile the source code with a 32-bit compiler. Next, you will link
the object files together with the MathSoft-provided mcaduser.lib library to
create a DLL. Finally, you will place your DLL into the userefi subdirectory. 

Writing your DLL source code

Provided below is an overview of the steps involved in creating a DLL. Refer to
the rest of this appendix for specific details on how to do each step. 

Writing a DLL entry point routine

When you start Mathcad PLUS, it looks in the userefi directory for library
files with a .dll extension. Mathcad attempts to load all such files. During this
loading process, your DLL must supply Mathcad with information about your li-
brary, including the names of the functions in the library, the types of arguments
the functions take, the types of values they return, and the text of possible error
messages. To supply this information, your DLL must have an entry point rou-
tine. A DLL entry point routine is called by the operating system when the DLL
is loaded. Because the way to specify the DLL entry point routine is linker spe-
cific, refer to the readme.mcd file in the userefi directory for linking instruc-
tions. 

Registering your function

For each function in your library, there must be a FUNCTIONINFO structure.
The FUNCTIONINFO structure contains the information that Mathcad uses to
register a user function. FUNCTIONINFO structure is an argument of
CreateUserFunction. A call to CreateUserFunction inside the DLL entry
point routine registers your function with Mathcad. 

Writing your function

You must, of course, write a C or C++ function which implements your Math-
cad user function. The parameters of your C/C++ function are pointers to the re-
turn value and to the arguments. The C/C++ function returns 0 if successful,
otherwise it returns an error code. The address of the C/C++ function is passed
to Mathcad inside a FUNCTIONINFO structure. In this way, Mathcad knows to
execute your code when the function is called from a Mathcad document. Refer
to the description of MyCFunction in the reference section at the end of this ap-
pendix.

Error Handling

C/C++ functions which return error messages require an error message table in
the DLL code. A call to CreateUserErrorMessageTable inside the DLL en-
try point routine informs Mathcad of the meaning of error codes returned by the
C/C++ functions from the DLL. 
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Compiling and linking  your DLL

To create your DLL you will need a 32-bit compiler such as Microsoft Visual
C++ (32-bit version), Borland C++ version 4.5, or Watcom C++32 version 10.0.
Instructions on compiling and linking your DLL are given in a readme.mcd file
located in the userefi directory. For more specific instructions on how to link
and compile your source code, refer to the user guide provided with your com-
piler.

A Sample DLL

To get you started writing DLLs for Mathcad we include a number of code sam-
ples. The example below is the file multiply.c located in the 
userefi\microsoft\sources\simple subdirectory.  

The file contains a function which returns the result of multiplying an array by a
scalar. This code implements the Mathcad user function multiply(a, M), which
returns the result of an array M multiplied by a scalar a. The source code is ex-
plained in detail in later sections.

Sample code
#include "mcadincl.h"
#define  INTERRUPTED 1
#define  INSUFFICIENT_MEMORY 2
#define  MUST_BE_REAL 3
#define  NUMBER_OF_ERRORS 3

// red box error messages
// if your function never returns an error, you do not need to create this table
char * myErrorMessageTable[NUMBER_OF_ERRORS] = 
{

"interrupted",
"insufficient memory",
"must be real"

};

// this code executes the multiplication
// see the information on MyCFunction to find out more
LRESULT  MultiplyRealArrayByRealScalar(

COMPLEXARRAY * const Product, 
const COMPLEXSCALAR * const Scalar,
const COMPLEXARRAY * const Array )

{
unsigned int row, col;
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// check that the scalar argument is real
if ( scalar->imag != 0.0 )

// if not, display "must be real" under scalar argument 
return MAKELRESULT( MUST_BE_REAL, 1 ); 

// check that the array argument is real
if ( Array->hImag != NULL )

// if not, display "must be real" under array argument 
return MAKELRESULT( MUST_BE_REAL, 2 );

// allocate memory for the product
if( !MathcadArrayAllocate( Product, Array-rows,
Array-cols, 

// allocate memory for the real part
TRUE ,

// do not allocate memory for the imaginary part
FALSE ))

// if allocation is not successful, return with the appropriate error code
return  INSUFFICIENT_MEMORY;

// if all is well so far, perform the multiplication
for (  col = 0; col < Product-> cols; col++ )
{

// check that a user has not tried to interrupt the calculation
if ( isUserInterrupted() )
{

// if user has interrupted, free the allocated memory 
MathcadArrayFree( Product ); 

// and return with an appropriate error code 
return INTERRUPTED;

}
for ( row = 0; row < Product-> rows; row++ )

Product->hReal[col][row] = 
Scalar-> real*Array-> hReal[col][row];

}
// normal return
return 0;

}
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// fill out a FunctionInfo structure with
// the information needed for registering the function with Mathcad
FUNCTIONINFO multiply = 
{
// name by which Mathcad will recognize the function
"multiply", 

// description of "multiply" parameters for the Insert Function dialog box
"a,M",

// description of the function for the Insert Function dialog box
"returns the product of real scalar a and real array M",

// pointer to the executable code
// i.e. code that should be executed when a user types in "multiply(a,M)="
(LPCFUNCTION)MultiplyRealArrayByRealScalar;

// multiply(a, M) returns a complex array
COMPLEX_ARRAY,

// multiply(a,M) takes on two arguments
2, 

// the first is a complex scalar, the second a complex array 
{ COMPLEX_SCALAR, COMPLEX_ARRAY} 
};

// all Mathcad DLLs must have a DLL entry point code
// the_CRT_INIT  function is needed if you are using Microsoft’s 32-bit compiler
BOOL WINAPI _CRT_INIT(HINSTANCE hinstDLL, DWORD dwReason,
LPVOID lpReserved);
BOOL WINAPI  DllEntryPoint (HINSTANCE hDLL, DWORD dwReason,
LPVOID lpReserved) 
{

switch (dwReason)
{

case DLL_PROCESS_ATTACH:
// DLL is attaching to the address space of the current process.
// the next two lines are Microsoft-specific
if (!_CRT_INIT(hDLL, dwReason, lpReserved))

return FALSE;

// register the error message table
// if your function never returns an error, 
// you don’t need to register an error message table
if ( CreateUserErrorMessageTable( hDLL, 
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NUMBER_OF_ERRORS  , myErrorMessageTable ) )
// and if the errors register OK, register the user function 
CreateUserFunction( hDLL, &multiply );

break;
case DLL_THREAD_ATTACH:
case DLL_THREAD_DETACH:
case DLL_PROCESS_DETACH:

// the next two lines are Microsoft-specific
if (!_CRT_INIT(hDLL, dwReason, lpReserved)) 

return FALSE;
break;

}
return TRUE;

}
#undef INTERRUPTED    
#undef INSUFFICIENT_MEMORY
#undef MUST_BE_REAL   
#undef NUMBER_OF_ERRORS 

Compiling and linking the sample DLL

If you are using a Microsoft 32-bit compiler you can compile this file with the
following command

cl -c -I..\..\include -DWIN32 multiply.c 

This creates an object file MULTIPLY.OBJ. You can use the following command
to link MULTIPLY.OBJ with the appropriate library and place MULTIPLY.DLL
in the userefi directory.

link -out:..\..\..\multiply.dll -dll 
-entry:"DllEntryPoint" multiply.obj
..\..\lib\mcaduser.lib

Check to make sure the MULTIPLY.DLL file is in the userefi subdirectory.
Start Mathcad and verify that multiply appears in the Insert Function dialog box.
You are now ready to use multiply in Mathcad.
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Examining a sample DLL 

This section will examine the source code of the simple example in the previous
section. Refer to the code in the sample DLL.

MyCFunction

The heart of the program is MyCFunction, called MultiplyRealArrayByRe-
alScalar function. It performs the actual multiplication. When the user types
multiply(a,M)=, Mathcad executes the MultiplyRealArrayByRealSca-
lar routine. The value of a is passed to the MultiplyRealArrayByRealSca-
lar function in the Scalar argument. The value of M is passed in the Array
argument. A pointer to the return value Product is the first argument of the
MultiplyRealArrayByRealScalar function. 

COMPLEXSCALAR structure

The scalar value a is passed to the MultiplyRealArrayByRealScalar func-
tion in a COMPLEXSCALAR structure. The structure has two members, real and
imag. The real part of a is stored in Scalar-> real, the imaginary part  in
Scalar-> imag. 

COMPLEXARRAY structure

The array value M is passed to the MultiplyRealArrayByRealScalar func-
tion in a COMPLEXARRAY structure. The COMPLEXARRAY structure has four mem-
bers, rows, cols, hReal, and hImag. The number of rows in M is found in
Array-> rows, the number of columns is found in Array-> cols. The real
part of the element Mrow,col is found in Array-> hReal[col][row] and the
imaginary part in Array-> hImag[col][row]. If no element of M has an
imaginary part, Array-> hImag is equal to NULL. If all elements of M are
purely imaginary, Array-> hReal is equal to NULL.  

The result of the multiplication of M by a is stored by the program in the
COMPLEXARRAY structure pointed to by the argument Product. Note the mem-
ory for the multiplication result is allocated inside the MultiplyRealArray-
ByRealScalar function with a call to the MathcadArrayAllocate function. 

Error Messages

If the multiplication was successful, MultiplyRealArrayByRealScalar
stores the result in the COMPLEXARRAY structure pointed to by the argument
Product and returns 0. In the case of an error, its return value has two compo-
nents. One is the error code and the other is the location in which to display the
error message. 

Look at the error message table from the top of the file:

char * myErrorMessageTable[NUMBER_OF_ERRORS] = 
{
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"interrupted",
"insufficient memory",
"must be real"

};

The function MultiplyRealArrayByRealScalar returns MAKELRE-
SULT(3,1) to display string number 3, “must be real,” under the first argument
of multiply(a,M). If  MathcadArrayAllocate is unable to allocate mem-
ory, MultiplyRealArrayByRealScalar returns 2 to display string number
2, “insufficient memory,” under the function name.

As shown in the sample DLL code, the following steps are involved in produc-
ing an error message:

creation of an array of error message strings. 

registering the error message strings with Mathcad via a call to CreateUser-

ErrorMessageTable. This call is made within the DLL entry point routine.

returning an appropriate error code from the user function.

DLL entry point function

The DLL entry point is called by the operating system when the DLL is loaded.
Mathcad requires that you register your user functions and your error message
table while the DLL is being loaded. Note how this is done in the following code
lines.

BOOL WINAPI  DllEntryPoint (HINSTANCE hDLL, DWORD dwReason,
LPVOID lpReserved) 
{

switch (dwReason)
{

case DLL_PROCESS_ATTACH:

if ( CreateUserErrorMessageTable( hDLL, 
NUMBER_OF_ERRORS  , myErrorMessageTable ) )
// if the errors register OK, register user function 
CreateUserFunction( hDLL, &multiply );

break;
case DLL_THREAD_ATTACH:
case DLL_THREAD_DETACH:
case DLL_PROCESS_DETACH:

break;
}
return TRUE;

}

CreateUserErrorMessageTable registers the error messages. CreateUser-

Function registers the function. You can register only one error message table
per DLL, but you can register more than one function per DLL. 
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FUNCTIONINFO structure

The FUNCTIONINFO structure, multiply, is used for registering the DLL function
with Mathcad. It contains information about the name by which Mathcad recog-
nizes the function, the description of the function parameters, its arguments, its
return value, and the pointer to the code which executes the function.

FUNCTIONINFO multiply = 
{
"multiply", 
"a,M",
"returns the product of real scalar a and real array M",
(LPCFUNCTION)MultiplyRealArrayByRealScalar;
COMPLEX_ARRAY,
2, 
{COMPLEX_SCALAR, COMPLEX_ARRAY} 
};

Precision

Data is passed between Mathcad and MyCFunction in double precision. Use
the appropriate conversion inside MyCFunction for different data types.

mcadincl.h

MathSoft provides the mcadincl.h include file. This file contains the proto-
types for the following functions: CreateUserFunction, CreateUserEr-
rorMessageTable, MathcadAllocate, MathcadFree,
MathcadArrayAllocate, MyCFunction, MathcadArrayFree, isUserIn-
terrupted. mcadincl.h also includes the type definitions for the structures
COMPLEXSCALAR, COMPLEXARRAY, and FUNCTIONINFO.

Handling arrays

If your function takes an array as its argument or returns an array, refer to the
COMPLEXARRAY structure description in the reference section, “Structure and
function definitions.” Note that the arrays are two-dimensional and the structure
contains information about the size of the arrays and the pointers to the real and
imaginary parts of the array. Refer to the next section “Allocating Memory” for
how to allocate memory inside COMPLEXARRAY structures.
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Allocating memory

The first argument of MyCFunction is a pointer to a return value. If it points to
a COMPLEXARRAY structure, you will need to allocate memory for the members
of this structure using MathcadArrayAllocate. If MyCFunction is returning
an error, free the memory allocated for the return value using MathcadArray-
Free. In the case of an error-free return, do not free the memory allocated for
the return value. 

Use the MathcadAllocate and MathcadFree functions to allocate and free
memory inside MyCFunction.

Exception handling

Mathcad traps the following floating point exceptions; overflow, divide by zero,
and invalid operation. In the case of these exceptions, Mathcad will display a
floating point error message under the function. Mathcad will also free all the
memory allocated inside MyCFunction with MathcadArrayAllocate and
MathcadAllocate.

Structure and function definitions

This section describes in more detail the structures and functions used in creat-
ing your own dynamically linked library.

The COMPLEXSCALAR Structure
typedef struct tagCOMPLEXSCALAR {

double real;
double imag;

} COMPLEXSCALAR;

The COMPLEXSCALAR structure is used to pass scalar data between Mathcad and
a user DLL. The real part of a scalar is stored in the real member of a 
COMPLEXSCALAR, and the imaginary in the imag member.

Member Description

real Contains the real part of a scalar.
imag Contains the imaginary part of a scalar.
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The COMPLEXARRAY Structure
typedef struct tagCOMPLEXARRAY  {

unsigned int rows;
unsigned int cols;
double **hReal; 
double **hImag;     

} COMPLEXARRAY;

The COMPLEXARRAY structure is used to pass array data between Mathcad and a
user DLL. It contains the information about the size of the array and whether any
of the elements in the array has an imaginary or a real component.

Member Description

rows Number of rows in the array.
cols Number of columns in the array.
hReal Points to the real part of a complex array hReal[i][j] contains

the element in the ith column and the jth row of the array. hReal
is equal to NULL if the array has no real component.

hImag Points to the imaginary part of a complex array hImag[i][j], con-
tains the element in the ith column and the jth row of the array.
hImag equals NULL if the array has no imaginary component.

Comments

hReal and hImag members of the argument array are indexed as two-dimen-
sional array of the range [0..cols–1][0..rows–1].

The FUNCTIONINFO Structure
typedef struct  tagFUNCTIONINFO{

char * lpstrName;
char * lpstrParameters; 
char * lpstrDescription;
LPCFUNCTION lpfnMyCFunction;
long unsigned int returnType;
unsigned int nArgs;
long unsigned int argType[MAX_ARGS];

} FUNCTIONINFO;

The FUNCTIONINFO structure contains the information that Mathcad uses to reg-
ister a user function. Refer below for each member and its description.

Member Description

lpstrName Points to a NULL-terminated string that specifies the name of
the user function.

lpstrParameters Points to a NULL-terminated string that specifies the parameters
of the user function. The string is used by the Insert Function
dialog box.

lpstrDescription Points to a NULL-terminated string that specifies the function
description for the Insert Function dialog box.
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lpfnMyCFunction Pointer to the code that executes the user function.
returnType Specifies the type of value returned by the function. The values

are COMPLEX_ARRAY or COMPLEX_SCALAR.
nArgs Specifies the number of arguments expected by the function.

Must be between 1 and MAX_ARGS.
argType Specifies an array of long unsigned integers containing input pa-

rameter types.

CreateUserFunction
const void * CreateUserFunction(hDLL, functionInfo)
HINSTANCE hDLL;
FUNCTIONINFO * functionInfo ;

CreateUserFunction is called when the DLL is attaching to the address space
of the current process in order to  register the user function with Mathcad.

Parameter Description

hDLL Handle of the DLL supplied by the DLL entry point routine.
functionInfo Points to the FUNCTIONINFO structure that contains informa-

tion about the function. 
The FUNCTIONINFO structure has the following form:

typedef struct  tagFUNCTIONINFO{

char *  lpstrName;

char *  lpstrParameters; 

char *  lpstrDescription;

LPCFUNCTION  lpfnMyCFunction;

long unsigned int returnType;

unsigned int nArgs;

long unsigned int argType[MAX_ARGS];

} FUNCTIONINFO;

Return value

The return value is a non-NULL handle if the registration is successful. Other-
wise, it is NULL.  

CreateUserErrorMessageTable
BOOL CreateUserErrorMessageTable(hDLL,n,ErrorMessageTable)
HINSTANCE hDLL;
unsigned int n;  
char * ErrorMessageTable [ ];

CreateUserErrorMessageTable is called when the DLL is attaching to the
address space of the current process in order to registers the user error message
table with Mathcad.
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Parameter Description

hDLL Handle of the DLL supplied by the DLL entry point routine. 
n Number of error messages in the table.  
ErrorMessageTable An array of n strings with the text of the error messages.  

Return value

The return value is TRUE if the registration is successful. Otherwise, it is
FALSE.  

MathcadAllocate
char * MathcadAllocate(size)
unsigned int size;

Should be used to allocated memory inside the MyCFunction. Allocates a mem-
ory block of a given size (in bytes) of memory.

Parameter Description

size Size ( in bytes ) of memory block to allocate. Should be non-
zero.

Return value

Returns a pointer to the storage space. To get a pointer to a type other than char,
use a type cast on the return value. Returns NULL if the allocation failed or if
size is equal to 0. 

MathcadFree
void MathcadFree(address)
char * address;

Should be used to free memory allocated with MathcadAllocate. The argu-
ment address points to the memory previously allocated with MathcadAllo-
cate. A NULL pointer argument is ignored. 

Parameter Description

address Address of the memory block that is to be freed.

Return value

The function does not return a value.
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MathcadArrayAllocate
BOOL MathcadArrayAllocate(array, rows, cols, allocateReal,
allocateImaginary)
COMPLEXARRAY* const array; 
unsigned int rows;
unsigned int cols;
BOOL allocateReal;
BOOL allocateImaginary;

Allocates memory for a COMPLEXARRAY of cols columns and rows rows. Sets
the hReal, hImag, rows and cols members of the argument array. 

Parameter Description

array Points to the COMPLEXARRAY structure that is to be filled with
the information about an array.  
The COMPLEXARRAY structure has the following form:

typedef struct tagCOMPLEXARRAY  {

unsigned int rows;

unsigned int cols;

double **hReal; 

double **hImag; 

} COMPLEXARRAY;

rows Row dimension of the array that is being allocated. After a suc-
cessful allocation, the rows member of the argument array is set
to the value of rows.

cols Column dimension of the array that is being allocated. After a
successful allocation, the cols member of the argument array is
set to the value of cols.

allocateReal Boolean flag indicating whether a memory block should be allo-
cated to store the real part of the array. If allocateReal is FALSE

the function does not allocate storage for the real part of array
and sets the hReal member to NULL. 

allocateImag Boolean flag indicating whether a memory block should be allo-
cated to store the imaginary part of the array. If allocateImag is
FALSE the function does not allocate storage for the imaginary
part of array and sets the hImag member to NULL.

Return value

Returns TRUE if the allocation is successful, FALSE otherwise.

Comments

 hReal and hImag members of the argument array are allocated as 2-dimensional
array of the range [0..cols–1][0..rows–1].
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MyCFunction
LRESULT MyCFunction(returnValue, argument1,...)
void * const returnValue;
const void * const argument1;
...

MyCFunction is the actual code which executes the user function. Mathcad ar-
guments and a pointer to a return value are passed to this function. It puts the re-
sult of the calculation in the return value.

Parameter Description

returnValue Points to a COMPLEXARRAY or a COMPLEXSCALAR structure
where the function result is to be stored. If you are implement-
ing a Mathcad user function which returns a scalar, returnValue
is a pointer to a COMPLEXSCALAR structure. If you are imple-
menting a Mathcad user function that returns an array, return-
Value points to a COMPLEXARRAY structure.

argument1 Points to a read-only COMPLEXARRAY or a COMPLEXSCALAR
structure where the first function argument is stored. If you are
implementing a Mathcad user function that has a scalar as its
first argument, argument1 is a pointer to a COMPLEXSCALAR
structure. If you are implementing a Mathcad user function that
has an array as its first argument, argument1 points to a COM-
PLEXARRAY structure.

... If you are implementing a Mathcad user function that has more
than one argument, your MyCFunction will have additional ar-
guments. The additional arguments will be pointers to the read-
only COMPLEXARRAY or a COMPLEXSCALAR structures where the
data for the corresponding Mathcad user function argument is
stored.

Return value

MyCFunction should return 0 to indicate an error-free return. To indicate an er-
ror MyCFunction should  return an error code in the low word of the returned
LRESULT, and in the high word the number of the argument under which the er-
ror box should be placed. If the high word is zero the error message box is
placed under the function itself. See the section on error handling to find out
more about error codes.

Comments

MyCFunction is a place-holder for the library-supplied function name. You can
name the function that executes your Mathcad user function anything you would
like, but you must register the address of your executable code with Mathcad by
setting the lpfnMyCFunction member of the FUNCTIONINFO structure. 
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MathcadArrayFree
void MathcadArrayFree(array)
COMPLEXARRAY * const array;

Frees memory that was allocated by the MathcadArrayAllocate function to
the the hReal and hImag members of the argument array. 

Parameter Description

array Points to the COMPLEXARRAY structure that is to be filled with
the information about an array.
The COMPLEXARRAY structure has the following form:

typedef struct tagCOMPLEXARRAY  {

unsigned int rows;

unsigned int cols;

double **hReal; 

double **hImag; 

} COMPLEXARRAY;

 

Return value

The function does not return a value.

isUserInterrupted
BOOL isUserInterrupted(void)

The isUserInterrupted function is used to check whether a user has pressed
the [Esc] key. Include this function if you want to be able to interrupt your
function like other Mathcad functions.

Parameter

The function does not take on any parameters.

Return value

Returns TRUE if the[Esc]key has been pressed, FALSE otherwise.

DLL interface specifications, contained in the documentation, may be used for creating
user-written external functions which work with Mathcad for your personal or internal
business use only. These specifications may not be used for creating external func-
tions for commercial resale, without the prior written consent of MathSoft, Inc.
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Index

!

! (factorial) 240
% 165
() (parentheses) 60
+ (with line break) 242
+, −, ⋅, and /  242
3D Plot Format dialog box

Axes page for 3D bar charts 532
Axes page for 3D scatter plots 546
Axes page for contour plots 520
Axes page for surface plots 506
Axes page for vector field plots 554
Color & Lines page for 3D bar charts 530
Color & Lines page for 3D scatter plots 544
Color & Lines page for contour plots 517
Color & Lines page for surface plots 503
Title page for 3D bar chart 534
Title page for 3D scatter plots 547
Title page for contour plots 521
Title page for surface plots 508
Title page for vector field plots 555
View page for 3D bar charts 527
View page for 3D scatter plots 541
View page for contour plots 516
View page for surface plots 500

:= (definition) 138
≠ (not equal to) 242
<, >, ≤, ≥ (inequalities) 242
≡ (global assignment) 144
 X 
___

  169, 240
δ (unit impulse function) 282
n√   241
∫ (integral) 242, 252

X → (vectorize) 198, 206, 207, 240
| ⋅ | (determinant) 241
| ⋅ | (magnitude/absolute value) 241

d⁄dx and d
n
⁄dx

n (derivative and nth derivative) 242,
248, 251
ε function 283
∞ 160

Φ (unit step function 282
π 53, 165
Σ (vector sum) 241
√  (square root) 241
× (vector product) 241
→ (symbolic equals sign) 379
= (boolean equals) 242
= (evaluating expression) 146

A

aborting calculations in progress 152
absolute value 241

See magnitude
acosh function 269
adaptive smoothing of data 312
addition 242
algorithms

See numerical methods
aligning regions 67
aligning text 110
anchor points 142
angle function 273
Animate command 558
animation

compressing QuickTime movies 558
creating 558
playback 560
saving 558
speed 558, 561

annotations
deleting from Electronic Books 40
highlighting 39
inserting in Electronic Books 39

antisymmetric tensor function 283
APPEND function 424, 425, 429
APPENDPRN function 424, 426, 434
approximations

Mathcad’s numerical methods 632
minerr function 340
root of expression 334

area under a curve
See integrals

arg function 273
argument of complex number 273
arguments
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hiding in graphs 462
hiding in polar plots 485
of functions 139

arrays
as arguments to user functions 210
calculating with 185, 227
calculations by element 206
creating 184
defining 182, 185, 212
definition of 182
displaying results 192
extracting a column 189
extracting a subarray 201, 202
functions for 198
matrices 182
nested 211
operators for 195
ORIGIN used with 190
setting starting index 190
size limits 194
subscripts 187
vectors 182
when to use subscripts 235

arrow keys
for editing 607
for scrolling 74

asinh function 269
Associate command 426
assume keyword 381, 382
atanh function 269
augment function 201, 202

used to write several variables to file 435
auto (on status bar) 149
Auto Contour

using 519
Auto Grid

contour plots 521
graphs 451
polar plots 476

automatic mode 149
Autoscale

3D bar charts 533
3D scatter plots 547
contour plots 521
graphs 450, 452
polar plots 479

surface plots 507
autoscroll 66
average

See mean
Axes page

3D bar charts 532
3D scatter plots 546
contour plots 520
surface plots 506
vector field plots 554
X-Y plot defaults dialog box 458
X-Y plots 449, 452

axes style
graphs 451
polar plots 477

axes, formatting
3D bar charts 532
3D scatter plots 546
contour plots 520
surface plots 506
vector field plots 554

axis limits 440

B

back planes
3D bar charts 528
3D scatter plots 543
surface plots 502

bandpass filter 282, 283
bar charts (2D)

graphs 457
polar plots 481

bar charts (3D) 523
adjusting spacing between bars 531
Autoscale 533
back planes 528
bar configurations 531
borders 528
boxes 528
changing bar colors 530
converting 527
creating 524
formatting 526
formatting axes 532
grid intervals 533
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grid lines 532
of function of two variables 525
perspective 526, 527
resizing 526
setting axis limits 533
tick marks 532
titles 534
vertical scale 528

base of results (decimal/hex/octal) 124
base units 177
Bessel functions 270
beta distribution 290
binomial distribution 290
blank lines, inserting or deleting 69
blank pages in printouts 84
blank space between regions 21
boilerplate math 32
boolean operators 257, 280
borders

3D bar charts 528
3D scatter plots 542
surface plots 501

bottom margin 83
boundary value problems 370
boxed axes 451
boxes

3D bar charts 528
3D scatter plots 542
surface plots 502

branching
See conditionals

breaking equations 242, 420
built-in functions 266

alphabetical list 594
listed by type 266
symbolic only 417

built-in variables 165
bulstoer function 365
bvalfit function 372

C

calc on message line 150
calculation 18, 149

disabling for individual equation 153
equations 18, 146, 412

interrupting 152
locking 79, 81
order in worksheets 142
restarting after interrupting 152
units in 173
unlocking 82

calculator, using Mathcad as 16
carriage returns in text 101
cauchy distribution 290
ceil function 273
centigrade 175
cfft function 273, 274, 275, 277
CGS units 177
changing size

See resizing
character

deleting 54
inserting 54

charts
See plots, graphs

chemical formulas 164
chi function 417
chi-squared distribution 290
cholesky decomposition function 204
Ci function 417
clipboard 61, 420
cnorm function 290
Collect command 392
colon (:) as definition symbol 17, 138
color

3D bar charts 530
3D scatter plots 544
changes to Electronic Books 39
contour plots 517
equaion highlights 133
graphs 456
in equations 129
in text 109
polar plots 481
surface plots 503

Color & Lines page
3D bar charts 530
3D scatter plots 544
contour plots 517
surface plots 503

cols function 199
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column vectors
See vectors

comments in Electronic Books 39
comments in worksheet 100
common log 270
complementary error function 272
complex

conjugate 169, 240
fast Fourier transform 273
keyword 381, 383
tolerance 125

Complex Evaluation command 386
complex numbers 168

conjugate 169
determining angle 169
display of 125
imaginary unit symbol 125
in graphs 441
magnitude of 169
operators and functions for 169, 272
real and imaginary parts 169
vector field plots 549, 550, 551

computing results 18
condition number of matrix 201
conditional

functions 279
statement 319

configuration files 87
conjugate (complex) 169, 240
constants

font tag 130
See also numbers
See also predefined variables

constraints
components of error vector for 637
defined 341
in solve blocks 341
too few 347

context sensitive help 34
contour integrals 255
contour plots 511

Auto Grid 521
Autoscale 521
changing the shading 517
converting 516
converting plot type 516

creating 512
displaying as points 516
formatting 515
formatting axes 520
grid intervals 521
hiding the contours 518
numbering the contours 518
of function of two variables 513
resizing 514
setting axis limits 521
specifying how many contours 519
specifying tick marks and grid lines 520
titles 521

Convert to Partial Fraction command 392
converting 3D plots

from 3D bar charts 527
from 3D scatter plots 541
from contour plots 516
from surface plots 500

copying
arrays 147
from Electronic Book 36
regions 65
results 147
text 107
to clipboard 61

correlation (corr) function 286
cosecant function 268
cosh function 269
cosine (cos) function 268
cosine integral 417
cotangent function 268
coth function 269
covariance (cvar) function 286
creating

3D bar charts 524
3D scatter plots 538, 539
contour plots 512
See also defining
graphs 440
paragraphs 102
polar plots 472
surface plots 496
text regions 100
vector field plots 550, 551

cross product 198, 241
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crossed axes 451, 477
csch function 269
csgn function 417
csort function 278
cspline function 300, 303
Ctrl+M

to create matrix 184
to create vector 182
to edit matrix 184

Ctrl+P for pi 161
cube root 170, 241
cubic spline interpolation 298, 301
cumulative distribution functions 289
cumulative distributions 287
cursor

See crosshair
See insertion point
See selection box

curve fitting
functions for 304
linear 305
polynomial 306, 308
using cubic splines 298

curves, finding area under 252
cutting text 107
cvar function 286

D

d/dx
See derivatives

dashed selection rectangle 64
data analysis

See statistics
data files 424

column width 434
format for data in 424
graphing 446
PRNCOLWIDTH used with 434
PRNPRECISION used with 434
reading data from 426, 428
reading into a matrix 430
significant figures 434
spreadsheet 424
structured 430, 433
unstructured 428

writing a matrix to a file 433
writing data to 426, 429
writing rows and columns of data 433

Data Points, display as
3D bar plots 527
contour plots 516
surface plots 500

date in headers/footers 86
dbeta function 287
dbinom function 287
dcauchy function 287
dchisq function 288
decimal places

See precision
decimal points

symbolic calculation 387
decomposition

matrix 204
partial fraction 392
singular value 205

default formats
graphs 457
polar plots 482

Defaults page
polar plots 482
X-Y plots 457

defining
arrays 182
See also creating
functions 139
global 144
matrices 182
multiple definitions of variable 143
operators 258
programs 316
range variables 218
recursive functions 328
several variables at once 209
units 172, 177
variable in program 316
variables 17, 138
vectors 182

definition symbol (:=) 138
degrees, converting to radians 175
deleting

annotations from Electronic Books 40
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blank lines 69
characters 54
equations 68
filename association 427
graphs 442
line breaks from text 101
lockable area 82
operators 57
pagebreaks 85
parentheses 60
parts of an expression 62
regions 68
text 100, 107

delta function 282, 417
density functions 287
derivatives 242, 248

higher order 251
numerical methods for 635
symbolic 396

determinant 198, 241
numerical methods for 639

Determinant of Matrix command 406
dexp function 288
dF function 288
dgamma function 288
dgeom function 288
diagonal matrix (diag) function 200
dictionaries (spell-checker) 117
did not find solution (error)

in solve block 346
differential equations 358

higher order 361
partial 373
second order 360
slowly varying solutions 366
smooth systems 365
specialized solvers 365
stiff systems 367
systems 362, 363

Differentiate on Variable command 396
differentiation

See derivatives
differentiation variable 248, 251
digamma function 418
dilog function 417
dilogarithm integral 417

dimensions 167, 169
common sources of error 171
consistency 171

Dirac delta function 417
disabling equations 105, 153
Display as Matrix 125
displayed precision 125
distribution functions 287
division 241
dlls 652
dlnorm function 288
dlogis function 288
dnbinom function 289
dnorm function 289
dot product 197
double integrals 255
dpois function 289
dragging regions 65, 66
drawings

See pictures
dt function 289
dunif function 289
dweibull function 289
dynamic-link libraries for Mathcad 652

E

e, base of natural logarithms 165
editing equations

annotated example 52
compared to word-processors 52
deleting ()’s from around expression 60
deleting an operator 57
deleting parts of expression 62
existing expressions 53
inserting an operator 54
making expression an argument to a function 59
math 52
moving parts of an expression 61
moving/rearranging equations 64
numbers 54
putting ()’s around an expression 60
variable or function names 54

editing lines 54
Ei function 417
eigenvalues 203, 204, 415
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eigenvectors 203, 204
Electronic Book

annotating 39
copying information from 36

Electronic Books 11, 12, 34, 35, 37, 39
Desktop Reference 35
moving around in 35
searching for information in 36
table of contents 35

elements, vector and matrix 187
elliptic integral 418
endpoints for ranges 220
epsilon function 283
equality constraints 341
equals sign (→)

symbolic calculations 379
equals sign (=)

as boolean operator 242
in numerical calculations 146
in solve blocks 339, 341
symbolic calculations 401

equations
as constraints in solve blocks 341
breaking 242, 420
calculating results 18, 146, 412
changing font 129
color 129
commenting out 105, 153
definition 138
disabling calculation for 105, 153
effect of range variables in 220
errors in 153
font 129
global definitions 144
highlighting 133
in text 104
locking 79, 81
order of evaluation 142, 149
processing and calculating 18, 149
solving for root 334
solving symbolically 401, 404
solving with solve blocks 339
turning off 105, 153
unlocking 82
using units in 170
wrapping 242

erf function 271, 418
ERR variable 354
error bars

graphs 457, 467
polar plots 481

error function 271, 418
error messages

and user functions 156
correcting 155
in equations 153
not detected with 0 as factor/numerator 155
with units 171

error vector in solve blocks 637
errors

See also individual error messages
Euler’s constant 417
Euler’s gamma function 271
Evaluate command 386
Evaluate in Place command 411
Evaluate Symbolically command 386
Evaluation Style command 410
exp function 270
Expand command 389
expand keyword 380
Expand to Series command 389
exponent 240
exponential

function 269
notation 167
notation in displayed results 125
threshold 125

exponential distribution 290
exponential integral 417
exporting

worksheets as RTF 79
exporting text 113
expressions

applying a function to 59
correcting errors in 155
deleting parts of 62
See editing
error messages in 153
evaluating 146
finding the coefficients of 393
moving parts of 61
range variables in 220
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selecting several 64
simplifying 412
symbolic evaluation of 386
transforming 412

F

F distribution 290
F keys, table of 589
F1, to show Help 31, 33
Factor Expression command 391
factor keyword 380
factorial (!) 240
fahrenheit 175
fast Fourier transform

alternate forms of 277
See Fourier transforms

FFT
See Fourier transforms

fft function 273, 274, 277
file variable 426
file-access functions 424
filename for reading or writing data 426
filename in headers/footers 86
files

compressed 8
reading and writing data files 426
reading data from 424
saving 30
writing data to 424

filters 282, 283
Find function

at end of solve block 340
user functions defined with 349
values returned by 340

first order differential equation 358
fitting a surface

using cubic splines 301
float keyword 381, 383
floating point accelerator 8
Floating Point Evaluation command 386
floor function 273
font

changing in math 129
changing in text 108
default text 109

sensitivity 133
tagging 129
used to display equations 129

font bar
defined 15

font tags 129
applications 132
saving 133
See also tags

for loop 323
formatting

3D bar charts 526
3D scatter plots 540
contour plots 515
results 124
surface plots 499
symbolic 410
vector field plots 553

Fourier transforms
2 dimensional 276
alternate form 277
symbolic 407
using fft 273

FRAME for animation 558
Fresnel cosine integral 418
Fresnel sine integral 418
functions

applying to an expression 59
boolean 280
built-in 266, 594
See also built-in functions
complex arithmetic 169
defined in terms of solve blocks 349
defining 23, 139
file-access 424
Fourier transform 273
graphing 441
hyperbolic 269
inverse trigonometric 268
piecewise continuous 279, 320
plotting function of two variables 497, 513, 525
plotting in polar plot 477
population statistics 286
prediction 303
probability distribution 287
real and imaginary part 272
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recursive 328
regression 304
series for 389
statistical 286
symbolic calculation 417
tensor 283
that take vector arguments 198
to combine arrays 201
to combine vectors or matrices 202
to compute angle to a point 273
to find roots of expressions 334
trigonometric 268
user function names 160
user-defined 139
vector and matrix 198

G

gamma (Euler’s constant) 417
gamma distribution 290
gamma function 271
Gaussian distribution 290
generalized

eigenvalues 203
eigenvectors 203
inverse of a matrix 200

genfit function 310
geninv function 200
genvals function 203
geometric distribution 290
Given, keyword in solve blocks 339
global definitions 144, 145
Go to Page command 74
graphs 439

Auto Grid 451
Autoscale 450, 452
axes style 451
axis labels 461
axis limits 440
axis settings in dialog box 450
bar charts (2D) 457
changing perspective 462
color of traces 456
complex numbers 441
copying format from existing plot 457
creating 25, 27, 29, 440

data values 446
deleting 442
error bars 457, 467
formatting 28, 449
formatting traces 455, 456
graphing functions 441
graphing several curves 447
graphing vectors 444
grid lines 450
hiding arguments 462
horizontal and vertical lines 453
labels and titles 459
legends 456, 462, 468
line charts 457
logarithmic axes 450, 467
markers 456
moving 442
polar coordinates 443, 445
read out of coordinates 465
resizing 27, 463
setting axis limits 452
setting defaults with no plot 458
Show Markers 453, 454
step 457, 467
tick marks 450, 451, 469
titles 460
trace settings in dialog box 455
traces on 447
what to graph 441
with dots 457
zooming 463

grayscale
3D bar charts 530
contour plots 517
surface plots 503

greatest integer 273
Greek letters

in equations 160
in text 111
palette 161
table of 161, 590

grid intervals
3D bar charts 533
3D scatter plots 547
contour plots 521
surface plots 507
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vector field plots 555
grid lines

3D bar charts 532
3D scatter plots 546
graphs 450
on contour plots 520
polar plots 476
surface plots 506
vector field plots 554

guess
for root function 334
for solve blocks 339

H

halting iteration on a condition 281
handbook

See Electronic Book
hard line breaks in text 101
hardware requirements for Mathcad 8
headers and footers 86
Heaviside step function 282
Help 12, 31, 33

context sensitive 34
QuickSheets 31

hexadecimal numbers 124, 167
highlighting changes in Books 39
highlighting equations 133
highpass filter 282
histogram (hist) function 293
history of browsing in Electronic Book 36
hyperbolic cosine integral 417
hyperbolic functions 269
hyperbolic sign integral 418

I

i (imaginary unit) 167
I0, I1 and In Bessel functions 271
icfft function 275, 277
identity matrix 200
if function 279, 280
if statement 319
ifft and icfft functions 273, 274
IFFT function 277
Im function 273

imaginary numbers 167, 168
choosing i or j for display 125
symbol for 125

imaginary part 273
importing

text 113
impulse function 282
Include command 77
incompatible units 172
incompatible units error 171
increments for ranges 220
indefinite integral 398
indefinite sum 395
indented paragraphs 110
index variables

See range variables
inequalities 242

as constraints in solve blocks 341
infinity 165
infinity (∞) 160
inner product 197
input tables 224
Insert Function command 424
Insert Function dialog box 266
insert key 54, 101
Insert Matrix dialog box 182, 184, 185
Insert Unit dialog box 170
Insert Worksheet command 77
inserting

annotations in Electronic Books 39
blank lines 69
characters 54
functions 59
line break in text 101
minus sign in front of expression 58
parentheses around expression 60
text 100
worksheet 77

insertion point 16
installation 8

troubleshooting 8
installing Mathcad 8
integral transforms

Fourier 407
Laplace 408

integrals 242, 252
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contour 255
double 255, 256
indefinite 398
numerical approximations use 254
numerical methods for 633
symbolic evaluation of 399
tolerance for numeric approximation 254
variable limits 253

integrand, of definite integral 252
Integrate on Variable command 398
integrating variable, of definite integral 252
integration

See integrals
intercept function 305
Internet 76
interp function 300, 303, 307, 308
interpolation 297

cubic splines 298
for a vector of points 301
linear 297
using cubic splines 301

interrupted (error) 152
interrupting calculations in progress 152
inverse

cumulative distributions 291
Fourier transform 273, 407
hyperbolic functions 269
Laplace transform 408
matrix 197, 241, 405
trigonometric functions 268
wavelet transform 277
z-transform 409

inverse video
See reverse video

Invert Matrix command 405
iterated product 241, 242, 243
iterated sum 243
iteration 227

See also range variables
faster without subscripts 237
halting 281
on a vector 233
over a range 227
program loops 321
recursive 231
with seed value 231

with several variables 232
iwave function 277

J

j (imaginary unit) 167
J0, J1 and Jn Bessel functions 271

K

K0, K1 and Kn Bessel functions 271
keywords 380
Kronecker delta function 282
ksmooth function 312

L

labeling axes
 graphs 461

labels
graphs 459
polar plots 483

Labels page
polar plots 484
X-Y plots 460

Lambert’s W function 418
Laplace transforms 408
Laplace’s equation 373
last function 199
Laurent series 389
least integer 273
left inverse of a matrix 200
left margin 83
legends

graphs 456, 462
polar plots 480, 485

legends in graphs 468
length function 199
level curves 537
Levenberg-Marquardt method 637

Mathcad’s modifications to 639
steps in 637
termination criteria 638

limits (calculus) 400
limits on array sizes 194
line break
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in equation 242
in text 101

line charts 457
polar plots 481

linear
interpolation 297
prediction 303
regression 304, 305
systems of differential equations 362, 363
systems of equations 205

lines
polar plots 480

linfit function 310
link

to Internet 76
to other worksheets 118
to World Wide Web 76

linterp function 297
Lissajous figures 441
literal subscripts 163
literally keyword 381
ln (natural log) function 270
Load from Web command 76
local result format 25, 126
Lock Area command 81
Lock Regions command 80
lockable area 79

deleting 82
specifying 80

locked calculations 79, 81, 82
loess function 307, 308
log function 269, 270
log normal distribution 290
logical operators 280

See boolean operators
logistic distribution 290
looping 321

for loop 323
while loops 321

loops
See programs
See also range variables

lowpass filter 282, 283
lsolve function 205
lspline function 300, 303
LU decomposition 639

LU decomposition (lu) function 204

M

magnitude 241
complex numbers 169
vector 198

mantissa 272
manual mode 150

starting in 152
margins 83
markers

3D scatter plots 543
graphs 456
polar plots 480

marking changes in Books 39
Markov processes 233
Marquardt method

See Levenberg-Marquardt method
Mathcad

hardware/software requirements 8
icon 14
quitting 31

matrices
adding/deleting rows or columns 184
as arguments to user functions 210
as array elements 211
calculations by element 206
combining 201
combining with augment function 202
combining with stack function 202
condition number 201
creating 184
defining 185
defining by formula 229
defining with two range variables 229
definition of 182
determinant 198, 241, 406
displayed as scrolling output tables 192
extracting a column 187
extracting a submatrix 201, 202
extracting elements 187, 211
functions for 198
inverting 197, 241, 405
limit on size 195
limits on size 194
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matrix arithmetic 197
norm 201
numbering elements 187, 190
numerical methods for 639
operators for 195
ORIGIN used with 190
plotting in 3D bar chart 524
plotting in contour plot 512
plotting in surface plot 496
plotting in vector field plots 551
raising to a power 197, 241
rank 201
reading from data files 430
sorting by row or column 278
start with row and column zero 190
subscripts 189
transpose 198, 240, 405
when to use subscripts 235
writing to data files 433

matrix subscript 240
max function 199
mean function 286
median function 286
medsmooth function 311
memory 8
menu commands

See also indiviudal commands
listed by menu 580

min function 199
minerr function

at end of solve block 354
values returned by 340, 354

MINPACK routines 637
minus sign 241

inserting in front of expression 58
MKS units 177
mod function 273
mode

See auto calc mode, manual calc mode
moving

crosshair 607
editing lines 607
graphs 442
insertion point 607
regions 66
scrollbar 74

to bottom of worksheet 74
to top of worksheet 74

multigrid function 374
multiple integrals 256
multiple roots, finding with solve blocks 344
multiple summations 244, 246
multiplication 51, 241
multivalued functions 170, 269
multivariate cubic spline interpolation 301

N

names
font sensitive 133
operators in 163
variable and function names 160
vectors and scalars use same names 186

natural log 270
negating an expression 58, 241
negative binomial distribution 290
nested arrays 211
noisy data 311
non-linear

differential equations 360
regression 309
systems of equations 339

non-scalar value (error message) 219
norm

functions 201
of matrix 201
of vector 198, 241

norm1 and norm2 functions 201
normal distribution 290
norme and normi functions 201
not converging (error)

integrals 254
root function 335

notation used in manual 13
nth order derivative 251
nth root 170, 241
numbering pages 86
numbers 166

complex 167, 168
dimensional values 167
displayed as zero 125
exponential notation for 125, 167
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format for computed results 124
formatting 24, 124
hexadecimal 167
imaginary 167, 168
octal 167
radix (base) for results 124

numeric format
See result format

numerical methods 632
differentiation 248, 251
for derivatives 635
for matrix inversion and determinants 639
for root function 636
for solve blocks 637
integrals 633
integration 252
sorting vectors and matrices 640

O

octal numbers 124, 167
opening

Electronic Books 37
opening a worksheet 75
operators

as parts of variable name 163
boolean 280
complete list of 591, 593
defined 48
defining 258
derivative 248
for complex numbers 169
for vectors and matrices 195
how to type 240
indefinite integral 398
inserting 54
integral 252
iterated product 243
iterated sum 243
limits 400
listed in order of precedence 240
logical 257, 280
nth order derivative 251
palette 12, 15, 240, 243
vector sum 247

Optimize command 413

optimizing expressions 412
order of calculation of equations 149
order of derivative 251
order of evaluation 145
ORIGIN variable 165, 190, 226
output tables 222
overlapping regions 69
overtyping text 101

P

page
boundary 83
headers and footers 86
numbering 86

Page Setup dialog box 83, 84
pagebreaks, inserting and deleting 84
palette 12, 15, 243
paragraphs 102

changing into text regions 104
compared to text regions 102
creating 102
editing 105
format 110
how to use in worksheets 102
push other regions out of the way 102
wrap margin for 103

parametric surface plots 498
parentheses 60

deleting from expression  60
partial differential equations 373
partial fractions 392
password

locked areas 81
pasting

arrays 147
from clipboard 61
from Electronic Books 37
numerical results 147
text 107

patch plots 505
pbeta function 290
pbinom function 290
pcauchy function 290
pchisq function 290
pending computations 149, 150
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percent 165
perimeter axes 477
permutations 283
personal dictionary (spell-checker) 117
perspective for 3D bar charts 527
perspective, changing

3D bar charts 526
3D scatter plots 541
surface plots 501
vector field plots 553

pexp function 290
pF function 290
pgamma function 290
pgeom function 290
pi (3.14159...) 53, 165
pi (product symbol) 243
pictures

importing into an array 436
piecewise continuous functions 279, 320
placeholder 16

in graph regions 440
units 174

Playback command 561
plnorm function 290
plogis function 290
plots

3D bar charts 523
3D scatter plots 537
contour plots 511
graphs 439
See also graphs, surface plots
polar plots 471
read out of coordinates 488
surface plots 495
vector field plots 549

pnbinom function 290
pnorm function 290
points, plotting 538
poisson distribution 290
Poisson’s equation 373
Polar Axes page

polar plot defaults 482
polar plots 475

polar coordinates 471
polar plot defaults dialog box 482
polar plot dialog box

Defaults page 482
Labels page 484
Polar Axes page 475
Traces page 479

polar plots 471
Auto Grid 476
Autoscale 479
axes style 477
axis settings in dialog box 476
bar charts 481
changing perspective 486
color of traces 481
copying coordinates to Clipboard 489
copying format from existing plot 482
creating 472
error bars 481
formatting 475
formatting traces 479, 480
graphing several curves 473
grid lines 476
hiding arguments 485
horizontal and vertical lines 478
labels and titles 483
legends 480, 485
line charts 481
lines 480
logarithmic axes 476
logarithmic axis limits 477
markers 480
radial reference lines 478
relation to rectangular plots 443
resizing 486
setting axis limits 477
setting defaults with no plot 482
Show Markers 478
step 481
tick marks 476
titles 484
trace settings in dialog box 479
traces on 473
using default settings 483
with dots 481
zooming 486

Polar Trace dialog box 488
Polar Zoom dialog box 486
polygamma function 418
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polynomial
finding the roots of 338
regression 306, 308

Polynomial Coefficients command 393
polyroots function 338
population statistics 286
power 240
ppois function 290
precedence among operators 240
precision in displayed results 125
predefined variables 165
predict function 303
prediction 297
principal branch of function 170, 269
Print to Right Margin button 84
Print Whole Width button 84
printing 30, 82

blank pages in 83, 84
calculate worksheet first 151
color 133
current page 82
extra pages 83
print preview 86
selected pages 83
selected regions 82
wide worksheets 84

PRN files 430, 433
PRNCOLWIDTH variable 165, 434
PRNPRECISION variable 165, 434
probability density functions 287
probability distribution

beta 290
binomial 290
cauchy 290
chi-squared 290
exponential 290
F 290
gamma 290
geometric 290
log normal 290
logistic 290
negative binomial 290
normal 290

poisson 290
Sudent’s t 290
uniform 291
Weibull 291

probability distributions 287
processing equations 18, 149, 151

results of 149
product 241, 242, 243

cross product 198
dot product 197
over a range 243
symbolic 395

program
defining 316
if statement 319
looping 321
palette for creating 15
recursion 328
statements 316
subroutine 327

proxy server 76
Psi functions 418
pspline function 300, 303
pt function 290
pulse function 282, 283
punif function 291
pweibull function 291

Q

qbeta function 291
qbinom function 291
qcauchy function 291
qchisq function 291
qexp function 291
qF function 291
qgamma function 291
qgeom function 291
qlnorm function 291
qlogis function 291
qnbinom function 291
qnorm function 292
qpois function 292
QR decomposition function 204
qt function 292
QuickSheets 12, 31
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storing custom operators 262
QuickTime movies

compression 558
playback 561
saving 558

quitting Mathcad 31
qunif function 292
qweibull function 292

R

radians
converting to degrees 175
trig functions 267

radix of displayed results 124
random number generators 294
Randomize command 295
range variables 22, 218

creating 22
defining 218, 220
fundamental principle for 220
how Mathcad evaluates equations with 220
in expressions 220
setting endpoints and increments 220
using two in one equation 230

rank function 201
rbeta function 294
rbinom function 294
rcauchy function 294
rchisq function 294
Re function 273
READ function 425, 428
READBMP function 436
readout of coordinates

graphs 465
plots 488

READPRN function 425, 430
advantages of 435

READRGB function 436
real part 273
rectangle to indicate disabled equation 153
recursion 231, 328
reduced view 64
reduced-row echelon form 200
reference existing worksheet 77
reference lines in graphs 453

regions 21
3D bar charts 523
3D scatter plots 537
aligning 67
blank space between 21
contour plot 511
copying 65
deleting 68
dragging 65, 66
dragging across documents 66, 67
equation 21
graphs 439
locking 79, 81
moving 66
overlapping 69
polar plots 471
selecting 17
separating 69
surface plot 495
text 100
unlocking 82
vector field plots 549
viewing 21, 69

regress function 307, 308
regression

linear 305
non-linear 309
polynomial 306, 308
using linear combinations of any functions 309

regression functions 304
relational operators 280

See boolean operators
relax function 374
replacing

string 114
resizing

3D bar charts 526
3D scatter plots 540
contour plot 514
graphs 463
polar plots 486
surface plot 499
text regions 101
vector field plots 552

result format 124
global 124
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local 126
results

calculating 18
calculating with equations 146, 412
copying 147
dimensions in 173
scaling 175

reverse function 278
rexp function 294
rF function 294
rgamma function 294
rgeom function 294
Rich Text Format (RTF) 79, 113
right margin 83
right page boundary 83
rkadapt function 365
rkfixed function 358
rlnorm function 294
rlogis function 294
rnbinom function 294
rnd function 294, 295
rnorm function 294
Romberg integration 633
root

See also root function
root function 334

defining user function in terms of 337
failure of 335
initial guess for 334
numerical methods for 636
tolerance for numeric approximation 335
uses secant method 335

roots
finding 334
finding multiple roots with solve blocks 344
of polynomials 338
using plots to find 336

rounding off 272
row vectors 184
rows function 199
rpois function 294
rref function 200
rsort function 278
rt function 294
runif function 295
rweibull function 295

S

Save As dialog box 30
Save Configuration command

used to save calculation mode 152
saving

annotations in Electronic Books 39
configuration 87
font tags 87
new file 30
worksheets 30, 76

sbval function 371
scalar

addition 197
definition of 182
division 197
multiplication 197

scaling results 175
scatter plots 468, 537
scatter plots (3D)

Autoscale 547
back planes 543
borders 542
boxes 542
changing marker formats 543
connecting by lines 545
converting 541
creating 538, 539
formatting 540
formatting axes 546
grid intervals 547
grid lines 546
perspective 541
resizing 540
setting axis limits 547
tick marks 546
titles 547

scientific notation
See exponential notation

scrolling 74
autoscroll 66

scrolling output table 192
copying values from 148
setting numerical format for 125

search
Electronic Book 36
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See Find command
in equations 113
in text 113

secant (sec) function 268
secant method 335, 636
sech function 269
second derivative 251
second derivatives

for spline functions 302
second order differential equations 360
seeded iteration 231

with a vector 233
with several variables 232

selecting regions 17
selecting several equations 64
selection rectangle 64
semicolon, in range variable definitions 218
separating overlapping regions 69
series 389
series keyword 380
Set Lockable Area command 80
shading

contour plots 517
surface plots 503

Shi function 418
Show Markers

graphs 454
polar plots 478

Si function 418
sigma (summation symbol) 243

for vector 198
sign function (complex) 417
sign function (real) 418
signum function 418
Simplify command 388
simplify keyword 380
simultaneous definitions 209
simultaneous equations

solving numerically 339
solving symbolically 404

sine function 268
sine integral 418
singular value decomposition 205
singular values of a matrix 205
singularities in trig functions 268
sinh function 269

slope function (linear regression) 305
smooth systems (differential equations) 365
smoothing data 311
software requirements for Mathcad 8
solve blocks 339

cannot be nested 342
constraints in 341
defining a function that uses 349
defining variables in terms of 343
definition of 340
did not find solution error 346
displaying results of 342
end with Find or Minerr 354
error vector in 637
expressions allowed in 341
finding multiple solutions 344
finding vector of results 350
Given keyword 339
Levenberg-Marquardt algorithm 637
numerical methods for 637
solving for different variables 352
too few constraints in 347
using effectively 349
using to solve symbolically 404
values returned by 340, 354

Solve for Variable command 401
solving equations 339

differential equations 359
See also solve blocks
with matrix function 205
with root function 334
with solve blocks 339, 404
with Solve for Variable 401

sort function 278
sorting vectors and matrices 278

algorithm used for 640
spaces, inserting or deleting 69
spellcheck 116
spline functions 298, 301

end conditions for 300, 303
example using 299
multivariate 301
second derivatives for 302

spreadsheets 424
reading data from 430

square root 241
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estimating arithmetically 231
stack function 201, 202
standard deviation (stdev) function 286
standard normal distribution 290
starting Mathcad 8
statistics

cubic spline interpolation 298
cumulative distribution functions 289
density functions 287
functions 286
generalized linear regression 309
histograms 293
interpolation 297
inverse cumulative distributions 291
linear interpolation 297
linear prediction 297, 303
linear regression 304
multivariate cubic spline 301
multivariate polynomial regression 308
non-linear regression 309
polynomial regression 306
random number generation 294
smoothing data 311

step function 282
step graph

graphs 457, 467
polar plots 481

step-size for iteration 220
stiffb function 365
stiffr function 365
structured data 433
submatrix function 201, 202
subroutines 327
subscripted variables

calculating with 227
entering values in input tables 224

subscripts
in text 109
last element function 199
left bracket used to type 187
literal 163
non-numeric 163
ORIGIN used with 190
start with zero 190
vector and matrix 187, 240
when to use 235

Substitute for Variable command 394
subtraction 242
Sudent’s t distribution 290
summation 241

multiple 244, 246
of vector elements 198
symbolic evaluation of 395
variable upper limit 246

summations, over a range 243
superscript

array 240
example of array superscript in use 233
in text 109
to get column from matrix 189

supsmooth function 312
surface plots 495

Autoscale 507
back planes 502
borders 501
boxes 502
changing the shading 503
controlling how bumpy 501
converting 500
creating 496
discontinuous 505
formatting 499
formatting axes 506
grid intervals 507
grid lines 506
mesh on the surface 504
of function of two variables 497
parametric 498
patch plots 505
perspective 501
resizing 499
setting axis limits 507
tick marks 506
titles 508
vertical scale 501

svd function 205
svds function 205
symbol palette 12, 15, 243
symbolic

equal sign 379
evaluation 379
evaluation returns long answers 420
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optimization 412
transforms 407
updating results of evaluation 386

system requirements for Mathcad 8

T

tables
input 224
output 222
show only 50 elements 223

tags 129
applications 132
saving 133

tangent (tan) function 268
tanh function 269
Taylor series 389
temperature 175
templates

for math 32
text 99

alignment 110
changing font 108
changing from paragraph to region 104
cut and paste in 107
deleting 107
editing 105
entering 19
exporting to other programs 113
Greek letters in 111
importing from other programs 113
inserting equations 104
moving 104
moving insertion point in 106
paragraphs 102
regions 100
selecting 106
selecting a word 106
spellcheck 116

text box 19, 100
text regions 100

changing width 101
compared to paragraphs 102
creating 19, 100
editing 105
hard line breaks 101

how to exit 20, 100
three-dimensional plots

See surface plots
tick marks 451

3D bar charts 532
3D scatter plots 546
contour plots 520
graphs 450
polar plots 476
surface plots 506
vector field plots 554

tilde (~), used in global definitions 144
tiling windows 37
time in headers/footers 86
Title page

3D bar chart 534
3D scatter plots 547
contour plots 521
surface plots 508
vector field plots 555

titles
3D bar charts 534
3D scatter plots 547
contour plots 521
graphs 459, 460
polar plots 483, 484
surface plots 508
vector field plots 555

TOL variable 165
used with integrals 254
used with root function 336
used with solve blocks 346

tolerance
in integration algorithm 633
in root function 636
See also TOL variable

too few constraints (error) 347
too many files (error) 427
toolbar 15
top margin 83
top-to-bottom evaluation 142
trace (tr) function 201
traces

graphs 447
polar plots 473

Traces page
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polar plots 479, 482
X-Y plots 455

trailing zeros 125
transcendental functions 267
transforms

Fourier (numerical) 273
Fourier (symbolic) 407
Laplace 408
symbolic 407
wavelet 277
z 409

Transpose Matrix command 405
transpose of matrix 198, 240, 405
trigonometric functions 267, 268

with degrees and radians 175
troubleshoooting 8
truncation 272, 273

See floor function
two point boundary value problems 370
typing over text 101

U

undefined variables 143, 145
uniform distribution 291
unit impulse function 282
unit step function 282
units 169

base units 177
CGS system 177
changing dimension names 179
common sources of error 171
converting calculated results 174
defining 177
defining your own 172
dimensional consistency 171
dimensional values 167
errors in dimensions 171
in calculated values 173
in equations 170
in tables 223
metric 177
placeholder 173, 174
US Customary 177

Unlock Area command 82
until function 279, 281

update
file access functions 427
results in window 149
window manually 150
worksheet 151
worksheet window 151

URL (for Internet address) 76
US Customary units 177
user functions 139

array arguments 210
defined in terms of root 337
defined in terms of solve blocks 349
errors in 156
evaluating variables in 141
valid names 160

V

values
See numbers

variables
complex 168
defining 17, 138
defining several at once 209
font tag 129
global definitions of 144
in red 145, 154
matrices 182
names 160
predefined 165
range variables 22, 218
substituting for 394
variable names 160
vectors 182

variance (var) function 286
vector field plots 549

creating 550, 551
formatting 553
formatting axes 554
from complex matrices 550, 551
from real matrices 551
grid intervals 555
grid lines 554
perspective 553
resizing 552
tick marks 554
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titles 555
vector product 241
vector subscript 240
vector-sum operator 247
vectorize operator 206, 240

effect of 207
how to type 207
properties of 209
when to use 237

vectors
as arguments to user functions 210
as array elements 211
calculations by element 206
column vectors 184
combining 201
combining with augment function 202
combining with stack function 202
computing with 185
cross product 198
defining 182, 185
defining several variables at once 209
definition of 182
displayed as scrolling output tables 192
dot product 197
functions for 198
graphing 444
limit on size 195
magnitude 198, 241
norm 198, 241
numbering elements 187, 190
operators for 195
ORIGIN used with 190
row vectors 184
solve blocks applied to 350
sorting elements 278
start with element zero 190
subscripts 187
sum elements of 241
sum of elements operator 198
undefined elements filled with zeros 188, 190
vector arithmetic 197
vectorize operator 206
when to use subscripts 235

vertical scale
3D bar charts 528
surface plots 501

View page
3D bar charts 527
3D scatter plots 541
contour plots 516
surface plots 500

W

W function 418
wait message 150
wave function 277
wavelet transforms 277
Weibull distribution 291
while loops 321
windows

generally 74
multiple 75
scrolling 74
update results automatically 149
update results manually 150
zooming in and out 64

Worksheet command 77
worksheets

definition of 13
exporting as RTF 79
inserting 77
Internet 76
opening 75
order of evaluation 142
pointer to 77
printing 30
referencing in another worksheet 77
saving 30, 76

World Wide Web 76
wrap margin for paragraphs 103
wrapping equations 242
WRITE function 424, 425, 429
WRITEBMP function 438
WRITEPRN function 424, 425, 433

advantages of 435
WRITERGB function 438

X

X-Y plot default dialog box 458
X-Y plot dialog box
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Axes page 449, 452
Defaults page 457
Labels page 460
Traces page 455

X-Y Trace dialog box 465
X-Y Zoom dialog box 463

Y

y-intercept 305
Y0, Y1 and Yn Bessel functions 271

Z

z-transform 409
zero

as denominator 633
as factor or numerator 633
tolerance 125

zeros of expressions or functions
See roots

Zeta function 419
zooming

graphs 463
polar plots 486
windows 64
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